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1 Welcome to the Signavio user guide
If you are new to Signavio, we recommend to read the sections Getting started
and What kind of Signavio user am I .
If you are already familiar with Signavio, navigate the table of content on the left
side of your screen, or use the search to find the sections that are most relevant to
you.
For additional information, take a look at:
o
o
o
o
o

Signavio Featured Videos

Signavio Tutorial Videos
Signavio applied BPM and DMN Blog
The Signavio White Paper Download Center
Signavio's eLearning courses
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2 Signing up
Signavio is a web application. This means you access your Signavio Process Manager workspace by logging into your account on the Signavio server.
Go to http://www.signavio.com and click the Try it button in the upper right
corner of the page to register for the software. Alternatively, if you received an
invitation email to the Signavio software, you can click the link in the email to get
to the page. If you are using the On Premise version of Signavio, get the local URL
from your workspace administrator.
If you register for a trial account with an email address that has been
invited to join a Signavio workspace, this license will be automatically
added to your new account.
To optimize worldwide availability, we provide three Software-as-a-Service systems:
o

https://app-us.signavio.com/ is hosted in the USA.

o

https://editor.signavio.com is hosted in Germany.

o

https://app-au.signavio.com is hosted in Australia.

When you register to create your workspace, you can decide which system you want to use.

2.1 Create your Business Transformation Suite account
1. Go to the registration page or click the link you received in your invitation
email.

2. Follow the steps on the screen to set up your account.
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When you received an invitation email, you need to use the email
address to which the email was sent in order to sign up with the
proper license.
3. Use your account email and password to log in to the Business
Transformation Suite.

2.2 Supported browsers
Signavio Process Manager supports all popular browsers. If you experience problems
with Signavio Process Manager, you may be using an outdated browser that is not
fully compatible with our system. The following web page provides a detailed list of
supported browsers and assesses the compatibility of your browser automatically:
http://www.signavio.com/browser-compatibility
If the page indicates that your browser seems to be compatible, some
features may not be fully supported. We recommend you switch to a
browser that fully supports all features, to have an optimal user experience.
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3 Log in to the Business Transformation Suite
3.1 Log in with your account credentials
After you've created your Business Transformation Suite account (see section
Create your Business Transformation Suite account), use your account email and
password to log in.
In the case that your workspace administrator has created the account for you, you
received an email to reset your password. When SSO is enabled for your workspace,
you log in using a shared link (see section Log in using a shared link).
1. Go to the Business Transformation Suite login page:
o
o
o

Login page (hosted in EU)
Login page (hosted in Australia)
Login page (hosted in US)

2. Enter your account email and password and click Login.
o

If you receive the error message that the login with email and password
is disabled, SSO is enforced for your workspace and you need to you log
in using a shared link (see section Log in using a shared link).

3. Select your workspace and click Login. The Collaboration Hub launchpad
opens. Continue with section launchpad.

If you don't have the Suite license, Process Manager explorer or
the Collaboration Hub opens depending on your user license.

3.2 Log in using a shared link
When SSO is enabled for your workspace, you log in through a shared link. The link
is shared with you, for example, in an invitation email or on a wiki page.
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We recommend that you bookmark the shared link for future logins.
Depending on your workspace configuration, you might only be able to
log in to the Business Transformation Suite through the shared link.
1. Click the link.
2. Follow the steps you see on the screen. Your account will be authenticated by
a third-party application.
3. After successful log in, the Collaboration Hub launchpad opens. Continue with
section launchpad.

3.3 Log in to the on-premises solution
When SSO is enabled for your workspace, you log in through a shared link. The link
is shared with you, for example, in an invitation email or on a wiki page.
1. Go to the local URL or click the shared link to open the login page. You can get
the local URL from your workspace administrator.
2. Enter your account email and password and click Login. Process Manager
explorer opens.

3.4 Next steps
o
o
o

Launchpad
Create a diagram
Move and change elements
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4 Getting started
Signavio is a web application. This means you access your Signavio Process Manager workspace by logging into your account on the Signavio server. You can find
out how to register and login in the section Signing up .
This chapter provides an overview of the features of Signavio Process Manager. If
you are already familiar with Process Manager, you can use the content overview
to jump to the chapter that is relevant to you.

4.1 The Explorer
After logging in, What is the Explorer? opens in your browser. It allows you to navigate through diagrams and files stored in your Signavio workspace. Here you can
create new diagrams and publish them in the Collaboration Hub or share them by
other means. As Signavio supports open standards, importing diagrams from other
systems is easy. In the Explorer, you can adjust your personal settings. Administrators can also configure workspace settings here.

The Explorer with expanded diagram preview/activity feed panel

4.2 The Editor
The Editor (Modeling) can be accessed by opening a diagram or creating a new one.
Using the Editor, you can create and edit all kinds of supported diagrams.
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The Editor with opened attributes panel
Besides BPMN 2.0, Signavio supports Decision Model and Notation (DMN),
ArchiMate, and many Further notations.

4.3 QuickModel
Modeling with QuickModel gives you the possibility to create simple BPMN-diagrams within seconds by use of a spreadsheet-like interface. Diagrams created in
this application can be edited in the Editor like any other diagram to add complexity
or update the process.
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Creating a diagram in the QuickModel application

4.4 The Dictionary
Working with the Dictionary allows you to manage and re-use specific modeling
elements. It also allows you to ensure all your modelers are using the same terms
and elements in your organization-specific modeling environment.
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The Dictionary, shown here with the Roles category opened

4.5 Collaboration Hub
Collaboration Hub provides access to your published process landscape. Readers
and commenters can access Collaboration Hub via a browser certificate or Directory
Services and/or Microsoft SharePoint integration .
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Collaboration Hub

4.6 The Diagram and Revision Comparison Tool
The diagram and revision comparison tool (Comparing revisions ) helps you to keep
track of changes.

The diagram revision feature
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4.7 BPMN and DMN Simulation
With Signavio Process Manager, you can run Simulating BPMN diagrams and DMN
simulation to analyze key performance indicators and bottlenecks and apply your
business decision logic directly within the tool. The DMN Test lab helps you to continuously check whether your decision logic is consistent with your initial requirements.

A diagram being simulated

4.8 Support
Our team is constantly improving and extending Signavio Process Manager. You will
find the latest version number and our release notes at http://www.signavio.com/release-notes/.
Do you have any questions about working with Signavio Process Manager?
Our Customer Support will be happy to help you!
Contact the Signavio Customer Support at: support@signavio.com
You can also send a support request from the editor. Go to the user menu and select
Send feedback from the drop-down list.
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4.9 What kind of Signavio user am I
The following sections explain the different user types of Signavio. If you already
know in what way you would like to use the software, you can select the topic that
is relevant for you.

4.9.1 I am a business process (BPMN) modeler
Learn how to collaboratively model business processes in BPMN (Business Process Model and Notation) or EPC (Event-driven Process Chains) with Signavio
Process Manager. In addition to BPMN and EPC, Signavio supports all popular open
modeling languages for business users.
In the section BPMN modeling, you learn about the notation and about creating,
editing and working with Business Process Model diagrams.

4.9.2 I am a business decision modeler
Use the Signavio Decision Manager to model business decisions in a structured and
formalized manner all stakeholders can easily understand using the Decision Model
and Notation (DMN) . Integrate your DMN diagrams seamlessly into your BPMN process landscape.
In the section Decision Model and Notation (DMN), you learn about creating, editing and managing decision diagrams.

4.9.3 I am an enterprise architecture modeler
Use the Signavio ArchiMate Edition to create a visual, business domain-crossing
description of your enterprise architecture. Employ ArchiMate together with your
BPMN process landscape.
In the section ArchiMate, you learn about creating and editing Enterprise Architecture diagrams.
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4.9.4 I'd like to create a process diagram, but don't know BPMN very
well
Learn how to use the QuickModel to create valid BPMN processes through a spreadsheet-like interface. Create your first processes in just a couple of minutes or add
and maintain element attributes in a fast and well-structured manner.
In the section Modeling with QuickModel, you learn how to use the application to
quickly create BPMN diagrams.

4.9.5 I am a Collaboration Hub user
Get to know Signavio Collaboration Hub: view process diagrams and discuss them
with your colleagues.
In the section Collaboration Hub, you learn how to use the Collaboration Hub to
work on diagrams together with colleagues and external stakeholders.

4.9.6 I want to review and approve diagrams before they are
released
Make use of Signavio's Approval Workflows to ensure that diagrams have been
approved by specific users or user groups before they are published in Collaboration
Hub.
In the section Working with approval workflows, you learn how to start and work
with approval workflows.

4.9.7 I am a Signavio workspace administrator
Learn how to configure your workspace in order to get the most out of Signavio Process Manager and to maximize the benefit considering the unique needs of your
organization.
Moreover, learn how to integrate Signavio into your organization's IT infrastructure
and enable smooth and hassle-free process, business decision and enterprise architecture documentation, utilizing your existing IT systems to the fullest extent.
As a workspace administrator, you will find information about configuring the software in the Workspace administration section of the manual.
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4.10 What is the Explorer?
The Explorer is the entry and management point of Signavio Process Manager. In
the Explorer you can manage folders and diagrams, create new diagrams, export diagrams, generate reports, as well as publish and embed diagrams. You can also edit
your profile settings and manage the administrative aspects of your workspace. You
can access the Editor, Collaboration Hub and other functions in the software via
the Explorer.
From the Explorer view you have access to all tools that Signavio Process Manager
offers.

The Signavio Explorer: Creating a new diagram

The Explorer is structured as follows:
o

View
The central area displays the file contents of the selected folder.
Double-click diagrams in the Editor to open them. Unread diagram comments are displayed as small speech bubbles attached to the corresponding files. You can switch between The icon viewThe Explorer
view and the The list view. At the bottom of the central view is the
activity feed and the diagram preview.

o

Menu
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The toolbar with a dropdown menu allows you to access different functionalities. Read more in the section The Explorer menu.
o

Search function
The search function is a useful tool to quickly find diagrams. In addition to the
full text search, the advanced search option offers you a method to add specific search criteria. You can find a detailed description in the Search functions section.

o

Folder tree
The folder tree on the left allows you to quickly navigate within your workspace. Read more at Working with folders and diagrams .

o

Diagram details
The notification and activity feed allows you to view and manage the history
of a diagram and to modify notification settings of diagrams and folders. By
pressing the space bar you can open the preview panel (see Viewing diagram
details) and the version overview (see The notification and activity feed ) of a
diagram at the bottom.

o

Personal profile
You can customize the Explorer by adjusting your Personal profile settings
according to your needs.

4.11 The Explorer view
4.11.1 The icon view

In this view, diagrams and folders are represented as icons. For diagrams, a small
preview is provided that allows you to find the diagram you are looking for faster.
Details about a selected diagram can be found at the bottom of the Explorer in the
activity panel (see Viewing diagram details) .
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When working on diagrams collaboratively--for example, in the Collaboration Hub-it is possible to comment on diagrams and diagram elements. Unread comments
that were created by users who are not members of your workspace will be marked
with a little speech bubble symbol in the Explorer.

Unread comments are also displayed in the icon view

To view your colleagues' comments, open the respective diagram in the Editor. To
read more about commenting, go to section Accessing detailed information and
comments.

4.11.2 The list view

Diagrams and folders are listed along with additional information about each file.
Selecting an element activates the diagram preview in the preview panel at the bottom if the panel is extended.

Sort list entries

Clicking the title of a row sorts the elements by the respective column.
4.11.2.1 Managing the list view
You can individually configure which of the diagram attributes are shown as
columns in the table view. All attributes on diagram level and the attributes Revision , Last Change , Last Author and Published are available.
To configure the list view, proceed as follows:
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1. Click Setup , then Edit general configuration . A dialog box will open.
2. In the Explorer section, you can edit the table columns preferences. Click Add
attribute to add another attribute to the list view.

You can rearrange the order of the attributes using the arrow icons and configure the size and the position of the attribute column. To delete an attribute
from the list view click the trash button.
3. Click Save to save your settings. The list view is updated with the attributes
you have configured.

4.11.3 Refreshing the Explorer view
After saving a diagram in the Editor (after renaming it, for example), the Explorer
view may not be up-to-date anymore. In this case, a dialog asking you to refresh
pops up.

Note to refresh the Explorer view
Sometimes, you may want to refresh the Explorer manually. Use the Refresh button in the top right corner of the Explorer.
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Manually refresh the view if the system does not register a change

4.11.4 Display of the current path
In both the list and in the icon view, you see the file path on top of the list. If you
want to jump to a parent folder, click the corresponding folder name.
The following example shows how to jump back to the 'Shared documents' folder:

Use the diagram path for quick navigation

4.12 The Explorer menu
4.12.1 New
In the dropdown header New, you can create new folders and diagrams. The new
folder will appear at the location that is currently open in the Explorer. If you
choose to create a new diagram, a blank canvas on which you can model the kind of
diagram you selected will open in the Editor in a new tab. The menu item QuickModel opens a new BPMN 2.0 diagram in Modeling with QuickModel.
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4.12.2 Edit
Here, you can open the Editor or QuickModel to edit diagrams, simulate BPMN (see
Simulating BPMN diagrams) and DMN (see DMN simulation) diagrams and test
DMN diagrams (The DMN Test lab). To gain an overview of activities about a specific diagram you can display comments on diagrams in Collaboration Hub and compare versions of diagrams (see Comparing revisions). The folder content currently
displayed in the Explorer can be moved, copied, deleted, and renamed. BPMN 1.2
diagrams can also be migrated to the newer BPMN 2.0 format.
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4.12.3 Import/Export
You can import and export files in Signavio Process Manager. This means you are
able to upload files to your Signavio workspace and also download diagrams from
your workspace onto your computer in different formats.

4.12.4 Reporting
The Reporting menu allows you to create different kinds of reports about diagrams.
This enables business users to analyze their process hierarchy offline with decision
makers and analysts, regardless of their familiarity with BPMN modeling.
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4.12.5 Share
With the Share menu, you can use your Shared Documents folder to publish diagrams to Collaboration Hub and share documents in a variety of ways with your colleagues.

4.12.5.1 Approval workflows
Working with approval workflows are evaluating processes that diagrams have to
go through before they are automatically published to Collaboration Hub. You can
start approval workflows as well as edit published diagrams. Approval workflows
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are managed and executed in Workflow Accelerator. If you are interested in further
functionalities of Workflow Accelerator, you can get more information here:
https://www.signavio.com/products/workflow-accelerator/.
To use approval workflows in the On Premises Edition , the Workflow
Accelerator application will have to be installed alongside Process Manager on your server.
4.12.5.2 Invitations to comment/edit
The second section of the menu lets you invite modelers to edit. You can also use it
to invite Collaboration Hub users and external stakeholders to comment on diagrams.
Invite to comment

You can invite anyone to comment on a diagram--all you need is their email
address. They will receive an email with a link that leads directly to the corresponding diagram in the commenting view. Unregistered users can view and comment only on the specific diagrams they were invited to.
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The menu item Manage feedback invitations lets you revoke any invitations to
comment on a diagram.

Invite modeler to edit

You can invite modelers registered in your workspace to edit a diagram. As all
modelers are able to edit all diagrams in the Shared documents folder by default,
this function serves as notification to let fellow modelers know a diagram needs
their attention. You can clarify the reason why you are pointing a modeler towards
a certain diagram by editing the text of the email in the invitation dialog. The link
you send leads directly to the diagram, open and ready to be edited in Signavio Process Manager.
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The option to Invite to fill out QuickModel follows the same basic concept, only
instead of the Editor, the link leads to the diagram in Modeling with QuickModel.
4.12.5.3 Collaboration Hub
In this menu section, you can view diagrams in Collaboration Hub, publish and
unpublish diagrams, and invite users to open diagrams in Collaboration Hub.
Preview in Collaboration Hub

Collaboration Hub offers a structured and detailed overview on diagrams. Before
publication, you can check how a Collaboration Hub user would see the diagram.
This option can also be useful for modelers who need to to become familiar with
complex diagrams before editing them. Also, Collaboration Hub provides a full
screen view for diagrams.
Publish to Collaboration Hub

You can select one or several diagrams or folders and publish them (see Publishing
diagrams in Collaboration Hub). The corresponding diagrams will be visible for Collaboration Hub users and modelers in the folder tree of Collaboration Hub on the
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left. They will not be accessible for colleagues who have been invited to comment
on a specific diagram by email but do not possess a browser certificate or a Signavio
account.

Unpublish from Collaboration Hub

You can use this option to remove a diagram from Collaboration Hub's folder tree
for certificate based users. However, modelers that are logged in at Signavio will
still be able to see it when they go to Collaboration Hub. Also, this option has no
influence on feedback invitations. If you would like to revoke those as well, please
click on the menu item Manage feedback Invitations and remove the corresponding e-mail addresses from the list.
Invite to Collaboration Hub

If you click this option, you can send an invitation to Collaboration Hub to any email address. If this option is available in your version of Signavio, you can send a

Version 14.9

27

4

Getting started

browser certificate with the email. After the certificate has been installed in the
corresponding browser, the invitee will have access to the Signavio Collaboration
Hub and all published diagrams in your workspace.

4.12.5.4 Embed diagram
With the dialog that opens, you can embed the corresponding diagram into external
systems (see Publishing diagrams to external systems ) like webpages or wikis in
several ways, from simple HTML to Microsoft SharePoint.

4.13 Personal profile settings
You can use personal profile settings to customize Signavio Process Manager according to your needs. Profile settings are centrally managed in the My profile dialog,
which can be accessed via Setup - My profile.
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In the 'My profile' dialog you can customize your user profile

If you have registered multiple workspaces with the same email address,
the settings for password, language and user name apply globally for
all workspaces. The settings or information about licenses, groups, tips,
and subscriptions apply to the current workspace.

4.13.1 Global settings
Global settings apply to all the workspaces you are registered with.
In the My profile dialog, you can add or edit the following information:
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Parameter

Description

Academic
title, first
name, last
name

These three fields make up your user name. It appears whenever you
interact with the software or a colleague, like in diagram version histories in the activity feed or when you invite someone to collaborate.
Changes in the user name are only displayed after reloading the
page.

The email address you are registered with at Signavio Process Manager. You will get notifications from the Signavio
Email

software to this address if you have subscriptions.
Note : Because this email is associated with your license, you
will need to contact Signavio Support (support@signavio.com) if you want to change it.

Company/Org. The name of your organization.
Language

Here you can specify the language for your personal profile. After
clicking Save, the page will be reloaded in the selected language.
More information about languages can be found in the Supported
Languages section.

Password

To change your password, simply type the new password in the corresponding field, then again in the field below and click Save. The
password requirements can be set by the administrator. More information can be found in the section Manage security settings.

4.13.2 Local settings and information
Local settings and information apply only to the workspace you are currently working in.
Parameter

Description

Edition

This entry tells you what Signavio licenses you are registered for. If you
need additional licenses, please contact your administrator.

Groups

The user groups you are a member of are listed here. Administrators
can add and delete users to user groups as explained at Manage
users and groups.

Display
today's top
tip automatically

Activate the checkbox if you would like to see a new tip every day after
login.

All your subscriptions are listed here. You can delete those that are no
longer needed by clicking Remove. By default, new users are autoSubscriptions
matically subscribed to weekly email updates about changes to the
'Shared documents' folder.
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4.14 Search functions
Signavio Process Manager has many functions to help you manage large processes
repositories. The search function is a useful tool to quickly find diagrams. In addition
to the full text search, the advanced search option offers you a method to search
more purposefully by adding specific search criteria. You can save your search as a
smart folder for easy reference in the future.

4.14.1 Full text search
The full text search enables you to not only search for diagram titles or attributes
of diagrams and elements but also for any term within an element label. Additionally, comments, revision information and even the content of uploaded files
are included in the search results. By using the Wildcard option (*) instead of terms,
you can search for any character sequence. Search for a linked Dictionary entry by
entering the complete dictionary entry name in the search mask.
To execute a search, type the search term into the search mask and hit Enter.
For example, searching for order will return all diagrams having order in its title as
well as all diagrams containing a label that contains order.
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Full text search

To quickly find what you're looking for, enter specific keywords and not
whole sentences into the search function. If you are searching for multiple words that should be an exact match, put the term in quotes (for
example "enterprise resource planning system").
It is also possible to use the following operands:
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Search
operands
Wildcard The search will include all terms containing all included wild(*)

card-separated character sequences. Sample: A search with the
term ´regis*´ will list words like “registration” and “registering”.
A search with the term ´lab*r´ will consider the term in both
British English (“labour”) and American English (“labor”).

AND

The search will only consider diagrams containing all terms that
you connect with the AND command. Sample: A search with the
term ´Registration AND SaaS´ will list diagrams containing the
terms “Registration” and “SaaS”, but no diagrams including only
one of these terms.

Phrases

(terms in quotation marks “”) The search with a term in quotation marks will only consider the exact term. Sample: A search
with the term “user manual” will consider only diagrams containing the exact phrase “user manual”, but not diagrams containing the words “user” and “manual” in a different order.

It is possible to combine the advanced search commands in one query.

4.14.2 Advanced Search
The advanced search allows you to pinpoint your search query to include specific
attributes in addition to search terms.
In the Explorer, these attributes are:
o

single-line text

o

multi-line text

o

date

o

drop-down box

o

number

o

boolean
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o

dictionary-URL

o

diagram-URL

o

document-URL
The advanced search in the Explorer considers attributes on diagram
and element level.

To execute an advanced search, proceed as follows:
1. Click the Advanced Search icon next to the search box.

2. From the drop-down list, select the attribute you want to use. Select All if
you're not interested in a specific attribute.

3. Type in the search term and click Search. The search results are displayed.

4. If necessary, you can add additional search criteria, which will allow you to filter the search results by diagram properties and values. The following filter
criteria can be used:
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o

Element name

o

Last modified

o

Last author

o

Revision comment

o

Publishing date

o

Publishing state

o

Commenting state

o

Signavio ID

o

Type (diagram, file, folder, or comment)

5. Click Add & Search to start the filter the search result.

4.14.3 Smart Folder
Smart Folder is a function which allows you to save your advanced searches. Use it
and repeat frequently used searches with one click.
To save the search query as a smart folder, proceed as follows:
1. Execute an advanced search as described above. The Create smart folder dialog opens.
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2. Label the smart folder (you can also add a description, but this is optional).

3. Finally, confirm the action by clicking Save. Now, you can access the smart

folder through the Smart Folders directory in the navigation panel of the Signavio Explorer.
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The content of a smart folder changes dynamically according to the content of your workspace. In our example, the smart folder will show one
diagram less after the term "order" has been deleted from all "Description" attributes of a diagram.
4.14.3.1 Deleting a smart folder
Deleting a smart folder works the same way as deleting a normal folder.

Deleting a smart folder

4.14.4 Search results
4.14.4.1 Categorized results of full text searches
The results of full text searches are categorized according to where in the process a
search term is found:
o

Found in title or directly in diagram

o

Found in diagram elements

o

Found in comments

For a better overview, you can collapse or extend the categories using the minus or
plus icon next to the category name.
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If a search returns many hits, they will be displayed on several pages. Use the
arrow buttons

at the top to navigate the result pages.

By default, search results are displayed in the icon view. When switching to list
view, the search results are listed along with information such as location, description, revision version, and more. For list view, click
for icon view, click

in the top right corner, and

.

4.14.4.2 Showing a diagram at its location
To go to the folder in which a search result item is located, select the item and click
Go to parent:

4.14.5 Returning to the default Explorer view
To leave the search and return to the default Explorer view, select any of the
folders in the folder tree on the left.

4.15 Working with folders and diagrams
Folders allow you to organize and structure your workspace, even if you have a
large number of diagrams.
Diagrams placed in Shared documents can be viewed and edited by all users of a
workspace. Workspace administrators can enable the My documents folder which
is private. Other users can't view or edit them. Read more about how to work with
these folders in this section.
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Notes on working with multiple users and workspaces can be found in the
Managing users and access rights section.

4.15.1 The folder structure
The main workspace folder is Shared documents The My documents folder can
additionally be enabled by a workspace admin.
Within these folders, you can create subfolders to organize your diagrams.

Select a folder in the folder structure to see its content

Clicking the arrow next to the folder/s name or on folder/s name itself will collapse
or extend the folder. This way, you can quickly switch between folders and still keep
track, even if you have an extensive folder structure.

Expand or collapse a folder by clicking the arrow in front of its name

If the name of a folder is cut off due to the width of the folder column, the full name
will appear when hovering over it with your mouse. You can also extend the folder
column by dragging its border line to the right:
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Extend the folder structure column

4.15.2 The 'Shared documents' and 'My documents' folders
With the 12.8.0 release workspace administrators can choose to disable
the My documents folder for every user in the workspace. This prevents
documents from being inaccessible. It also fosters collaboration by
restricting drafts to Shared documents . For new tenants the folder My
documents is disabled by default but can be enabled by an administrator
under Setup > Edit general configuration .
Each registered user has a main folder: Shared documents . Aditionally, administrators can enable the folder My documents .

You can move diagrams from one folder to another .
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4.15.2.1 My documents
Workspace administrators can enable the My documents folder for all users under
Setup > Edit general configuration . Diagrams in this folder and its subfolders are
private. Other users can't view or edit them.
4.15.2.2 Shared documents
This folder contains diagrams you can work on alone and together with other modelers.
There are two ways to collaborate with colleagues: joint modeling within your workspace, and inviting colleagues to comment on diagrams.
o

Only colleagues who are registered in your workspace are able to actually edit
diagrams. Find out more about defining access rights to diagrams and the Dic-

o

tionary at Managing access rights .
Each person invited to comment on a diagram is able to do so - also those who
have no Process Manager account. In the section Inviting stakeholders to comment on a diagram, you will learn how to invite process stakeholders to comment on a diagram.

4.15.3 Creating a new folder
To create a new folder, proceed as follows:
1. If you want to create a subfolder, first navigate to the folder in which you
want to locate the new folder.
2. In the menu bar, click New > Folder . A dialog pops up, in which you can enter
the folder name.

3. Specify the folder name and then click OK . The new folder is now visible in
the folder structure.
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4.15.4 Renaming a folder or diagram
1. In the Explorer select the folder or diagram you want to rename.
2. In the main menu click Edit > Change name/description
3. Change the name. In multi-language workspaces translate the changed name
to all available languages.
4. Click Rename to save your changes.

4.15.5 Moving folders and diagrams
1. Select the folder or diagram you want to move to a different location.
2. In the menu bar, click Edit > Move . The corresponding dialog box opens.
3. Now select the new folder.
4. Click Move to complete the moving operation. The view of the folder will then
be updated.

5. Finally, click Move . The folder or diagram is moved to the selected location.
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4.15.6 Copying diagrams
You can only copy diagrams and groups of diagrams, not entire folders.
1. Select the diagram you want to copy. To copy several diagrams at once, hold
the Ctrl key while selecting them. Or, draw a selection frame around the diagrams.
2. In the menu bar, click Edit and then Copy . The Copy dialog opens.
3. Select which folder you'd like to place the copy in.

4. Optionally, you can select one of the following options by activating the corresponding checkbox:
o

o

Copy linked models, too Please note that BPMN call activities are not
copied.
Copy all revisions of the diagram .

For system performance reasons, only one option can be selected.
5. Click Copy . The copied file is then located in the selected target folder.
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4.15.7 Removing folders or diagrams
1. Select the folder or diagram to be removed in the main area of the Explorer.
To select multiple folders, keep Ctrl pressed while selecting, or draw a selection frame around them.
2. In the menu bar, click Edit > Delete . A confirmation dialog appears.
3. Click Yes to delete the selected object.

The selected objects are moved only in Trash, from which you can
restore objects if necessary. Objects will be permanently deleted
after you empty Trash.
4. To delete objects permanently, select the Trash folder in the folder navigation. All objects in Trash are displayed.
5. Select the objects you want to delete permanently.
6. In the menu bar, click Remove . A confirmation dialog appears.

7. Confirm by clicking Yes . The selected items are permanently deleted.
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4.15.8 Restoring diagrams and folders
Diagrams and folders that have been deleted are moved to Trash folder. If you do
not explicitly remove them from there, they can be restored.
To restore a diagram or folder from the Trash folder, proceed as follows:
1. Go to the Trash folder. It can be found in the folder tree on the left.
2. Select the files you want to restore.
3. Click Restore in the menu bar.

4.16 Viewing diagram details
The notification and activity feed allows you to view and manage version history,
and to edit notification settings for diagrams and folders. If you have selected one
or more diagrams or folders, the feed is displayed as a lower bar in the Explorer.
When you select a diagram file, the diagram, along with the date and author of the
most recent changes, is displayed:

The notification and activity panel provides diagram details
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4.16.1 Notification settings
As soon as changes to a diagram or folder are made, notifications are sent at configurable intervals as emails. In the notification and activity feed, you can configure
the notification settings of the selected diagrams or folder.
The following options are available:
o
o
o
o

daily
weekly
monthly
cancel subscription

Options for the notification settings

4.16.2 Preview and version history
The activity feed allows you to get a preview of the selected diagram and to view
and manage the version history. You can find detailed information about this feature in the section The notification and activity feed .

4.17 Supported Languages
Signavio Process Manager is available in the following languages:
o
o
o
o
o
o
o
o
o

Chinese (simplified/traditional)
Dutch
English
French
German
Japanese
Korean
Russian
Spanish
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To change the language for your account, follow the instructions in the chapter Personal profile settings.
Of course, you can create Diagrams in any language you like.
The Signavio user manual is available in English, German and French.

4.18 Today's top tips
Today's top tip is displayed every day when you first open the Explorer:

You can re-open the current tip of the day via the Explorer's help menu :

You can (de-)activate the automatic display of tips in your profile settings:
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4.19 The BPM Academic Initiative
The BPM Academic Initiative is a joint program of Signavio and several international universities to support business process management in academic teaching and research. As part of the Academic Initiative, Signavio allows students and
teachers to use the academic process modeling platform at academic.signavio.com
for free, given the purpose is non-commercial and non-productive.
Note the following differences between Signavio's academic platform and the commercial offering:
o

o

o

It is illegal to use Signavio's academic platform for commercial or productive purposes.
All content users create on the academic platform may be made publicly available for research purposes (if requested, anonymized).
Signavio doesn't provide any performance or availability guarantees for the academic platform. Signavio may deploy code to the academic platform before it is
deemed mature enough for our commercial systems.
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o

The focus of the academic platform is process modeling. Many advanced process
management and collaboration features are not available. The same applies to

o

document uploads and interfaces for system integrations.
While Signavio generally handles requests from users of our academic platform,
questions and issues of paying customers are given a higher priority. Signavio
doesn't commit to responding to inquiries of users of the academic platform
within a specific timeframe.

If you accidentally registered for the Academic Initiative at academic.signavio.com,
please create a new account for one of the following systems:
o
o
o

editor.signavio.com (Europe)
app-us.signavio.com (Americas)
app-au.signavio.com (APAC)

If you want to transfer your data from the academic platform to one of our production systems, contact the Signavio Support Team at support@signavio.com.

4.20 Frequently asked questions
4.20.1 How can I quickly display diagrams without opening the
Editor?
The fastest option is to use the diagram preview (see section Viewing diagram
details). Select a diagram in the Explorer and hit the space bar or use the arrow
symbol at the bottom left of the main window to expand the preview section.
Collaboration Hub preview allows you to quickly navigate the diagrams of your
workspace. To open the Collaboration Hub preview, open the Explorer and select
Share - Preview in Collaboration Hub.

4.20.2 How can I disable email notifications?
By default, the system informs you about every change made to a diagram you are
working on in a team. There are multiple ways to disable notifications:
o

Select the diagram in the explorer, open the activity feed (press the space bar )
and click Don't notify me.

Version 14.9

49

4

Getting started

o

Open your profile settings under Setup - My profile in the Explorer and scroll
down to the notification settings to adjust them.

4.20.3 My browser does not display Signavio's applications correctly.
What can I do?
o

Please ensure your browser supports Signavio. You find more information in the
section Supported browsers.

o

After a system update, in rare cases it is necessary to refresh the internal
storage (cache) of your browser.
For this, open the application in your browser and use one of the following
commands (depending on your operating system):
o
o
o
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5 Modeling
This section explains how you create models in all notations in Process Manager in
the following sections:
o
o
o
o
o
o
o

Create a diagram
Open and save diagrams
Editor toolbar and keyboard shortcuts
Add and connect elements
Move and change elements
Format diagrams
Work with modeling conventions

For information about modeling with specific notations, see section Modeling notations.

5.1 Create a diagram
In Process Manager, new diagram files are created in the explorer. You edit diagrams in the editor.
To create a new diagram, click New in the explorer and select a modeling notation
from the drop-down list. The editor opens with a blank canvas.

5.1.1 Editor overview
In the editor, you design, edit and format diagrams. You can also perform checks on
your diagrams. This overview can help you find the functions you need.
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1

Shape repository Contains all modeling elements available for a notation, read more in section Add elements from the
shape repository

2

Canvas

The area on which you design and edit diagrams,
read more in section Move and change elements

3

Dictionary

Reuse modeling elements, read more in section
Working with the Dictionary

4

Toolbar

The tools to edit and format diagrams, you find a
detailed description of the tool bar in the section
Editor toolbar and keyboard shortcuts

5

Share

Invite users to comment on the diagram, read
more in section Inviting users to access a diagram in Collaboration Hub

6

User menu

Here you can change the editing mode, open the
other Signavio products and log out

7

Attributes

Edit attributes of your modeling elements, read
more in section Edit attributes

8

Views

Create and edit views, read more in section Create
views
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5.1.2 User menu
The user menu has several sections.
The options in the section Editing mode depend on the current notation. For
example, for BPMN diagrams you have the following choices:
o

QuickModel

o

Graphical Editor

o

Simulation

o

Diagram comparison

If you have access to other products of the Business Transformation Suite, you find
them in theProductssection. When you click a product name, the selected product
opens in a new tab.
In the Helpsection, you find the link to the user guide. You can also send us feedback or contact Signavio Support.
You can log out of Process Manager by clicking Logout.

5.1.3 Next steps
o

Edit diagrams

5.2 Open and save diagrams
In Process Manager, you open diagrams in the explorer. You're editing diagrams in
the editor.

5.2.1 Open a diagram
1. Open the explorer and navigate to the diagram.
2. Double-click the diagram. Alternatively, select the diagram and click Edit
> Edit diagram in the explorer menu.

The diagram is opened in the editor in a new browser tab.
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5.2.2 Save a diagram
While you keep the editor browser tab open, your changes are saved automatically
in the background. When you save the diagram, you create a new diagram revision.
To save a diagram, follow these steps:
1. Click

in the toolbar.

2. When you save a diagram for the first time, enter a descriptive name and
select the directory for saving the diagram.
You can edit the diagram name later.
3. Add a comment about your current changes.
Adding comment helps other modelers and collaborators to understand and
track your changes. Your comments are shown in the in the feed in the
explorer.
4. Depending on the modeling notation, you can click

to run modeling con-

vention checks.

You can save the diagram with errors and warnings.
5. Click Save.
A new revision of the diagram is saved.

5.2.3 Next steps
o

Work with modeling conventions

5.3 Editor toolbar and keyboard shortcuts
5.3.1 Editor Toolbar
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Save diagram
Save a copy: You can save the diagram as a copy. The copy is saved
in the same directory as its original.
Export diagram as PDF
Cut selected elements to clipboard
Copy selected elements to clipboard
Paste clipboard to canvas
Delete selected elements
Undo/ Redo

Align modeling elements, distribute elements, adjust size of elements
to match
Adjust space between modeling elements.
Zoom in/out of the canvas.

Reset the canvas to its default size
Fit the diagram to the canvas size
Change font size in elements
Bold
Italic
Change font color

Version 14.9

55

5 Modeling

Change line color of modeling elements
Change fill color of modeling elements
Remove current formatting
Apply formatting to other elements
Show all comments
Show risk and controls
Show all elements with attachments
Perform checks
The following checks are available by default:
o

Syntax check

o

Simulation capability

o

Cost and resource analysis checks

Based on the modeling notation additional checks might be available
Select attribute visualizations (overlays)

Change workspace language
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5.3.2 Keyboard Shortcuts
Shortcuts for Windows

Shortcuts for Mac

Open dia- In the explorer, double click the dia- In the explorer, double click the diagram
gram name
gram name
Open dia- In the explorer, select the diagram
gram pre- and press Space
view

In the explorer, select the diagram
and press Space

Save dia- Ctrl + S
gram

⌘ +S

Ctrl + C
Copy
selection

⌘ +C

Ctrl + V
Paste
selection

⌘ +V

Cut selec- Ctrl + X
tion

⌘ +X

Del
Delete
selection

Del

⌘ +Z

Undo

Ctrl + Z

Redo

Ctrl + Y

⌘ +Y

Press Ctrl + + to make

Press ⌘ + + to make

everything larger

everything larger

Press Ctrl + - to make

Press ⌘ + - to make

everything smaller

everything smaller

Press Ctrl + 0 to reset

Press ⌘ + 0 to reset

Press F11 to use full-screen mode,
press F11 again to exit full-screen
mode

Press ⌘ + Ctrl + f to use full-screen
mode, press ⌘ + Ctrl + f again to
exit full-screen mode

Zoom

Fullscreen
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Shortcuts for Windows
Resize
element

Shortcuts for Mac

Hold Ctrl and drag the element Hold ⌘ and drag the element
connector to resize in all dir-

connector to resize in all dir-

ections

ections

Hold Shift and drag the ele-

Hold Shift and drag the ele-

ment connector to resize pro-

ment connector to resize pro-

portionally

portionally

Hold Alt and drag the element

Hold Alt and drag the element

connector to resize without

connector to resize without

snapping

snapping

Hold Alt or Ctrl while moving

Hold Alt or ⌘ while moving an

an element to move without

element to move without auto-

automatic snapping or ori-

matic snapping or orientation

lines
Move ele- entation lines
ments
Hold Shift+Alt or Shift+Strg to Hold Shift+Alt or Shift+Strg to
move an element along a hori-

move an element along a hori-

zontal or vertical line, without

zontal or vertical line, without

displayed orientation lines

displayed orientation lines

Adjust
Press Ctrl + M and add or
space
remove space, press Ctrl + M
between
elements again to deactivate

Press ⌘ + M and add or

Select
Select one or more elements eleelements ment and press Ctrl + I
of the
same
type

Select one or more elements element and press ⌘ + I

remove space, press ⌘ + M
again to deactivate

5.3.3 Next steps
o

Format diagrams

5.4 Add and connect elements
You have the following options to add elements to a diagram:
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o

You can drag elements from the shape repository onto the canvas.

o

You can use the interactive shortcut menu when you click an element on the
canvas.

o

You can copy and paste elements.

5.4.1 Add elements from the shape repository
The shape repository in the left panel of the editor lists all modeling elements available for a notation. For notations with lots of elements, elements are grouped into
subsets. To change subsets, click the current subset and select a different subset
from the drop-down list.
In a subset, elements are grouped thematically.
To add an element, follow these steps:
1. Click the element you want to add to your diagram.
2. Hold the mouse button and drag the element onto the canvas. Green icons
indicate where you can place an element.

3. To label an element, double-click the element and enter the label text in the
text box.

The label is saved when you click outside the text box. Available dictionary
entries are suggested while you type.

5.4.2 Add elements from the interactive shortcut menu
Which elements are shown in the interactive shortcut menu depends on
the selected subset of modeling elements. If you miss an element in the
shortcut menu, check which set of modeling elements is selected in the
shape repository.
To add an element, follow these steps:
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1. Select an element in the diagram.
The shortcut menu opens. Depending on the selected element, the shortcut
menu suggests elements.
2. Click the icon of the element you want to add. The new element is added to
the diagram.

The connector type between the selected element and the new element is set
automatically.
When you want to add an element and set its position, click the element icon and
drag the element to its position. The new element is added to the diagram where
you release the mouse button.

5.4.3 Add pools and lanes
Add a pool by dragging the Pool/Lane element onto the canvas.
Add a lane to a pool by dragging the Pool/Lane element onto a pool.
To add more lanes to a pool, drag a Pool/Lane element onto the left or right edge of
a lane.
To add a sublane, drag a Pool/Lane element onto the center of a lane.

5.4.4 Connect elements with flows
To connect elements with flows, drag the flow onto the target element. You can
also use the flow icons from the interactive shortcut menu.
When a connection is possible, green marks are shown on the edges on the element.

When a connection isn't possible, red marks are displayed on the edges of the element.
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5.4.4.1 Add gateways to flows
When you drag a gateway onto a flow, the flow is split and connected to the gateway.

5.4.5 Copy elements
You can copy elements to create similar elements. You can also copy parts of old diagrams to reuse in new diagrams.
1. Select the element you want to copy. Hold the Shift or Ctrl key to select multiple elements.

2. Click

to copy, click

to cut and click

to paste elements. You can

also use the shortcuts Ctrl + C to copy, Ctrl + X to cut and Ctrl + V to paste elements.

o

Copying elements between different diagrams can take a while,
because they are copied to the server first.

o

An internet connection is required for copying elements between
diagrams, but not for copying elements inside one diagram.

5.4.6 Remove elements
1. Select all elements you want to remove. To select multiple elements, press
and hold the left mouse button and draw a frame around the elements, or
press and hold the Ctrl key while you click the elements.
2. Press the Del key on your keyboard or click

in the toolbar.

The elements are deleted.

5.4.7 Next steps
o
o
o

Move and change elements
Format diagrams
Work with modeling conventions
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5.5 Move and change elements
While modeling, you can change the position of elements and labels.
You can also adjust the space between elements or change the canvas size.
You can change the element type.

5.5.1 Move elements and labels
To move an element or a label to a new position, select and drag it.

5.5.2 Change element labels
To edit a label, double-click the element. Available dictionary entries are suggested
automatically.

5.5.3 Change element size
1. Select the element.
2. Click the bottom right corner or top left corner and drag the corner.
For more options, keep one or more of the following keys pressed
while you drag the element:
o

Alt: Resize without snapping to other elements and orientation

o

lines
Ctrl: Resize in every direction
Shift: Resize the element proportionally

o

5.5.4 Adjust canvas space
You have two options to adjust the canvas area.
o
o

You can add or remove space between elements.
You can shrink or extend the whole canvas.
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Shrinking the canvas isn't possible if there are elements in the affected
area.
To add or remove space between elements, follow these steps:
1. Enable the space adjusting function by clicking

in the toolbar, or use the

shortcut Ctrl + M.

The mouse cursor turns into a cross and two lines are displayed on the canvas.
2. Where you want to adjust the space, click, hold and move the cursor.
Space is added or removed depending on your movements.
This works in all directions.
3. Release the mouse button.
4. Disable the space adjusting function by clicking

in the toolbar, or use the

shortcut Ctrl + M.

To shrink or extend the whole canvas, follow these steps:
1. Move you cursor to one edge of the canvas.
Two arrow icons are displayed,
2. Click the inward-pointing arrow
pointing arrow

and

.

to shrink the canvas, click the outward-

to expand the canvas.

5.5.4.1 Zoom
To view the complete diagram on your screen, use the zoom icons,
o

To make everything on the canvas larger, click

o

To make everything on the canvas smaller, click

and

.

.
.

To return to the standard zoom level and view the diagram in its default size, click
.
To fit the diagram to your canvas size, click
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5.5.5 Change the element type
Changes that affect the appearance and behavior of an element, but not
its type, can be made in the attribute panel. For example, to change a
task into a script task, you set the attribute Task type to Skript.
You can change the element type. For example, in BPMN the following transformations are possible:
o

task to subprocess

o

plain start event to message start event

o

collapsed pool to expanded pool

To transform an element, follow these steps:
1. Select the element you want to transform.
2. Click

below the element.

3. Select the new element type.
The element is transformed.
In the following example a parallel gateway is changed into an exclusive gateway.

5.5.6 Edit attributes
Modeling elements have several properties you can edit. These properties are called
attributes. You can use attributes to change the appearance of an element (for
example the background color or label). Attributes can also be necessary to execute
a process, for example the decision logic in a DMN diagram is an attribute.
You edit attributes in the attribute panel on the right side of the editor.
o

o

To change the attributes for one element, select the element and open the attributes panel.
To change diagram-wide attributes, click any empty space on the canvas and
open the attributes panel.
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The first section of the attribute panel contains custom attributes,
which can be defined by your workspace administrators.
You can change attributes for one element and diagram-wide attributes.
5.5.6.1 Select all elements of the same type
Select all elements of the same type to change them at once.
o

To select all elements of one type, select one element and press Ctrl + I. All
elements of the same type are selected.

o

To select all elements of multiple types, select elements from each type and
press Ctrl + I. All elements of the chosen types are selected.

5.5.7 Next steps
o
o

Format diagrams
Work with modeling conventions

5.6 Format diagrams
To add clarity and to customize a diagram, you can re-align and resize elements and
change their color, size, label, border and background style.

5.6.1 Align and distribute elements
Use the alignment menu

in the toolbar to align or distribute selected elements.

Select the elements to align or distribute and choose from the following options:
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Alignment Left

Aligns elements along their left edges, with the
element positioned farthest to the left as the reference element

Alignment

Aligns elements vertically through their centers,

Center

using the mean value of all centers

Alignment

Aligns elements along their right edges, with the

Right

element positioned farthest to the right as the reference element

Alignment Top

Aligns elements along their top edges, with the
highest element as the reference element

Alignment

Aligns elements horizontally through their

Middle

middles, using the mean value of all middles

Alignment Bot-

Aligns elements along their bottom edges, with

tom

the lowest element as the reference element

Distribute ele-

You need to select at least 3 elements for this

ments hori-

function.

zontally

Distributes elements evenly on a horizontal axis,
the outer 2 elements keep their position

Distribute ele-

You need to select at least 3 elements for this

ments ver-

function.

tically

Distributes elements evenly on a vertical axis, the
outer 2 elements keep their position

Same Size

Resizes the elements to the size of the largest element in the selection

5.6.2 Format elements and labels
You can change the attribute values of an element in the attribute panel to change
its appearance:
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o

Change the label either by clicking the element or the attribute name.

o

Change the element color by clicking

o

Change the border color by clicking

o

Change the color gradient of an element's background to a flat design. To do

in the toolbar.
in the toolbar.

this, enable Flat design under More Attributes in the attribute panel.
You can change the labels with the following tools in the toolbar:
Change the font size

o

o

Make the font bold

o

Make the font italics

o

Change the font color

5.6.2.1 Copy and apply formatting
1. Select the element that has the format you want to copy.
2. Click

in the toolbar.

3. Select the element you want to apply the formatting to. The copied formatting is applied.

To apply the default format to an element, select the element and click

.

5.6.2.2 Select all elements of the same type
Select all elements of the same type to change them at once.
o

To select all elements of one type, select one element and press Ctrl + I. All
elements of the same type are selected.

o

To select all elements of multiple types, select elements from each type and
press Ctrl + I. All elements of the chosen types are selected.

5.7 Work with modeling conventions
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The functions available to you depend on your license.
Modeling conventions make it easier to use a consistent modeling style.
A modeling convention consists of modeling guidelines regarding notation set,
labeling, process structure and diagram layout
With modeling convention checks, you can find out if a diagram violates these
guidelines. You can run a check while modeling or when you save a diagram. Additionally, you can create a modeling conventions report after a check that contains
an summary of the errors. Modeling conventions can be defined by your workspace
administrator.
To run the check, you have several options:
o

Click

in the editor toolbar and select the convention.

o

Depending on your workspace settings, a prompt for a check when saving a
diagram can be integrated. In this case, click

o

in the save dialog.

Select Help > Modeling Conventions in the menu of the explorer.

Elements which violate conventions are flagged with an exclamation mark. To view
a short info about the violation, hover over the exclamation mark. Additionally, the
information is summarized in a table below the process diagram.
In the table, click the element to view it in the diagram. If available, click the link
icon

for more information about a guideline.

5.7.1 Modeling conventions report
You can create a modeling convention report for one or multiple diagrams in the
explorer. The report contains a summary of violations of modeling conventions and
is generated as an XLSX file.
To create a report, follow these steps:
1. Select Reporting > Modeling Conventions in the explorer.
2. Select the diagrams and modeling conventions you want to include.
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3. Click Start analysis.
An XLSX file is generated.

5.8 Working with the Dictionary
The Dictionary is the central object management repository in Signavio. A dictionary entry represents an object that is relevant for one or more of your processes. It allows you to manage and re-use specific modeling elements - it also
helps you make sure all your modelers are using the same terms and the same elements in your organization-specific modeling environment.
The dictionary is a crucial component to achieve a consistent and well-structured
business objects management in your diagrams.

5.8.1 Using the Dictionary in the Editor
Most of the Dictionary functions can be used directly from the Editor. This includes
creating new dictionary entries, referencing existing dictionary entries, and reading
properties of already referenced entries. In this section you will learn how to work
with the Dictionary from the Editor.
A description of access rights of the Dictionary can be found in the section Managing access rights .
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5.8.1.1 Creating new dictionary entries
To add, delete, or publish a dictionary entry, you need the corresponding access
rights. Workspace administrators can grant users publish, write, or delete rights
for the Dictionary. Please contact an administrator and ask them for the corresponding rights if you cannot access entries in the dictionary. Workspace administrators can find instructions on how to grant rights for dictionary users in the
section Managing access rights .
Generally, you can add new dictionary entries in the dictionary. As you may need to
add new dictionary entries while modeling, particularly in the beginning of a project, you have the option to add new dictionary entries directly from the Editor:
1. Type in the label of a diagram element (for example: "Check purchase order").
2. Click the book icon in the lower left corner of the element. The New entry dialog will open.

3. A category for the dictionary entry is automatically preselected, depending on
the type of modeling element. You can change the category using the dropdown menu.
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4. Type in a short description of the dictionary entry. You can format the text
here, just like any other text editing software. The entry will be created in the
language that is currently chosen for the diagram. To translate the entry
later, open it in the Dictionary. See the section Working with the Dictionary .
5. Optionally, you can add documents to a dictionary entry. Insert an identifier
and the URL of the document in the corresponding input fields. To add multiple documents, use the + -symbol next to the URL field. If you want to link
to files on network drives, follow the instructions under Link to files in diagrams .

6. Click Create and the new entry will be created. The diagram element will now
reference the new dictionary entry.
5.8.1.2 Auto-completion
Once the Dictionary contains entries, the auto-completion feature allows you to
reuse these entries when creating new elements.
By default, only dictionary entries whose category type matches the element type
pop up in the auto suggestions. This behavior can be changed by a workspace administrator (see section Editor settings).
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1. Start typing in a label for the diagram element. While you type, dictionary
entry suggestions will appear below the element.

The auto-completion feature supports wildcards (*). For example,
typing C*O may return the entries CIO, CFO and CEO.
2. You can select an entry by using the arrow key on your keyboard. Press Enter
to choose the selected entry. Alternately, you can select an entry with your
mouse.
Once you have referenced a dictionary entry, the entry's title will be copied into
the element's label and the attribute values of the dictionary entry are adopted.
5.8.1.3 Reusing dictionary entries via drag & drop
You can also use the search function for dictionary entries in the Editor. It can be
accessed through the shape repository. In order to reuse an object from the dictionary, use the search box below the element repository.
1. Enter the desired search term. Search results will appear as you type.
2. If necessary, you can apply a filter to include specific dictionary categories
only.
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3. Now, you can drag and drop the element onto the diagram canvas. The dictionary entry is already referenced and dictionary attributes are displayed directly at the element.

5.8.1.4 Publishing dictionary entries
Publishing rights for dictionary entries must be specifically granted for
every user by a workspace administrator.
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If a dictionary entry is set to manual publishing mode and has been altered
without being republished, the Editor will display a warning message:

To avoid this, make sure you publish the current entry dictionary along with the diagram you're creating.
5.8.1.5 Displaying dictionary entries
Once an element references a dictionary entry, you can navigate to the entry.
1. Click the book icon. A popup window displays the dictionary entry.

2. Click Remove link to remove the connection to the Dictionary. This is especially useful for establishing a connection to a different dictionary entry.
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3. Click Open in dictionary. A new browser tab will open with the full dictionary
entry, including its description, attached documents and a list of all diagrams
that reference this dictionary entry.

5.8.1.6 Overwriting locally dictionary entries
If you would like to individually specify a value for the current process context during modeling, you can locally overwrite attribute values that are prescribed by a referenced dictionary entry.
You should however take care when doing this: local modifications are
not applied in the Dictionary. Generally speaking, such an approach will
cause that corresponding element properties can be no longer managed
centrally in the Dictionary and causes inconsistencies between elements that reference the same dictionary entry. Furthermore, there is
currently no way to check which dictionary entries have local versions
in diagrams.
To change locally the value of an attribute of the Dictionary and to undo if necessary, proceed as follows:
1. First, select the element in your diagram with the attribute that is defined by
a linked dictionary entry.
2. Click on the value of the attribute you want to modify locally. A warning message appears to point out that local changes do not affect the dictionary
entry.
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3. Click OK to continue. Depending on the attribute value, an additional editing
dialog opens.

4. Now enter the desired attribute value. If the new value is applied, the attribute is marked accordingly (yellow book icon).

It is not possible to overwrite a dictionary attribute value with its
default value.
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5. To undo the local change of an attribute value, click the corresponding book
icon. The dialog Dictionary entry opens. Here, you see the local element value
compared to the dictionary value.

6. Click Revert to set the value of the Dictionary as the value of the element
attribute.
7. Close the dialog.

5.8.2 Working with the Dictionary
The Dictionary allows you to search, view, create, edit, delete, and publish dictionary entries.
To open the Dictionary, click the corresponding folder in the navigation tree on the
left side in the Explorer. The Dictionary opens in a new browser tab.

Open the dictionary via the folder tree on the left of the Explorer
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Select a dictionary entry. Its full description, a list of attached documents and a list
of diagrams referencing that entry will be displayed.

To add, delete or publish a dictionary entry, you need the corresponding
access rights. Workspace administrators can grant users publish ,
write or delete rights for the Dictionary. Please contact an administrator and ask them for the corresponding rights if you cannot access
the option you need. As an administrator, you will have to grant yourself
publishing rights because they are not activated by default. You can
learn how to grant dictionary access rights in the chapter Managing
access rights .
5.8.2.1 Navigating the Dictionary
You can navigate the Dictionary by using the dictionary categories.
1. Click the category that you want to display (for example, 'Roles').
2. Use the alphabet links at the top to navigate to the entry you are looking for
faster.
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5.8.2.2 Finding out where a dictionary entry is used
To find out where a specific dictionary entry is referenced in your process landscape, select the entry and click Show usages . A dialog opens and displays the
type and name of the referencing elements, as well as the names of the referencing diagrams. Clicking Load next allows you to view links to the referencing
elements to analyze the whole chain of references:

Analyzing references to a dictionary entry

5.8.2.3 Switching the language
If there are multiple languages activated for your workspace, it is possible to switch
between them by clicking on the language symbol.

Switch the language from German to English

Dictionary entries that have not been translated into the currently selected language will be displayed in their default language and marked with a country flag.
5.8.2.4 Full-text search
You can find specific entries by using the full-text search.
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1. Type the word(s) you are looking for into the search field.
2. Hit Enter on your keyboard. The search results will be listed. The order indicates the entries' relevance regarding the search. For example, an entry with
your search terms in the title will rank higher than one with the terms only
in the description.

5.8.2.5 The activity feed
Similar to the activity feed in the Signavio Explorer, the dictionary feed allows you
to manage revisions.

The revision feed opens automatically once you select a dictionary entry. When
selecting a revision in the feed, you can trigger the following activities:
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o

Restore
Will restore your entry to a previous version. Note that this does not delete
revisions, but allows you to switch between them.

o

Publishing
Will make this revision available in the Collaboration Hub. By default, the newest revision is automatically published upon creation.

o

Unpublishing
Will revoke the revision's publication in Collaboration Hub.
The buttons to publish and unpublish revisions will only be active
in categories, whose Publishing Mode has been set to Manual .
Under Defining custom categories for dictionary entries you find
more information.

5.8.2.6 Managing dictionary entries
Creating new dictionary entries

To create a new dictionary entry, proceed as follows:
1. Click New in the top toolbar. The New Entry dialog will open.
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2. In the New Entry dialog box, make the following configuration:
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Parameter

Description

Category

A number of possible attributes can be defined for a dictionary entry. Start with selecting a category for the
entry, as the category may affect the custom attributes
that can be defined for the entry. Read more about the
configuration of dictionary categories in section Defining custom categories for dictionary entries.

Language

Select the desired language in the dropdown menu.
Attribute values of dictionary entries can be defined in
multiple languages. Please make sure that the title of
the entry is defined in at least one language. You can
link dictionary entries by their name by beginning to
type the title of the entry that is supposed to be linked
and choosing it from the auto-completion drop-down
menu. This is useful if a dictionary entry contains other
dictionary entries in its title. For example, the dictionary entry Prepare loan application for check by
risk manager can reference loan application and risk
manager as further entries. Readers - especially Collaboration Hub users - can now easily navigate to these
entries via the established references.

Title

Enter the name of the dictionary entry (manadatory).

Description Enter a short description. You can format this description, as you already know it from common writing programs or the Editor.
Relevant

To attach documents, edit the attribute Attached doc-

documents uments.
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3. Click Create to save the dictionary entry.
Editing dictionary entries

To edit an existing dictionary entry, follow these steps:
1. Choose the dictionary entry you want to edit and click Edit . The edit dialog
for dictionary entries appears.

2. Now you can edit the dictionary entry.

3. Click Save .
If the category of the dictionary term you are trying to edit is set
to automatically update when making changes, the diagram elements that refer to this entry will be updated automatically. This
will create new versions of the diagram. If there are many diagrams affected, it may take the Process Manager up to 30 seconds
to save your changes.
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Deleting dictionary entries

To delete an exisitng dictionary entry, proceed as follows:
1. Select the dictionary entry you want to delete.
2. Click the Delete button in the top toolbar. A confirmation dialog will tell you
about the diagrams that will be affected.

3. Click Yes to confirm deletion. If you don't want to delete the entry after all,
click No .

Referencing documents

You can reference external documents for a dictionary entry while creating or editing it.
1. Select a dictionary entry and then click Edit . The Edit entry dialog box
opens.

2. Scroll to the attribute Relevant documents and select Add a new document
. The dialog Link files/ pictures opens.
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3. Select a file from your Signavio team directory. Alternatively, you can upload
a new file/picture from your local file storage.
4. Click Add . The selected file is added to the dictionary entry.
Please take the chapter Managing external data sources into
account.
Publishing dictionary entries

If a dictionary entry is set to manual publishing mode and has been altered
without being republished, an appropriate warning notice will appear, when the dictionary entry is used in the Editor.

If this is the case, make sure that the current dictionary entry is also published
when publishing the diagram.
To publish a dictionary entry, proceed as follows:
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1. First select the entry you want to publish.
2. Open the activity feed at the bottom by clicking Expand .

3. Click the desired revision of the dictionary entry in the activity feed. An
information dialog box opens.

4. Click Publish . The dictionary entry is now published in Collaboration Hub.

5.8.3 Merging dictionary entries
The Dictionary allows you to keep all the terms that are often used in your diagrams in one easy-to-reference place. However, over time the use of terms can
change, entries with a similar meaning but different description might be added,
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and extraneous copies of existing entries might be created when many modelers
work together. Duplication can also happen when importing Signavio archive (.SGX)
files, because entries from these files will automatically be added to the Dictionary.
Regardless of the source, merging dictionary entries will help you keeping the Dictionary in good condition.
The following example shows the merging of the entries ACME AG and ACME Inc. ,
so that there is only one entry for the German and the English naming convention
of the company.
o
o

o

o

Open the Dictionary and choose the category the entries can be found in.
Choose the first dictionary entry you want to merge. (If desired, you can select
multiple entries at once.)
Click the toolbar button Merge Dictionary Entries .

Enter the name of the second dictionary entry into the field Add Dictionary
Entry . Use the auto-completion here. You can merge as many entries as you
want using this method.

Use the auto-completion to add more entries
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o

Choose the elements to be added to the resulting entry. Attached documents,
linked dictionary items, and links are added to the target entry automatically.

Select the fields that will be included in the resulting entry
o
o

Click Merge and confirm the warning.
The entries are merged. The resulting entry will be displayed, and can now be
edited.

5.8.4 Referencing external data sources
To be able to reference external data sources, you need to implement
and configure the corresponding interface first. Read more at Managing
external data sources
Once an external service has been set up, it can be selected in the Dictionary under
Simple Type - External Enumeration of Values .
In the Dictionary, all categories that can be used to define input data can have dictionary entries that make use of external data. To be able to define input data for a
category, the check-box Use as DMN input data has to be activated.
To reference an external data source in a dictionary item, use Simple Type in the
Type Definition field and choose ExternalService as Value Domain . Now, the field
Service allows you to select one of the services that have been registered:
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When the dictionary item is used in a decision table, the service response will
determine the data type, for example enumeration or hierarchy.

5.8.5 Tutorial: How to use the dictionary as a modeler
This tutorial describes how to use the Dictionary as a business process/business
decision modeler.
You will learn how to...
o
o

o

...reference and create dictionary objects directly from the modeling canvas.
...drag & drop existing dictionary entries as modeling elements from the element
repository onto the canvas.
...manage changes to diagram elements.

Following our recommendations will increase your modeling speed as well as the
consistency and completeness of your process landscape.
Let's start by creating a new process as part of our example process landscape.
First, we create a pool for our company. The pool ACME AG can be dropped from the
dictionary entry repository on the left side of the modeling canvas. It is directly
available under Frequently used dictionary items :
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Drag & drop from the element the dictionary entry repository
In the attribute panel on the right-hand side we can see that element attributes
have been filled in automatically, based on the attribute values of the dictionary
item:

The attribute values are fetched from the referenced dictionary entry
Subsequently, we want to add the organizational role Approver as a lane.
We are not sure if a corresponding dictionary entry exists, so we simply start to fill
in the corresponding label. As we type, the dictionary entry Approver is suggested
as a reference.
We select the entry to assign it to the lane:
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Select the dictionary entry you want to reference
If the default Dictionary settings have not been changed, only dictionary
items that match the corresponding element type are suggested. In our
case, only organizational units and IT systems are suggested and e.g. no
events or activities. IT systems can be referenced from pools and lanes
because they are similar to organizational units in their ability to
execute tasks. For example, the task 'Send email' can be executed by
both an employee and an IT system.
Now we add a start event and name it Employment contract received
We can assume that this event is only occurring in this one diagram, so we don't
need to create a dictionary entry for it.
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Subsequently, we create the task Review employment contract. No dictionary
entry is suggested by the system. Let's now assume that we need to create the
same task in a different process later on. Thus, we create a new dictionary entry by
clicking the dictionary icon at the lower left corner of the element:

Create a new dictionary entry
The dictionary entry is now available in the dictionary element repository.
The document employment contract already exists:

Reference the dictionary item 'employment contract'
Now, we want to link the IT system that the approver needs to use. We don't know
which system to use exactly, so we use the filter function of the dictionary element
repository to gain an overview over our IT systems:
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Filter the dictionary for IT systems
We identify Personnel System as the correct IT System and drag it onto the modeling canvas:

We can refer to the steps described above to continue adding elements to our
model.
Generally, we recommend to re-use dictionary entries wherever it makes sense
and to create or reference dictionary entries for all elements that are likely to be
re-used. This prevents duplicates and inconsistent information in your Signavio
workspace.
However, when revising the process, we find that the role Approver is too generic
for our purpose:
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The dictionary entry does not provide specific information
To adjust the element, we have three options:
o

Edit the element ( not recommended ):
We can edit the attribute documentation and adjust it to a more specific
description.
Before editing the attribute, a warning will appear:

A warning is displayed, as element attribute and dictionary item attribute will no
longer be consistent
After the attribute was edited, a warning icon next to the attribute indicates that
the value is not consistent with the corresponding value of the referenced dictionary item:

The warning sign indicates the inconsistency between element attribute and dictionary item attribute
However, this procedure is not recommended, as it makes it very hard to detect the
difference between the approver in our current lane and other lanes referencing
the approver object. Moreover, it is no longer possible to centrally manage the
attribute value via the Dictionary.
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5.8.5.1 Adjust the dictionary entry:
We can click the dictionary item and select Open in dictionary :

Now, we can click Edit and adjust the dictionary entry our needs:

This option is recommended if the dictionary entry is generally not correct or lacks
information. This does not apply in our case.
5.8.5.2 Create a new dictionary entry (recommended in our case)
As our approver is a human resource/legal specialist, we need to add more specific
information. However, we can assume that the approver reference in other diagrams doesn't match our new specification. In that case, we will need to click the
dictionary icon next to the entry and select Remove link :
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We confirm the action and rename the lane with a more specific term, for example
Legal approver (HR) . Subsequently, we add a new dictionary entry:

We recommend to avoid inconsistencies between dictionary entries and
referencing elements and to avoid re-purposing dictionary entries
because of one specific reference . In such cases, the creation of a new
Dictionary is usually the best alternative.

5.9 Process hierarchies
You create process hierarchies to map the processes on all levels of your organization.
With value chain diagrams, you can create high-level perspectives on your process
landscape. The diagram elements are linked in chronological order to show the hierarchical relationships between processes and process groups. With the collapsed
process element, you can link BPMN diagrams to the value chain diagram.
BPMN is used to map the detailed processes. The processes in BPMN diagrams are
also showing different process levels. You create a high-level overview of a main
process and in separate diagrams you model subprocesses. Then you link these subprocesses to the main process. We recommend linking subprocesses with the collapsed subprocess element, which links to subprocesses defined in separate models.
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5.9.1 Next steps
o
o

Value chains
Create subprocesses

5.10 Create subprocesses
When you create a high-level overview of the main process, you model subprocesses in separate diagrams and link these subprocesses to the main process.
There are two ways to add subprocesses to diagrams, as expanded or collapsed subprocesses.
With the expanded subprocess element, subprocesses are shown with the main process. Since this does increase diagram size and visual complexity, we recommend
using the collapsed subprocess element, which links to subprocesses defined in separate models.

5.10.1 When to use subprocesses
Subprocesses can be complete processes or partial processes. They can only be
executed as parts of a larger process.
You can reuse subprocesses in multiple diagrams. We recommend using a subprocess in the following cases:
o
o
o

a part of the process is the same for several processes
a part of the process is changed often
a part of the process is executed differently but the main process is the same

A subprocess needs to be a process, with a start and end event. When you have a
complex activity that cannot be meaningfully divided into different tasks, use a task
element in your process model.

5.10.2 Subprocess elements
The notations in which you use subprocesses are usually value chains and BPMN
models. In value chains, you use the Collapsed Process element. In BPMN diagrams
, you use the Collapsed Subprocess element.
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Elements that link to other diagrams are marked with a + icon. This is the Collapsed Subprocess element in BPMN:

5.10.3 Add subprocesses to a diagram
The following descriptions apply to BPMN diagrams, linking diagrams to
elements is similar for other notations.
You have the following options to create subprocesses:
o

When you have a complex diagram, you can group parts into subprocesses.

o

You can add a Collapsed Subprocess element to your diagram.
o

From the subprocess element, you can create a subprocess diagram that
is automatically linked.

o

When you already have a subprocess defined, you can add a subprocess
element to the main diagram and link your defined subprocess to this
element.
You can link diagrams in your workspace, or diagrams in other locations
via URL.

5.10.3.1 Group diagram elements into a subprocess
1. Open the BPMN diagram.
2. Select the process elements you want to group. It is possible to select only
one element.

3. Click

below your selection and select Collapsed subprocess.

4. Enter a name for the subprocess and click Create linked subprocess.
The subprocess is saved as a new diagram. In the original diagram, a Collapsed Subprocess element replaces the subprocess.
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The new diagram is created in the same folder as the original diagram. Refresh the
explorer to view it.
5.10.3.2 Link a diagram to a subprocess element
1. Select a Collapsed Subprocess element in your diagram and click the + symbol.

The Establish link dialog opens.
2. Select one of the options to add a link:
o

Use existing diagram. Select the diagram to link in the folder structure.

o

Use web link. Paste the URL to the input field.

3. If the preview is too small, enlarge the Establish link dialog.
4. Click Link diagram.
The diagram is linked to the subprocess element.
5.10.3.3 Create a new subprocess from the subprocess element
1. Select a Collapsed Subprocess element in your diagram and click the + symbol.

The Establish link dialog opens.
2. Enter a diagram name in the text field.
3. Select the diagram type.
4. Click Link diagram.
A diagram is created and opened in a new tab.

5.10.4 Change linked diagrams
Once you have added a linked subprocess to a process, you can open the linked diagram from the subprocess element.
In a Collapsed Subprocesselement in your diagram, click the + symbol.
A preview of the currently linked diagram is displayed. If the preview is too small,
enlarge the Establish link dialog.
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o

To open the diagram in a new browser tab, click Open.

o

To select a new diagram to link, click Edit link.

o

To remove a diagram link, click Remove link.

5.11 Add Live Insights
With Live Insights shapes, you can display the result of a Process Intelligence
investigation in a diagram.
When you create an investigation, you configure widgets to analyze specific process aspects.
You can add Live Insights linked to widgets to the following diagrams:
o

BPMN diagrams

o

Value chains

The investigation results are represented by the colors of the Live Insights shapes.

To link widgets to Live Insights, you need to have the Process Intelligence feature set enabled.
You find the different Live Insights in the Live Insights shape repository.
To link a Live Insight to a widget, add the widget ID in the attribute panel. The Driving widget sets the color.
You can add additional widgets, they are shown in the details panel of the diagram
when you click the Live Insight.
To use one of the Live Insight shapes without a linked widget, set a Manual value.
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5.12 Link to files in diagrams
From a diagram or from diagram elements, you can link to online documents, files
in your document management system, or files in your network.
There are two ways of linking documents to diagrams:
o

To access documents from different elements or diagrams, link them to dictionary entries.

o

To make the document accessible only from one diagram, use a custom attribute.

5.12.1 Use dictionary entries to link documents
We recommend to create dictionary entries to link documents to elements. You can
reuse dictionary entries throughout your process landscape.
To link a document to a dictionary entry, follow these steps:
1. From the explorer, open the dictionary.
2. Add a new dictionary entry or edit an available entry:
o

To create a new entry, click

New.

o

To open an existing entry, select the entry and click

Edit.

3. In Relevant documents, add the link.
The documents aren't uploaded to Process Manager. Ensure that all
users can access the linked documents.

5.12.2 Use a custom attribute to link documents
Custom attributes are defined by your workspace administrator. The name for the
custom attribute used for linking documents is specific to your workspace.
You have several options for adding a file to a diagram:
o

You can upload a file to the Signavio file storage.

o

You can link to a file in the Signavio file storage.
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o

You can link to files in your document management system, in your network,
or to online documents.
Process Manager is not designed as a document management system.
We recommend linking to documents instead of uploading documents.

To add a link to a document to your diagram, follow these steps:
1. Select the diagram element to which you want to add a linked document. If
you don't select an element, the link is added to the diagram.

2. Open the attribute panel.
3. In the section Custom Attributes, select the custom attribute used for linking
documents in your workspace.

4. Click the

icon.

5. Click Add a new document.
6. Select one of the options:
o

To upload a file, enable Upload a new pictureand select the file.

o

To link to a file in the Signavio file storage, enable Choose a picture
from your file storage and select the file.

o

To link to a file in your document management system or in your network, enable Link a file/picture on a web resource or network storage
and add the URL.

7. To save, click Add.

5.13 Displaying attribute visualization layers
Important attributes can be configured to be displayed in distinguished visualization
layers. The configuration procedure of these layers is described in the chapter
Managing attribute visualization layers.
In Signavio, attribute visualization layers can be configured and displayed for BPMN
and Archimate diagrams, Value Chains and Organization Charts.
To display a visualization layer click the corresponding button in the upper toolbar:
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Now, icons (or the corresponding attributes' properties) will appear next to the
tasks in the diagram and provide you with an overview over the attribute properties:

The colored icons provide information about the attributes.

5.14 Comparing revisions
With the diagram and revision comparison tool, you can track changes in diagram
revisions. While the activity feed in the Explorer gives you all the comments made
on revisions of diagrams, the comparison view displays two diagram revisions next
to each other with all the changes marked according to their nature: alterations,
deletions and additions. Here, you can compare any two revisions of a diagram to
another. This can be helpful when you are working collaboratively with your colleagues (see Collaboration) and need to approve or implement the changes
someone else has made to a process.
In addition, you can compare two different diagrams with each other. This is useful
when you are checking your workspace for duplicates after you imported multiple
diagrams (see Importing/exporting diagrams and uploading files, for example).
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The diagram and revision comparison tool

5.14.1 Open the diagram comparison tool
You can open the diagram comparison tool in the following components:
o

In the explorer, select a diagram or two diagrams you want to compare and
click Edit > Compare revisions/diagrams.

o

In the BPMN simulation, editor and QuickModel, click Diagram comparison in
the user menu.

o

In the activity feed, select a diagram revision from the feed and click Open to
Compare.
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5.14.2 Display options
By using the zoom slider in the top left-hand corner you can change the diagram
size. This is helpful for when you have a very large diagram that you want to view
at a glance.

The zoom slider in the comparison tool

In addition, you can move diagram snippets by holding down the left mouse button
and dragging the map in the desired direction.
By default, navigating through the diagrams is synchronized in both windows - if
you zoom into one diagram, the other diagram will zoom in, too. You can deactivate
this feature by unchecking Synchronized scrolling .

Deselection of 'Synchronized scrolling'

5.14.3 Selecting a revision
The comparison view shows the revision history of each diagram. To switch to a diffrent revision, proceed as follows:
1. Select the desired revision number from the dropdown menu on the top left.

2. Alternatively, you can click Choose revisions/diagrams to select a different
diagram for comparison. The corresponding dialog box opens. Now all diagrams of the workspace with all their revisions are displayed.
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3. Now you can choose between all diagrams and their revisions.

4. Click Compare .

5.14.4 Diagram information displayed in the comparison tool
The diagram comparison shows structural and logic differences between diagrams
or diagram revisions. Some of these differences can be easily seen when changing
the sequence flow of a diagram. Other changes, like altering an attribute or adding
a dictionary entry to an element, would not be visible when simply comparing two
diagrams. Thus, all changes in the diagrams or diagram revisions are marked as follows. Hover the mouse on the icon in the right upper corner of an element to get
more detailed information:
The following table lists all possible changes.
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Change (image)

Description
New elements : An element
has been added to the diagram.

Changed attribute : the element's attribute(s) has/have
been changed.

Changes in the Dictionary :
a Dictionary entry has been
added, removed or changed
on this element.

Changes in roles : the role
the element was assigned to
has changed.

Deletions : an element has
been removed from the diagram.

At the bottom of the window, you can view information about how many changes
of the same kind have occured.
If there are many changes, you may want to turn off some change notes. For
example, when a lane is deleted, the role mapping changes all of the elements,
which can lead to very long change notes. In this case, you can turn off all references to changed roles. To do so, use the selection at the bottom of the view.
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By disabling the checkbox 'Changed role' you can turn off all references to changed roles

5.15 Custom graphics
Users with Enterprise or Enterprise Plus licenses can upload custom graphics for
use in Customer journey maps, Value chains, and BPMN 2.0 diagrams. Uploaded
files must be in SVG format and individually no larger than 20 KB.
The following elements can be customized:
Customer journey maps
o
o
o
o
o

Persona

Touchpoint
Moment of truth
Customer
Decoration

Value chains
o
o

Process
Collapsed process

BPMN 2.0 diagrams
o
o

IT System
Additional Participant

Custom graphics are tied to the workspace to which they are uploaded--if you have
multiple workspaces and want to use custom graphics in each, you must upload
them separately to each workspace.
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Custom graphic files do not count towards the file limit for a workspace.
To upload custom graphics, do the following:
1. Create or save the image you want to use as an SVG file.
2. In Process Manager, navigate to the Setup button in the toolbar. Select
Define notations/attributes from the drop-down menu. The Define notations/attributes dialog will open.
3. In the Modeling language section, select either customer journey map, value
chain, or BPMN 2.0 diagram.

4. In the Diagram element types section, select the element type you want to
set the custom graphic for. Note that not all elements are able to be customized.
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5. In the Custom attributes section, click the Custom Graphics tab. Click the
Add button. The Upload Custom Graphic dialog will open, with details about
the upload requirements for SVG files.
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6. Click Choose File and select the file you want to upload. The Name field will
by default be filled with the file name. A preview of the image will be displayed below. Edit the name if you want, and then click Add.

7. Process Manager will perform a validation while your file uploads, to make
sure it fits all requirements (see "Validation criteria" section below).
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o

o

If the validation is successful, your custom graphic will be displayed in a list
in the Custom Graphics tab.
If the validation fails, a dialog will be displayed, showing you the original
image and what the image will look like after being scrubbed. If the

o

scrubbed image is fine, click Add scrubbed image.
If the validation fails, it may also be that the uploaded SVG does not meet
our requirements.

8. Your custom graphic will be displayed in a list in the Custom Graphics tab,
where you can now set and use it for modeling.

5.15.1 Validation criteria
SVG is a flexible, powerful file format. However, this flexibility makes it vulnerable
to security exploits. To prevent possible security problems, Process Manager will
check each SVG file you try to upload and scrub anything potentially malicious from
the file. It will then show you a preview dialog, so you can see the differences
between the original and scrubbed file. If the scrubbed file is acceptable to you, you
can then continue with the upload.
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The requirements for SVG files are:
o

o
o
o
o

The root element of the SVG must contain the required attributes either width
and height or viewBox. The width and height attributes must be absolute size.
The attributes of the SVG file must not contain JavaScript in attributes
The elements and attributes of the SVG file must not contain URLs
The SVG file must not exceed the size limit of 20 KB
The SVG file must not exceed the supported complexity of 2000 anchor points

Here is the list of allowed tags and attributes for SVG files:
Tags: "svg", "style", "g", "path", "ellipse", "circle", "polygon", "rect", "line", "polyline", "defs", "clipPath", "mask", "use", "radialGradient", "linearGradient", "stop"

Version 14.9

114

5 Modeling

Attributes: "version", "xmlns", "xmlns:svg","xmlns:xlink", "xlink:href", "xlink:type",
"xlink:actuate", "xlink:show", "viewBox", "zoomAndPan", "xml:space", "contentStyleType", "contentScriptType", "preserveAspectRatio", "id", "class", "name",
"style", "transform", "d", "points", "x", "x1", "x2", "y", "y1", "y2", "cx", "cy", "r", "rx",
"ry", "width", "height", "fill", "fill-opacity", "fill-rule", "opacity", "offset", "stroke",
"stroke-width", "stroke-opacity", "stroke-dasharray", "stroke-miterlimit", "strokedashoffset", "stroke-linecap", "stroke-linejoin", "type","clip-path", "mask"

5.15.2 Modeling with custom graphics
Once uploaded, custom graphics can be used in customer journey maps, value
chains, and BPMN 2.0 diagrams.
To use custom graphics in a model:
1. Open your existing customer journey map, value chain, or BPMN diagram, or
create a new one from scratch, in the Editor.
2. Select an element you have defined a custom graphic for.
3. In the Attributes panel under Main Attrribute, click the arrow next to the
Image field.
4. Select your custom graphic from the drop-down menu.
5. Your element will now change from the default graphic to the custom graphic
you defined.
Models with custom graphics can be imported, exported and published to Collaboration Hub the same as standard models.
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6 Modeling notations
In this section, you find the editing features of the different modeling notations:
o

The section BPMN modeling explains how to model business process diagrams in the editor.

o

With Value chains, you create high-level perspectives on the process hierarchy in your organization.

o

Customer journey maps depict a customer's perspective on a product or service that contains specific touch points that link customer experience with
process architecture.

o

With Decision Model and Notation (DMN), you model decision diagrams to
describe frequently made decisions of an organization. It is also possible to
simulate decisions and define and execute test case for DMN decision logic.

o

Enterprise architecture diagrams enable you to visualize your corporate IT system architecture within and across business domains. You can learn how to
model in the chapter ArchiMate.

o

In addition, Process Manager supports a set of Further notations that are of
lesser importance in practical process management scenarios.

6.1 What is BPMN?
The Business Process Modeling Notation (BPMN) is the de-facto standard for business process modeling. It is an industry standard released by the Object Management Group (OMG) and supported by a wide range of vendors and consultants.
The current version BPMN 2.0 allows you to define activities, control flow, data
flow, organizational dependencies and system dependencies of business processes.
Signavio Process Manager supports BPMN 2.0 in full, including all modeling constructs and attributes. The syntax rules of BPMN are enforced by the Editor. Signavio is committed to BPMN, was and remains involved in the standardization
process and, promotes BPMN in industry and academia.
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6.1.1 BPMN elements
If you are interested in more details about BPMN, take a look at our BPMN element
overview at https://www.signavio.com/bpmn-introductory-guide/.
Signavio Process Editor Manager provides the custom elements IT system and additional participant. These elements are extensions of the
BPMN standard and as such standard-compliant. Many of our customers
find these additional elements a convenient alternative to pools and
lanes to model humans or systems involved in particular aspects of a
business process. If desired, you can deactivate these elements (see section Configuring notations and attributes for details), so your user can
only create elements the BPMN standard supports by default.

6.1.2 BPMN modeling
This section describes how to create and edit BPMN diagrams in Process Manager.
If you like to learn about the basic modeling functions first, go to Create a diagram
in the Basic Modeling section of the manual.
6.1.2.1 Creating a new BPMN 2.0 diagram
o

o

Click New > Business Process Diagram (BPMN 2.0) in the top drop-down menu
of the Explorer.
The Editor will open in a new browser tab. Now you can start adding modeling
elements.
In case you would like to to edit an existing diagram, just double-click the diagram in the Editor. Alternatively, you can select the diagram and click Edit >
Edit diagram:

6.1.2.2 Editing BPMN diagrams
To add the first element to the diagram canvas, select it from the shape repository
on the left side of the Editor, drag it onto the diagram canvas and drop it there:
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The green or red status icon indicates whether or not it is possible to drop the element at the current location. This might depend on whether an element can be
added to another element. For example, a Data Object cannot be added to a Task.
The shape repository contains all modeling elements that are available in the selected subset. To change the shape repository subset, click the drop-down menu above
the shape repository. The elements are grouped into element types (in activities,
gateways, roles, etc.).
Once you get started, you can add elements using the interactive context menus of
existing elements. Depending on the shape currently selected, the menu suggests
which modeling element might be added next.
The subset of modeling elements you have selected influences the elements you can add through the interactive context menu. If the element
you want to add doesn't appear in the interactive context menu, it probably does not exist in the current subset--simply switch to a subset that
contains the needed element.
In order to make use of the interactive context menu, proceed as follows:
o

Select an element on the diagram canvas (for example a Start Event). The inter-

o

active context menu appears right of the element.
Click the icon representing the element you want to add (e.g. a task).
The new element appears in the diagram.

o

If you want to define the position of the newly created element yourself, you
can also click the icon and drag the element to the desired position.
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The type of connector that is created between the selected element and
the newly created element is determined automatically. In BPMN, the
connector will usually be a sequence flow. When adding text annotations
or data objects, it will be an association. In case the flow crosses pool
boundaries, it will be a message flow.
If you want to duplicate one or multiple existing elements, you can simply select
them and click

in the toolbar. Use

cut and paste elements, use the

and

in the toolbar to insert the elements. To
in the toolbar.

Instead of using the buttons, you can also use the keyboard shortcutsCtrl + CCtrl +
V and Ctrl + X.
The copy functionality makes it easy to create similar elements with complex but
similar values. It also lets you re-use parts of old diagrams by copying some of their
elements and pasting them in a new diagram.
Copying elements between different diagrams may a few minutes, as
the elements are copied to the server first. An Internet connection is
required for copying elements between diagrams, but not for copying elements within one diagram.
Once you created an element in your diagram, you can label it:

If you want to edit the label of an existing element, double-click it in order to open
the text box.
You can edit the element's attributes by using the attribute panel on the right.
The position of labels and connectors can be changed via drag and drop:
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6.1.2.3 Working with pools and lanes
Pools and lanes are modeling constructs in BPMN that allow for the assignment of
organizational units, people or systems to activities. As the concept of pools and
lanes is BPMN-specific, readers concentrating on other modeling notations may
skip this chapter.
Adding pools and lanes to a diagram

Like with other modeling elements, the panel on the left is used to add new pools
and lanes to a diagram. In most cases, a pool represents a company and lanes subdivide this company, e.g. into roles or departments.
Pools can either be collapsed or expanded. Collapsed pools cannot contain modeling
elements, as they represent an abstract organizational unit or system. Expanded
pools can contain lanes to further subdivide the pool. Those lanes can be subdivided
further into sublanes.
This chapter explains how to add and edit expanded pools and lanes.
If you are using the subset BPMN (complete) you will find pools and
lanes under swimlanes.
Pools and lanes are added via the modeling element Pool/Lane:
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1. Select the Pool/Lane entry in the shape repository on the left side.

The Pool/Lane modeling element is context sensitive and becomes either a pool or a
lane, depending on the area it will be dropped on.

2. Drag the element to the desired position. The Editor helps you by highlighting

possible positions. It also decides automatically whether the new element will
be a pool or a lane:
o

Create a new pool with two lanes:

Drag the element to a spot on the canvas where no pool can be found. The
information Create new pool will appear next to the cursor.

A pool is created whenever the pool/lane element is dropped into an area that does not
already contain a pool.

3. Create an additional lane beneath an already existing lane
Drag the element to the upper or lower border of another lane. The border will
be highlighted in green and and an alert will show up, explaining where the
lane will be added.
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A lane is added between 'Central purchasing' and 'Department'.

If you want to add a lane above, move the cursor to the upper border. To add a
lane below, target the lower border.
4. Create a sublane that splits an existing lane into two sublanes
When moving a Pool/Lane element over the body of a lane it will be colored
green. To divide a lane into two sublanes, position the new lane here:

Before: The 'Central purchasing' needs to be subdivided into two organizational units.

After: The sublanes have been created and can be named now.

5. Drop the element onto the canvas at its new position.
6. Insert a title for the lane or pool created.
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Renaming pools and lanes

To change a roles title, double-click its head at the left border. A text field appears:

A pool or lane is named by double-clicking its header.

Here you can add the new name. To create a line break, use the Enter key. To apply
your changes, click the area outside the text field.
Reordering lanes within a pool

Lanes can be moved within a pool. If a lane is moved, its semantic content (i.e.
tasks, gateways etc.) will be moved with it.
There are two possibilities to move lanes:
o

Drag & Drop
Click the head of a role and drag the lane to its new position, holding the
mouse button pressed. Possible new positions will be marked green in the
same way as described above.
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The lane 'Department B' has to be moved above 'Department A'. Both will stay sublanes of
'Central purchasing'.

To move a lane up a level, move the cursor onto the head of its parent:

The lane 'Department B' has to be moved between 'Central purchasing' and "Department'.

Existing lanes can be moved, but not in a way that they subdivide
another lane into two separate lanes.
When selecting a lane by clicking its head, arrows will appear on its left border. The
arrows can be used to move a lane into a certain direction:
o

The lane will be exchanged with the one above, but will stay on the same level:
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o

The lane will be exchanged with the one below, but will stay on the same level:

o

The lane will be outdented, i.e. moved beneath the lane thatcurrently contains it.
It will be positioned above if the arrow on the upper border is used, and below, if
the arrow on the lower border is used:

o

The lane will be indented, i.e. become a sublane of one of its neighbors. It will be
added to the one above, if the arrow on the upper border is used, and below, if
the arrow for the lower border is used:

Example: Moving a new lane as a sublane into an existing lane

In the following example, the role 'Releaser' will be added to the Central purchasing, which will then be divided into Department A, Department B and
Releaser.
The lane Releaser was selected and the indent arrow will be used:

The releaser is supposed to become part of the central purchasing.

The lane was moved into the "Central purchasing". This can be redone later on by
using the "outdent"-arrow:
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The lane 'releaser' is supposed to be removed from the pool 'central purchasing'.
Resizing pools and lanes

To resize elements, proceed as follows:
o
o

Click the header of the pool or lane you want to resize.
Click the three dots in the lower right or upper left corner of the element and
drag it to a new position in order to perform the resizing.

The size of a pool is adjusted in the same way as the task size.

Resizing of a pool / lane affects the parent and child pool / lanes in the following
way:
o

Resizing a pool: The new width is propagated to all contained lanes. Changing
the height of the pool results in changing the height of all contained lanes, the

o

height distribution is kept though.
Resizing a lane: The new width is propagated to the parent pool and all lanes contained in it. Changing the height results in moving the lanes below it up or down.

6.1.2.4 Working with connectors
To connect two elements in your diagram, you can also use the interactive context
menu. Proceed as follows:
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o
o

Select the element the connector should start from.
Click the arrow icon in the shortcut menu and drag it to the target element. The
red and green colors indicate whether the selected target is valid. For example,

o

two start events cannot be connected in BPMN.
A connector will be created. The type of the connector will be automatically selected in compliance with the BPMN 2.0 specification:

To insert an element into an already existing process flow, drop it onto the connector at the desired position:
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In case you lack space for dropping the element onto the connector, you can make
use of the create/remove space tool, see Creating more space
Connector layouting is an essential aspect as well-structured diagrams are more
comprehensible for the readers. The Editor does connector layouting automatically
but you can also adjust the layout yourself.
Adding connectors between existing elements

If you want to connect two elements in your diagram you can also use the interactive shortcut menu.
o
o

Select the source element.
Click the arrow icon in the shortcut menu and drag it to the target element. The
red and green colors will give you a hint which elements can be connected. E.g.

o

two start events cannot be connected in BPMN.
A connecor will be created. The connector type depends on the types of the elements you have connected. E.g., two BPMN tasks will be connected through a
sequence flow and two pools will be connected through a message flow.

The Editor gives you a hint about which elements can be connected (green) and which can't (red).
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Dropping a new element on an existing connector

It is possible to position an element between two existing elements. Drag it from
the shape repository to the connector between the existing elements. If adding the
element at this position is allowed in BPMN, a green frame will appear around the
connector. Drop the element onto the connector.

Drop an element onto a connector.

You may use this functionality together with the stretching connectors functionality.
Automatic layouting of connectors

The connector layouting feature helps you to create well-structured diagrams. Signavio Process Manager provides automatic layouting for connectors.
The auto-layout function is triggered:
o
o

whenever a connector is created.
whenever a element that is target or source of a connector is moved or re-sized.

Moving, adding and removing bending points

By moving the cursor over a connector, bending points of that connector are displayed. You can drag a bending point to another location in order to re-shape the
connector:
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A red dot appears whenever you move your cursor over a connector. To bend it, just
click the red dot and drag it to its new position. Drop it there:
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To remove a bending point you only need to drag it onto a straight connection
between the two neighboring bending points or elements or directly on one of the
neighboring bending points:
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Adding and removing bending points

A red dot appears whenever you move your cursor over a connector. To bend it, just
click the red dot and drag it to its new position. Drop it there.

Bending points can be moved per drag & drop.

To remove a bending point you only have to drag it onto a direct connection
between the two neighbored bending points or elements.
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Bending points can be removed by dragging them onto a direct connection between its neighbors.
Moving connector segments

Connector segments can be moved vertically or horizontally to improve the visual
appearance of a diagram. To do so, move the cursor over the connector segment
and a yellow rectangle will appear in its center. Drag and drop the yellow rectangle
to move the connector to its new position.
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Labeling connectors

While tasks and events usually should carry label, this only applies to certain connectors. For example, sequence flows in BPMN can carry a conditional expression
and message flows can carry the name of the message to be transferred.
In order to label a connector, proceed as follows:
o
o

o

Double-click on the connector you want to label or edit. An input field appears.
Type in the label:

As soon as you deselect the connector, the label will appear next to it.

You can now move the connector descriptor to another position to visualize logical
connections to an element. Click the label and drag it to its new position:

Dragging a connector label close to its connector, will cause the label to align automatically.
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Creating attached intermediate events/boundary events

The BPMN specification uses the term boundary event instead of
attached intermediate event. According to the BPMN specification,
attached intermediate events with the activated check box attribute
Cancel activity are interrupting attached intermediate events.
Catching BPMN intermediate events can be attached to a task. Those events can
occur during the execution of a task and either cancel it or are handled afterwards.
To create an attached intermediate event, drag a catching intermediate event to a
task and drop it there. When hovering over a task with an intermediate event, the
task will be displayed either with a green border or in red brackets. A green border
indicates that the intermediate event can be attached to it:

Some intermediate events, like the link intermediate event, cannot be attached to
a task, which is indicated with red corners:

By default, an attached intermediate event will cancel the task it is attached to. To
make it a non-canceling event, select an attached intermediate event, open the
attribute panel on the right and deactivate the checkbox Cancel activity.
Canceling events are displayed with a solid border whereas the border of non-canceling events is a dotted line:
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Some start events can be marked as canceling or non-canceling as well.
Changing the type of modeling elements

The transformation functionality lets you switch easily from one element type to
another.
In BPMN, you can transform, for example...
o
o
o

...a task into a subprocess.
...a plain start event into a message start event.
...a collapsed pool into an expanded pool.

In order to change the type of an element, proceed as follows:
o

o
o

Select the element you want to transform.
Click the
below the element.
Select the type you want to change the element to:

Some changes that affect the appearance and behavior of a modeling
element but not its actual type can be done in the attribute Editor on
the right. E.g., if a canceling intermediate timer event has to be changed

Version 14.9

136

6 Modeling notations

to a non-canceling intermediate timer event, the attribute cancel activity has to be set to false.
Creating more space - shortening and stretching diagrams

You can easily stretch the diagram size to create compact diagrams or to create
space for additional elements. Proceed as follows:
o

Activate shortening/stretching by clicking

in the toolbar or using the

shortcut Ctrl + M.
o

Click and hold the left mouse button on the place in the diagram where you
want to create or remove free space:
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o

Move your cursor to shorten or stretch the connector. All connectors with the
same alignment on the same horizontal line will change their size, too. This
works horizontally and vertically. All connectors are hidden during this step.

o

Release the mouse button.

o

Deactivate shortening/stretching by clicking on the corresponding toolbar button or using the shortcut Ctrl-M again.
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Changing the process flow orientation

By default, BPMN diagrams are aligned horizontally. The alignment can be changed
if a vertical process flow is preferred. To change the alignment in a diagram, open
the Editor and make sure that no element on the canvas is selected. Expand the
attribute panel on the right and change the value of the attribute Diagram orientation.
If there are pools and lanes on the canvas, their orientation will be
changed as well. For all other elements, the auto-layouting function will
be triggered. This can change the diagram layout significantly. In order
to prevent an accidental re-layouting of the whole diagram, the changes
to the diagram orientation have to be confirmed explicitly.
6.1.2.5 Checking diagram syntax
You can check your BPMN process diagram or EPC for syntactical correctness by
clicking

> Check syntax the toolbar.

Errors will be highlighted. Move your cursor over one of these crosses to get more
information about the error:

The reason for the syntax error is explained by the tool.
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6.1.3 Set BPMN attributes
Modeling elements have several properties you can edit. These properties are called
attributes. You can use attributes to change the appearance of an element (for
example the background color or label). Attributes can also be necessary to execute
a process, for example the decision logic in a DMN diagram is an attribute.
You edit attributes in the attribute panel on the right side of the editor.
o

o

To change the attributes for one element, select the element and open the attributes panel.
To change diagram-wide attributes, click any empty space on the canvas and
open the attributes panel.
The first section of the attribute panel contains custom attributes,
which can be defined by your workspace administrators.

You can change attributes for one element and diagram-wide attributes.

Example:

6.1.3.1 Frequently used BPMN attributes
BPMN includes a range of attributes. The following table lists the most important
attributes.

Version 14.9

140

6 Modeling notations

Attribute

Elements

Default

Use
Standard: task is is executed multiple times

MI Parallel: task is executed multiple times in parallel
Loop type

task, subprocess

None

MI Sequential task is executed multiple times sequentially

Specifies the task
Send,
Task type

task

Receive,

User,

None
Manual,
ness rule,

Service,

Busi-

Script task

A compensation activity is used to
Is for com-

task, sub-

pensation

process

cancel the result of another activity
false

that has already been completed.

A transaction contains several activIs a transaction

ities that must be completed sucsubprocess false

cessfully for the flow to continue. If
any of the activities was not completed successfully, all of them must

Version 14.9

141

6 Modeling notations

Attribute

Elements

Default

Use
reversed to their original state.

In an ad hoc subprocess, you define
the steps, but not the order.
Is ad hoc

subprocess false

A call activity links to a globally
defined process or subprocess. The
task, subIs a call activ-

process,

ity

event-sub-

called process controls the flow.
false

Non-standard start events are
ignored.

process

Subprocess
reference

Version 14.9

The subprocess linked to the ele-

subprocess,
event-subprocess

none

ment is listed as the reference. Usually, a BPMN diagram in the same
workspace is linked.
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Attribute

Elements

Default

Use
Multiple similar organizations or
process participants can be con-

Is multi
instance par-

pool

false

ticipant

tacted during a process. For
example, project proposals can be
requested by multiple companies.

After a gateway, one sequence flow
can be the default flow that is followed in case no other condition is
Condition

sequence

type

flow

Standard

true.

States can further refine the life
cycle of data objects. You can use
State

data object none

any label for your states. For
example, you can distinguish
between 'new', 'completed' and
'rejected'.
Data objects can be read (input) or

Input/Output

data object none

written (output) during a process.
input,

output

Subprocesses, event-subprocesses and pools can be collapsed and expanded.
6.1.3.2 Add documentation to an element
You can add documentation to an element to include more details. For example, if a
rarely executed task requires instructions, you can add these instructions as documentation.
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The element documentation can also be accessed in Collaboration Hub.
To add documentation to an element, follow these steps:
1. In Main Attributes, click Documentation.
2. Click the

icon. The documentation editor opens.

3. Enter and format the documentation.
4. Save with Ok.

6.1.4 Responsibility assignment according to RACI
The responsibility assignment matrix RACI is used to represent responsibilities for
activities.
RACI is an acronym for the key responsibilities:
o

R for responsible: performs the activity

o

A for accountable: approves the activity

o

C for consulted: is consulted for the activity

o

I for informed: is informed about the activity

Responsibilities can be assigned to diagram elements.
6.1.4.1 Assign responsibilities in a diagram
For BPMN diagrams, there are different ways to assign responsibilities:
o

You can use lanes or the element Additional participant.

o

You can assign custom attributes to tasks.

Assign responsibilities with lanes and additional participants

Add a lane to set all activities in this lane as responsible (R) in the RACI matrix. It's
not possible to assign additional RACI responsibilities to a lane element.
The element Additional participant can be linked to an activity with the connector
Association (undirected). The connector has the attribute Responsibilities to
assign responsibilities.
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1. Add an Additional participant element to your diagram.
2. Connect the Additional participant and the Task with an Association (undirected) connector.

3. In the Attributes panel, assign one of the four RACI Responsibilities to the
connector.

The responsibility is displayed as the connector label in the diagram and listed
for the activity when you export a RACI matrix.
Assign responsibilities to tasks as custom attributes

To assign responsibilities to tasks, custom attributes for RACI need to be
available in your workspace. Custom attributes can be defined by your
workspace administrator.
1. Select a task in the diagram.
2. Open the attribute panel.
3. In the section Custom Attributes, click the responsibility you want to add.
4. Click the

icon.

5. Enter a role. Available dictionary entries are suggested as you type.
6. Select the role from the list. The role is added to the attribute.
You can add multiple roles for one responsibility. Roles that are already
assigned are displayed below the text field.
7. Click Save.
In the diagram, there is no visible change.
When you export a RACI matrix, the assigned responsibilities are listed.
To preview the dictionary entry for a responsible role, click the role.
To open the dictionary entry, click the
To remove a role, click the
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6.1.4.2 Export a RACI matrix
The RACI matrix lists the 4 RACI assignments and an additional responsibility
where no RACI category was used:
o

R - Responsible

o

A - Accountable

o

C - Consulted

o

I - Informed

o

X- Participates

To export a RACI matrix for one or multiple diagrams, follow these steps:
1. Select Reporting>Responsibility assignment matrix / RACI (XLS).
2. In the dialog, select the diagrams.
When you select multiple diagrams, one matrix including all diagrams is generated.
When a diagram has no responsibilities assigned, the matrix remains empty.
3. Click Start analysis.
An XLS file is generated.

6.1.5 Setting key performance indicators (KPIs)
Key performance indicators have to be set for a quantitative analysis. The indicators can be set for task execution probabilities and frequency. They also inform
about cost and execution time.
Diagrams have to be structurally and semantically correct to create a quantitative
analysis. Signavio provides tools that allow you to check the corresponding properties of process diagrams.
KPIs can be set for each element in the Attributes section on the right in the
Editor. Simply select an element, then click the two arrows above Attributes to
extend the section on the right. The KPI values for the corresponding analyses are
set under Cost and Resource Analysis and More Attributes. Simply click the corresponding headlines to expand the KPI settings. When you are finished setting the
KPI values for one element, simply click the next element in the central section and
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add the corresponding values on the right. When you are finished adding the necessary values to all elements, you can click the arrows on the left of the grey 'Attributes' header to close the Attributes menu and proceed with the calculation.
The following attributes are key values for the process cost and resource consumption analyses:
o

Frequency (per year): Start Event
Denotes how often a process is started via this entry point. Multiple start
events that represent alternative entry points for the process are allowed.
e.g. "1000"

o

Execution (minutes): Task (BPMN), Function (EPC)
Denotes how long it takes on average to complete the task. This value is
required for a resource consumption analysis.
e.g. "2.5"

o

Execution costs (currency): Task (BPMN), Function (EPC)
Denotes the costs that come up during the activity. This key value is
required for a process cost analysis.
e.g. "5"

o

Probability: Sequence Flow
Denotes the probability for choosing this sequence flow after a decision
gateway/XOR-connector. This is supposed to be a value between 0 and 1.
e.g. "0.2"
'20%' has to be denoted as '0.2'.s

o

Cost center: Task (BPMN), Function (EPC)
This is an optional value and represents the cost center for the activity
costs.
e.g. "KS 1008"
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o

Apply in calculation: All elements
Uncheck to exclude an element from the analysis.
"yes" / "no"
Floating point numbers are accepted either in the form of "2.5" or "2,5"
but will be automatically converted to the notation of "2,5".

6.1.5.1 Checking completeness
After setting the KPI, you can trigger a check for completeness to ensure that all
required values are present for analysis.
Click

the toolbar and select Cost and resource analysis check.

This check might take several seconds.
Some elements may now be marked with one of the following icons:
o

The white exclamation mark on orange denotes that key values are missing for
an element. It is also attached to elements that will be ignored during an analysis, as it is not logically contained in those measurements. (For example, a sending intermediate message event will be ignored during an analysis.)

This does not interfere with the analysis calculation, but some of the calculations
may not be able to run properly due to missing data.

o

The white exclamation mark on red denotes a heavy structural or logical mistake. Additionally, some modeling elements preventing an analysis are marked
with this symbol--for example, a complex gateway cannot be included in a process analysis.
This sign marks that an element interferes with the analysis calculation.
Hover over one of these symbols to get more details about the problem
that occurred.
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Get information about an error

An analysis calculation can be triggered only after all severe mistakes (indicated in
red) have been removed.
After removing them, switch to the Explorer.

6.1.6 Create views
You can create different views for different audiences. In a view, you include what
you want to show an audience and exclude what the audience does not need to see.
Examples for using different views of process models:
o

A model contains both user activities and elements for technical implementation. The audience wants to focus on the technical implementation.

o

A model contains different variants of one process. The audience should only
view one variant.

o

A model contains the expected path of a process and a number of exceptions.
The audience doesn't need to see the exceptions.

You can create as many views as you need.
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6.1.6.1 Create and change views
1. Extend the right panel and scroll to Views. All available views are listed.
o

To create a new view, click Create new view.

o

To configure an existing view, click the view.

The view configuration opens.
2. In the configuration, select the objects to exclude from a view.
You can preview the result and the original diagram.
3. Enter a name and a description for your view.
4. Click Save changes.
6.1.6.2 Navigate the view configuration
Click and drag a preview to scroll to other areas of the diagram.
Use the zoom slider to zoom in and out of the diagrams.
By default, you move both diagram versions in the preview. To move the diagrams
separately, disable Synchronous Scrolling.
6.1.6.3 Edit a view
You can exclude all Comments , Data objects, IT Systems, or Roles above the original view.
o

Data objects: contains data objects, data storage and messages

o

IT Systems: contains IT systems

o

Roles: contains pools, lanes, collapsed pools and additional participants

o

Comments : contains all comments on the diagram

You can show or hide each element. In the original view, disable elements to
exclude them from a view.
For pools, you have additional options. Select an option from the drop-down list at
the bottom of the pool.
o

Pool is opened: The pool and its content are included in the view. You can
define view options for all contained elements.

o

Pool is collapsed: The pool content is not shown.
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o

Only content: No roles that are defined by the pool and its lanes are shown.
Message flows attached to the pool are hidden.

o

Pool is hidden: Neither the pool nor its content is included in the view. Message flows attached to the pool are hidden.

When you uncheck a pool, all elements in that pool are excluded from a view.
To keep the original diagram size and the original placement of the shown elements, disableReduce free space.
The preview is refreshed after every change.
6.1.6.4 Duplicate a view
To create a duplicate view from an existing view, follow these steps:
1. Click the original view to open it.
2. Edit the view.
3. Click Save as duplicate....
4. Enter a name for the new view and click OK.
A new view is created.
6.1.6.5 Delete a view
1. Click the view to open it.
2. Click Delete view.
3. Confirm the deletion in the dialog.
The view is deleted.
6.1.6.6 Editing views from within the Editor
It is possible to include or exclude diagram elements from one or multiple views
while editing a diagram--without opening the views configuration. This makes it
fast and easy to edit existing views.
o

Choose one or multiple elements.
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Changes in the include option can be applied to single or multiple elements
o

Behind each view that is stored in the attribute editor. check boxes will appear.
Those can be empty, checked or, if multiple elements were selected, colored
green:

Only some of the selected elements are included in the view, but not all.

Checked
All selected elements are included in the view.

Empty
None of the selected elements is included in the view.
o

Check or uncheck the boxes, to add/remove the elements selected from one of
the views.

6.1.6.7 Exporting views
You can include views when you export a diagram as an SVG, PNG, PDF, or a BPMN
2.0 XML file. The SGX export contains all views for a diagram. Read more about
exporting diagrams in section Exporting.
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6.1.7 Risk Management
This feature is available in the Enterprise Edition.
In this article, you will learn how to define custom risk management tables in the
Dictionary.
6.1.7.1 Creating risks and controls in the Editor
In Signavio Process Manager, you can document the risks and controls directly in
your process landscape. This is obtained via the element attribute.
To use this feature, you need to configure it first, see section Managing
risks and controls definitions for details.
To add a risk to a diagram element, proceed as follows:
1. Ensure that you defined Risks and Controls as described in Managing risks
and controls definitions
2. Select the element.
3. In the attribute panel under Custom Attributes click the defined category.
The Risk Management dialog opens.
4. Enter the name for the risk. While typing a name, the system automatically
proposes possible names of existing risks.

Suggestions pop up as you type
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If you use an already existing risk attribute from the Dictionary, you can
change locally the corresponding value. Please be aware that this could
lead to inconsistency and should be avoided. For more detailed information see section Overwriting locally dictionary entries .
4. If you decide to create a new risk, you can now enter the risk definition.

The risk definition

5. For each risk, you can add controls:

Add a control

6. Click
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To create an overview over all risks and controls, you can create reports, see section Generating risks management reports.
6.1.7.2 Editing risks and controls in the Dictionary
When you need to update a specific risk or control, you can do this centrally in the
Dictionary. The update will affect all diagrams that reference this risk or control
immediately.
Of course, you can also add new risks and controls in the Dictionary (see Using the
Dictionary in the Editor ).
To add risks and controls to the Dictionary, open the Dictionary and create new
entries of the type Risk or Control:

Create a new risk in the Dictionary

To ensure your risks and controls definitions are updated when a process changes,
you can employ approval workflows, see section Working with approval
workflows, that enforce a review by a risk management specialist before a process
revision is published in Collaboration Hub or otherwise released into a production
environment.

6.1.8 Migrating diagrams to BPMN 2.0
Signavio provides a possibility to migrate BPMN 1.2 business process diagrams to
BPMN 2.0. This may be interesting for you if you want to reuse old diagrams
modeled in BPMN 1.2 with new elements from BPMN 2.0.

Version 14.9

155

6 Modeling notations

The diagram content will not be changed during this procedure.
Use the following steps:
o
o

Select the diagram you want to migrate.
Click Edit, then Migrate to BPMN 2.0 in the top drop-down menu of the Signavio Explorer

Migrate a BPMN 1.2 diagram to BPMN 2.0.

The diagram can now be edited and saved as a BPMN 2.0 diagram.

6.1.9 Converting EPC diagrams to BPMN 2.0
Signavio Process Manager allows you to automatically convert Event-driven Process Chains (EPCs) to BPMN 2.0 diagrams.
To convert one or multiple diagrams, open the Signavio Explorer, select the corresponding diagram(s) and go to Edit - Migrate EPC to BPMN 2.0:
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Now, you can decide whether to convert Position/Roles and Organizations to
BPMN 2.0 Pools and Lanes. The system handles the assignment to Pools/Lanes via
the custom Relation attribute Responsibility. To properly assign a function to a Positions/Role or Organization, you need to set the corresponding attribute value to
responsible:

Specify the responsibility type.
The system will create empty Pools/Lanes for all Positions/Roles and Organizations
that lack a corresponding responsibility assignment.
If you don't activate the corresponding checkbox, the system will convert Position/Roles and Organizations to the Signavio-specific BPMN extension Additional
Participant instead.
Click Migrate to proceed:
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Configure the converter and start the conversion.
EPC and BPMN 2.0 are not entirely congruent notations. The following
EPC elements cannot clearly be mapped to BPMN 2.0 elements and are
ignored by the converter:
o
o
o
o
o
o
o

Letter
Email
Fax
Phone
Entity
Form
Resource

If you use these elements in your EPC diagrams, we strongly recommend
you to review and edit the generated BPMN 2.0 diagrams after the conversion.
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6.1.10 FIM attributes for public administration
This articles introduces the FIM-BPMN-extensions, which are relevant
for the German public administration. The plugin for the Signavio Editor
is accessible on request.
The German Federal Ministry of the Interior created a BPMN extension for structuring BPMN-diagrams: the so called FIM attributes (trans. Federal Information Management). These attributes equip processes in departments and sectors of the
public administration with reference attributes, to compare them with more clarity
on a national level.
This refers mostly to common activity types like receive information or decide:
These are activities that occur commonly in the processes of the public administration, but different local authorities have different ideas of implementing them.
For example: Many local administrations use different forms to receive information
for public services, although on the basis of these information they have to decide
over the same factual matters. The FIM initiative strives to standardize the processes to reduce bureaucratic expenditure – and uses therefore the instruments of
process management:
In the BPMN extension, these processes are ordered into groups through FIM. the
reference activity groups are marked with different labels on the right top corner
of the activity (subprocess). In consequence, the FIM-Groups are easy to recognize.
The principle of the FIM initiative is: "Same content should always be described
alike."
You can also use the add-on outside of the public administration context: It is a useful tool to structure sub-processes and to standardize content that belongs to the
same reference group.
6.1.10.1 Adding an FIM attribute
1. Choose a collapsed sub process in the Editor and drop it onto the canvas.
2. Select the activity and open the attribute menu on the right side. Choose now
under main attributes, reference activity groups the correct FIM attribute
from the drop-down menu.
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6.1.10.2 Overview of the FIM-attributes
The attribute labels can be used flexibly, but usually they refer to:
1. Receive information describes the arrival of new information or documents.
2. Provide Information describes the forwarding of information or documents,
especially to external participants(, e.g civilians or (other) enterprises).
3. Check formally describes proving something on the basis of procedural law.
4. Check materially describes proving something on the basis of substantive law.
5. Decide refers to a decision based on an expert assessment.
6. Create e.g. a new document.
7. Execute participation involves an external participant into the process.
8. Execute other activity is optional, und can be used if no other type applies.

A list of all FIM-attributes

More information on how to create subprocesses are available in the section Create
subprocesses .
6.1.10.3 Creating attributes for FIM reference activities
1. Open the Explorer and select Setup - Define notations/attributes.
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2. Select Business Process Diagram (BPMN 2.0) as the modeling language and
Collapsed Subprocess as the element type and click Add in the Custom
attributes section. Now, you can define the attribute name and type.
Read more at Configuring notations and attributes.

6.1.11 Frequently asked questions
6.1.11.1 How can I add a second lane to a pool?
Lanes can be dragged from the column on the left. If you are using an extended
view, lanes can be found under Swim Lanes . Drag & drop the lane onto the head of
a pool and a new lane will be created. You find more information about pools and
lanes at Working with pools and lanes .
6.1.11.2 How can I change the orientation of a diagram (horizontal/vertical)?
You can change the orientation of a diagram in the attribute column under Main
Attributes . Simply click the set value ( horizontal or vertical ) of the attribute Diagram Orientation and change it correspondingly. The Editor will automatically realign the elements in the diagram after you confirm.
6.1.11.3 How can I link a document to a task?
Custom attributes can be defined for each modeling element. Open the Explorer,
click Setup and choose Define notations/attributes . Now, select a subset (e.g. Business Process Diagram (BPMN 2.0) and BPMN (complete)), the diagram element type
(e.g. Task) and click Add custom attribute . Name the attribute and choose the data
type Link/URL. Click Create .
Whenever a diagram is opened in the Editor, you can select a task and link a document to it using the attribute Editor.

6.2 Customer journey maps
Customer journey maps (CJMs) provide customer-centered entry points to your business process landscape. CJMs are high-level intuitively readable diagrams that
focus on the customer experience instead of internal processes. They help you
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understand how your customers perceive your products and services in the context
of their everyday lives and how their key decisions, which for example lead to a purchase or churn, are motivated.

A customer journey map in the Collaboration Hub.

6.2.1 What are customer journey maps?
Customer journey maps are graphical representations of the steps a customer
absolves when interaction with your organization. They can include a wide variety
of information, including things like critical decisions, touchpoints, departments
involved, IT systems, or any other points that are specific to your organization.
When creating a customer journey map, you model your organization from the outside in. Hence, customer journey maps provide customer-centered entry points to
your business process and/or enterprise application landscape.
6.2.1.1 Customer journey map elements
The following sections explain the customer journey map elements you can use in
Signavio Process Manager.
Persona

Personas represent typical customers. A persona's attributes and their associated
banners define their motivations, goals and pain points, as well as typical characteristics like preferred media channels and IT savviness.
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A female and a male persona.

Personas can be either female or male, depending on their gender attribute.
Customer

A customer element represents a persona at a specific step of a customer journey.
You can configure customer elements to express their feelings and attitudes as gestures, for example as a thumbs up.

A customer.

As personas, customers can be either female or male, depending on their gender
attribute.
Outcome

Outcomes define what your customers are trying to get out of their experience. For
example, an outcome of the customer journey of a banking customer might be
obtain loan. Outcomes can be either successes (hoisted flag) or failures (flag on the
ground).
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Successes and failures.
Step

Steps (connected through paths) show the sequence of events at a high level and
form the backbone of a customer journey map around which supporting elements
are arranged.

A sequence of steps.
Path

Paths connect different steps to define the flow of a customer journey.
Touchpoints

Touchpoints represent steps where your customer comes into direct contact with
your brand. Each touchpoint relates to at least one of your business processes and
roles or IT systems. Touchpoints can be either physical (for example: a cash desk) or
virtual (for example: social media).
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Different touchpoints
Moment of truth

Moments of truth are key decision points that can make or break your business’s
chance for succeeding with the customer. They are either barriers (requiring customer empowerment) or signposts (requiring a customer decision).

Moments of truth: barriers and signposts.
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Trigger

Triggers start a customer journey. They can be either ideas (inspiration-driven) or
demands (driven by need).

A trigger.
Text

Text labels describe specific customer journey map elements or element groups.

A text describing a customer's thoughts at a specific journey step.
Banner

Banners are post-it-style notes that contain important textual information about a
customer journey map element or about the customer journey in general. The icon
and default color of a banner depends on the elements type attribute, which can be
idea (light bulb), demand (bell) or goal (flag).
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Banners of different types.
Decoration

Decoration elements provide additional visual information to support specific process steps. For example, a package decoration element might indicate a delivery.

Different decoration elements.

6.2.2 Creating and editing customer journey maps
To create a new customer journey map, open the Explorer and click New - Customer journey map:
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Creating a new customer journey map.

The system opens the Editor with an empty diagram canvas in a new tab.
You can work on the customer journey map like a diagram of any other type.
6.2.2.1 Grouping elements
In order to create groups, you must include one step element.
Grouping elements makes it easier to model your process landscape, because it lets
you move multiple elements together as though they were one single element.
You can group elements in one of three ways. In the Editor:
o

Select a set of elements and click

in the left bottom corner of the selection

rectangle.
o
o

Select a set of elements and click the
in the toolbar.
Select a set of elements and press the shortcut "Ctrl + G"

To ungroup elements, do one of the following in the Editor:
o
o
o

Select a group and click

in the left bottom corner of the selection rectangle.

Select a group and click the ungroup button
in the toolbar.
Select a group and press the Shortcut "Ctrl + Shift + G"

After grouping elements in the Editor, open your customer journey map in Collaboration Hub. Click on each group and you will see all information about each element in the group displayed in the annotation.
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6.2.2.2 Navigating through customer journey maps
If you publish to or preview your customer journey map in Collaboration Hub, you
can use the arrow keys on your keyboard to navigate through each step.
To do so, either select a step with your mouse, or simply press the right arrow key
on your keyboard. The step you selected will be highlighted, while the rest of the
map will be greyed out.
If your step contains grouped elements, an information panel with information
about each element will also be displayed for the highlighted step.

6.2.3 Integrating customer journey maps into your process landscape
In customer journey map diagrams, touchpoints (see section Touchpoints ) depict
interaction points between your organization and your (potential) customers. In
other words, touchpoint elements are entry points to your process and application
landscape. When creating touchpoints in customer journey maps, you should reference the business process diagrams, roles and/or IT systems that are involved in
the corresponding customer interaction.
6.2.3.1 Creating custom attributes for the touchpoint element
To allow referencing process diagrams and - in the form of dictionary entries - roles
and IT systems, create a set of custom attributes for the touchpoint element type
(see section Configuring notations and attributes ). We recommend creating the
following custom attributes:
Name

Description

Type

As
list?

Process
links

Links to the business processes the customer
triggers/interacts with

Diagram link

X

IT systems

Links to the IT systems through which the
(potential) customer has contact with the
brand or organization

Dictionary link (Category: IT systems)

X

Roles

Links to the roles through which the (potential) customer has contact with the brand or
organization

Dictionary link (Category: organizational units)

X
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Creating a custom attribute to reference IT systems.

6.2.3.2 Referencing diagrams and dictionary entries at touchpoint elements
To reference a diagram or dictionary entry at a touchpoint, select the touchpoint
element in the Editor and open the attribute panel. Select the attribute you want to
edit - for example Process links - and add the reference:

Adding a process reference to a touchpoint element.
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6.3 Decision Model and Notation (DMN)
This modeling notation is available in the Enterprise Plus Edition.
Process Manager only supports DMN version 1.1. You find the specification at https://www.omg.org/spec/DMN/1.1/.
With DMN, you can describe and model frequently made decisions of an organization, which answer the following questions:
o

Which information is required for a decision?

o

Are there any preceding decisions?

o

Are there external or internal guidelines?

o

What are the dependencies?

DMN is not suitable for modeling strategic decisions.
The notation is designed to be readable by all types of business users in order to
ease collaboration for all stakeholders.
DMN and BPMN diagrams can be linked so that processes can be viewed separately
from decisions, with the advantage that the process is streamlined and the
decision is traceable.
DMN consists of the decision requirements diagram and the decision table.
The decision requirements diagram is the graphical representationof the decision
rule. For example, the diagram below describes what information and decisions are
needed to screen an applicant and decide whether to hire or not.
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From the decision table, the appropriate decision is read for each supplied input. For
example, in the table below it is defined whether or not an applicant must have specific technical knowledge, master certain foreign languages, and must have gained
experience abroad.

6.3.1 Next steps
Model a decision
Define a decision logic

6.3.2 Model a decision
Before you start modeling a decision, it is helpful to answer the following questions:
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o

Which decisions have to be made?

o

What is the goal of a decision?

o

Can a decision be split into partial decisions?

o

Which requirements are needed to make a decision?

o

Is the logic for a decision determined by external laws or internal guidelines?

Modeling a decision involves the following steps:
1. Create a DMN diagram.
To do so, add decision elements and connect them. Read more in section Available diagram elements.
2. For each decision, add rules to decision table and define a hit policy.
Read more in section Define a decision logic. The section also describes how
to create simple literal expressions.
To calculate sums using literal expressions, read more in section Using
advanced literal expressions (functions in DMN decision elements).
3. You can simulate the DMN diagram.
To do so, apply data to it and check the results. Read more in section DMN
simulation.
In addition, you can run test cases to check whether your DMN diagram
meets specific requirements.
Read more in section The DMN Test lab.
4. You can integrate your decision model with a BPMN business process.
Read more in section Link a DMN diagram to a BPMN diagram.
In this section, the diagram elements and editing functions that are only available
for this notation are described.
For general creation and editing options that are available for all notations, read
more in section Modeling.
6.3.2.1 Available diagram elements
In the shape repository, you can choose whether to use the core elements or a complete set of DMN 1.1 elements.
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Example:

Decision

A decision element determines a result based on input data and a decision logic.
Each decision element provides a table for the decision logic. You can open the
decision table by clicking

in the decision element.

To describe a decision, use a question-answer-scheme. By default, the attribute
panel provides the attributes Question and Answers for documenting this scheme
for each decision.
You can split a decision into one main and several sub decisions. To do this, you link
several decision elements in the necessary order. Read more in section Create a
sub decision.
Input data

Via the input data element, you provide information for decisions. One input data
element can be used by multiple decisions and business knowledge models.
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If you must model numerous data input elements, you can simplify this by using the
complex data input element. Read more in section Create complex input data elements.
Business knowledge model

With the business knowledge model element, you add a function containing business knowledge, for example, in form of business rules, an additional decision table,
or an analytic model.
Via this element, you can reuse decision logic. Read more in section Reuse decision
logic via business knowledge models.
Knowledge source

With the knowledge source element, you describe the source of rules for a decision,
for example laws, regulations, and guidelines.
Multi instance decision

A multi instance decision is a sub decisions which is executed several times. The result of a multi instance decision is a value or a list that is used as input for another
decision. Read more in section Create a multi instance decision.
Group

Use this element to group diagram elements that belong together.
Text annotation

Use this element to add information to the diagram or a diagram element.
Information requirement

This connector links any input data or decision element to the decision that
requires the information.
Knowledge requirement

This connector links any business knowledge model that must be used by the
decision logic, to the decision.
Authority requirement

This connector links any diagram element that acts as a source of guidance or knowledge to another diagram element.
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You can connect an input data element with a dependent knowledge source or a
knowledge source element with any dependent decision.
Association (undirected)

This connector links text annotations to other DMN elements.
6.3.2.2 Create complex input data elements
If a decision requires numerous input data, you must model many input data elements. You can simplify this by creating a complex input data element in which you
define all input data as attributes.

Example:

To determine a discount, you need data on the purchase value and the customer
status. Instead of creating an input data element for both pieces of information,
you create one complex data input element and configure the purchase value and
the customer status as its attributes. In the decision table, both attributes are
available.

To create a complex input data element, follow these steps:
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1. Select the data input element you want to configure as complex.
2. In the attributes panel, set the value of the attribute Type definition to Complex type.

Example:

3. To add attributes to the data input element, click the

button next to the

Attributes attribute.

The configuration dialog opens.

Example:
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4. Type a name and select a type.
Depending on the type, you can define further properties.
5. Confirm with Save.
The attribute is created.
6. To add more attributes, open the configuration dialog again by clicking the
button.
6.3.2.3 Create a sub decision
When a lot of information has to be considered for a decision, you can outsource
part of the information to sub decisions. This makes the diagram easier to understand as the dependencies and input values are easier to see. The logic of each
decision is also easier to define.

Example DMN diagram without sub decisions:
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Example DMN diagram with sub decisions:

For sub decisions, the decision element is used. To create a sub decision, add a
decision element and connect it with the decision that needs the result of the sub
decision as input.
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6.3.2.4 Create a multi instance decision
Multi instance decisions are sub decisions that provide input for other decisions.
They are similar to a for-loop in a computer program: They iterate decisions and
expressions over a selected list. The list is contained within the input data where
the input data is either a list or a complex input data type.

Example:

Each position of the purchase agreement is validated to determine the validity of
the entire agreement.

To create a multi instance decision, follow these steps:
1. Add a Multi Instance Decision element to your diagram and name it.
2. Add an Input Data element, which represents the list, and name the element.
3. In the attribute panel, define the input data element as a list in the Is list
attribute.

4. Connect the two elements.
To do so, select the multi instance decision element and from its shortcut
menu, drag the connector icon to the input data element.
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Example:

5. To specify the list over which the multi instance decision must iterate, click
in the element.
The configuration dialog opens.
You can also open this dialog via the Iteration attribute in the attribute panel.
6. Select your input data element as the input list.
7. Select the aggregation to specify what will happen with the result of the
multi instance decision.

8. Confirm with Save.
In the multi instance decision, an input data element is added representing
the values of the list.
Don't define this element as a list, otherwise the multi instance decision is
set up incorrectly.
9. Define the internal logic of the multi instance decision.
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To do so, add a decision and place it in the multi instance decision. Connect
the decision with the input data element that is also located in the multi
instance decision.

Example:

Setting up the multi instance decision is complete.
Now, you can link it to the decision that needs the result of the multi
instance decision as input.

Example:

Version 14.9

182

6 Modeling notations

6.3.2.5 Next steps
Define a decision logic
Link DMN elements and diagrams

6.3.3 Define a decision logic
Decision logic specifies the details of a decision. This means you define rules in form
of a decision table or literal expression to describe which combinations of data lead
to certain results. In addition to the rules, you must define what happens when
inputs meet multiple or no rules. This is done by specifying a hit policy.
In this section, the options for defining a decision logic are explained.
To learn how to specify the hit policy and set the completeness requirement, read
more in section Define a hit policy and the completeness requirement.
6.3.3.1 Define a decision table
Decision logic can be presented as a table. A business rule that exists in your company is represented by a decision rule in the decision table. All cells in a table row
form a decision rule.
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Table inputs are specified in columns. Each input has a specific data type. The output column shows the result of the applied business rule. Like the inputs, each output also has a data type.
The decision rule then compares input data with the values in the cells.

Add rules to a decision table

To create decision rules, you must configure input data in the Inputs column and
map them to output data in the Output column.
Any input data modeled on the canvas is already available when you open decision
table. You can add missing input data by defining input columns in the table.
All input data defined via the table is added as input data elements to the canvas
when the table is saved. You also need to define decision rules and map the outputs.
To define input data and add decision rules, follow these steps:
1. Open the decision table. To do so, select the decision to which you want to
add rules and click

.

The decision logic configuration dialog opens.
You can also open this dialog via the Decision logic attribute in the attribute
panel.
2. Configure the input data. To do so, follow these steps:
a. Double-click New Input in the column header, and enter a name for the
input data.
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b. Below the input data name, double-click Text, select the type of the

input data, and define its options. The following data types are available:
o

Enumeration

o

Text

o

Number

o

Boolean

o

Hierarchy

o

Date

3. In the same way, configure the output data in the Outputs column.
4. In the same way, you can configure the Annotations column to add information to the decision rules.

5. Define the first decision rule:
a. Double-click the left area of the first table cell. A list opens.
b. Select an operator to define the relation between the input and the output.

Read more on operators in section Decision table operators.
c. Double-click the right area of the same cell. Again, a list opens.
d. Select or enter an input value.
e. In the Outputs column, double-click the cell and enter an output value.
6. With the buttons at the top of the table, you can add more rules, input data,
output data, and annotations.
7. To define more rules, you have the following options:
o

You can continue defining rules cell by cell as described above.

o

With Add rule > Duplicate rule, you can copy and paste existing rules.

o

With Import/Export > Text Import, you can add text-based decision
rules instead of defining the rules cell by cell. Read more in section
Import decision rules to the decision table.
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8. Select a hit policy for the decision table and specify the completeness requirement.

In case of a multi hit policy, you can also select an aggregation. Read more in
section Define a hit policy and the completeness requirement.
9. With Verify, you can check the logic for completeness and consistency. Below
the table, all combinations of input values are displayed that aren't covered
by a decision rule.
10. Confirm with Apply.

Your decision logic is set up.
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Decision table operators
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Operator
equal

For dates: on

Symbol

Description
Returns true if the
input value equals
the specified value.
Returns true if the

not equal

input value doesn't

For dates: not on

equal the specified
value.
Returns true if the

less

input value is less

For dates: before

than the specified
value.
Returns true if the

less or equal

input value is less

For dates: until

than or equals the
specified value.
Returns true if the

greater

input value is

For dates: after

greater than the
specified value.
Returns true if the

greater or equal

For dates: from

input value is
greater or equal
than the specified
value.
Returns true if the

contains

input value con-

For numbers: included

tains the specified
value.

not contains

Returns true if the

For numbers: not

input value doesn't

included

contain the spe-
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Symbol

Operator

Description
cified value.
Returns true if the
input value begins

begins with

with the specified
value.
Returns true if the
input value ends

ends with

with the specified
value.
Returns true if the
input value is also

element of

in the list of the
decision table.
Returns true if the

not element of

input value isn't in
the list of the
decision table.
Returns true if the
input list contains

elements of
tains only

and con-

and only items the list

in the decision
table contains as
well.
Returns true if the
input list contains

contains any of

at least one item
the list in the
decision table contains.

contains none of
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Operator

Symbol

Description
contain any item
the list in the
decision table contains.
Returns true if the
input value is
defined (not empty)
and valid. For
example, if you only

valid

consider numeric
values equal or
greater than zero,
all numeric values
less than zero and
all non-numeric values aren't valid.
Returns true if the
input value is
defined (not
empty), but invalid.
For example, if you
only consider

not valid

numeric values
equal or greater
than zero, all
numeric values less
than zero and all
non-numeric values
are invalid.
Returns true if the

defined

input value is
defined (not
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Symbol

Operator

Description
empty).
Returns true if the

not defined

input value isn't
defined (empty).

Import decision rules to the decision table

Instead of defining the decision rules cell by cell, you can import text-based
decision rules into the table. The columns still need to be configured as described
above. The individual rules can be in the form of a list, separated by the delimiters
tab, semicolon, or comma.
The import function doesn't overwrite or delete existing rules. Imported rules are
always added.
Text-based rules must have the following structure:
o

Relational operators like = and <= must be part of the field they relate to.

o

For each rule, you need to start a new line.

o

The import only supports the following literal expressions:
o

not(value)

o

not(value1, ..., valueN)

o

!=value

To add text-based decision rules, follow these steps:
1. Open the decision table and click Import/Export > Text Import in the topright corner.

The text import dialog opens.
2. Select a delimiter.
3. Either enter the decision rules or copy them, for example from a text file or
spreadsheet, to the editor field.

4. Click Import.
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The rules are added to the table. You can add more by opening the text import
dialog again.

Example:

6.3.3.2 Define a literal expression
As an alternative to the logic in the decision table, you can define logic via a literal
expression.
If a literal expression is defined, it supersedes the decision logic in the
decision table.
Literal expressions represent predefined logical algorithms or rules that can be used
to automatically create output results for decisions, often but not necessarily in a
formal expression language. You can use literal expressions to add logic that can't
be expressed in the decision table, for example, function calls, interim values, or list
manipulation.
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Literal expressions are written in FEEL, the 'friendly enough expression language'
specified as part of the DMN standard. You can download the specification along
with examples for literal expression use cases at https://www.omg.org/spec/DMN/1.1/.
To define a literal expression, follow these steps:
1. Select a decision and click

.

The decision logic editor opens.
2. Select the Expression tab on the left side and add the literal expression.
3. Confirm with Apply.
Read more about literal expressions in section Using advanced literal expressions
(functions in DMN decision elements).
6.3.3.3 Define an informal expression
If decision logic can't be expressed formally, you can describe it with natural language. The description doesn't have to be formal or executable.
To define an informal expression, follow these steps:
1. Select a decision and click

.

The decision logic editor opens.
2. Select the Informal expression tab on the left side and add the description of
the decision.

3. Select the data type of the decision logic via the Value domain list in the
upper right corner.

4. Confirm with Apply.
6.3.3.4 Next steps
Link the logic of another decision
Reuse decision logic via business knowledge models
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6.3.4 Define a hit policy and the completeness requirement
With the hit policy, you define how your decision table manages inputs that are
handled by several rules and inputs for which no rules are defined. There are two
types:
o

Single hit policies produce one result per input. Here, only one rule is applied
at a time, even if several rules exist.

o

Multi hit policies produce an array of outputs. Here, all applicable rules are considered regardless of their position in the table. The resulting output can be a
list or aggregated to a single value.

With the completeness requirement, you define whether your decision table is only
valid if its rules consider all possible inputs. This means, a table is only valid if the
modeler added rules for all input data. When checking the decision table with
Verify, the completeness is checked as well.
Unique (single) is the default hit policy. Read more in section Hit policy types.
To select another hit policy for a decision table, follow these steps:
1. In a DMN diagram, click

in the decision element.

The decision table opens.
2. Click the letter in the upper left corner.
The configuration dialog opens.

Example:
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3. Select the hit policy. Find details on each hit policy type below.
4. In case of a multi hit policy, select the aggregation:
o

Collect (multiple)

o

Sum

o

Minimum

o

Maximum

o

Count

5. Select the completeness requirement:
o

Complete: A complete decision table is only valid if it considers all possible inputs.

o

Incomplete: An incomplete decision table is valid even if it doesn't consider all possible inputs.

6. Confirm with Save.

Version 14.9

195

6 Modeling notations

The hit policy and completeness is set.
6.3.4.1 Hit policy types
Unique (single)

One input combination is covered by exactly one rule. It's assumed that all inputs
are independent of each other, so any combination is possible. Overlapping rules
are not allowed.
Unique (single) is the default hit policy. In the decision table, it's indicated with the
letter U.

Example:
Depending on the current season, a retailer decides which product group to offer
at a reduced price. Only one product group can be offered, since only one season
exists at the same time.
Input

Output

Season

Product group

Spring

garden equipment

Summer beverages
Autumn

clothes

Winter

food

Any (single)

Multiple rules cover the same combination of input values. This overlap is only
allowed if the rules also lead to the same result.
In the decision table, this hit policy is indicated with the letter A.

Example:

If a credit applicant is younger than 18 years old and is already in debt, the
application is rejected. Otherwise the credit applicant gets a credit.
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Input

Output

Age

Debt Result

< 18

yes

rejected

-

no

approved

>= 18 -

approved

Priority (single)

Multiple rules can apply for one input value. The results are ordered according to
their priority. The result with the highest priority is returned.
In the decision table, this hit policy is indicated with the letter P.

Example:

In a decision table, the logic determines at what age customers get certain discount vouchers. Customers aged 18 or over get vouchers for sports equipment,
and all customers older than 3 vouchers for toys. Both rules apply to a 30-yearold customer. As the sports equipment has a higher priority, the customer gets a
voucher for this. Consequently, the output list is [sports equipment, toys,
clothing].

Input Output
Age

Voucher for

> 18

Sports equipment

>3

Toys

-

Clothing

First (single)

Overlapping rules are allowed, but only the first applicable rule is used. As the rules
are evaluated from top to bottom, you must sort the rules in the table.
In the decision table, this hit policy is indicated with the letter F.

Example:
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In a decision table, the logic determines at what age customers get certain discount vouchers. Customers aged 18 or over get vouchers for clothing, and all customers older than 3 vouchers for sports equipment. Both rules apply to a 30year-old customer. As the rule for 18-year-old customers is at the top of the
decision table, this rule serves as the basis for the decision. The customer
receives a voucher for clothing.
Input Output
Age

Voucher for

> 18

Clothing

>3

Sports equipment

-

Toys

Collect (multiple)

By default, the collect hit policy collects the outputs of matching rules, but can be
configured to determine the sum, minimum, maximum, or count of matching outputs instead.
In the decision table, this hit policy is indicated with the letter C.

Example:

An online shop adds a discount coupon to specific orders. The discount depends
on the total sum of an order. In the decision table below, the outcome differs
depending on the aggregation set for the hit policy. Given a 250$ purchase
order, the following applies:
o

Without aggregation set, the hit policy returns two coupons (5% and 25%
discount) in no particular order.

o

With aggregation set to sum, the hit policy returns one coupon with 30%
discount.

o

With aggregation set to maximum, the hit policy returns one coupon with
25% discount.
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o

With aggregation set to minimum, the hit policy returns one coupon with
0% discount and disappoints the customer in this scenario.

o

With aggregation set to count, the hit policy returns 2, which doesn't
provide any relevant information in this scenario.

Input

Output

Total order sum Discount coupon
<= 50$

0%

> 50$

5%

> 200$

25%

Output order (multiple)

Results are ordered by the priority of the output values.
In the decision table, this hit policy is indicated with the letter O.

Example:

An online shop adds small gifts to orders. The gifts a customer receives depend
on the total order sum. If the order sum is 50$ or lower, the customer receives a
discount coupon. If the order sum exceeds 50$, the customer receives a small
pack of high-quality coffee in addition to the coupon.
With an output order hit policy, for the total order sum of 250$ the table below
will return the result [Coffee, Discount coupon], sorted according to the
order of the specified output list.
Input

Output

Total order sum Gift = [Coffee, Discount coupon]
-

Discount coupon

> 50$

Coffee
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Rule order (multiple)

Results are ordered by the order of matching rules.
In the decision table, this hit policy is indicated with the letter R.

Example:

An online shop adds small gifts to orders. The gifts a customer receives depend
on the total order sum. If the order sum is 50$ or lower, the customer receives a
discount coupon. If the order sum exceeds 50$, the customer receives a small
pack of high-quality coffee in addition to the coupon.
When applying a rule order hit policy, an input of 250$ will return the result
[Discount coupon, Coffee],

sorted according to the order of the applying

rules.
Input

Output

Total order sum Gift = [Coffee, Discount coupon]
-

Discount coupon

> 50$

Coffee

6.3.4.2 Next steps
Define a decision logic
DMN simulation

6.3.5 Using advanced literal expressions (functions in DMN decision
elements)
In case you have modeled your first DMN diagram, you are already familiar with
DMN expressions for decision logic, e.g. in the form of a simple smaller than statement. These expressions are explained in the chapter Model a decision.
You might remember that you selected the corresponding operator from a dropdown list in the Decision Table Editor.
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In many cases, these basic operators are not sufficient.
A simple example is determining a discount based on the total value of a list of purchased objects.
To determine the sum, we need to use Signavio's advanced literal expressions. The
expressions are based on FEEL, the friendly enough expression language specified
as part of the DMN standard, which you can download as PDF at
http://www.omg.org/spec/DMN/1.0/PDF .
The single commands can be used in combination, like in the following example:
Product((1 - DiscountRate) * Sum(ListOfItemPrices))

In the example, we calculate the total purchase sum of a list of items, considering a
discount. The variables used here correspond to the data types defined in Input
Data element's attributes and can be set when simulating the DMN diagram.
The documentation of all available expressions can be found at Documentation of
all literal expressions .
Of course, you can also use standard operators ( +, -, *, /, and, or) within literal
expressions.
Consequently, the example above can be expressed more concisely:
(1 - DiscountRate) * Sum(ListOfItemPrices)

Version 14.9

201

6 Modeling notations

6.3.5.1 Using literal expressions in Decision Tables
In our example, we want to determine - as already mentioned above - a discount
based on the total value of all purchased items.
First, create the Purchased items Data Input element. The input should be a list of
numbers of the type currency.
Now create a Decision, connect it to the data input and label it Determine discount.
Click the table icon in the upper left corner of the Decision element to open the
Decision Table Editor.

Create a Decision, reference the Data Input element and open the decision table editor.

To activate the literal expression input, click the header and delete the input reference in the table:

Delete the input reference to be able to insert a literal expression.

Type in =. An overview over available variables and functions is displayed:
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After inserting an initial '=' sign, available variables and functions are displayed.
Suggestions appear as you type. Type in Sum and select the Sum function. Then,
insert the variable PurchasedItems as a parameter of Sum:

Insert the literal expression 'Sum(PurchasedItems)'.
Now, the decision logic's Input Data is the sum of all purchased items. You can
define the decision logic as usual.
Mind the first hit policy in our example:
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Decision logic for determining a discount based on the total sum of purchased items
6.3.5.2 Using literal expressions instead of Decision Tables
You can also use literal expressions instead of Decision Tables.
For example, you can split a decision into two daisy-chained elements, one with a
decision table and another one with literal expression logic.

'Calculate total sum' and 'Determine discount' as two separate Decision elements.
o
o

The first element calculates the total sum of purchased items.
The second element determines the discount based on the total sum.

We can model the first decision without using a decision table.
Open the decision table editor and switch to the Literal expressions tab. There,
insert the literal expression to calculate the sum of items:
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Open the 'Literal expression tab' and insert the literal expression.
Now, the decision element returns the sum of items as a Data Output and can be
referenced by the following Decision element.
If we create complex literal expressions, we can define variables - so called boxed
contexts and reference them in our decision function:

Manage complex expressions with boxed contexts.
This improves the readability of our literal expressions.
If a literal expression is defined, it supersedes the decision logic in the
decision table.
6.3.5.3 Documentation of all literal expressions
This section lists all available literal expressions, grouped by operation type.
Arithmetic operations
Abs
Abs(number):NUMERIC

Returns the absolute value of a number.
Example: Abs(-5) returns 5.
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Count
Count([num1 ,num2, num3]):NUMERIC

Returns the number of elements of the given list.
Example: Count(["item1", "item2", "item3"]) returns 3.
Round
Round(number,digits):NUMERIC

Returns a number rounded to the corresponding number of digits.
Example: Round(3.44,1) returns 3.4.
Ceiling
Ceiling(number):NUMERIC

Returns a number rounded up to the next integer.
Example: Ceiling(1.3) returns 2.
Floor
Floor(number):NUMERIC

Returns a number rounded down to the next integer.
Example: Floor(1.6) returns 1.
Integer
Integer(number): NUMERIC

Returns the integer part of a number.
Example: Integer(1.34) returns 1.
Modulo
Modulo(divident, divisor):NUMERIC

Returns the remainder of the divident divided by the divisor.
Example: Modulo(4, 3) returns 1.
Percent
Percent(number):NUMERIC

Returns the number divided by 100.
Example: Percent(10) returns 0.1.
Power
Power(base, exponent):NUMERIC

Returns the base raised to the power of the exponent.
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Example: Power(2, 3) returns 8.
Product
Product([factor1, factor2, factor3]):NUMERIC

Returns the product of a list of factors.
Example: Product([2, 3, 4]) returns 24.
RoundDown
RoundDown(number, digits):NUMERIC

Returns a number rounded down to the corresponding number of digits.
Example: RoundDown(1.3674, 2) returns 1.36.
RoundUp
RoundUp(number, digits):NUMERIC

Returns a number rounded up to the corresponding number of digits.
Example: Abs(1.344, 2) returns 1.35.
Sum
Sum([number1, number2, number3]):NUMERIC

Returns the sum of a list of values.
Example: Sum([1, 2, 3, 4, 5]) returns 15.
Date & time operations
Day
Day(datetime):NUMERIC

Returns the day part of a datetime.
Example: Day(2015-12-24T12:15:00.000+01:00) returns 24.
DayAdd
DayAdd(datetime, days to add):DATE

Returns the date plus the provided number of days.
Example: DayAdd(2015-12-24T12:15:00.000+01:00, 1) returns 2015-1225T12:15:00.000+01:00.
DayDiff
DayDiff(datetime1, datetime2):NUMERIC

Returns the amount of full days between two dates.

Version 14.9

207

6 Modeling notations

Example: DayDiff(2015-12-24T12:15:00.000+01:00, 2015-1225T12:15:00.000+01:00)

returns 1.

Date
Date(year, month, day):DATE

Returns a date using the standard parameters of a date: year, month, day
Example: Date(2015, 12, 25) returns 2015-12-25.
DateTime
DateTime(day, month, year, hour, minute, second, hourOffsett):DATE

Returns the dateTime using the standard parameters of a data time. The last parameter 'hourOffset' is optional.
Example: DateTime(25, 12, 2015, 12, 15, 0, 1) returns 2015-1224T12:15:00.000+01:00.
Hour
Hour(datetime):NUMERIC

Returns the hour part of a datetime.
Example: Hour(2015-12-24T12:15:00.000+01:00) returns 12.
HourDiff
Hour(time):NUMERIC

Returns the amount of full hours between two dates.
Example: HourDiff(2015-12-24T12:15:00.000+01:00, 2015-1224T14:15:00.000+01:00)

returns 2.

Minute
Minute(time):NUMERIC

Returns the minute part of a datetime.
Example: Minute(2015-12-24T12:15:00.000+01:00) returns 15.
MinutesDiff
MinutesDiff(datetimes1, date2times):NUMERIC

Returns the amount of full minutes between two dates.
Example: MinutesDiff(2015-12-24T12:15:00.000+01:00, 2015-1224T13:15:00.000+01:00)
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Month
Month(datetime):NUMERIC

Returns the month part of a datetime.
Example: Month(2015-12-24T12:15:00.000+01:00) returns 12.
MonthAdd
MonthAdd(datetime, months_to_add):DATE

Returns the datetime plus the number of months.
Example: MonthAdd(2015-10-10T12:15:00.000+01:00, 1) returns 2015-1110T12:15:00.000+01:00.
MonthDiff
MonthDiff(datetime1, datetime2):NUMERIC

Returns the amount of full months between two dates.
Example: MonthDiff(2015-10-10T12:15:00.000+01:00, 2015-1110T12:15:00.000+01:00)

returns 1.

Now
Now():DATE

Returns current datetime.
Example: Now() could have returned 2015-11-10T12:15:00.000+01:00.
Today
Today():DATE

Returns the current date.
Example : Today() could have returned 2015-11-10.
Weekday
Weekday(datetime):NUMERIC

Returns a number (1 to 7) representing the day of the week.
Example: weekday(2016-02-09T12:15:00.000+01:00) returns 3.
Year
Year(datetime):NUMERIC

Returns the year part of a datetime.
Example: Year(2016-02-09T12:15:00.000+01:00) returns 2016.
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YearAdd
YearAdd(datetime, years_to_add):DATE

Returns the datetime plus the number of years.
Example: YearAdd(2016-02-09T12:15:00.000+01:00, 1) returns 2017-0209T12:15:00.000+01:00.
YearDiff
YearDiff(datetime1, datetime2):NUMERIC

Returns the amount of full years between two dates.
Example: YearDiff(2016-02-09T12:15:00.000+01:00, 2017-0209T12:15:00.000+01:00)

returns 1.

List operations
Append
Append(list, element): LIST

Adds the element to a copy of the provided list. Returns the manipulated copy.
Example : Append([2.5, 5.8, 4.3], 6.7) returns [2.5, 5.8, 4.3, 6.7].
AppendAll
AppendAll(list1, list2): LIST

Adds all elements from the second provided list to a copy of the first one. Returns
the manipulated copy.
Example: AppendAll([2.5, 5.8, 4.3], [2.1, 3.5, 7.4]) returns [2.5, 5.8,
4.3, 2.1, 3.5, 7.4].
Zip
Zip(attributes, values1, ..., valuesN): LIST

Assembles a list of objects out of a list of attributes and multiple lists of values. :
Zip(["id", "value"], [23a3e98, c45da1b], [40, 120])

returns [{id:

23a3e98, value: 40},{ id: c45da1b, value: 120}].

Before version 10.11.0 of the Decision Manager, the values were passed
to the function as a list of lists, for example:
Zip(["id", "value"], [[23a3e98, c45da1b], [40, 120]])

Literal expressions that used the old Zip function have been automatically transformed to the new syntax.
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NotContainsAny
NotContainsAny(list1, list2): BOOLEAN

Determines whether list1 contains any element of list2.
Example : NotContainsAny(["item1", "item2"], ["item2", "item3"]) returns
false.
ContainsOnly
ContainsOnly(list1, list2): BOOLEAN

Determines whether list1 contains only elements of list2.
Example: ContainsOnly(["item1", "item2"], ["item2", "item3"]) returns
false.
AreElementsOf
AreElementsOf(list1, list2): BOOLEAN

Determines whether list2 contains all elements of list1.
Example: AreElementsOf(["item2, item3"], ["item1", "item2", "item3"])
returns true.
Remove

This expression is available only in the Literal Expressions Editor (not in the
Decision Table Editor).
Remove(list, element): LIST

Removes the specified element from the specified list.
Example: Remove(["item1", "item2"], "item1") returns ["item2"].
RemoveAll

This expression is available only in the Literal Expressions Editor (not in the
Decision Table Editor).
RemoveAll(list1, list2): LIST

Removes all elements of list2 from list1.
Example: Remove(["item1", "item2", "item3"], ["item1", "item2"]) returns
["item3"].
Statistical operations
Avg
Avg([number1, number2, number3]):NUMERIC

Returns the average of the values of the given list.
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Example: Avg([3,5]) returns 4.
Max
Max([number1, number2, number3]):NUMERIC

Returns the maximum value of the given list.
Example: Max([5, 4, 10]) returns 10.
Median
Median([number1, number2, number3]):NUMERIC

Returns the median value of the given list.
Example: Median([2, 5, 10, 12, 34, 35]) returns 11.
Min
Min([number1, number2, number3]):NUMERIC

Returns the minimum value of the given list.
Example : Min([5, 4, 10]) returns 4.
Mode
Mode([number1, number2, number3]):NUMERIC

Returns the most frequently occurring value of the given list. Returns the first
(most left) most frequent value, if several values occur most frequently (e.g. two values appear each two times).
Example: Mode([1, 2, 4, 4, 5, 6]) returns 4.
Text handling
Concat
Concat([text1, text2, text3]):TEXT

Returns the concatenation of the given list of text values.
Example: Concat(["Hello ", "World", "!"]) returns "Hello World!".
IsAlpha
IsAlpha(text):BOOLEAN

Determines whether the text contains only alphabetic characters (A-Z, a-z).
Umlauts and similar characters (e.g.Ä, Å ß) must not be included.
Example: IsAlpha("abcdefg5") returns false.
IsAlphanumeric
IsAlphanumeric(text):BOOLEAN
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Determines whether the text contains only alphanumeric characters (A-Z, a-z, 09). Umlauts and similar characters (e.g. Ä, Å ß) must not be included.
Example: isAlphanumeric("abcdefg5") returns true.
IsNumeric
IsNumeric(text):BOOLEAN

Determines whether the text is a valid number containing only plus or minus sign,
digits, commas, and decimal points.
Example: IsNumeric("2.3.5") returns false
IsSpaces
IsSpaces(text):BOOLEAN

Determines whether the text contains only spaces.
Example: IsSpaces(" ") returns true.
Len
Len(text):NUMERIC

Returns the number of characters in a text string.
Example : Len("five") returns 4.
Lower
Lower(text):TEXT

Returns the text string with all letters converted to lowercase.
Example: Lower("UPPER") returns upper.
Trim
Trim(text):TEXT

Returns the text string with all spaces removed except single spaces between
words.
Example: Trim("Hello World! ") returns "Hello World!".
Upper
Upper(text):TEXT

Returns the text string with all letters converted to uppercase.
Example: Upper("lower") returns "LOWER".
Number
Number(text):NUMERIC
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Returns the numerical value represented in the text string. Only a period (.) is
allowed as a separator.
Example: Number("5") returns 5.
Number
Number(text, default_value):NUMERIC

Returns the numerical value represented in the text string. Only a period (.) is
allowed as a separator. Returns default_value if unable to convert text into number.
Example: Number("5,5", 10) returns 10 (Number("5.5", 10) returns 5.5).
Mid
Mid(text, start, num_chars):TEXT

Returns the character sequence of the length num_chars from the corresponding
starting position of a text string.
Example: Mid("Hello World!", 6, 5) returns "World".
Left
Left(text, num_chars):TEXT

Returns the character sequence of the length num_chars from the start of a text
string.
Example: Left("Hello World!", 5) returns "Hello".
Right
Right(text, num_chars):TEXT

Returns the character sequence of the length num_chars from the end of a text
string.
Example: Right("Hello World!", 7) returns "World!".
Text
Text(num, format_text):TEXT

Returns a numeric value as a text string in a specific format. The format is specified
by the placeholders # and 0 and a decimal point ..
Example: Text(1, "#.000") returns "1.000".
TextOccurrences
TextOccurrences(find_text, within_text):NUMERIC

Returns the number of occurrences of find_text within within_text.
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Example: TextOccurrences("can", "Can you can a can as a canner can can a
can?")

returns 6.

Contains
Contains(text, substring): BOOLEAN

Determines whether text contains the substring.
Example: Contains("Hello World!", "o World") returns true.
StartsWith
StartsWith(text, prefix): BOOLEAN

Determines whether text starts with the prefix.
Example: StartsWith("Hello World!", "Hello") returns true.
EndsWith
EndsWith(text, suffix): BOOLEAN

Determines whether text ends with the suffix.
Example: endsWith("Hello World!", "!") returns true.
Logical operators
Not
Not(boolean): BOOLEAN

Negates the input boolean.
Example: Not(true) returns false.

6.3.6 Link DMN elements and diagrams
6.3.6.1 Link a DMN diagram to a BPMN diagram
You can link DMN and BPMN diagrams so that processes can be viewed separately
from decisions, with the advantage that the process is streamlined and the
decision is traceable.
Follow these steps:
1. Open your BPMN diagram and select the task to which you want to link the
decision diagram.

2. In the attribute panel, set the Task type attribute to Business rule.
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3. In the task element, click

.

The configuration dialog to create a link opens.
You can also open this dialog via the Decision reference attribute in the attribute panel.
4. You can either create a new DMN diagram or link an existing one.
5. Confirm with Link diagram.
The DMN diagram is linked. To open a preview of it, click

in the business

rule task again.
Once the BPMN process is published to Collaboration Hub, users can open the
decision diagram in via the BPMN process. With Run decision, they can then add
data to the rules defined in the decision diagram and determine the result of the
decision. For more on simulation, read DMN simulation.
6.3.6.2 Link the logic of another decision
Instead of adding decision rules to a decision of a DMN diagram, you can integrate
the decision logic from another DMN diagram.
To link a decision of another DMN diagram, follow these steps:
1. Open the decision table and click Link on the left side of the dialog.
The configuration dialog to create a link opens.
2. Navigate to the DMN diagram and select the decision you want to link.
3. Confirm with Link diagram.
The decision of the DMN diagram is linked.
In an older version of the decision logic editor, you were able to link a
diagram without selecting a decision. Such a link is incomplete and can't
be read out by the simulation and test lab features. If you find such a
link, always edit it so that it links the decision.
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6.3.6.3 Reuse decision logic via business knowledge models
If you want to run a decision multiple times with different data input, you can link it
to a business knowledge model. If you then link the business knowledge model to
other decisions, they can reuse the logic of the linked decision. This is called a
boxed invocation.
Boxed invocations provide decision logic and input type information as a generic
function, whereas decisions directly linked to other decisions provide not only the
input data types, but the specific input data objects.
In the following example, an insurance premium is calculated based on the applicant's and their spouse's risk level. For each person, the same decision logic determines a different risk level. A link via a business knowledge model allows calling the
linked decision model with different data inputs. In contrast, a direct link to a
decision diagram will fail to distinguish between the two data sources.

To link a decision to a business knowledge model, click

in the business know-

ledge model and select the decision you want to link from the configuration dialog.
To reuse the logic of the decision linked to the business knowledge model, follow
these steps:
1. Open the decision table and select the Invocation tab on the left side.
2. Map the linked and the invoked decision's input data.
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3. Confirm with Apply.
The boxed invocation is set up.
You can find more information on boxed invocation in the DMN specification at
https://www.omg.org/spec/DMN/1.1/.
6.3.6.4 Next steps
Define a decision logic
Set BPMN attributes
Comparing DMN diagrams and revisions

6.3.7 The DMN Test lab
The DMN Test lab enables you to define and run test cases in order to check
whether a DMN diagram fulfills certain requirements.
This is helpful in order to ensure that diagrams are still consistent with initial
decision logic after being extended or to control the correctness of specific input
combinations and outputs in complex diagrams.

The DMN Test lab

To open the Test lab, select the diagram you want to test in the Explorer and click
Edit, then Test DMN diagram in the top drop-down menu:
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Alternatively, you can open the DMN diagram in the Editor and switch to the Test
lab via the drop-down menu in the upper right corner and vice versa:

Switch from the Editor to the DMN Test lab.
6.3.7.1 Creating test cases
In order to create a new test case, proceed as follows:
o

Create a new test case by clicking the '#' sign left of the test cases table:

Create a new test case
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o

Click one of the test case's columns to define all its values. A drop-down dialog
opens and you can enter the necessary information. Then, click Apply:

Specify the input data of your test case.
o

Now, click the column that shows the calculated value in red in the Result
column on the right and specify the expected output value(s):

Specify the expected output value(s)

After you have created all necessary cases, you can save them by clicking the Save
button.
To delete a test case, it must be saved first. Simply click onto the number of the saved test case(s) you would like to remove, then click Save.
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Delete a test case.

Each test case is automatically executed as soon as a parameter is changed.
In the following simple case, we want to determine a discount. The only input parameter here is the purchase value. In the first test case, no value is given for the
expected result as indicated by the red X on the left in the result column. In the
second case, the actual discount corresponds with the expected result as indicated
by the green check mark icon. In the third case. the expected result is different
from the actual result, as indicated, again, by the red X.

Undefined, passing and failing test cases

6.3.7.2 Inspecting test cases in the simulation tool
Often, you want to find out why a test case is producing a certain output. With the
DMN simulation you can inspect a decision's behavior, for example to see exactly
which rules fire for your input data set. To open the simulation tool, select a test
case and click Inspect in Simulation:
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Open a test case in the simulation tool.

Then, the simulation tool applies the input data of your test case automatically.
6.3.7.3 Importing and exporting test cases
You need to save test cases in order to be able to export them.
It is possible to export and import test cases as JSON (JavaScript Object Notation)
files. This enables you to keep the test cases when transferring diagrams between
Signavio workspaces. To be able to import or export test cases, all cases that were
created before must be saved first. In order to export test cases for a diagram, open
the Test lab and click the Export button in the test management interface:

A .json file containing the test cases will be downloaded.
For importing test cases click the Import button in the test management interface:

Now, select the .json file you want to import and click Open.

6.3.8 DMN simulation
The decision management extension of Signavio Process Editor allows you to
model, manage and better understand complex business decisions. In the DMN simulation tool, you can simulate business decisions by applying data to the rules that
are defined in a decision diagram. The simulation tool helps you to understand
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dependencies between sub-decisions and to identify scenarios for which no rules
have been established. Thus, this tool is a powerful addition to your Business
Decision Management initiative and makes business decisions and decision logic
understandable for everyone.
The DMN Simulation is also available as an additional feature in the Collaboration Hub.
To open the DMN simulation tool, select the diagram in the Explorer and click Edit Simulate DMN diagram:

Open the DMN simulation tool from the Explorer.
Alternatively, you can open the diagram in the Editor and use the dropdown menu
in the upper right corner to switch from the Graphical Editor to the Simulation
tool:

Switch from the Editor to the DMN simulation tool.
Now, you can start using the simulation tool.
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Simulate business decisions.
Select a decision in the diagram, either by clicking on it or by using the dropdown
menu in the top right corner. Then, scroll to the Inputs section and fill in the data
of your simulation scenario. The Outputs section shows the decision output as computed by the simulation tool. The Wildcard mode toggle affects the evaluation
semantics. Wildcard mode turned on means that empty input values are replaced
with wildcards, which will, for example, match all conditions in decision tables.
When turned off, empty input values will remain undefined during evaluation.
If the Wildcard mode is activated and one or multiple input parameters
are not defined, the simulation tool will determine the set of possible
output values. This is helpful, for example, if in specific application scenarios some input values remain unknown.
The progress bars in the decision elements indicates the extent to which data
inputs are defined so far. When scrolling down, you can see a decision table overview that highlights the rules that apply in the current scenario:
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The rules that apply to the provided input data are highlighted in green.

6.3.9 Comparing DMN diagrams and revisions
The Signavio diagram comparison tool allows you to easily compare two diagrams,
as well as different revisions of one diagram. In the revision comparison, details
about all changes in a diagram over time are documented.
To open the comparison tool, select a diagram (or, in case you want to compare two
different diagrams and not revisions: two diagrams) and click Edit, then Compare
revisions/diagrams in the top drop-down menu of the Signavio Explorer.

Click 'Edit' - 'Compare revisions/diagrams'.
The diagram comparison view appears. The drop-down menu allows you to switch
between diagram revisions:
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The diagram comparison.
In case you would like to load a different diagram for comparison, click Choose revisions/diagrams in the upper right corner of the tool, will be able to select both diagrams to be compared in the dialog that opens:

Click 'Choose revisions/diagrams'.
Clicking the pen icon of a changed element gives you detailed information about
the adjusted element properties.
To narrow down the changes, you can deactivate one or multiple check boxes in the
panel below the canvas and exclude changes made to attributes or to specific element types:

Deactivate a check box to exclude changes made to attributes or to specific element types.
To learn more about the basic usage of the diagram and revision comparison tool,
please read the chapter Comparing revisions. The following section explains how to
extract DMN-specific information from the comparison tool.
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6.3.9.1 Comparing Data Inputs
To view the changes made to a Data Input element, select the element to see the
exact changes. In our example, a Data Input element of the type Enumeration was
replaced by a Decision element:

Clicking the pen icon displays the adjusted element properties in detail.
6.3.9.2 Comparing Decision Tables
To view the changes made to a Decision Table, select the element to access an overview of the changes.
Then, click the compare link to compare the tables:

Click the 'compare' link...
In the tables, all changes are highlighted:
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...and open the decision table comparison.

6.4 Value chains
With value chains, you can create high-level perspectives on your process landscape.
Each modeling element in a value chain represents a process or process group of a
specific business unit. You can link the elements in chronological order and show
the hierarchical relationships between processes and process groups.
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For value chains, no official specification or set of syntax rules exist. To keep value
chains simple and easy to read, you can link the elements of a value chain to other
process models.
In this section, the diagram elements and editing functions that are only available
for this notation are described.
For general creation and editing options that are available for all notations, read
more in section Modeling.

6.4.1 Available diagram elements
6.4.1.1 Process
The process element represents a business process within your organization.
6.4.1.2 Collapsed process
The collapsed process element represents a business process that is linked to
another process diagram.
You can create links to the following diagram types:
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o

value chain diagrams

o

BPMN diagrams

o

event-driven process chains

o

customer journey maps

To link the collapsed process element with a new or existing process, click the +
symbol in the element.
6.4.1.3 Group
Use this element to group processes that belong together.
6.4.1.4 Process link
Use this element to create a hierarchy of process elements and process group elements.
6.4.1.5 Text note
Use the text note to add information to the diagram or a diagram element.
6.4.1.6 Association
Use the association to connect a text note to any diagram element.

6.4.2 Additional editing options
6.4.2.1 Change element orientation
To change the orientation of a process element or collapsed process element, select
it and click

at the bottom. You have the following options:

o

Left to right

o

Right to left

o

Top down

o

Bottom up

o

Rectangle
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6.4.2.2 Rotate text
To rotate text in a diagram element, select the element and in the attribute panel,
choose a rotation value for the Text direction attribute.
6.4.2.3 Add Live Insights
You can add Live Insights shapes to display the result of a Process Intelligence
investigation in a value chain. Read more in section Add Live Insights.

6.5 ArchiMate
This feature is available in the Enterprise Edition.
In Process Manager, you can model enterprise architecture diagrams in the
ArchiMate notation, an open enterprise architecture modeling language for describing, analyzing, and visualizing enterprise architectures within and across business
domains.

An ArchiMate 3.0 diagram in the Editor.
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6.6 ArchiMate
This feature is available in the Enterprise Edition.
In Process Manager, you can model enterprise architecture diagrams in the
ArchiMate notation, an open enterprise architecture modeling language for describing, analyzing, and visualizing enterprise architectures within and across business
domains.

An ArchiMate 3.0 diagram in the Editor.

6.6.1 What is ArchiMate?
This feature is available in the Enterprise Edition.
ArchiMate is an open enterprise architecture modeling language for describing and
visualizing enterprise architectures within and across business domains.
Developing enterprise architecture descriptions enables you to base requirements
and stakeholder concerns regarding your IT and business systems on formal and uniform models.
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ArchiMate is a lightweight but comprehensive language that enables you to define
the architecture of your business and IT systems using a service oriented view
model. It allows you to see your process architectures over time. This is helpful in
many areas, such as transformation and migration planning.
The complete ArchiMate specification can be found here:
http://pubs.opengroup.org/architecture/archimate3-doc/

An example of an ArchiMate enterprise architecture diagram
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6.6.2 Creating and editing ArchiMate diagrams
This feature is available in the Enterprise Edition.
To create an ArchiMate diagram, open the Explorer and click New > ArchiMate 3.0.
Your browser will open a new tab with the ArchiMate diagram canvas.
You can switch between different ArchiMate element sub sets using the drop-down
menu in the shape repository. You can drag and drop elements onto the canvas. You
can also use the interactive context menu to add more elements.
To save the diagram, click

in the toolbar.

More detailed instructions on how to edit diagrams can be easily derived from the
section BPMN modeling .
6.6.2.1 Linking ArchiMate to BPMN diagrams
You can easily link BPMN diagrams to ArchiMate's Business Process objects.
Once you have created the business process object in ArchiMate, select the element and click the attribute Business process reference in the attribute panel.
Alternatively, you can click

in the upper right corner of the Business Process

object.
Now, a dialog opens from which you can either create a new diagram or link an
existing one:
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Link a BPMN diagram to an ArchiMate 'Business Process' object

6.6.2.2 Using the dictionary with the ArchiMate Editor
Within the ArchiMate Editor it's easy to make use of the dictionary, see Working
with the Dictionary for details.
The dictionary is modeling language-independent, meaning you can access entries
you created from BPMN diagrams in ArchiMate and vice versa.

6.7 Case Management Model and Notation (CMMN)
The Signavio Support Team (support@signavio.com) can activate Signavio Process Manager’s CMMN support on request.
CMMN is a relatively new notation, first published in 2014, that was created to
allow more flexibility in the business process landscape. Signavio supports CMMN
version 1.1.
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6.7.1 About CMMN
In a business process that has variation, it may be more efficient for a case worker
to determine the sequence in which to perform a set of tasks. For example, a hotel
guest may always go through the same process when checking in and checking out,
while the regularly tasks to clean the room may vary from day to day.

A CMMN model for maintaining a hotel room

In general, many BPM scenarios include actions that may diverge from the common
sequence flow, within a framework of set tasks. CMMN supports the flexibility of
these workflows. The notation is designed for scenarios when a case worker can
decide in what order tasks or sequence flows shall be performed. A CMMN sequence
flow may be triggered by an event (event listener), a state (milestone) or with an
action (task).

6.7.2 CMMN in Signavio Process Manager
In Signavio Process Manager, you can model the standard framework of the corresponding process in a BPMN diagram and then link a BPMN sub-process to a
CMMN diagram that defines flexible sequences. You can also change a task in a
BPMN diagram to a sub-process that links to a CMMN model, to define a number of
flexible actions more accurately.
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You can seamlessly integrata CMMN into BPMN and DMN-diagrams, to complement your existing process landscape. CMMN allows you to more accurately
model highly variable processes, such as working with patient files or managing customer support processes.

6.7.3 Creating and editing CMMN diagrams
You can create CMMN diagrams in the Signavio Explorer like any other diagram and
edit them in the Editor. This chapter explains the CMMN Elements and their alignment options on the modeling canvas. See Modeling to learn about modeling diagrams with the Editor.
6.7.3.1 Creating a CMMN diagram
To create a new CMMN diagram in the explorer, click New > Case Management Diagram (CMMN 1.1). The Editor opens with a blank modeling canvas, ready for you to
edit the diagram.
Starting with a blank canvas in the Editor, you can add elements from the Shape
Repository.
6.7.3.2 Case plan items
You can use the following elements from the shape repository to model your CMMN
diagram.
Case plan model

The case plan model contains the case model. The case plan model encloses the
whole diagram. You can place the element first and resize it with the growing diagram by dragging its lower right corner, or you can model the case and place the
case file element when you have finished adding and connecting the other diagram
elements.
To label the file, enter a name into the ‘naming slip’ at the top left of the element.
You can also attach an exit criterion to the case plan model to indicate that the
incoming sequence flow ends and completes the case.
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A CMMN diagram, enclosed in a ‘case plan model’
Task

Tasks are the central elements in CMMN and BPMN notations. A task models a
single action that needs to be performed. In addition to the ordinary task, there are
five different types of task elements in CMMN:
1. Non-blocking human task
2. Blocking human task
3. Process task
4. Decision task
5. Case task
The model can depict each task as an ordinary task element or as a discretionary
task, which is not obligatory and may be performed at the case worker’s discretion.
o

A non-blocking human task does not stop the sequence flow. In the case model,
the task does not take any time to perform. The task is complete at the same
moment it starts, and the sequence flow continues unstopped. All other tasks
are ‘blocking’ by default.
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A ‘non-blocking human task’
o

A blocking human task stops the sequence flow until it is completed.

A ‘blocking human task’
o

A process task links to a BPMN diagram. To link a diagram, click the symbol in
the upper left corner of the element. To learn more, see Integrating CMMN diagrams .

A ‘process task’
o

A decision task links to a DMN diagram. To link a diagram, click the symbol in
the upper left corner of the element. To learn more, see Integrating CMMN diagrams.
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A ‘decision task’
o

A case task links to another CMMN diagram. To link a diagram, click the symbol
in the upper left corner of the element. To learn more, see Integrating CMMN
diagrams.

A ‘case task’
Discretionary task

Every task type mentioned above also exists as discretionary task in the CMMN 1.1
definition. This means that the case worker may decide whether to perform the
task for that case.
In Process Manager, you can create a discretionary task by creating an ordinary
task of the necessary type, for example a non-blocking human task and defining it
as discretionary. Select the corresponding task and open the Attributes panel on
the right. Click the Discretionary attribute and activate the checkbox.
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When checking the box, the ordinary task transforms into a discretionary task.
Stage

Stages divide cases into subdivisions. You can group sequence flows, tasks and/or
(sub-)stages into a stage.
o

You can also define a stage as a discretionary stage. Select the corresponding
stage and open the Attributes panel on the right. Click the discretionary attribute and activate the checkbox.

o

o

An expanded stage can contain sequence flows of tasks and/or (sub-)stages. You
can change a stage’s size by dragging its bottom-right corner.
A collapsed stage is linked to another CMMN diagram. In contrast to tasks, collapsed stages’ linked diagrams may also just contain single sequence flows that
do not define a whole case.

An expanded stage.
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A collapsed stage is linked to the ‘Procure parts’ BPMN diagram.
Milestone

Milestones are sub-goals within the process model. They indicate that a certain
point or stage within a case has been reached or completed.

A milestone element
Sentries

You can attach the diamond shaped entry criterion and exit criterion symbol (called
‘sentries’) to any task, milestone, stage or case file. There, they define dependencies or the direction of the sequence flow. Sentries do not need to be attached to
other elements - they may also stand alone within a sequence flow.
o

The entry criterion indicates that the incoming sequence flow(s) directly
attached to the sentry is/are necessary to be finished before the sequence flow

o

can continue.
The exit criterion indicates when a plan item is complete and in what direction
(s) the sequence can continue. A sequence can continue when the following
action is available or a data object has been created. an exit criterion attached to
a case plan model indicates that the arriving sequence flow closes the case.

In this example, the claim analysis starts when a claim with more than €100,000
has arrived and the claim information document is available. The check finishes
when a claims evaluation report has been created:
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The entry and exit criteria mark the beginning and the end of this stage

You can attach several sentries of one type to an element. Each sentry defines its
own entry or exit criteria for its element. Two or more sentries of one type
attached to one element define a logical ‘or’ relationship, while several sequence
flows attached to one sentry form a logical ‘and’ relationship.
If all workflows of one entry criterion have arrived at the element, the corresponding task can be performed. If several criteria have to be met, more than one
sequence flow can be attached to one sentry element. Similarly, you can attach several exit criteria to an element. All sequence flows that exit one sentry will be
executed, unless a discretionary task follows.
Event listeners

A listener waits for something to happen, usually to then trigger a new sequence
flow.
o
o

o

A event listener waits for an event to occur.
A timer event listener waits for a certain amount of time to pass, or until a
defined time.
A user event listener waits for user input, such as a completed form in a web
user interface.

The event listener, timer event listener and user event listener elements (left to right)
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Case file item

A case file item represents a data file or document that contains information that
is relevant to the case, such a patient file. Use a connector to attach a case file
item to another element, to show that the other element’s execution uses its data.
It can also function as a trigger or a result and thus can stand at the beginning or
at the end of a sequence.

A case file item related to a task

6.7.3.3 Other elements
Connectors

A connectors between CMMN elements defines a relation. An entry criterion or exit
criterion defines the sequence flow direction or association.
o
o

o

A simple connector links different (non-discretionary) elements togther.
A discretionary association links a discretionary task to another CMMN element.
An annotation association links a text annotation to another CMMN element.

A connector, a discretionary association and an annotation association (top to bottom)
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Plan fragment

A plan fragment contains a group of elements that exist outside the cases’ runtime.
Plan fragments are discretionary, as indicated by the dotted lines. Also, elements
contained inside the plan fragment may contain sentries or be part of a sequence
flow, but a sentry or sequence flow may not be attached to a plan fragment. A
plan fragment essentially contains everything that has no other place but needs to
be in the case model.

A plan fragment containing three tasks
Planning table

A planning table signifies that discretionary tasks are present. A collapsed planning table indicates that discretionary tasks are not displayed, whereas an expanded planning table indicates they are shown.
A (collapsed) planning table (default) signifies that collapsed (or hidden) discretionary tasks are present in the diagram. The hidden tasks are not modeled in
Process Manager. Instead, the modeler attaches the planning table to a stage,
human task (only) or case plan model to signify that (hidden) discretionary tasks
are available.
To hint that modeled, visible discretionary tasks are available in the corresponding
stage or plan fragment, add an expanded planning table to the element by unchecking the box defining the collapsed attribute in the attribute panel.
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A (collapsed) planning table attached to a stage
Text Annotation

A text annotation contains additional textual information about the diagram, an element or a group of elements.
6.7.3.4 CMMN Attributes
The following attributes can be set in the attribute panel by checking or unchecking
the value of the corresponding element. When the value is enabled, an icon will
appear on the corresponding element or the elements appearance will change, as
depicted below.
o

The discretionary attribute can be set for all kinds of tasks and stages. If the
attribute is activated, the task/stage may be performed if the case worker
decides it is necessary. Plan fragments are by default discretionary, this cannot

o
o

be changed as it is a pre-defined condition in CMMN.
The autocomplete attribute can be set for stages and case plan models.
The manual activation attribute can be set for all kinds of stages and tasks. If
the attribute is activated, the corresponding element has to be triggered manu-

o

ally.
The repetition attribute can be set for milestones, stages and tasks. If the
attribute is activated, the case worker will evaluate if the task needs to be

o

repeated every time it is finished. If the result is ‘yes’, the task will be repeated.
The required attribute can be set for milestones, stages and tasks. If the attribute is activated, the corresponding action needs to be completed for the
sequence flow to continue or the containing element to be completed.
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Unactivated and activated attributes in process manager (left to right): discretionary, manual activation, repetition, required, autocomplete

6.7.4 Integrating CMMN diagrams
You can seamlessly integrate CMMN diagrams with DMN and BPMN diagrams in
your process landscape. You can, for example, embed a CMMN model in a BPMN process by use of the BPMN sub-process as depicted below. This allows you to model
the static part of a process in BPMN and only depict the flexible part in a CMMN
model.
6.7.4.1 Linking to a diagram in a CMMN model
To add a diagram link to a CMMN model, first add the corresponding CMMN element:
o
o
o

Process Task - to link to a BPMN diagram
Decision Task - to link to a DMN diagram
Case Task - to link to a CMMN diagram

Click the symbol in the top left corner of the diagram element and select a diagram
of the corresponding type in the dialog that appears or choose to create a new one.
Click Link diagram to confirm.
If you chose to create a new diagram, the editor opens in a new tab, ready for you
to edit the new diagram. After modeling the new diagram, save both the new one
and the CMMN model the new diagram is now linked to.
6.7.4.2 Linking to a CMMN model in a BPMN model
To add to CMMN model link to a BPMN diagram, add a collapsed subprocess and
click the + -symbol at the bottom of the element. In the dialog that opens, choose a
CMMN model or create a new one by choosing Case Management Diagram (CMMN
1.0) at the top under Create new diagram. Click Link diagram to confirm.
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If you chose to create a new diagram, the editor opens in a new tab, ready for you
to edit the new diagram. After modeling the new diagram, save both the new one
and the CMMN model the new diagram is now linked to.

Linking a new CMMN diagram to a BPMN Subprocess

You can also link CMMN diagrams in value chains the same way to create complete
process levels that also show in Collaboration Hub. For more information on diagram hierarchy levels in your process landscape, see Create subprocesses .

6.8 Further notations
Process Manager supports a comprehensive set of modeling notations. This article
lists the ones that are typically not relevant for the most common use cases.

6.8.1 Organizational charts
Organizational charts outline the internal structure of a company. Illustrating a
company this way shows the internal hierarchy and how each role relates to others
in the same organization.
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6.8.2 Choreography diagrams
Choreography diagrams depict the details of complex collaboration between process
participants. This allows for an analysis of how information is exchanged and how
participants coordinate their actions. Choreography diagrams are part of the BPMN
standard, but are not widely used. We recommend staying with BPMN process diagrams.
For more information on Choreography diagrams, see the OMG BPMN specification
document.

6.8.3 Conversation diagrams
Conversation diagrams focus on communications between process participants.
They allow for the viewing of relationships at a glance. Conversation diagrams are
part of the BPMN standard, but are not widely used. We recommend sticking to
BPMN process diagrams when modeling process participant interactions.
For more information on Collaboration diagrams, see the OMG BPMN specification
document.

6.8.4 Event-driven process chains
Event-driven process chains (EPC) are used to model business processes. EPCs capture and visualize processes, but are--unlike BPMN--not executable. EPCs generally
focus on the lower levels of the process hierarchy (operational sequences of processes). While EPCs were popular in some European countries in the late 90s and
early 2000s, they have now been eclipsed by BPMN, which is more appealing to
both business users and technical experts. We don't recommend using EPCs.
For more information on EPCs, see this page.

6.8.5 UML use case diagrams
Use case diagrams are used to view what actions can be performed collaboratively
between systems and users. They are a part of the UML (Unified Modeling Language) standard.
For more information on UML use case diagrams, see this page.
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6.8.6 UML class diagrams
Class diagrams show the properties, methods, and relationships of a system's
classes. They are commonly used to describe object-oriented programing code. They
are a part of the UML (Unified Modeling Language) standard. The Signavio Support
Team can activate UML class diagrams for your Signavio Process Manager workspace on request.
For more information on UML class diagrams, see this page.
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7 Modeling with QuickModel
QuickModel allows fast process capturing and completion. It supports a table based
modeling approach where you can add information by filling a table. The graphical
diagram representation will automatically be created by the system, which enables
you to fully concentrate on the diagram information.
QuickModel can help you with your work on diagrams in many areas:
o

It enables you to create diagrams even if you are unfamiliar with modeling conventions. With QuickModel you create diagrams by adding information to a table
instead of adding elements to a diagram, with no special knowledge of the modeling language being required. The resulting diagram will be BPMN 2.0

o

compliant.
You can edit diagram information even faster as the system does the graphical
modeling. You can implicitly edit the graphical representation by changing the
workflow order, whereas modeling actions like rearranging the diagram will be

o

executed by the application.
Diagram information can be displayed clearly in a table and process information
can be added even faster than in the Graphical Editor.
After logging into Collaboration Hub, users with a Hub license can open
QuickModel through the Explorer by clicking the logo in the top left
corner of the application.
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The QuickModel application

7.1 Capturing processes with QuickModel
QuickModel enables you to capture processes in a fast and well-structured manner.
Information is simply added to a table and a diagram is automatically created from
the information you put in.
The following chapter explains process capturing with QuickModel in-depth.
QuickModel can be used to capture linear processes, which contain a workflow with
a well defined order of activities.
With the application you can also make modeling complex processes much faster by
simply recording the main path first. Complex structural information like parallel
tasks or exclusive gateways you can add later in the Graphical Editor.
To capture a new process with QuickModel, open the Signavio Explorer and click
New > QuickModel in the top drop-down menu.
The QuickModel application will open in a new tab:
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a new BPMN diagram in QuickModel

The QuickModel window consists of three sections, top to bottom:
o

Process details are displayed at the top of the window. They contain information about the process as a whole (attributes on diagram level).

o

Activities are listed in the middle. The workflow order in the diagram will be the
same as displayed here.

Version 14.9

253

7 Modeling with QuickModel

The order of lines in the table under 'what' (1, 2, 3, 4, 5) is the same as the order of the tasks in the diagram
o

A diagram preview is displayed at the bottom. The preview is automatically generated by the application.

7.1.1 Adding tasks
o

Start with adding a process trigger (start event) that initiates the process and an
end event that concludes it, if applicable.

Add a trigger/start event.
o

Add tasks that are executed during the process. To do so, select the first cell in
the table directly below What?:

Select the first cell to add a task.

To ease the navigation in the table, the row and column name of the currently selected cells are always highlighted.
o

Type in the activity name and press Enter. The diagram preview will refresh and
show a start event, the task and an end event:
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The task is automatically added to the diagram.
o

Continue adding tasks in the same way. As the activity list grows, the diagram
preview may scroll out of view. To always keep it in view, you can use the pin on
the upper right:

You can pin the diagram preview to the bottom of the window.
This will pin the preview to the bottom of the window. You can adjust the diagram
size via the slider on the left or resize the preview window itself:
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To add more information about activities (to fill in additional attributes), use the tabulator key instead of Enter. Instead of the next line for a new task, the next column
will be selected and allows you to enter detailed information:

Navigate to the next column after labeling a task to define roles for the tasks.
To add information to previous activities, select the corresponding cell by clicking
or navigating to it with the arrow keys. To extend information about an activity,
double click the cell instead of simply typing the information or press Enter.
If you forgot an activity in between, select the next activity in the workflow and
click Add activity above:

Adding an activity inbetween existing tasks.

This will add a new, empty row.
o

After adding all activities, you can add a process result in the process details
area:
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The diagram preview in the bottom will refresh constantly. Answering the question
Who? will add pools and lanes, adding IT Systems to the table will create them
accordingly in the preview:

After creating your new diagram with QuickModel, you can open the diagram in the
editor in order to add complex elements, such as gateways. Open the diagram in the
editor by clicking Graphical editor in the user menu.
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7.1.2 Removing tasks and information
To remove a task, select the corresponding line and click Remove activity

To remove single information, select a cell and hit Del on your keyboard. The cell
content will be removed but the task will remain.

7.1.3 Saving a diagram
Add a name for the process at the top of the window before saving:

Then, add a process description. if you click on the field Documentation in the Process details section, a text Editor will appear that also allows formatting the text:

Add your information and hit OK. The process description will later help readers of
the process to get an idea of the process without diving into its structure.
Finally, click Save in the QuickModel toolbar:
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The diagram will be saved und be accessible in the Signavio Explorer after refreshing.

7.2 Completing diagram data with QuickModel
QuickModel cannot only be used to capture processes. The table view also allows
getting a quick overview of all the process information.
o
o

o

You can add key process indicators (KPIs) very quickly due to the table view.
New custom attributes can be created immediately by adding a new column to
the Activities table.
Process diagram information can be checked for completeness very easily.

7.2.1 Opening an existing diagram with QuickModel
There are different ways to display a diagram with QuickModel:
o

You are in the Signavio Explorer. Select the diagram and select Edit QuickModel
from the Edit menu:
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Open a digaram in QuickModel from the Explorer.
o

You already opened the diagram in the Editor. There is a toggle button in the top
right corner that allows switching to the QuickModel view instantly:

Switch from the Editor to QuickModel.

Simply click Graphical Editor and select QuickModel in the top right dropdown menu.
When switching views, unsaved changes have to be saved first. If you
have unsaved changes that you want to discard, close the Editor
without saving and open the diagram in QuickModel from the Explorer.
Using that menu you can easily toggle between the Editor and QuickModel.
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7.2.2 Completing diagram information
Some diagrams contain non-linear processes, for example decisions or
parallel workflows (gateways) or multilevel roles. You can open these diagrams in QuickModel to edit and complete those diagrams but it is not
possible to edit them structurally, for example to add or remove tasks or
roles. These buttons appear grayed. Columns that are not editable are
marked with a star symbol.

If you edited a diagram in the Editor before, some attributes may be 'read only' in
QuickModel.

7.2.3 Show or hide (custom) attributes
Usually, the main attributes are displayed in the activities area, but you can easily
add or hide columns that contain (custom) attributes.
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o

Click the tool symbol on the top right of the activities list:

o

A dialog will appear that allows you to choose the attributes to be displayed in
the table:

Configure the attributes that are displayed in QuickModel for this diagram.
QuickModel allows editing activities as well as linked subprocesses. The
section custom attributes allows selecting attributes that were individually defined for both element types.

Version 14.9

262

7 Modeling with QuickModel

o

After choosing a number of attributes to be displayed, click OK.

The view will be updated accordingly.
You can define custom attributes to add domain specific information. The chapter
Configuring notations and attributes offers more information for workspace
administrators about the usage and creation of custom attributes in the whole
workspace.
Custom attribute information on process level, if defined, will be accessible with
show more process attribute.

Display custom attributes in the process details view.
Add your domain specific information here.

7.2.4 Adding (custom) attribute values in QuickModel
Some information may have been left blank during process modeling. This can happen, for example, if you want to capture very fast or if the information was simply
not available at the time of the first modeling process.
In QuickModel, the table in the Activities window allows completing this information easily:
o
o

Use the arrow keys to select the right cell or simply click it.
Activate the editing mode by pressing enter or, if you want to replace information that is already there, simply start typing. Depending on the attribute type
there are different ways of adding information. If you have a number of dictionary entries for roles, these can be picked in the corresponding attributes.
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Selecting a role for the custom attribute 'consulted'
o

After adding a value, confirm it by pressing Enter. The value will then be inserted
into the cell.

Depending on the attributes defined and their data type, which can, for example, be
a list, a boolean value or simply text, the application will automatically provide the
right input form for you to provide the attribute value.
It is possible to copy data and paste it into other cells. Simply select one or more
cells (by pressing Ctrl or Shift while selecting) and press Ctrl + C Select the target
cell or multiple target cells and press Ctrl + V to insert the data.

7.2.5 Undo and redo actions
Use the arrow symbols in the toolbar to redo and undo actions:

You can also press Ctrl + Z (undo) and Ctrl + Y (redo).

7.3 Connecting dictionary entries to activities in
QuickModel
Like in the Editor, you can connect dictionary entries to tasks in the QuickModel
application. This can be done with the task or its attributes.
Dictionary entries allow applying naming conventions more easily, finding connections between diagrams and capturing information even faster using the auto
completion.
Start typing a task name in the What? column and the auto completion will suggest
a list of dictionary entries that are related to the text you entered:
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The auto completion functionality suggests dictionary entries.

Choose the dictionary entry you want to link to the task by clicking it or selecting it
with the arrow keys and pressing Enter. The task will be will be linked to the dictionary entry. You can now edit the name of the task, the dictionary entry will stay
linked to it.
Linked information will get a small dictionary icon:

The task 'Create Order template' is connected to a dictionary entry.

You can also connect single attribute values to dictionary entries. Whenever you
add textual information to an attribute the auto completion will suggest dictionary
entries in the same way:

An attribute is referencing a dictionary entry.

Attributes referencing dictionary entries are fixed links to the entry, you
cannot edit the attribute's name.

7.4 Tutorial: Modeling for beginners with QuickModel
With the QuickModel tool, Signavio provides an easy start to business process modeling with BPMN 2.0. Here, you create a BPMN process by filling a table with
information about the process. The tool models a BPMN 2.0 conform diagram that
can later be altered in the Editor.
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The BPMN diagram 'Procure Parts' created in QuickModel. It can now be completed in the Editor.

QuickModel can also be useful for fast modeling - for example if you want to sketch
out a lot of different diagrams. Simply create the basic structure of the diagram in
QuickModel, then switch to the Editor to add more complex structures.
You don't need any knowledge about BPMN to work with QuickModel. The tool, however, does have limitations: you will only be able to define one diagram path.
'Branches' (Gateways) and sub-processes need to be added in the Editor later. We
recommend modeling either the 'happy path' - the path the process follows if no
obstructions or errors occur. You can add information about branches and other diagram details in the documentation so that an experienced modeler can add them to
the diagram in the Editor later.
To create a diagram in QuickModel, click New-QuickModel in the Signavio Explorer.
The QuickModel tool will open in a new browser tab.
In the tool, proceed as follows:
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o

o

First, name the process by clicking the pen symbol in the header of the application.
Start creating the diagram by defining a start- and an end event in the corresponding form fields in the 'Process details' section on the right side.

Add a trigger/start event.
o

Now, you can add Tasks to the table. Create a task by entering its label into the
first column. You can add a Task at any position in the model by selecting the corresponding row in the table and then clicking the Add activity above button
above the column header. To remove a Task, click Remove activity. When you
added your first task, the tool will start modeling the changes you make to the
diagram in real time in the 'Diagram preview' section.

Add an activity between existing tasks.

Remove an activity.
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o

In the other columns of the table, you can add element characteristics (so-called
'attributes') and other information. You can for example add an IT System or a
Data Object (any kind of document) that may be needed to complete a Task. If visible in the diagram, this information will also be added to the model by the tool
automatically. You can configure the columns that are displayed by clicking the
wrench symbol on the top right of the 'Activities' section.

Configure the attributes that are displayed in QuickModel for this diagram.
o

If dictionary entries are defined, suggestions will be displayed as soon as you
start filling a field. If you click an entry, the corresponding field will be automatically filled and linked to the this dictionary entry. If your organization uses
the Signavio Dictionary, it should contain definitions for the most-used elements
and attributes. Like this, all modelers in Signavio use the same pre-defined
terms. You can learn more about the Dictionary in the chapter Working with the
Dictionary.

The Dictionary is automatically suggesting fitting entries as you type.
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o

The label of the framing element ('Pool') that encompasses the model is defined
in the 'Organization' form field at top left in the 'Process Details' section. The
Pool represents the organization that owns and executes the process. Pools can
contain 'Lanes' that represent actors. Actors can be people, positions or departments within an organization. They define, who can or should perform a Task. If
you would like to define actors for certain Task elements, define them in the
'Who?' column of the table. We recommend to put positions, roles or departments instead of the name of a person as responsibilities of people within organizations change.

Define a role (in this case a department).
When you are done creating the diagram and you checked the model that the tool
created, provide a description of the diagram in the 'Documentation' form field of
the 'Process Details' section at the top. If necessary, also define what needs to be
added or changed in the model to add complexity like branches ('Gateways'), additional attributes or linked sub-processes.

Save the diagram so that it can be completed in the Editor.
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8 Simulating BPMN diagrams
The BPMN simulation tool allows you to visualize process runs and to analyze processes based on configurable one-case and multiple-case scenarios in order to gain
information about cost, cycle times, resources and bottlenecks.
Modeling users who merely have read access to a diagram can still use
its BPMN simulation. However, such users can't manage its simulation
scenarios.
Simulating BPMN diagrams can help to increase process awareness and can answer
specific questions like:
o

How much does a process run cost on average?

o

How are costs distributed over roles / tasks?

o

How much would 10% more of case X instead of case Y affect the cost?

o

Where is the bottleneck in this process?

o

How much of everyone‘s time is consumed in this process?

o

How would 20% more requests affect the cycle time?

o

Would an additional risk analyst speed up the cycle time?
The simulation works with BPMN 2.0 diagrams only.

The simulation tool offers the following modes:
The step-by-step simulation mode allows you to step through the process element
by element and to focus completely on the process flow.
o

Step-by-step simulation

The one-case simulation mode allows you to simulate one specific case and to analyze costs and time consumption for this case.
o

One-case simulation

This feature is available in the Enterprise Edition.
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The multiple-cases simulation mode allows you to simulate multiple process runs
taking into account configured probabilities and analyzing quantitative data and bottlenecks.
o

Multiple-case simulation

For creating and managing simulation scenarios, refer to the following section:
o

Managing simulation scenarios

You can export the results of the multiple case simulation as an XLS spreadsheet.
o

Exporting simulation results

If you're not sure what specific metrics in the simulation results mean, please refer
to our metrics overview section.
o

BPMN simulation - result metrics

In case you encounter problems with the BPMN simulation tool, please check the
troubleshooting-chapter.
o

Troubleshooting issues with the BPMN simulation feature

8.1 Open the BPMN simulator
In the explorer, select a model and click Edit > Simulate BPMN Diagram.
When a diagram is opened in the editor, QuickModel or diagram comparison, click
Simulator in the user menu to open the BPMN simulator.
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You can now choose between
step-by-step simulation

one-case simulation

multiple-cases simulation
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8.2 Step-by-step simulation
The step-by-step simulation function allows you to go through the process element
by element and to focus completely on the process flow.
The step-by-step simulation can be started immediately, without any preparations.
To start the step-by-step simulation, click the Play button in the lower left corner
of the diagram canvas:

Afterwards, you can click through the process flow step-by-step:

When passing an exclusive (XOR) gateway, you can determine the subsequent
sequence flow:

Step-by step simulation: The simulation canvas

To restart the step-by-step simulation, click the Restart button:
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8.3 One-case simulation
This function is available in the Enterprise Edition.
The one-case simulation function allows you to simulate one specific case and to
analyze costs and time consumption for this case.
Before running the one-case simulation, you might want to configure the scenario
on which the simulation is based. You can find more information about scenarios in
the chapter Managing simulation scenarios .
To run the one-case simulation, select a scenario and click the Play button:

The BPMN Simulator will automatically go through the process flow step-by-step.
When passing an exclusive (XOR) gateway, you can determine the subsequent
sequence flow or wait for the system to decide (based on the probabilities given)
which way to choose. The simulation will continue and choose a path automatically
when the timer symbol on the top right of the element has run full circle:

Either wait for the system to choose a way or select the desired subsequent sequence flow
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During the simulation, the simulation tiles display the overall costs, cycle time and
resource consumption at the current position in the process (left column) and of the
complete previous run (right column). The bottleneck tile is only relevant for n-case
simulation.

The tiles display costs, cycle time and resource consumption.

It might be necessary to explain the difference between cycle time and resource
consumption: Cycle time refers to the amount of time between start and completion of a process while resource consumption is used as a term for the overall
time process participants committed to process execution.
For detailed quantitative information, click More in the corresponding tile:
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In case the simulation speed is faster or slower than needed, you can click the
Pause button...

...and use the Step button to go through the each process element manually:

To restart the simulation, click the Restart button:

8.4 Multiple-case simulation
This feature is available in the Enterprise Edition.
The multiple-cases simulation function allows you to simulate multiple process runs
taking into account configured quantitative figures and analyzing quantitative data
and bottlenecks.
Before running the n-case simulation, you might want to configure the scenario on
which the simulation is based. You can find more information about scenarios in the
chapter Managing simulation scenarios .
Additionally, you can configure the period of time the simulation should cover. To do
so, proceed as follows:
Click Duration:

Now type in the desired number of days and click Save:
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To run the multiple-cases simulation, select a scenario and click the Play button:

The BPMN Simulator will now analyze the selected scenario and display the results
in the process diagram and on the simulation tiles.
The simulation tiles display the overall costs, cycle time, resource consumption and
bottlenecks of the current simulation scenario run (left column) and of the previous
of run (right column).

The Multiple-Cases Simulation Dashboard

It might be necessary to explain the difference between cycle time and resource
consumption: Cycle time refers to the amount of time the process start and process completion while resource consumption is used as a term for the overall time
process participants committed to process execution.
For detailed quantitative information, click the more link on the corresponding tile:
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The simulation dashboard contains detailed quantitative information.

To restart the simulation, click the Restart button:

To simulate the run through all process instances of the previously calculated scenario, click the Play button on the lowest simulation tile:

In the diagram, waiting instances are displayed as blue dots place above the ingoing
sequence flow:
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Running instances are displayed as blue dots within the border of a task and
already executed instances as a stack next to corresponding task:

8.5 Managing simulation scenarios
This chapter explains functionality that is available in the Enterprise Edition .
Before running a one-case or n-case simulation, you might want to configure the
data that the simulation is based on.
This can be done via simulation scenarios .
When a diagram is initially opened in the simulator, it already contains one scenario based on the diagram's attribute Cost & Resource Analysis. To define the attribute, open the diagram in the editor by clicking Graphical Editor in the user menu.
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With the help of scenarios you can manage different data sets for simulating one
process. You can edit the scenario data by simply clicking on the corresponding
fields:

The scenario data is categorized by four different tabs:
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o
o
o

o

The Costs tab contains granular costs of activities.
The Time tab contains granular execution durations of activities.
The Frequency tab contains frequency and probabilities of start events, of junctions after gateways and of boundary events.
The Resources tab allows you to define availabilities and costs of process participants in great detail:

For each role you can define costs per hour.

You can also define a detailed work schedule for each role. Click a role's work schedule in order to adjust it:

Now you can define detailed work times for any number of resources: In the
example below, the role is fulfilled by two full-time (40 hours/week) employees and
one part-time employee (only Mondays and Tuesdays).
Let's create the schedule for the part-time employee:

Click the dots to open the detailed schedule dialog.
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Now you can define the working hours of the worker per day:

For our example, we set the working hours of Mondays and Tuesdays from 09:00 to
17:00:

After going back to the Resources overview, you can see that three employees are
now available for this role, in total for 96 (2*40 + 16) hours a week:

Three employees work in total for 96 hours per week in this role.
In the Time tab of the Scenario menu at the bottom, you can define task execution
times as distribution functions.
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This helps you to simulate non-deterministic task execution times. For example, if a
clerk typically needs approximately between five and ten minutes to reply to an
email.
To open the time distribution dialog, go to the Time tab and click the '...' behind the
pre-defined execution time of the corresponding task.
Set the time distribution for the task and click Accept to confirm.

The option Constant lets you define an execution time that has a specific probability. With the help of several probability-constant mappings, you can create a
discrete probability distribution.
Alternatively (or in addition), you can define uniformly distributed or normally distributed execution times.
We recommend a Normal distribution in case the task execution times
are likely concentrate around a certain value. In many scenarios, this is
a reasonable approximation. For example, a sales manager needs most
likely around 30 minutes to conduct a web demo for a prospective
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customer.
You can configure a Uniform distribution in case the task execution times are
equally distributed within a range of two values.
To save a scenario, press Ctrl + S or select the Save scenario button on the very
left side:

Alternatively, you can click the Play/Restart button - the following dialog will pop
up:

Click "Save" and continue to save the edited scenario and to execute the simulation.
You can create a additional scenario by clicking on the Plus -button in the scenario
tab bar:

Now you can choose between creating a scenario based on the Cost & Resource
Analysis attributes (Create from template: None) or to use the data of another scenario as a starting point:

Version 14.9

284

8 Simulating BPMN diagrams

When starting a new simulation, you can now select the desired scenario from the
drop down menu:

8.6 Exporting simulation results
You can export the results of a Multiple-case simulation as XLS (Microsoft Excel)
files. This makes it easy to share the results with colleges and other stakeholders.
To export the results, click the Excel Export button below the simulation tiles:

An Excel (XLS) file will be created and downloaded
If more than one simulation scenario has been executed, the Excel file contains the
following eleven tabs with tables and diagrams:
If you are using Microsoft Excel 2010, please make sure to deactivate
the Protected View (click Enable Editing) to make sure the spreadsheet
is displayed correctly.
o

The Overview tab contains general information about the runs:
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The 'Overview' tab
o

The Costs tab provides the reader with minimum, maximum and average costs
of the simulation runs and task executions:

Excerpt of the 'Costs' spreadsheet

Values that are especially high are highlighted according to the scheme displayed
below the calculation table in the sheet:
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High values are highlighted according to the legend.

The same scheme applies to the other calculation tables as well.
o

The Costs charts tab visualizes the cost relation of the executed tasks:

Costs of each task in relation to total costs
o

The cycle time of a process instance measures the time between process start
and process completion. The Total cycle time tab shows process instance cycle
times and activity execution times:
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Excerpt of the "Total cycle time" spreadsheet
o

The Total cycle time charts tab is visualizing the data of the Total cycle time tab:

Cycle time of each task in relation to total cycle time
o

The Resource consumption tab contains information about the time the different Resources (lanes) where occupied with a task and sets their workloads in
relation to reach other:
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Excerpt of the 'Resource consumption' spreadsheet
o

The Resource consumption charts tab is visualizing the data of the Resource
consumption tab:

Resource consumption of each task in relation to total resource consumption
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o

The Bottlenecks tab contains information about process bottlenecks (if existent):

The 'Bottlenecks' tab

The Bottlenecks charts tab is visualizing the data in the Bottlenecks tab.
o

The 10th and 11th tab contain information about the scenario properties:

In case there are problems with displaying the charts in the report,
please check if you have opened the report with a program that allows
editing Excel diagrams. If this is not the case, we recommend you to
open the program with one of the more recent versions of Microsoft
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Excel.

8.7 BPMN simulation - result metrics
This article explains the metrics of the results of a multiple-case simulation.
We use the following simplified vacation request handling process to produce
example metrics.

A vacation request handling process

We have one Team Lead resource available at a cost of 60€ per hour. The execution
costs are:
o
o

1 € per activity, plus
60 € * #hours of human work needed to execute the activities.

The execution times are:
o
o

10 minutes for Assess vacation request,
5 minutes for Explain rejection.

Consequently, the activity Assess vacation request costs 11€ and takes 10 minutes.
The activity Explain rejection costs 6€ and takes 5 minutes.
The process has two flow variants:
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o
o

variant 1: vacation is granted,
variant 2: vacation is rejected.

Variant 1 occurs in 80% of the cases, costs 11€ and takes 10 minutes. Variant 2
occurs in 20% of the cases, costs 17€ and takes 15 minutes.

8.7.1 Costs
The simulation tool calculates average, minimum, maximum , and total costs. The
tool determines all cost types based on the simulation result. If you run a simulation
of our example process with exactly one case that takes process variant 2, each
cost amounts to 17€.

8.7.2 Cycle time
The simulation tool calculates average, minimum, maximum and total cycle times.
As for the costs, the simulation tool determines the cycle times based on the simulation result. If you run a simulation of our example process with exactly one case
that takes process variant 2, each cycle time amounts to 15 minutes.
The total cycle time can exceed the simulation time span. This can happen for two reasons:
o

o

Your resources can't handle cases fast enough and process instances
'pile up'.
The cases that occur in the last hours/minutes of your simulation
time frame exceed this frame before they are completed.

8.7.3 Resource consumption
The resource consumption lists the consumed time and the workload for each process resource.
The consumed time is the total time a resource spends on executing activities. For
example, if your simulation result contains 80 cases of variant 1 and 20 cases of
variant 2, the Team Lead 's resource consumption is 80 x 10 minutes + 20 x 15
minutes = 1100 minutes.
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The workload is the percentage of the available time a resource is occupied with
executing activities. Given the example above, a simulation time frame of one week
and a resource availability of 40 hours per week, the workload of the Team Lead
resource is 1100 / (40 * 60) = 37% (approx.) (given no case exceeds the simulation time frame).

8.7.4 Bottlenecks & waiting times
A bottleneck occurs when a resource's limited availability increases the waiting
times of cases. In our example, a bottleneck occurs at Assess vacation request as soon
as a new case starts while the Team Lead is still handling a previously started case.
Then, adding additional Team Leads will reduce waiting times and cycle times.
Waiting times describe how long cases are idle because no resource is available to
execute the current activity. In our example scenario, only one resource is available
to handle process activities. Consequently, waiting times occur when a new case is
started before all previous cases have been terminated.

8.8 Troubleshooting issues with the BPMN simulation
feature
In order for a simulation to be executed, some necessary conditions must be fulfilled:
o

The syntax of the diagram has to stick to BPMN 2.0 syntax rules. The process
flow must not be interrupted, for example:

The diagram must not infringe BPMN 2.0 syntax rules
o

To check if a diagram sticks to BPMN 2.0 syntax rules, you can also use the syntax check in the graphical Editor.
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Check syntax rules in the graphical Editor
o

Elements that affect the process flow, but cannot be clearly specified regarding
their impact on the process flow, must not be used. Such elements are - for
example - inclusive gateways and non-interrupting boundary events.

The BPMN simulation feature does not support inclusive gateways
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In Signavio Process Manager, there are several ways to enable collaborators to contribute to your business process and business decision landscape.
Fellow modelers in your workspace can by default edit and comment on all diagrams in the workspace's Shared documents folder. You can also invite modelers to
edit to call attention to a diagram. They can also preview diagrams in Collaboration
Hub which also provides a reader-friendly diagram presentation, with its full screen
view and detailed documentation.
Stakeholders who do not have access to your workspace can be invited to comment
on diagrams. The modeler simply needs to send an invitation from the Explorer's
Share menu to grant access. For external persons, the link acts as a key to Collaboration Hub where unregistered stakeholders can see and comment on diagrams. Certificate-based Collaboration Hub users can additionally see all published
diagrams of the corresponding workspace in the folder tree on the left. The stakeholders click a link they receive by email that allows them to see and comment on
diagrams.
Exporting diagrams and sharing, saving or printing them is another collaborative
option for modelers. This way, diagrams can be transferred between Signavio workspaces (SGX) and Signavio and other modeling softwares (BPMN 2.0 conform XML),
saved locally, and sent by email (PDF, SVG or PNG) or printed out.
Embedding diagrams in websites or Microsoft SharePoint-based systems is another
way of collaborating for more advanced users.

9.1 Inviting modelers to edit a diagram
After you created or updated a diagram you might want to notify your fellow modelers and invite them to further refine the diagram. Or if you noticed that a diagram
has not been updated for a long time, you might want to invite your colleagues to
check its actuality and have it updated if necessary.
To be able to edit a diagram directly in the Editor, users must be
registered in your workspace. Persons who are not registered can use
the commenting feature in Collaboration Hub to contribute indirectly
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(see Inviting stakeholders to comment on a diagram).
With the feature Invite modeler to edit you can send registered workspace users
an invitation to edit diagrams. Unless configured otherwise, all modelers in your
workspace can edit diagrams that are stored in the Shared documents folder. If
you try to open a diagram while it is being edited by a colleague in the Editor, a
warning will be displayed. You can still edit the diagram, but if you save, you will
override the changes made by your colleague(s).

Invite colleagues to edit a diagram.

To send an invitation email, proceed as follows:
1. First select a diagram.
2. Click Share , then Invite modeler to edit in the menu bar. The dialog Invite
modeler to edit opens.
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3. Click the arrow to get to the next page.
4. All registered users with editing rights are displayed on the left. Select the
people you want to invite.
5. Customize the invitation message (optional).
6. Click Send and an invitation email will be sent to all selected users.
You cannot grant additional access rights to people using this dialog. It
only sends notifications. If you want to add more people to your workspace, please ask your system administrator. To discuss your diagram(s)
with colleagues, you can also invite them to comment .

9.2 Inviting stakeholders to comment on a diagram
One of the most powerful features in collaborative process design is inviting process stakeholders to review and comment on diagrams. This functionality allows
you to get a large number of contributors involved. They do not need to be modeling
experts to work with you in Collaboration Hub.
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This way, you can invite people who have a deep understanding of the business process and can contribute to proper process documentation and process innovation
without having to be familiar with Signavio software.
A special feature of the comment-functionality is that the commentators do not
need to be registered users in your workspace. You can invite anybody via email to
comment on your diagrams.
This section describes how you can invite colleagues who are not users
of Signavio Process Manager to comment on diagrams. To take advantage of the Process Manager in the long term, however we recommend
that you use reading and commenting access rights in Collaboration Hub
.

9.2.1 Inviting collaborators in the editor to comment
This feature is available with the Hub and Suite license.
When you invite collaborators in the editor, the invited collaborator can view the
unpublished diagram in the Collaboration Hub preview and add comments. If the collaborator has an account with a modeling license, the collaborator can also edit the
diagram in the editor and QuickModel. Invited collaborators with no account have
to create an account first.
To invite stakeholders in the editor, follow these steps:
1. Open the diagram you want to share.
2. In the editor's toolbar, click Share. The dialog Share for feedback opens.
3. Enter the email addresses of the stakeholders you want to invite. Optionally,
add a note to your invitation.

4. Click Send. An email invitation with a diagram link is sent.
9.2.1.1 Remove collaborators
You can remove collaborators from the diagram. After removing access, collaborators can no longer view the diagram and add comments.

Version 14.9

298

9 Collaboration

1. Open the diagram you want to share.
2. In the editor's toolbar, click Share. The dialog Share for feedback opens.
3. Click the email address of the collaborator you want to remove and click

.

4. Click Done.

9.2.2 Inviting new stakeholders via email
To send an invitation email, take the following steps:
1. Select the diagram(s) you want to share (optional).
2. Click Share , then Invite anyone for feedback in the menu bar. The dialog
that allows you to invite commentators opens.

3. If you didn't select a diagram in step one, you will reach the selection page
first. Select one or multiple diagrams. You can go back to this page any time
by clicking Choose diagrams .
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4. Type in the email addresses of all colleagues you want to invite. Multiple
entries can be separated by commas, semicolons or line breaks.
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5. Create optionally a simplified view for you colleagues. The next section "Simplified views on diagrams" contains more information on this topic.
If you have selected more than one diagram, this option will not be
available.
6. Tick the box Send a copy to me if you want to receive a copy of the invitation
email.
7. Customize the invitation message.
8. Click Send and the invitation emails will be sent out, containing a web link
that will take your colleagues to the commenting mode in the Signavio software.
The stakeholders will now receive an email with a link. Clicking this link will allow
them to view and access the diagram in Collaboration Hub. The link works as a key
to Collaboration Hub.
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9.2.3 Simplified views on diagrams
When inviting a colleague to comment on a diagram, it is possible to create simplified views. Simplified views can ease reading a diagram, especially if the colleague you invited is not a modeling expert. You can also hide irrelevant
information, to making viewing diagrams easier.
9.2.3.1 Creating while inviting
As described above, simplified views can be created while inviting colleagues to
comment on a diagram.
1. Click Selection of a simplified view or check the box in front of it. The Selection of a simplified view dialog opens.

2. In the Create simplified view tab, you can simplify the diagram view by hiding
element types. As soon as an element type gets chosen or dismissed, the preview refreshes.
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3. If you have created your desired view, click on OK to return to the Invite anyone for feedback dialog.
4. Follow the steps to invite to comment as described above.
9.2.3.2 Creating a stakeholder-specific view
You can create simplified diagram views in the Editor before you invite stakeholders to comment.
1. Open the diagram in the Editor.
2. In the attribute panel, click Create new view under Views. The dialog View
configuration opens.
3. If no views have been created for this diagram, you can now configure a simplified view by selecting which element types you'd like to be hidden. As soon
as an element type gets chosen or dismissed, the preview refreshes.
4. Now specify a name for the simplified view. If desired, you can also include a
description.
5. If there are already existing simplified views for this diagram, choose a view
from the drop-down menu.
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6. Click OK .

9.2.4 Withdrawing commenting rights
Use the Manage access rights dialog to view the collaborators that were invited to
comment on a diagram.
1. Click Share then Manage feedback invitations in the menu bar.
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2. The Manage feedback invitations dialog opens. All email addresses that have
received an email invitation are listed. If you want to remove commenting
rights for a particular person, click Remove next to the corresponding email
address. A confirmation dialog box appears.
3. Click Yes to confirm the deletion.
If you are an administrator , you can also manage invitations to comment in
the Security center .
4. Click Setup then Manage access rights in the menu bar. The settings dialog
box opens.
5. Click the Access Rights tab. The invitations can be found at Additional access
rights at the bottom of the dialog.
6. Select a diagram on the left. Click Remove next to the email address whose
access rights you want to revoke.

More information about security settings can be found in the section Managing
users and access rights.
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9.3 Comments
Comments are displayed in the comment panel. To open the comment panel, click
the comments icon
notifications

. You can also open the comment panel directly from your

when you receive a notification about new comments.

9.3.1 View comments
All comments on a diagram are visible in the comment panel by default.
Comments on model elements are labeled with the element name.
You can still access comments on elements that were deleted during the editing
process. These comments become process level comments and they are labeled to
indicate that they refer to a deleted element.

9.3.2 Filter comments by status
To filter by comment status, click Status and select a status from the list.
To clear status filters, select All from the list.

9.3.3 Filter comments by element
To display comments for one element only, you have the following options:
o
o

Click Element and select an element from the list.
Click an element label.

To clear an element filter, you have the following options:
o
o

Click clear
next to the element filter.
Click Back to all comments.
When you are viewing only comments for an element, new comments
are added as comments on this element. Clear the element filter to add
a comment on the diagram.
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9.3.4 Add comments to a diagram
1. Open a diagram.
2. Click

. The comment panel opens.

3. Enter your comment and click Comment. The comment is posted and collaborators are notified.

9.3.5 Add comments to an element
1. Open a diagram.
2. Click an element. The comment panel for the element opens.
3. Click Add comment.
4. Enter your comment and click Comment. The comment is posted and is
labeled with the element name. Collaborators are notified.

9.3.6 Reply to comments
1. Open a diagram.
2. Click

. The comment panel opens.

3. In the comment, click Reply.
4. Enter your comment and click Comment. The comment is posted in a comment thread under the original comment.
Additional replies can be added to the comment thread.

9.3.7 Mention others in comments
When you want to address a comment directly to someone, you can mention this
person in a comment. Mention someone by typing an @ followed by their name
while you enter a comment. When you mention someone in a comment, they are
notified.
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9.3.8 Edit comments
1. Click

in the comment and select Edit.

2. Change your comment.
3. Click Save. Edited comments are marked as edited.

9.3.9 Reject comments
Reject comments that don't trigger any changes to the diagram, for example
because other changes make it obsolete.
When you reject a comment, it is hidden in the default comment view in Collaboration Hub. Collaboration Hub users can still view rejected comments when
they select Rejected when filtering comments by status.
To reject a comment, click

in the comment and select Reject. The comment is

labeled Rejected and hidden in the default comment view.
To display a rejected comment again, click

and select Show.

9.3.10 Resolve comments
When you resolve a comment, it signifies to your collaborators that the comment
has been taken care of.
To resolve a comment, click Resolve. Resolved comments are labeled Resolved.
Users who posted a comment get notified when their comment is resolved.
To re-open a comment, click Re-open. The Resolved label is removed. Users who
posted a comment get notified when their comment is reopened.
Your changes are saved immediately. The number of updated comments
is shown.
To make changes to the comment status visible to collaborators, you
need to save the diagram.
The status changes only for the first comment in a commenting thread.
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9.3.11 Delete comments
Deleting comments can't be undone.
1. Click

in the comment and select Delete.

2. Confirm the deletion in the dialog.

9.3.12 Comment notifications
You get notified for the following actions:
o
o
o
o
o

Someone adds a comment to one of your diagrams
Someone resolves one of your comments
Someone reopens one of your comments
Someone mentions you in a comment
Someone replies to one of your comments
Modelers get notified for all revisions, Collaboration Hub users only get
notified about actions on the published revision.

9.4 Granting read-only access to diagrams
Signavio allows you to share diagrams with collaborators in read-only mode. For
read only access without the commenting option, create a link to send to your colleagues via the embedding function.
The system allows you to generate a link to a PNG-picture representation of your
diagram.
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Open the embedding menu.

1. Click Share, then Embed diagram in the menu bar.
2. If the embedding function for this diagram has been activated, you can copy
the link in the Simple image tab using the key combination CTRL+C.
3. Now you can paste this link in an email and send it to the desired recipient.
When opening the diagram via this link, the most recent version of it will be displayed.
To revoke link access and at the same time stop all sharing and embedding of a diagram, click Stop sharing the diagram for read-only access
in the Embed diagram window.

9.5 Publishing diagrams in Collaboration Hub
Every modeler who has the corresponding rights to publish a diagram can publish it
in Collaboration Hub. You can also define and use approval workflows to publish diagrams. Read about this in the section Working with approval workflows.
Apart from diagrams, pictures and files stored in your Signavio file storage can be
made available in Collaboration Hub too. Publishing those files is similar to pub-
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lishing diagrams. Depending on your configuration settings, you might need to explicitly publish dictionary entries. Read more about publishing dictionary entries in the
section Publishing dictionary entries .
Administrators can grant users the right to publish , edit or delete diagrams in the Shared documents folder. Please contact an administrator
and ask them for the corresponding rights if you cannot access these
options. You can learn how to grant access rights in the section Defining access rights .
To publish a diagram, proceed as follows:
1. In the menu bar, click Share then Publish to Collaboration Hub. The corresponding dialog box opens.
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2. Select the diagrams you want to publish.

3. To publish an older revision of the diagram or to revert changes to a published
diagram, use the activity feed of the diagram. Select a diagram and click
Expand in the lower left corner of the Explorer. Alternatively, you can hit the
space bar on your keyboard.
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4. In case the feed tab is not opened by default, click the Feed button.

5. The activity feed will now be displayed. Select the revision you want to publish.

6. Now, click Publish revision . A confirmation dialog box opens.
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7. Proceed by clicking Yes . Now, your diagram is published to Collaboration Hub.

Just one revision of a diagram can be published. To publish multiple
revisions, save a copy of the diagram and then publish the corresponding revision.

9.5.1 Revoke a published diagram
To revoke a published diagram, proceed as follows:
1. Select one diagram or several diagrams at once, which you want to unpublish.
2. Click in the menu bar Share and then Unpublish from Collaboration Hub .
The selected diagrams are now unpublished.

To revoke a single published diagram, you can also use its activity feed.
1. Select a diagram and click Expand in the lower left corner of the Explorer.
Alternatively, you can hit the space bar on your keyboard.
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2. In case the feed tab is not opened by default, click the Feed button.

3. Subsequently, select the publish event in the activity feed.
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4. Click Unpublish :

Now, the diagram will no longer be available in Collaboration Hub.

9.5.2 Opening a diagram's published revision
It is often useful to know what the published version of a particular diagram looks
like in Collaboration Hub. To find this out, select the diagram in the Explorer and
click Share - Open published version:

Open the currently published version in Collaboration Hub.
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9.6 Inviting users to access a diagram in Collaboration
Hub
In many situations, you may want to point one or several readers to a specific diagram in Collaboration Hub.
For this purpose, you can send emails containing the link to a diagram in Collaboration Hub and further information via the Signavio Explorer invite.
To invite users to access published diagrams in Collaboration Hub, proceed as follows:
1. First, select a published diagram.
2. Click Share , then Invite to Collaboration Hub in the menu bar.

3. Subsequently, you can insert the email addresses of the recipients.
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4. Edit the message text (optional).
5. You can also choose to send a copy of the invitation email to yourself.
6. If you have administrator rights in the workspace, you can attach the authentication certificate for certificate-based access (see Installing the browser
certificate) to Collaboration Hub.
7. Now, click Send. The invitation message is sent to the selected email
addresses.
You can also use this feature to encourage somebody to have a look at
Collaboration Hub in general. Open the Invite to Collaboration Hub dialog without selecting a diagram. The link in the email will lead to the
entry point of Collaboration Hub.

9.7 Organizing diagrams
Signavio offers a variety of functionalities for organizing diagrams.
Find out more about
o
o
o
o
o
o

Working with folders and diagrams

Search functions
Viewing diagram details
Migrating diagrams to BPMN 2.0
Work with modeling conventions
Displaying attribute visualization layers
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The diagram preview provides information about a diagram and its revisions in the Explorer.

9.8 The notification and activity feed
Once you have created diagrams and then updated or changed them at least once,
you have the option to see what was changed by whom at what time in the activity
panel.
When you select folders or diagrams, the explorer displays the activity panel at the
bottom of the screen:

The activity panel provides diagram details.
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9.8.1 Notification configuration
Notifications need to be enabled by your workspace administrator.
In the activity panel, you can set how frequently you receive email updates about
specific diagram(s) or folder(s). If you subscribe to a folder, you will receive updates
regarding all the diagrams and sub-folders contained within. You can daily, weekly
or monthly notifications. Alternately, you can unsubscribe from notifications
entirely.

Manage email notifications about updates of the selected diagram or folder.

Your notifications are sent in a single email.

9.8.2 Additional functions
The activity panel provides a preview of the diagram/folder as well as detailed
information and management options regarding its version history.
To access this preview, proceed as follows:
1. Select a diagram/folder.
2. Click Expand in the lower left corner of the Explorer. Alternately, you can use
the space bar on your keyboard:
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3. The panel expands, providing a visual overview of the diagram:

4. To view the activity feed and manage the change and version history of the
diagram, click the Feed button. The activity feed will now be displayed.
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5. Hovering over the timeline provides you with specific time spans.

6. To gain a visual overview over an activity, click the Activity description.

The visualization will highlight the elements that have been changed.
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7. The overview also provides links to publish or comment the revision and to
switch to the diagram comparison (see section Comparing revisions).

8. If the selected revision is not the latest revision of the diagram, it is also possible to restore the revision:

9. To get a more detailed view on an activity set, it can be opened to show all its
single activities by clicking the dots on the grey stripe at the right side. Each
activity will be displayed separately:

10. To hide the panel again, hit the space bar or click Collapse.

9.9 Translating diagrams
This feature is available in the Enterprise Edition .
You can model your diagrams in multiple languages. This allows viewers and modelers who do not understand your standard diagram language to collaborate with you.
Multilingualism is a feature which is available in the Editor, Collaboration Hub and
in the Dictionary. You need to configure languages in the Explorer (see section Configuring language settings for all users ) to use this feature.
The following explains how to translate a diagram and the modeling elements. Note
that you need to have already defined your desired language in the Explorer.
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9.9.1 Changing the language
When creating a new diagram, it will be displayed in the default language of the
workspace. To change the default language, read the section Default language settings.
The current language of a diagram can be switched in the Editor via the little flag
symbol on the right side of the upper toolbar:

The language is switched from English to German.
If the flag symbol is not visible for you, it is possible that there are no
languages defined for your workspace. As a workspace administrator,
you can define a set of available languages in the Explorer's configuration dialog, which is described in the section Default language settings.
Select one of the available languages. The diagram will adapt to the language immediately and may look like the following:

The highlighted elements have not been translated into English, yet.
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Diagram elements that were already translated are displayed will be displayed normally. In our example, the task 'Problem lösen' was already translated. If the label
was formatted, this formatting will be kept.
Diagram elements that are not yet translated are highlighted in red--in this
example, the incoming message event 'Received Invoice' is only available in English
(thus, the "en_us" in brackets).
The following chapter describes how diagram elements can be translated.

9.9.2 Translating diagrams
Translating diagrams means defining a translation for each diagram element in
each required language, which can include all element labels and documentation.
This chapter describes how diagrams can be translated into other languages. This is
especially useful when multiple people are involved on the translation, each translated into one language. Later in this chapter, you will learn how to translate a diagram in different languages at the same time.
The following example shows a translation from English to German:
1. First, select which language you want to translate. Proceed as explained
above. Elements that were not yet translated are highlighted in red.
2. Double-click an element to define its label.
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3. Click somewhere on the canvas to accept the new label. The translation will
now be stored in the attribute panel on the right.

4. In the attribute panel, you can also add documentation in the current language.
Translate the remaining diagram elements in the same way. After saving the diagram, it will be accessible in all languages of the workspace.

9.9.3 Translating diagrams into multiple languages at the same time
Sometimes, a modeler might want to define a diagram in multiple languages while
modeling the diagram. In this case, it is recommended to have the required languages set available while modeling.
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1. Add languages to the diagram via the language tool of the Editor toolbar.

2. Select all the languages you want to work with in your diagram. They will
appear in the attribute panel on the right hand side.

3. Now you translate diagram elements into the desired languages simultaneously in the attribute panel by simply entering the translations into the
corresponding columns and lines.
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4. To view the result in the other languages, switch the display language on the
flag icon in the toolbar.

9.9.4 Migrating diagrams to a different language
You can migrate the contents of a digram from one language to another. This is
especially helpful when switching between dialects of a specific language (for
example, British English to American/Canadian English). or if the diagram was created in the wrong language and you want to correct this.
When opening a diagram, the system will ask you for the diagram language if no default is defined.
To migrate a diagram into another language, proceed as follows:
1. Click the flag symbol , then Migrate diagram to a different language in the
top toolbar on the right. The corresponding dialog box opens.

2. Now choose the source and the target language for the migration. You can
choose between all languages that are defined for the workspace.
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3. Optionally, you can delete information in the source language. Activate the
checkbox Delete original texts to do so.
4. Click OK. A confirmation prompt is displayed.

5. Click Yes to confirm.
In this example a diagram was created without language definitions. The content
was defined in German. As the workspaces' default language is English, the diagram
was configured to be in English when the language tools were activated. The content is now supposed to be migrated from German to English and the German contents are supposed to be removed.

9.9.5 Translating diagram, folder and file names
Please keep in mind that translations that you make within the framework of this feature are only visible in Collaboration Hub.
1. Select the the name of a diagram, folder or file name you want to translate in
the Explorer.
2. Open the Edit menu and click Change name/description (for files and folders)
or Rename (for diagrams).

Version 14.9

329

9 Collaboration

3. Now you can add translations of the name in all available languages.

4. Click Change name/description respectively Rename to save your settings.
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9.10 Executing processes in Workflow Accelerator
Workflow Accelerator is a workflow execution platform targeted at business users who want to perform intuitive and professional automation
of personalized processes. To make use of the Workflow Accelerator
integration, you need to have purchased Workflow Accelerator licenses.
For more information, contact sales@signavio.com.
To switch from the Signavio Explorer to your task list in Workflow Accelerator, click
Workflow Accelerator - Open workflows in Workflow Accelerator:

Open your task list in Workflow Accelerator.

If the process has not been deployed to Workflow Accelerator and you are the workspace owner, you can deploy the process (see section Process deployment ).
For more information about process execution, please refer to the Workflow Accelerator User Guide.

9.11 Working with approval workflows
Please note that the installation of Workflow Accelerator is mandatory
in addition to Signavio Process Manager. The approval workflow functionality can only be activated if Workflow Accelerator was successfully
installed. Please follow the instructions in the Workflow Accelerator
administrators manual.
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Approval workflows enable you to control validation of diagrams before publishing.
Approval workflows ensure that decision makers and/or BPM experts review and
approve the quality and factual correctness of a diagram before it is published in
the Collaboration Hub or deployed to a workflow execution system, like Signavio
Workflow Accelerator .
Approval workflows make sure that diagrams have been approved by a list of users
before they are published in the Collaboration Hub .
Approval workflows can be configured to automatically publish an approved diagram
to Collaboration Hub, or to send rejected diagrams back for editing. In the Explorer,
a rejected diagram is marked with a red X, an approved diagram with a green check
mark and a published diagram with a globe icon.
If you want to configure approval workflows, read more at Managing approval
workflows and contact your workspace administrator to receive the corresponding
license.
Workflow Accelerator is much more than just a tool to execute diagram
approvals. You can automate all kinds of other processes as well. If you
are interested in a Workflow Accelerator subscription, contact
sales@signavio.com.

9.11.1 Start an approval workflow
In this section, you will learn how to start an approval workflow for diagrams.
You can start approval workflows for diagrams of all types.
1. To start an approval workflow, select the diagram you want to have approved
in the Explorer.

Version 14.9

332

9 Collaboration

2. In the menu bar select Share and then Start approval workflow. The corresponding dialog box will open.

3. Click the link to open the workflow instance in Workflow Accelerator.

Sample: Jane Doe needs to approve the diagram.
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4. In case there is more than one approval workflow for your workspace, select
the approval workflow you want to start from the dropdown menu and then
click Start.

5. You receive a message that the approval workflow has been started successfully. This hint dialog also contains a link to the appropriate workflow
instance.

If the diagram is approved, you can see that the approval status of the diagram has
been updated in the Explorer.

9.11.2 Processing an approval task
This section describes how you work as a recipient of an approval workflow task.
As soon as a modeler requests an approval from you, you will receive an email with
a link to the case in Workflow Accelerator.
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1. Click the link to open the approval task. The approval task opens in Workflow
Accelerator.

2. Check whether the corresponding diagram fulfills your requirements.
3. Click the Show comments link to open the diagram in Signavio's commenting
view.
4. Click the Compare revisions link to get a better overview over recent
changes via the Comparing revisions tool.
5. Open the Explorer to access further functions:

o

To open the diagram again, double-click it or select it and click Show comments, then Compare revisions/diagrams.
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o

To check whether a diagram complies with modeling conventions, select
Modeling conventions (XLSX) .
The report is especially helpful when you conduct a formal approval with
focus on BPMN quality.

o

o

o

To point a colleague to a diagram, select the diagram you want to share
and select Invite to Collaboration Hub.
Start approval workflow triggers a new approval workflow case for the
selected diagram.
To get an overview of all pending approval workflows, you can either click
Show started approval WFs or Open approval task list in the upper panel.
Show started approval WFs provides a basic overview in the Signavio
Explorer, whereas Open approval task list opens a more detailed, filterable view in Workflow Accelerator.

6. Once you have finished the review, go back to the approval case in Workflow
Accelerator to approve or reject the change.
In the Explorer, a rejected diagram is marked with a red X , an approved diagram with a green check mark , and a published diagram with a globe icon:

A rejected diagram is marked with a red X, an approved diagram with a green check mark
and a published diagram with a globe symbol.
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9.11.3 Processing open approval tasks
1. In the menu bar, select Share and then Open approval task list .
You will be redirected to your Workflow Accelerator workspace. Here you can
see your tasks:

2. Click a task to open it.
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3. Click the corresponding buttons to complete the task.

4. In the menu bar, select Share , then Show started approval WFs . A dialog
with an overview of running (and completed) approval workflows opens.
o

o

o

If you have selected a diagram before opening the dialog, all approval workflows for this diagram will be displayed.
If you have selected a folder, all approval workflows for diagrams in the
selected folder will be displayed.
If you haven't selected anything, all approval workflows of the folder that
is open will be displayed.

5. Optionally, you can activate the check box Show completed approval workflows to include completed workflows in the list.
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The entries are sorted by creation date. Approval requests that are in progress are shown first, followed by completed approval requests.
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10 Creating reports
Process Manager allows you to create various customizable reports in the form of
spreadsheets or as PDF files. This enables business users to analyze your process
hierarchy offline, and in formats decision makers and analysts are already familiar
with. The standard reports that are accessible via the Explorer's Reporting dropdown menu cover most business use cases. If you require a special kind of report
that is not provided by the tool, you can ask one of your workspace administrators
to create a custom template.

The reporting menu

Many of the reports access default dictionary categories during the generation process. In case you suspect that your dictionary configuration
causes problems during the generation of a report, take a look at the section Defining custom categories for dictionary entries.

10.1 Process documentation and templates
It is possible to export process documentation documents as PDF and Microsoft
Word files. Process documentation documents are comprehensive documents that
contain both diagram graphics as well as relevant diagram attributes, such as
description and responsibilities.
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As a workspace administrator, you can create individual templates for process documentation reports. A guide on how to create new templates can be found in the
corresponding chapter of this manual. Once created, a custom template can then be
selected during the creation of a process documentation report.
Read more about:
o
o

Generating process documentation reports
Creating and managing process documentation templates

10.2 Analysis
Signavio Process Manager provides a possibility to set key performance indicators
(KPI) in event-driven process chains (EPC) and BPMN 2.0 process diagrams, which
allows detailed process analyses.
Read more about:
o
o
o

Creating quantitative process analysis reports
Creating process cost analysis reports
Creating resource consumption analysis reports

Furthermore, qualitative reports can be created for BPMN 2.0 diagrams and EPC:
o
o
o
o
o
o

Generating responsibility handovers matrices
Generating IT system usage matrices
Generating job profile reports
Generating risks management reports
Generating modeling convention reports
Generating document usage matrices

10.3 Process model metric and process characteristics
A process model metric contains information about the usage of diagram element
types and can be created for any diagram type:
o

Generating process model metrics

To create a summary of element details that are used in your BPMN 2.0 or EPC diagrams, read the following chapter:
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o

Generating process characteristics reports

10.4 User and group assignment
Workspace administrators can create reports that list for each user the groups the
user is a member of:
o

Generating user group reports

10.5 Governance report
Workspace administrators can access usage data of your workspace with the governance report. For example, you can see at a glance how many process models
have been created.
o

Viewing governance reports

10.6 Generating process documentation reports
Process Manager allows you to generate process documentation reports. These
reports are comprehensive documents that contain all your diagrams, including all
element descriptions and dictionary entries.
You can generate these reports as either PDFs or Microsoft Word documents.
To generate a process report, follow these steps:
o

Click Process Documentation (PDF) or Process Documentation (Word) in the
Reporting menu of the Explorer's top drop-down menu.

o

A configuration wizard appears, where you can select the diagrams that are
to be included in the process documentation:

Change the diagram selection
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o

Select the diagrams that should be included in the process documentation:

Select the diagrams you want to include in the process documentation
o

It is also possible to use a filtering functionality to select diagrams. Click
Add filter to open the corresponding dialog:

Add a filter to find diagrams faster

The example below creates a filter for Business Process Diagrams that are
stored in the folder Shared documents and have the word "supply" in their
title.
Choose the folder "Shared documents" from the upper drop down list. Tick Diagram type and select Business Process Diagram (BPMN 2.0) from the drop
down list on the right ( Diagram type equals Business Process Diagram
(BPMN 2.0) ). To filter for the word "supply" in the diagram title, tick Name
and type in a search term, e.g. supply on the right:
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Adjust the filter
o

o

Click OK . Diagrams that are found in the filter will be selected for the process
documentation report.
Select whether diagrams that are linked in the chosen diagrams shall be
included. By default, no additional diagrams will be included. If Linked subprocesses of the first level is chosen, only those diagrams connected directly to
those selected before will be included in the documentation, whereas Linked subprocesses of all levels includes all reachable diagrams.

In this case, every linked subprocess is supposed to be exported
o

Click Define Export options .

o

A second page appears where you can configure the documentation.
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o

Choose a template. If you already created process documentation templates , those can be used when generating a process documentation.
Otherwise, the Signavio Template is selected by default.

Selecting a template for the report

The template Signavio matches the default process documentation
template that was included in newly created workspace until version 5.1 of Signavio Process Manager.
o

Choose the template language (only if multiple languages are defined for
your workspace)
The chosen language will be applied to the process documentation template as well as the diagrams that are included in the export.

Choose a template language
o

Configure diagram information
You can now enter information about the diagram, e.g. the author or
organization. In the Enterprise edition, it is also possible to remove the
Signavio logos:
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An example configuration

The option "Remove Signavio logos" is deactivated for customized
templates. Instead, the headers of customized templates can be
configured when editing the templates .
o

Click Generate documentation and the PDF or Word file will be generated. If you
are exporting less than 20 diagrams, this should only take a few seconds. If you
are exporting a larger group of diagrams, this might take more than a minute.
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o

(For Microsoft Word documents only) A dialog window indicating that the
table of contents will not be up-to-date when opening the generated document appears. Click OK and follow the steps described below after the export
finished.

A dialog informs you that the table of contents must be updated in the Microsoft Word document

10.6.1 Updating the Table of Contents in Microsoft Word
The table of contents (page 2) in the generated report needs to be updated manually.

An example of a table of contents

Due to hidden action fields, the page numbers have to be updated by selecting the
whole table of contents and pushing the F9 button.
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Select the whole content table

Alternatively, the action fields can be updated one-by-one by right-clicking them
and selecting Update Field .

Select 'Update Field' from the context menu

10.7 Generating responsibility handovers matrices
If there are different roles or organizations participating in one process, the process
flow will be handed over from one participant to another at well-defined places.
Those roles are represented as pools and lanes in BPMN 2.0 process diagrams.
Event-driven process chains (EPC) use attached roles, positions and organizations.

Version 14.9

348

10 Creating reports

Handover of responsibilities in a BPMN diagram

However, a responsibility handover can be either a sequence or an information
flow.
The functionality described here creates an XLS file for each diagram that is
included in the report. The responsibility handovers matrix calculation considers
pools and lanes and, in case of EPC, attached roles, as well as links to organizational dictionary entries.
This section explains how to generate a responsibility handovers matrix for a BPMN
2.0 process diagram. However, the process is the same with EPC.
o

(optional) Select a diagram

o

Click Reporting , then Responsibility handovers matrix (XLS) in the top
drop-down menu.
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Create a responsibility handovers matrix
o

The the system opens the Responsibility handovers matrix (XLS) dialog.

o

If a diagram was selected during step one, it will already be selected. You can
also select additional diagrams to be included.
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Start the analysis
o

Click Start analysis .

o

Open the new document. An assignment matrix will be shown, displaying who
hands over which responsibilities to whom.

An example of a responsibility handovers matrix

If custom attributes linking to organizational dictionary entries were
defined, those will be included in the calculation as well.

Version 14.9

351

10 Creating reports

10.8 Generating IT system usage matrices
BPMN 2.0 process diagrams and event-driven process chains provide the possibility
to attach IT systems to a task. With BPMN, those IT systems can be tagged as an
input or output.
The IT system usage matrices report creates an assignment matrix that shows
which IT systems data is read from during an activity, and which IT system data is
written to. You can choose whether the assignments refer to roles or diagrams. The
functionality also includes IT systems that were linked as dictionary entries from a
custom defined attribute.
This article explains how to generate an IT system usage matrix for a BPMN 2.0 process diagram. However, those steps will work with EPC diagrams as well.
1. Select a diagram (optional).
2. Click Reporting and choose IT system usage matrix (by diagrams) (XLS) or IT
system usage matrix (by roles) (XLS) .

3. The IT system usage dialog opens.
4. If a diagram was selected during step 1, it will be selected in this dialog, too. It
is now possible to extend or change the selection.
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5. Click Start analysis .
6. Open the created document e.g. with Microsoft Excel. The IT systems will be
highlighted in red.
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An example of an IT systems usage report
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An example of an IT systems usage report (roles)

If custom attributes linking to organizational dictionary entries were
defined, those will also be included in the calculation.

10.9 Generating job profile reports
Signavio Process Manager enables you to automatically create job profiles based
on your documented process landscape. Job profile reports allow you to view all
activities that an organizational role is involved in at one glance.
In contrast to the diagram-centered RACI report, the job profile report creates a
role-specific matrix over all workspace diagrams with the click of a button. To cre-
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ate a job profile, select the corresponding role in the Signavio dictionary and click
Import/Export , then Export Job Profile Report in the top drop-down menu of the
dictionary:

Create a job profile report.

A spreadsheet (.XLS) file can be downloaded.
The file contains a responsibility assignment (RACI) matrix of the selected role over
all processes in your workspace:

A job profile report.

10.10 Generating risks management reports
This feature is available in the Enterprise Edition .
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With Process Manager's integrated risk management feature, process modelers
now have the ability to define risks and controls directly at any step of a process
within the process model. These risks and controls can be defined and then associated with the corresponding activities.
To obtain an overview of potential risks and related controls, an automatic report
can be generated. This report summarizes all information about the risks and controls in the selected process models.
To generate the report, click Reporting , then Risks & controls report in the top
drop-down menu in the Explorer.

Select the diagrams you want to include. Expand the selection menu Show additional attributes in the report to select additional attributes that the report should
include along with the risk management attributes.
It is not possible to include table attributes. You cannot select risk management attributes on diagram level as the report includes them by
default.
Then, click Start analysis :
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Configure the risk management report

An Excel sheet (.xls) will be generated:

A risks and controls report

10.11 Generating modeling convention reports
In addition to the checks in the Editor, a modeling convention Excel report--containing details of one or multiple processes--can be created in the Explorer.
To create an Excel report, click Reporting then Modeling conventions (XLSX) in
the Explorer's top drop-down menu:
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Create a modeling conventions report.

Now select the diagram(s) and modeling convention you want to include:

Select the diagram(s) and the convention for the report
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Click Start analysis . An Excel spreadsheet containing information about violations
of modeling conventions will be generated:

An example of a modeling convention report.

10.12 Generating document usage matrices
Data objects can be attached to an activity in BPMN 2.0 and denoted as input or
output. In EPCs, documents can be attached to functions. The Document usage
report creates an XLS file for one or many diagrams describing the assignment of
documents to tasks. Moreover, linked dictionary entries representing a document
are included in the report.
If custom attributes that link to dictionary entries representing documents are defined, those will also be included in the calculation.
This section explains how to generate a document usage matrix for a BPMN 2.0 process diagram. The steps will work with EPC as well.
o

(optional) Select a diagram

o

Click Reporting and click Document usage matrix (XLS) :
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Click 'Document usage matrix (XLS)'
o

The Document usage dialog opens.

o

If you selected a diagram during step 1, this is selected by default. If you want
to include other diagrams into the report, it is possible to select them here.
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Trigger the export of the report.
o

Click Start analysis .

o

Open the generated document (in this example, using Microsoft Excel). Documents will be highlighted with a red background.
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This is what a document usage matrix could look like.

Documents that were attached to an element as a BPMN attribute can
be either 'Input' or 'Output' documents and will be marked accordingly.
For EPC, an information flow can be directed using the Information
Flow attribute.

10.13 Generating process characteristics reports
Process characteristics reports are available for the following diagram
types:
o
o
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o
o
o
o

ArchiMate
EPC
Value chain
Organization chart

Process characteristics reports are spreadsheets (.XLS files) that contain an overview of elements and attribute values that are found in the selected diagram(s).
Attributes without values are not listed in the report.
To create process characteristics follow these steps:
1. Open the Explorer and click Reporting , then Process characteristics with element details (XLS) :

Opening the process characteristics export dialog

2. Now, you can redefine the diagram selection. Click Export options to configure which elements and attributes you want to include in the report:
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Configuring export options

3. Click Start analysis to generate and download the report.

An example process characteristics report

10.14 Generating process model metrics
With process model metrics it is possible to generate statistics for your diagrams.
These statistics include:
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o
o
o
o
o
o
o

o
o
o
o

the diagram type
the number of elements in the diagram
the number of connectors in the diagram
the number of gateways and their type in the diagram
the number of subprocesses linked from and processed linking to the diagram
the number of dictionary links (including links in custom attributes)
the number of process elements that are not assigned to a person, role or organization
the number of responsibility handovers
the publishing state
the date of the last editing
the path to the diagram

This chapter explains how to generate a process model metric for a BPMN 2.0 process diagram. These steps will work with EPC as well.
o
o

(optional) Select a diagram.
Click Reporting and Process model metrics (XLS) in the top drop-down menu.

The menu entry for creating process model metrics
o
o

The Process model metrics dialog opens up.
If a diagram was selected during step 1, it will now be selected by default. It is
possible to change or extend that selection here.
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Start the analysis
o
o

Click Start analysis .
Open the generated document.

An example process model metric

10.15 Creating quantitative process analysis reports
Process Manager enables you to run quantitative analyses of your processes. After
setting KPI on diagram elements, process cost analyses and resource consumption
analyses can be created for BPMN 2.0 process diagrams and event-driven process
chains (EPC).
A process cost analysis assigns process costs to processes and tasks and lists
them in cost centers. Based on the key process indicators set, the tool creates a
table that shows costs for certain tasks and named cost centers.
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The resource consumption analysis allows for the computing of time consumption
per task or process.
Both analyses consider the execution probability and frequency before computing
the actual resource consumption or costs.
To learn more about this procedure, see the chapters Setting key performance
indicators (KPIs), Creating resource consumption analysis reports and Creating
process cost analysis reports .

Create a quantitative process analysis report

10.16 Creating process cost analysis reports
This feature is available in the Enterprise Edition.
Process cost analysis reports show the computing costs that arise in a process.
They display the costs, tasks, and cost centers in a table.
To create a process cost analysis for one or multiple diagrams, follow these steps:
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o
o

Click Reporting in the upper drop-down menu.
Click Process cost analysis (XLS).

The menu entry for exporting a process cost analysis
o

The Quantitative analysis dialog opens. Here you can select a diagram for analysis:
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Choosing diagrams for the report
o

Click Next.

o

Now you can set the analysis options:
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Setting the options for the report

Process cost analysis is already selected. To also include linked subprocesses
into the calculation, tick Include subprocesses in calculation on the bottom
of the dialog. If tasks have been embedded in lanes, the element Additional
participant was used (BPMN) or an organization was attached to a function
(EPC), the resource consumption can also be included into the cost analysis
calculation. Enable it by ticking the box use resource consumption attributes
for the calculation (if provided).

Include or exclude resource consumption information in the report
o

If this possibility is enabled, the next dialog lets you determine the resources'
costs:
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Start the calculation
o

Click Start Calculation. If the diagram contains any structural or logical mistakes,
the system will inform you about that.

o

Click Start Calculation. If the diagram contains any structural or logical mistakes, the system will inform you about that. If errors occur, the program will
ask you to go back to check the diagram in the Editor. Click Open diagram to
do so and check the steps described at the beginning of this section:

If the diagram's syntax is not valid, an error is displayed

Version 14.9

372

10 Creating reports

If there are no errors, an XLS file will be generated. Click the link to open or save
the file.
The file contains the analysis. The values are based on functions, so changing one
value may change the values in other fields accordingly.
If multiple diagrams were included in the report, one new tab will be created for
each diagram in the Microsoft Excel file. An additional tab will be created as a front
page that shows the data for the processes.

10.17 Creating resource consumption analysis reports
This feature is available in the Enterprise Edition.
A resource consumption analysis allows for the calculating of time consumed in a
process or a task. It can help you find complex and time consuming tasks and plot
out the resource consumption of process participants.
To create a resource consumption analysis for one or multiple diagrams, follow
these steps:
o
o
o

Select the diagram in the Explorer.
Click Reporting in the upper drop-down menu.
Click Resource consumption analysis (XLS).
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The menu entry for exporting a Resource consumption analysis
o

The Quantitative analysis dialog opens. At first, you can adjust the diagram selection:

Select the diagrams to be included in the report
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o
o

Click Next.
You can now choose the analysis options:

Configure report options

Resource consumption analysis is already selected. To also include linked subprocesses in the calculation, select Include subprocesses in calculation.
o

You can now add more information about the processes:
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Personal allowance describes the delay during the execution that happens for personal reasons (breaks etc.). Technical allowance describes delays that happen for
technical reasons (e.g. starting software, etc.). Based on the attributes Nominal
value of work days / year and Nominal value of work hours / day, the full-time
units are calculated.
You can also configure if the allowances and nominal values are supposed to be
kept for the next analysis.
o

Click Start Calculation. If the diagram contains any structural or logical mistakes,
the system will inform you about that. If errors occur, the program will ask you
to go back to check the diagram in the Editor. Click Open diagram to do so and
check the steps described at the beginning of this section:

Version 14.9

376

10 Creating reports

An error message is displayed if there are syntax errors in the included diagrams.

If there are no errors, an XLS file will be generated. Open it with a program such as
Microsoft Excel. Click the link to open or save the file.
This file contains the analysis. The values are based on functions, so changing one
value may change the values in other fields accordingly.
If multiple diagrams were included in the report, one new tab will be created for
each diagram in the Excel file. An additional tab will be created as a front page that
shows the data for the processes.

10.18 Generating user group reports
To generate a user group report, you need to have workspace administration privileges.
The user group report lists which group each user is included in.
To generate the report, open the Explorer and click Reporting, then User
group/assignment:
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Generate a user group report

Now, your browser downloads the report as an .xls file.
For each user, the report annotates all user groups the user is a member of as a direct member. User groups that contain other user groups the user is a member of
are annotated as indirect member:

A user group report
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10.19 Viewing governance reports
The feature "Governance report" is available only for users with the
Enterprise Edition. To access the governance report, you also need
administration rights for the workspace.
The governance report provides an overview of the user activity in your workspace.
Here, you can get aggregate metrics (for example, the number of unpublished diagrams) that you can use to draw conclusions regarding the success of your process
modeling initiative.
1. Open the Explorer and click under Reporting the menu entry Governance
report.

Generating a governance report

2. The Governance report dialog opens. Each tile in the dialog displays a different usage metric.
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The 'Governance report' dialog

3. Click the tile with the desired value to access detailed information--for
example, diagrams marked "Not published".
4. In a new browser tab, the results list of an advanced search with the filter
"publication state is not published " is displayed. All models with the corresponding publication status are listed here.

Detailed information of a governance report
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10.19.1 The governance report's usage metrics
The aggregates in the governance reports also consider diagrams you
don't have permission to access. Your current access rights are taken
into account for the linked search.
In the overview, the following usage metrics are available:
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Data

Description

The total number of diagrams in your workspace is shown in
brackets.
Diagrams

The number of diagrams grouped by publishing state and
type (value chain, organization chart, etc.) is shown in the
respective tile.
The total number of existing comments is shown in brackets.

Comments

The number of comments grouped by commenting state is
shown in the respective tile.
The total number of existing dictionary items is shown in
brackets.

Dictionary
items

The number of dictionary items grouped by publishing state
and dictionary category type (events, requirements, etc.) is
shown in the respective tile.
The total number of existing files is shown in brackets.

Files

The number of file grouped by publishing state and the type
(.PDF, .JPG, etc.) is shown in the respective tile.
The number of Page visits represent a single user opening
any published object (diagram, file, or Dictionary item) in the
Collaboration Hub. Every time someone opens one of these
items in Collaboration Hub, it is counted as a view and will be
shown in the report--it does not matter how it is accessed.
Time ranges are based on calendar month and year, starting
from the 1st day of the previous month at 00:00:00 and counting up until the last day of the current month at 23:59:59.

Collaboration
Times are based on local server time. On the EU server, it is in
Hub

CEST, on the US server it is in EST and on the Australian
server it is in AEST.
Unique users refers to the total amount of visitors to Collaboration Hub in the given time span. It will only be displayed
once more than 10 users have accessed Collaboration Hub,
due to data protection. If a single user visits Collaboration
Hub several times in the given time span, only their first visit
is reflected in the unique users count.
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11 Exporting
In this section, it is described how to share diagrams and dictionary entries using
the export functions:
o

Export a diagram to PDF

o

Export a diagram as an image

o

Export a diagram to a Signavio archive (SGX)

o

Export a BPMN diagram to XML

o

Export a diagram to XML

o

Export a DMN diagram to XML

o

Exporting DMN diagrams as drools rules

o

Exporting diagrams to Red Hat Decision Manager projects on GitHub

o

Export dictionary entries

For the import functions, read more in section Importing/exporting diagrams and
uploading files.

11.1 Export dictionary entries
You can export dictionary entries to an Excel file, for example to print them, for offline review, or for further processing in third-party systems.
To export the entire dictionary, follow these steps:
1. In the explorer, open the dictionary.
2. Click Import / Export > Export Excel. The option Export the entire dictionary
is selected by default.

3. If multiple languages are set up for the workspace, select the language for the
export.

For each language, you must run an individual export.
4. Click Export Excel.
The dictionary entries are exported. The file is saved to your browser's download folder.
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To export specific dictionary entries, follow these steps:
1. Before you start the export, select the entries you want to export in the dictionary

You can export the following entry sets:
o

All entries of the category you select.

o

All entries in a category that begin with a specific letter.

o

All entries that are returned by a search.

2. Click Import / Export > Export Excel.
3. Select an export option. It depends on your previous selection which option is
available:
o

Export the entire dictionary

o

Export entries with the selected initial in the current category

o

Export the current category

o

Export the current search result

4. If multiple languages are set up for the workspace, select the language for the
export.

For each language, you must run an individual export.
5. Click Export Excel.
The dictionary entries are exported. The file is saved to your browser's download folder.
If you want to import dictionary entries from an Excel file to your workspace, read
more in section Import dictionary entries.

11.2 Export a diagram to PDF
With this function, you can export a diagram as a PDF file from the explorer.
You can either select a single diagram for export, or a folder. When selecting a
folder, all diagrams contained are combined into one PDF document.
To export diagrams, follow these steps:
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1. In the explorer, select the diagram or the folder you want to export.
You can change your selection via the export options described below.
2. In the toolbar, click Import / Export > Export PDF.
The export configuration dialog opens.
3. Configure the export. Read more in section Export options.
4. If you want to save your export configuration as default for your workspace,
enable Save as defaults at the bottom of the dialog.

o

o

You need an administrator account to have this option available.
The export configuration is only saved when you export a PDF.
If you cancel the export, your settings aren't saved.

5. Click Export.
The PDF is exported. The file is saved to your browser's download folder.
To export a diagram to PDF from the editor, use the print function in the toolbar.
Read more in section Editor toolbar and keyboard shortcuts .

11.2.1 Export options
In the General section, the following options are available:
o

Language
If multiple languages are set up for the workspace, select the language for the
diagram you want to export.

o

Print in black and white
Specify whether to print the diagram in color or black and white.

o

Show additional information
Enable this option if you want to add printing attributes to the PDF document,
for example the author, creation date, or page number. You can also add diagram attributes.
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The preview area shows how many attributes you can add and where they are
positioned.
To add diagram attributes, click Own attribute and select up to 3 diagram
attributes for each attribute position.
o

Paper size
Select a paper size for your PDF. The default is set to the international standard size A4.

o

Stretch small diagrams to whole page
Specify whether small diagrams are enlarged to fit the full page.

In the Logo section, the following options are available:
o

Logo
Add a custom logo. You can upload a new file or choose an image that already
exists in your workspace. The maximum size for a logo file is 5 MB.

o

Use original size
Specify whether to use the original size of the image file.

In the Orientation section, the following options are available:
o

Landscape or Portrait
For the PDF pages, select landscape orientation or portrait orientation.

o

Diagram rotation
Specify whether the diagram rotation is managed automatically or not.
With Automatic, the internal diagram rotation is used.
With Always, the diagram rotation you choose below is used.
With Never, the diagram isn't rotated.

o

Diagram orientation
If you've selected Always for the diagram rotation above, select whether to
rotate the diagram clockwise or counterclockwise.

In the Distribution section, the following options are available:
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o

Single page or Multiple pages
Specify whether to have the diagram fitted to one page or, if necessary distributed over several pages.
For printing on multiple pages, the diagram size and width will be automatically adjusted to the paper size.

In the Attribute visualization section, the following options are available:
o

Rule sets
Select which attributes should be visible.

o

Risks and controls
Specify whether to show the configured attributes for risks and controls.

o

Show attachment icon
Specify whether to mark attachments by adding a paper clip icon.

In the Selected diagrams section, the following option is available:
o

Click Configure to add diagrams to your export or remove them.

o

If different views exist for the diagram, click Select a view to select the view
you want to export. By default, the original view is selected.

11.3 Export a diagram as an image
In the explorer, there are two export functions that transform diagrams into
images: The PNG export creates pixel graphics, the SVG export creates vector graphics.
To export diagrams, follow these steps:
1. In the explorer, select the diagram you want to export.
2. In the toolbar, click Import / Export > Export PNG (pixel graphics) or Import
/ Export > Export SVG (vector graphics).
The export configuration dialog opens.
3. Configure the export. Read more in section Export options.
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4. Click Export.
The image is exported. The file is saved to your browser's download folder.
If you want to embed the image of a diagram in web pages, which means the image
updates automatically with each change on the diagram, read more in section
Embed a diagram as an image.

11.3.1 Export options
In the export configuration dialog, the following options are available:
o

Language
If multiple languages are set up for the workspace, select the language for the
diagram you want to export.

o

If different views exist for the diagram, select the view you want to export. By
default, the original view is selected.

11.4 Export a diagram to a Signavio archive (SGX)
With this function, you can export one or more diagrams to a Signavio archive from
the explorer.
Signavio archives, SGX files, allow you to exchange diagrams and folders between
workspaces. SGX is a Signavio-specific file format, which can't be used by thirdparty systems.
We recommend to use the SGX export only to exchange diagrams between different
workspaces. If users are registered in the same workspace, use the shared documents folder and collaboration functions to work together on diagrams. Read more
in Working with folders and diagrams and Collaboration.
To export diagrams, follow these steps:
1. In the explorer, select the diagram or folder you want to export.
2. In the toolbar, click Import / Export > Export Signavio archive (SGX).
The export configuration dialog opens.
3. Select more diagrams or folders if you want.
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4. Specify whether to export the latest or all revisions of diagrams with Export
only the latest revision of each diagram.

5. Click Export.
Your selection is exported. The file is saved to your browser's download folder.

11.5 Export a BPMN diagram to XML
With this function, you can export a BPMN 2.0 diagram to an XML file from the
explorer.
The BPMN 2.0 standard includes an XML notation which enables the platform-independent exchange of BPMN 2.0 diagrams. For more information about this XML
standard or the BPMN 2.0 specifications, go to http://www.bpmn.org.
You can export the following diagram types to BPMN 2.0 XML:
o

business process diagrams (BPMN 2.0)

o

conversation diagrams (BPMN 2.0)

o

choreography diagrams (BPMN 2.0)

If you want to export diagrams of other modeling notations, use the XML export as
described in section Export a diagram to XML.
To export diagrams, follow these steps:
1. In the explorer, select the diagram you want to export.
2. In the toolbar, click Import / Export > Export BPMN 2.0 XML.
The export configuration dialog opens.
3. Configure the export. Read more in section Export options.
4. Click Export.
The XML file is exported. The file is saved to your browser's download folder.

11.5.1 Export options
In the export configuration dialog, the following options are available:
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o

Language
If multiple languages are set up for the workspace, select the language for the
diagram you want to export.

o

Include linked subprocesses
Specify whether to also export linked subprocesses.

o

If different views exist for the diagram, select the view you want to export. By
default, the original view is selected.

11.6 Export a DMN diagram to XML
With this function, you can export a DMN 1.1 diagram to an XML file from the
explorer.
The DMN 1.1 standard includes an XML notation which enables the platform-independent exchange of DMN 1.1 diagrams. For more information about this XML
standard or the DMN 1.1 specifications, go to http://www.omg.org/spec/DMN/.
The file extension is DMN.
To export diagrams, follow these steps:
1. In the explorer, select the diagram you want to export.
2. In the toolbar, click Import / Export > Export DMN 1.1 XML.
The export file is created and prepared for download.
3. Download the export file by clicking the link Click here to download the XML
file.

The file is saved to your browser's download folder.
4. Click OK.
The export is complete.

11.7 Exporting DMN diagrams as drools rules
Signavio Process manager enables you to model decision logic with the easy-to-use
Editor and to subsequently export DMN diagrams as DRL files to transfer them into
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the open source business rules management solution Drools
(http://www.drools.org/). Thus, you can easily transfer DMN diagrams into automated business logic.
You can either export multiple diagrams, one diagram, or just one decision table and
its sub-decisions. The Signavio Drools export supports four different export types:
Production , Development , Test , and Cases . In contrast to the Production , Development adds additional comments and logging behavior.
You can select which diagram revision to export.
Permissions for the Drools export can be limited to users of specific user groups.
In order to export decision logic to Drools, open the Explorer. Select one or multiple
diagrams and go to Import/Export , then Export Drools:

Select one or multiple diagrams and go to 'Import/Export', then 'Export Drools'.

Now you can adjust your selection and set the following export properties:

Version 14.9

392

11 Exporting

o

Export revision
You can choose whether to export the latest revision of the diagram that has
been saved in the Editor or the latest revision that was published in Collaboration Hub.

o

Export mode
o

The option Production mode exports the decision logic to drools. It does
not include comprehensive comments, support for detailed logging, and

o
o

test cases.
Development mode provides additional comments and logging behavior.

Development mode + test cases provides additional test cases in the form
of .csv files (one .csv file for each top level decision). The .csv files contain
all combinations of all relevant sub-decisions.

In the export dialog, you can configure the export options in detail.

Click Export to trigger the export process.
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Alternatively, you can export a decision table and its sub-decisions directly from
the Editor.
In the Editor, open a decision table and click Import/Export in the top-right corner
of the dialog. There you can chose between generating the Drools export or the test
cases (as described above):

Click 'Import/Export' in the decision table dialog.

Before starting the export, you can choose whether to include related sub-decisions
(if applicable):

Choose if you want to include related sub-decisions.

As soon as the files are generated, you can download them in you browser:

11.8 Export a diagram to XML
With this function, you can export a diagram to an XML file from the explorer, for
example for further processing in third-party systems.
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Use this export for diagrams of any modeling notation, except for BPMN
2.0 diagrams. If you want to export BPMN 2.0 diagrams, use the BPMN
2.0 XML export as described in section Export a BPMN diagram to XML.
The Signavio-specific XML format produced by this export is a special form of RDF,
the Resource Description Framework which is used for conceptual description or
modeling of information that is implemented in web resources. You can use XML
transformation tools to generate other XML formats from the export file.
To export diagrams, follow these steps:
1. In the explorer, select the diagram you want to export.
2. In the toolbar, click Import / Export > Export XML.
The XML is exported. The file is saved to your browser's download folder.

11.9 Exporting diagrams to Red Hat Decision Manager
projects on GitHub
This feature is available in the Enterprise Edition .
Signavio allows you to export process and decision models directly to Red Hat
Decision Manager projects at GitHub. Like this, you can seamlessly integrate diagrams that have been modeled with Signavio into your Red Hat Decision Manager
projects.
Process models are exported and uploaded as BPMN 2.0 XML files and all linked
decision models are exported and uploaded as DRL files.
To start an export, select a BPMN diagram in the Signavio Explorer and click
Import/Export - Export RedHat files to GitHub:
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Open the Red Hat Decision Manager export dialog.

You need to select exactly one diagram. The export will include all linked
DMN and BPMN diagrams.
In case you haven't configured the GitHub integration, yet, you need to authorize
Signavio to push to your GitHub repositories.
Otherwise, proceed at section Pushing diagrams to Red Hat Decision Manager
projects.
Now, click Authorize .

Click 'Authorize'.
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You will be forwarded to GitHub, where you need to grant Signavio permission to
push to your repositories:

Authorize Signavio to push to your GitHub repositories.

Re-enter your password to confirm. Upon successful authorization, the following
page will be displayed:

You successfully authorized Signavio to push to your repositories.

Now you can go back to the Signavio Explorer and export the diagram(s) to GitHub.

11.9.1 Pushing diagrams to Red Hat Decision Manager projects
As described above, to start an export, select a BPMN diagram in the Signavio
Explorer and click Import/Export - Export RedHat files to GitHub .
Now, configure the following parameters:
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o
o
o

The repository you want to push to
The project path (within the repository)
The name of the Java package that will be created

Click Upload to push the files to your repository:

The files are pushed by your user to the default branch (for example master). The
commit message is signavio upload .
An information dialog will inform you about the successful export.

11.10 Translate content with PO files
In multi-language workspaces you can translate content to languages that are activated in your workspace.
Translating content with PO files is only available for Enterprise Plus
customers.
The following content can be exported for translations:
o
o
o

Diagram content (e.g. attribute values)
Dictionary entries that are linked in diagrams (optional)
Folder names

The content is exported to PO files which are sent to translators. To make the translation available in Process Manager, the translated PO files are imported to Process
Manager.
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11.10.1 Export content for translation
1. In the main menu open Import/Export > Export Diagram Translations .
2. In the folder view select the diagrams and folders that need to be translated
and click Export. To include linked dictionary entries of the selected diagrams,
select the checkbox.
You can only export up to 100 diagrams.
→ The selected content is exported to PO files and downloaded as a
ZIP archive to your computer. The CSV file summary.csv included in the ZIP
archive lists all exported items.
When you send the ZIP archive to the translator, ensure that its original structure is maintained.

11.10.2 Import translated content
Once the PO files are translated, you can import the PO files to Process Manager.
1. In the main menu open Import/Export > Import Diagram Translations.
2. Click Choose file, select the translated PO file from your computer and click
Import.
Already existing translations will be overwritten by the import.
For each language you can upload one translated PO file at a time. Repeat this
step in case you have several translated PO files for one language.
→ PO files are uploaded. The content is available for all languages that are
activated for the workspace.
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12 Publishing diagrams to external systems
With Process Manager, you can publish single diagrams to any intranet or Internet
website using the embedding feature. This chapter describes how to embed a diagram into a blog post or web page.
If you want to embed diagrams in your Microsoft SharePoint system, you can simply
integrate the whole Collaboration Hub into Microsoft SharePoint using a web part
(see section Integrate Collaboration Hub in a Microsoft SharePoint installation).
Of course, you can embed diagrams in other systems that Process Manager supports.

The embedding functionality of the Explorer

12.1 Enabling diagram embedding
If you want to share diagrams publically, enable diagram embedding.
To enable diagram embedding, proceed as follows:
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1. First, select the diagram you want to embed in the Explorer.
2. Then select in the menu Share the Embed diagram entry. The Embed diagram dialog opens.

3. If you have not already done, enable embedding by clicking Share diagram for
read-only access . The read-access for this diagram is now activated.

You have now several options to embed the diagram:
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o
o
o
o

as an interactive element (embedding)
as a simple image
as a Google gadget
in MediaWiki.

To embed diagrams in your Microsoft SharePoint system, you can simply integrate
the whole Collaboration Hub into Microsoft SharePoint using a so-called webpart .
To embed a diagram in an external system, you have to explicitly allow the embedding. This can be reverted later on - in this case, all existing integrations of Signavio diagrams will be deactivated.
Diagrams can be published on web pages by embedding them with HTML.
Several use cases for embedding are listed and explained in the following chapters.

12.1.1 Disabling diagram embedding
Embeddings of diagrams can be disabled at any time by withdrawing read access for
these diagrams. This can also be set in the Embed diagram dialog. Click the link
Stop sharing the diagram for read-only access :

Revoking read access disables all embeddings.

Via this link all embeddings (simple image, HTML, Google gadgets, and MediaWiki)
become inactive, so that your diagram are no longer viewed on pages which previously have linked such a link.
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12.2 Embed a diagram as an image
You can embed diagrams as images in web pages and this way share the diagrams
with users outside your workspace. Users can see the diagram image, but can't edit
or comment on it.
Follow these steps:
1. In the explorer, select the diagram you want to embed.
2. In the toolbar, click Share > Embed diagram.
The Embed diagram dialog opens.
3. If the embedding options are disabled, click the link Share diagram for readonly access to enable them.

4. On the Simple image tab, you'll find a diagram preview and the link containing the image in PNG format.

5. To embed the image, paste the link into your web page.
The embedded diagram image is automatically updated when a change is made to
the diagram.
If you want to use a specific diagram version as an image which never changes, you
can export the diagram in PNG or SVG format and use it in any context. Read more
in section Export a diagram as an image.

12.3 Embedding diagrams as HTML code
You can embed a diagram using a HTML code snippet in a website or blog as an
interactive element. The advantage of this method over a picture export is that the
most current version of the diagram is always available on your page.
The following paragraph explains how to embed diagrams as an HTML code snippet
into a blog or a web page like Blogger, TypePad, or WordPress.
To embed a diagram in your website or blog, proceed as follows:
1. First, select the diagram you want to embed in the Explorer.
2. Then select in the menu Share the Embed diagram entry. The Embed diagram dialog opens.

Version 14.9

403

12

Publishing diagrams to external systems

3. Open the Embedding tab and then copy the HTML code snippet.

4. Paste the copied snippet in the desired location of the HTML code of your
page or blog posts.
5. If the diagram is not shared for read access yet, click Share document for
read-only access .
If you click Stop sharing the diagram for read-only access in the embedding
menu, the diagram will not be available on the web page and on any other
pages it was embedded in.
6. See a list of Supported blog and content management systems to get an
overview of supported systems.
The embedded diagram does not allow navigation to linked diagrams or
linked documents. If you need the viewers to be able to navigate to
linked diagrams and documents, please use Collaboration Hub.

12.3.1 The diagram preview
To embed your diagram optimally in your website, you have to option to alter the
diagram's size and then to check size and aspect ration in a preview.

Version 14.9

404

12

Publishing diagrams to external systems

1. Specify the desired Width and Height . By default, it is set to auto , so the
size of the interactive element adapts to the system it is embedded in.
2. Click Preview to check the changes.

In the preview of the generated HTML code is displayed in addition to the interactive element. A zoom slider and scrollbars are added automatically.
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12.4 Embedding diagrams in MediaWiki
The Signavio Embed Extension for MediaWiki was developed independently from
Signavio by Hauke Pribnow. It provides the possibility to embed diagrams in MediaWiki easily. The corresponding developers page can be found at http://www.mediawiki.org/wiki/Extension:SignavioEmbed.
Signavio Embed was developed for MediaWiki 1.15.

12.4.1 Installing the Signavio Embed Extension
Please follow these steps:
1. Create the following file and folder:
[installdir]/extensions/SignavioEmbed/SignavioEmbed.php
installdir

where

stands for the directory MediaWiki is installed in and which con-

tains the file LocalSettings.php .
2. Copy the code from http://www.mediawiki.org/wiki/Extension:SignavioEmbed/code into the file and save
the changes.
3. Add following lines to the file LocalSettings.php that is contained in the
installation directory of MediaWiki:

require_once
("$IP/extensions/SignavioEmbed/SignavioEmbed.php");
// set this to true if you want to enable the function to link sub
diagrams:
$sigemLinkSubDiagrams = false;

12.4.2 Embedding a diagram
Follow these steps:
1. Activate embedding on the site the diagram is to be embedded in.
2. Add an empty Signavio tag to your wiki page:
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<signavio></signavio>

3. Open the Explorer, select Share - Embed diagram and click the link that locks
the pop-up settings to confirm sharing. Go to the tab MediaWiki and copy the
code that is shown:

Copy the code for embedding a diagram in MediaWiki
4. Add the code into the Signavio tag.
5. Save the wiki page. The diagram will be embedded as an interactive element.

12.5 Embedding diagrams in Microsoft SharePoint wiki
pages
The following paragraph explains how to embed single diagrams in Microsoft
SharePoint wiki pages.
Microsoft SharePoint wiki ignores JavaScript parts in HTML code like many wikis/content management systems. So if you insert the code and save, JavaScript parts
will be automatically removed. The insertion of the HTML code directly into the wiki
is not possible. You can however add a webpart to the wiki page that contains the
HTML/JavaScript code.
Proceed as follows:
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1. Go to the wiki page and click Edit page on the upper right side under Website
actions .
2. Click Add Webpart and add a Content Editor Webpart .
3. Edit this Webpart and insert the HTML / JavaScript code as Source code .
The exact procedure can differ depending on the Microsoft SharePoint
version you use.

12.6 Embedding diagrams as a Google gadget
Google gadgets can be embedded as interactive elements in various applications.
Process Manager can create URLs for diagrams that can be embedded into Google
gadgets.
To embed a diagram, proceed as follows:
1. First, select the diagram you want to embed in the Explorer.
2. Then select in the menu Share the Embed diagram entry. The Embed diagram dialog opens.
3. Open the tab Google .

Copy the code from the 'Google'-tab.

4. Cope the URL of the Google gadget.
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5. If read access has not been activated yet, click Share diagram for read-only
access .
If you click Stop sharing the diagram for read-only access the diagram will
not be available on the web page and on any other pages it was embedded in.
To read more about how to create a and manage Google gadgets on a web
page, please go to the Google gadget support website at https://support.google.com/sites/answer/153306?hl=en.

12.7 Supported blog and content management systems
You can embed Signavio diagrams in all blog and content management systems
that allow the embedding of HTML snippets.
For example:
o
o
o
o
o

SharePoint Wiki
Google Gadget
Jira
Confluence
MediaWiki

You can also embed a diagram view of the Collaboration Hub in 3rd-party applications. These applications include:
o
o

Microsoft SharePoint
Confluence

and any system that allows embedding of HTML iframes.
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13 Workspace administration
Administrators manage workspace settings and user access. They also make sure
that even with many users, the workspace remains well structured and clean.
The first user registering for a Signavio workspace is by default an administrator.
As administrators have extensive rights and can make profound changes to your
Signavio workspace, we recommend IT-skilled users familiar with the Signavio software and BPMN should be in charge. It is important to communicate and document
changes in workspace settings among your administrative team, so that all administrators are up to date and can give accurate responses to user queries.

The 'Setup' menu in a user account

The 'Setup' menu in an administrator's account in the Enterprise Edition
To add or remove administrator permissions, add or remove the user to or from the
user group Administrators. You can follow the instructions in the section Manage
users and groups (new Signavio edition) or Managing users and access rights
(classic Signavio edition).
An administrator has the following special privileges:
o
o
o
o

Managing users and access rights
Configure general software settings
Configuring language settings for all users
Configuring Collaboration Hub
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o
o
o
o
o
o
o
o

Managing approval workflows
Managing notations, attributes and the dictionary configuration
Importing/exporting diagrams and uploading files
Embedding Signavio diagrams in 3rd-party systems
Integrating Signavio Process Manager with Workflow Accelerator
Integrate Collaboration Hub in a Microsoft SharePoint installation
Signavio Process Manager for SAP Solution Manager 7.2
Purchasing additional licenses

To get started as a Signavio Process Manager workspace administrator, have a look
at our tutorial Preparing your Process Manager workspace - overview. You find an
overview of the most popular integration scenarios at System integration scenarios. A description of the Process Manager APIs is available at API access to the
Signavio Process Manager. You can also refer to our Frequently asked questions.

13.1 Preparing your Process Manager workspace overview
This article guides you through the configuration settings of your Signavio Process
Manager workspace. Because some configuration and access rights management
settings depend on each other, we recommend you follow the steps in this tutorial
in the provided order.
1. Configure general settings
First, open the general configuration (see section Configure general software
settings). There, you can configure the name of your workspace and the workspace owning organization, as well as currency and subscription settings. You
can also activate a set of links to help and training resources, or add links to
custom webpages.
2. Configure language settings
If your organization wants to manage content in multiple languages, you need
to configure these languages in your workspace settings, see section Configuring language settings for all users . To avoid confusion, we recommend
to only configure your workspace for multiple languages if you actually use
them. When activating multiple languages for your workspace, you need to
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set a default language, which determines, for example, the content that is displayed to a modeler who opens a diagram in the editor. In most international
organizations, the default language should be English.
3. Configure notation/attributes
You can configure all modeling notations you plan to use. To control complexity in your diagrams, you can create element subsets, see section Configuring notations and attributes. In our blog post Making Your
Stakeholders’ Lives Easier with BPMN Subsets you can learn more about
how element subsets help facilitate communication about your process landscape. For each notation element type, you can define custom attributes that
allow you to add additional information to elements of the corresponding
type, see section Configuring notations and attributes. For example, you
might want to add an attribute to the BPMN lane element that points to a
description of the role or IT system the lane represents.
4. Configure dictionary settings
The Dictionary allows you to centrally manage definitions for objects like documents and IT systems to reuse them throughout your process landscape. You
can create your own dictionary categories that help you structure the dictionary entries, see section Defining custom categories for dictionary
entries and configure custom attributes for dictionary categories, see section
Configuring notations and attributes. To learn more about the Dictionary,
see our blog post Using the Signavio Dictionary to facilitate consistency and
reusability of object definitions .
5. Configure modeling guidelines
Process Manager can check automatically if your process and decision diagrams follow specific modeling conventions . You can configure these conventions to fit your organization's requirements, as described at Managing
modeling conventions . To learn more about how modeling conventions help
you improve your diagrams read our blog post Improving Process Models
with Modeling Conventions .
6. Configure attribute visualization

Version 14.9

413

13 Workspace administration

The attribute visualization feature allows you to highlight attributes to which
specific rules apply, for example tasks that exceed an execution cost limit. As
a workspace administrator, you can configure custom attribute visualization
rules, see section Managing attribute visualization layers. To learn more
about the benefits of attribute visualization, read our blog post Visualizing
Business process KPIs .
7. Collaboration Hub configuration
Collaboration Hub provides an intuitive interface for users to view and comment on diagrams. You can configure Collaboration Hub, see section Configuring Collaboration Hub to adjust its layout to your requirements and
select which attributes and visualization layers should be available.
8. Configure process documentation templates
With process documentation reports you can generate a comprehensive overview of your process landscape as a PDF document, for example to provide documentation to external stakeholders like auditors. You can create templates
for these reports to specify what information you want to include and how to
present it, see section Creating and managing process documentation templates.
9. Configure approval workflows
If you are using Signavio Process Manager together with Signavio Workflow
Accelerator, you can configure approval workflows to ensure diagrams have
been reviewed by the right people before they are published in Collaboration
Hub or made available to specific stakeholders or systems like workflow
engines. See section Managing approval workflows.
If you use approval workflows to publish diagrams in Collaboration
Hub, ensure you revoke the publishing rights of your users to prevent they publish unapproved diagrams.
10. Configure security settings
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You can adjust the workspace's security settings to set up an IP address
whitelist and configure password policies. Read more in section Manage security settings.
11. Configure access rights
Before you roll out Signavio Process Manager to your users, you need to create and implement a user management concept. Read more in section
Managing users and access rights (new Signavio edition) or Managing users
and access rights (classic Signavio edition).
o

o

There are two types of users, modeling users and Collaboration Hub
users.
By default, every modeling user has access to all documents in the Share
documents folder. To restrict access rights of users, you can assign them
to a user group with limited access permissions already when you invite
them to join your Process Manager workspace. To restrict access rights
based on organizational roles, we recommend setting up a folder structure
that reflects the different access rights variations. Then, create user
groups with access rights that are tailored to your organizational requirements. See sections Managing users and Managing user groups.

o

Collaboration Hub users only have access to diagrams that have been
explicitly published in Collaboration Hub. The way you can manage
access rights for Collaboration Hub users on a more granular level
depends on your usage scenario:
o

If the users authenticate via an Active Directory- or SAML-based
mechanism, you can manage access rights of Collaboration Hub
users based on their Active Directory user groups or names, respect-

o

ively their SAML identities.
If you roll out an authentication certificate to your Collaboration Hub
users, all users will have access to all published diagrams.

Read more about the different ways to manage access to Collaboration
Hub at Configuring access to Collaboration Hub.
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13.2 Managing users and access rights
Signavio Process Manager possesses comprehensive user and access right management options. The following chapter describes user, user group and access rights
management in detail.

The user management dialog in the Explorer

13.2.1 Manage users and groups
User accounts are created via invitation: You invite users to your workspace via
email, provide them with a license and access rights, and manage their accounts.
In addition, Process Manager users can invite internal and external process stakeholders to review and comment on diagrams. Internal users already have Signavio
account. Externals need to create an account to log in.
If invited users can't access Signavio, check the IP filtering settings of
the workspace.
Groups allow you to effectively manage a large number of users and their access
rights by creating a group for each organizational role and setting up a group hierarchy. This simplifies assigning access rights and feature sets to users.
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In addition, changing user accounts to administrator accounts is done by assigning
them to the Administrators user group.
To open the user management, go to Setup > Manage users & groups in the
explorer.
13.2.1.1 Users invited for feedback
Internal users

When users who already have a Signavio account and a license to this workspace
are invited to review and comment on diagrams, they use their existing emailaddress/password combination to log in.
Internal users are managed via the user management in Process Manager.
External users

When external users are invited to comment on diagrams, they must create a Signavio account using the link in the invitation email. They can then sign in to Collaboration Hub and view the diagram, for which they have received and invitation.
They can't see any other diagram.
By default, external users get a commenting license. They can only view and add
comments.
External users are automatically added to the user management once they have
accepted the invitation and logged in to the workspace. External users aren't
assigned to any user group, not even the default groups.
When available in the user management, you can manage the accounts of external
users. When you remove the commenting license, external users can still sign in to
Collaboration Hub but don't see any diagram. External users can't access any other
Signavio component.
To completely deny access to Signavio for an external user, you need to remove the
account from the user management.
13.2.1.2 Users invited to workspace
You use the user management in Process Manager to invite users to your workspace. There, you can select the license type and the user groups you want to
assign to the new user.
o

The license for a new user is bound to the email address to which you send an
invitation. So, the new user has to register with the same email address to use
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the license.
New users are automatically added to the user management once they have accepted the invitation and logged in to the workspace. You can then manage their
access rights.
By inviting users to your workspace, you are giving them access to all diagrams in
the Shared documents folder, by default. If you want them to manage the workspace, you also have to add them to the Administrators group.
13.2.1.3 Create accounts
If you want to set up auto-provisioning for your workspace, i.e. user
accounts are created automatically on login, read more in section Single
sign-on using SAML.
When you want to add users to your workspace, you have the following options:
o

Invite users to create accounts with bulk invites. Note that you can only
change users' permission after their first login.

o

Create multiple user accounts instantly. With this option, you can manage the
user's permission immediately after you've created the accounts.

Every user you invite to your organization's workspace has the following default permissions. Note that you can change these permissions by adding users to user
groups.
o

Viewing and editing diagrams in the folder Shared documents

o

Viewing and editing dictionary entries

You can change users' permission in Setup > Manage access rights in the explorer.
Invite users to create accounts with bulk invites

1. In the explorer, click Setup > Manage users & groups. The user management
opens.

2. In the sidebar, click Invites.
3. Copy and paste the email addresses in the field. Email addresses must be separated by a whitespace.

Version 14.9

418

13 Workspace administration

4. Select the license from the drop-down list. The license will be assigned to all
users you want to invite.
5. Optionally, you can assign each user to a user group from the drop-down list.
When you create users groups, you can assign licenses that are applied to
each user of the group.
6. Click Send invites. Email invitations with a link to the registration page are

sent. Note that you can only change user's permission after their first log in.

Create multiple accounts instantly

Before you start, check whether SSO is enforced for your workspace.
Read more in Single sign-on using SAML.
1. In the explorer, click Setup > Manage users & groups. The user management
opens.
2. In the sidebar, click Invites.
3. Copy and paste the email addresses in the field. Emails addresses must be separated by a whitespace.
4. Select the license from the drop-down list. The license will be assigned to all
users you want to invite.
5. Optionally, you can assign each user to a user group from the drop-down list.
When you create users groups, you can assign licenses that will be applied to
each user of the group.
6. Select Create new user accounts without sending invitations
7. If SSO is enforced for your workspace, you have following options:
o

o

Select Suppress sending notification email for generated accounts to create the accounts without sending an invitation email.
Clear Suppress sending notification email for generated accounts to create the accounts with sending an invitation email with a link to the workspace.

8. Click Create users. Users accounts are created instantly. To change the users'
permission, go to Setup > Manage access rights in the explorer.

Version 14.9

419

13 Workspace administration

When SSO is not enforced for the workspace, users are asked to
reset their password when logging in for the first time.
Delete pending email invitation

1. In the explorer, click Setup > Manage users & groups. The user management
opens.

2. In the sidebar, click Invites.
3. Click user's email address.
4. On the right side, click Cancel. The link in the email invitation becomes
invalid.

Resend email invitation

1. In the explorer, click Setup > Manage users & groups. The user management
opens.

2. In the sidebar, click Invites.
3. Click user's email address.
4. On the right side, click Resend. An email invitation is sent again.
13.2.1.4 Delete account
When you delete an account, all content in My Documents folder is removed from
the workspace. Content in Shared documents folder, the user's comments and
changes will remain.
1. In the explorer, click Setup > Manage users & groups. The user management
opens.

2. In the sidebar, click Users.
3. Click the user you want to remove from the workspace.
4. On the right panel, click Delete. The user's account is deleted and the user can
no longer log in.

13.2.1.5 Change user settings
In the user management described in this section, you can assign licenses to a user,
assign users to groups and reset the user's password. To do so, follow these steps:
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1. In the explorer, click Setup > Manage users & groups. The user management
opens.

2. In the sidebar, click Users.
3. Click the user whose settings you want to change.
4. On the right panel, you have the following options to change user's settings:
o

Licenses: Assign a license by selecting a license form the drop-down
list.

o

Groups: Assign user to a group by selecting a group from the drop-down
list.

o

Reset password: Send a password reset email

o

Remove user: Delete user account, see Delete account.

13.2.1.6 Add user groups
In the user management described in this section, you can add users to groups in
order to manage their permissions.
1. In the explorer, click Setup > Manage users & groups.
2. In the sidebar, click Groups.
3. Enter the group name and click Add a new group.
13.2.1.7 Delete groups
1. In the explorer, click Setup > Manage users & groups. The user management
opens.

2. In the sidebar, click Groups.
3. Click the group which settings you want to change.
4. In the right panel, click Delete. Users that are members of this group are not
deleted.

13.2.1.8 Change group settings
1. In the explorer, click Setup > Manage users & groups. The user management
opens.
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2. In the sidebar, click Groups.
3. Click the group which settings you want to change.
You have the following options to change the group's settings:
o

Name: Edit the name of the group.

o

Add new users to this group automatically: Decide whether to define this
group as the default group.

o

Select a group as member: Create a group hierarchy by adding another group.

o

Users: Remove users from the group by clicking X.

o

Select a user to add as a member: Select a user from the drop-down list to
add to group.

13.2.1.9 Default groups
When customizing user groups, you can set one or more groups as default groups.
For example, you can use a default group to provide new users with a basic set of
access rights.
To define a group as a default group, activate the option Add new users to this
group automatically in the group settings.
Each user invited through the user management is assigned to all default groups by
default.
To assign the user you want to invite to another group, you can assign user-specific
user groups in the user management dialog when you set up the invitation.
Users created via SAML or CSV API are also assigned to the default groups, unless
you specify other user groups by configuration.
13.2.1.10 Create workspace administrators
In Process Manager, administrators have extensive permissions to manage workspace settings and user access. The only thing they can't access or manage is the
content in a modelers My documents folders.
As administrators can make numerous changes to your workspace, we
recommend to enable people with tool-specific knowledge and experiences in business process management and BPMN.
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To switch a user account to an administrative one, assign the user account to the
Administrators group. The user then receives administrative rights for your workspace.
13.2.1.11 Next steps
o
o

Set up IP address filtering
Managing users and access rights

13.2.2 Managing access rights
Signavio offers you the ability to assign different access rights to your diagrams as
well as dictionary entries for users and user groups. To manage permissions to the
folders and files other than the Shared documents folder you must be a member
of the Admininistrators group.
Folders and models inherit their permissions from the parent folders. Assuming you
have started with the typical configuration containing a Shared documents
folder, all modelers have access to all folders and individual models by default. Initially, all modelers (not to be confused with Collaboration Hub readers) are able to
read, write, delete or publish in all folders and models that have been created in the
Shared documents folder with the exception of the My documents folder. By
default, any models or folders created in a user's My documents are set as
‘private’, this means they are not readable by any other user on the system.
The following section describes how to define access rights to diagrams and dictionary entries. It is also possible to manage access rights to specific feature sets.
This enables you to give each modeler group access to the exact feature sets they
require to perform their tasks. Read more about this feature at Managing access
rights to feature sets.
13.2.2.1 Defining access rights
Access rights are assigned additively in Signavio Process Manager. This means
that if you define access rights to a folder, the users will have access to all of the
subfolders and contained diagrams.
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If you grant diagram access to a user who has no access to the containing folder, only the diagram path will be shown to this user. He has
no access to other diagrams in this folder.
Administrators can grant users the rights to publish , edit or delete diagrams in
the Shared Documents folder. If this option is not available, contact your administrator. Please keep in mind that the right to publish is disabled also for administrators by default. If necessary, enable this right for yourself.
To define access rights, proceed as follows:
1. Click Setup , then Manage access rights in the top drop-down menu of the
Signavio Explorer. The user management dialog box opens.
2. Go to the Access rights tab. The tree structure on the left side contains all

diagrams and folders in the "Shared documents"-folder and in the dictionary.

The access rights management dialog

3. Select the element you want to define access rights for:
o
o
o

folder
diagram
dictionary
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4. Choose a user or a user group you want to give access to the selected diagram
or folder.
If a folder is selected, all its 'child elements',e.g. all diagrams in the corresponding folder, will inherit the access right defined.
5. Choose the access rights to be granted to the user or user group:
o

o

o

o
o

Hub (H) : Allows the user to view published content in Collaboration
Hub.
Read (R) : Allows the user to view diagrams in the simulation tool, the
revision comparison tool, the commenting view, and Collaboration Hub.
Write (W) : Allows the user to edit and save content in the Editor/Dictionary.
Delete (D) : Allows the user to delete and move content.
Publish (P) : Allows the user to publish diagrams in Collaboration Hub.
Please keep in mind that the commenting feature in Collaboration
Hub is a read access, since users who have been invited via the
function Invite anyone for feedback can only add comments to a
diagram, but are not allowed to edit it.

6. Finally click Add . The access rights that the user or user group include will
appear in the access rights list.
Revoking the publication of a diagram typically revokes the publication
of referenced dictionary entries that are not referenced in any other
published diagram. Consequently, you need to have publishing permissions for the corresponding dictionary categories, if you want to
revoke the publication of a diagram that references dictionary entries.
This is not the case if the corresponding dictionary categories are configured to require a manual publishing of dictionary entries.
13.2.2.2 Removing access rights
To remove access rights, proceed as follows:
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1. Click Setup , then Manage access rights in the top drop-down menu of the
Signavio Explorer. The user management dialog opens.
2. Go to the Access rights tab. The tree structure on the left side contains all
diagrams and folders in the "Shared documents"-folder and in the dictionary.
3. Select the desired folder or diagram an access right shall be removed from. A
list appears on the right side with the users and the corresponding access
rights.
4. Click Remove . If the Remove button is not visible, navigate to the parent
folder, for which the specific access right has been granted, by clicking on its
name in the Inherited from column and remove it from there.

5. Confirm the action by clicking Yes in the dialog box.

13.2.3 Managing access rights to feature sets
You manage access rights to specific feature sets in the user group management
dialog. You can give each modeler group access to the feature sets they require to
perform their tasks. For example, this helps prevents users from uncontrollably creating diagrams or dictionary entries in your workspace.
1. Open the Explorer and click Setup - Manage access rights. The user management dialog opens.
2. Go to the User groups tab.
3. Select the desired user group and activate or deactivate the features according to your requirements.
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Editing a feature set for a user group.

4. Click Save feature sets to confirm and save the changes.
The following table lists all available feature sets:
Feature set

Description

Decision Manager - DMN
requirements
modeling
(without
decision logic)

Allows users to create and edit DMN diagrams, but

Decision Manager - complete

Allows users to create and edit DMN diagrams including

Decision Manager - export
Drools

Allows users to export decision tables and diagrams as described
in Exporting DMN diagrams as drools rules .

doesn't allow creating and editing the decision logic in
such diagrams.

the decision logic.

General - DiaAllows users to import and export diagrams.
gram Import/Export
General - Dictionary
Import/Export
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Feature set

Description

General Allows users to generate basic reports, see section Creating
Reports (Basic & reports. Includes all reports with the exception of cost, resource
Documentation) consumption and resource consumption analysis report.
General reports (Cost &
Resources)

Allows users to generate cost and resource consumption analysis
reports.

General Upload files

Allows users to upload files to Signavio Process Manager.

Process Manager - edit processes

Allows users to create and edit diagrams.
Note: To create and edit DMN diagrams, users need the
feature set Decision Manager - DMN requirements modeling
(without decision logic) or Decision Manager - complete .

Process Intelligence

Access to Process Intelligence.

Process Intel-

Allows users to create processes in Process Intelligence.

ligence Create process

13.2.4 About Licenses
Workspace administrators must assign a license to every user in a workspace.
Licenses are bound to a specific workspace, so the following rules apply:
o

Inviting new users doesn't create new workspaces.

o

Users having a license for another workspace can't access your workspace
unless you assign a license of your workspace to the user.

o

If you remove a user from your workspace, the user's license assignments and
access rights for other workspaces remain unchanged.

Licenses are also bound to the email addresses you specify when inviting new
users. The new users can only use this email address to log in.
When you invite users via the user management, you select the license you want to
assign. If you need more licenses, the user management dialog provides you with
information for a license purchase on the tab New users.
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13.2.4.1 License types
There are different types of user licenses for modeling users and Hub users.
Modeling users

Modeling users have the full functionality of your Process Manager edition available, and additionally access to Collaboration Hub. You find an overview of the features that are available per edition on the Signavio website.
Hub users

The main application for Hub users is Collaboration Hub. Hub users have access to a
limited feature set in Process Manager:
o

They can create folders, as well as create and edit BPMN diagrams in QuickModel.

o

They can use the diagram comparison tool, see section Comparing revisions.

o

They can export diagrams as PNG, SVG, and PDF files, see Exporting.

o

They can create reports, see section Creating reports.

o

They have read access to the dictionary, see section Working with the Dictionary.

o

They can use the discussion and sharing features, see Collaboration Hub.

You can also use feature sets to add additional feature restrictions on Hub users.
This license type is by default available to new customers. If you
registered your workspace before version 11.11.0 (January 2018), only
Signavio can provide this license type. Please contact Signavio Support.
13.2.4.2 Commenting License
Process Manager users can invite external users, who do not have a license to the
workspace, for feedback. Then, the external users automatically get a commenting
license. They can only view the diagram for which they have received the invitation
in Collaboration Hub and can view and add comments. As these external users also
have to create a user account, you can manage them in the user management.
Read more in section Managing users and access rights (new Signavio edition) or
Managing users and access rights (classic Signavio edition).
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13.2.4.3 The monthly concurrent mechanism
Monthly concurrent licenses are no longer available with our current
licensing mechanism. This section is only relevant for users who purchased monthly concurrent licenses prior to April 2017.
It is possible to purchase licenses that can be assigned according to the monthly
concurrent mechanism. This allows registering more users in a workspace than
licenses were purchased. Each month, the license-user-assignment is reset, with
the benefit that the limited number of licenses can be assigned to different users
each month.
The licenses are assigned based on the first-comes-first-served algorithm: Each
month, the number of modelers is limited by the number of licenses in the workspace. With each new month, license assignment is reset so they are available
again. Each user that logs in at the beginning of the month then gets one of the
free licenses, as long as free licenses are available.
A license that was already assigned during the current month can only
be freed before the end of the month by deleting one user with an
assigned license from the workspace. To make sure that some users can
always log in to their workspace, you can force assigning a license to
them by selecting the Force access option in the user configuration dialog. This option is automatically set for users that are member of the
administrators group.
If assigning a license to a user is forced, this user will be marked with a little star in
the navigation panel on the left. Users who didn't log in during the current month
are grayed.
The following example illustrates those states:

One license each is automatically assigned to both John Smith and James Brown.
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Jane Young has already logged in this month, so one license was assigned to her.
Lisa Johnson did not log in yet. As her access is not forced, no license was assigned
to her.
All together there are 3 licenses assigned, one each to John Smith, Jane Young, and
James Brown.
13.2.4.4 Next steps
Managing users and access rights (new Signavio edition) or Managing users and
access rights (classic Signavio edition)

13.2.5 Possible issues: JavaScript & cookies
Signavio Process Manager requires JavaScript to run. Cookies are required to
authenticate your browser during the login. If one of those functionalities is disabled, problems will occur.
o

When trying to login, you are redirected to the login page again, even if the username and password entered are valid. In this case, cookies are deactivated in

o

your browser.
Instead of Signavio Process Manager, a blank page is displayed. In this case,
JavaScript is deactivated.

If you are using Linux/OSX/Windows 7 or higher and your browser is up to date,
JavaScript and cookies should be activated by default.
To change these settings, you may need administrator rights on your
account. Please contact your system administrator if you cannot access
and/or change the settings described in this chapter.
If you have the printed version of this manual, please check how to activate
JavaScript and/or cookies in your browser's online user guide.
The links to the corresponding webpages are provided below.
13.2.5.1 Activating JavaScript for all browsers
https://support.microsoft.com/en-US/gp/howtoscript
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13.2.5.2 Activating Cookies
To use Signavio Process Manager, you need to have Cookies activated.
Read more about cookies at:
o

Internet Explorer:
https://support.microsoft.com/en-us/help/17442/windows-internetexplorer-delete-manage-cookies

o

Firefox:
https://support.mozilla.org/en-US/kb/enable-and-disable-cookies-website-preferences

o

Chrome:
https://support.google.com/chrome/answer/95647?hl=en

o

Safari:
https://support.apple.com/kb/PH19214?viewlocale=en_US&locale=de_DE

13.2.6 Manage security settings
To enhance IT security, you can limit the access to your workspace by filtering IP
addresses. In addition, you can define password policies in order to have users use
strong passwords.
The security settings apply to every user currently in the workspace and also to all
future users.
13.2.6.1 Set up IP address filtering
Users of the on premises edition cannot set up IP address filters.
The IP address filter allows you to define a list of trusted IP addresses that can
access Process Manager and Collaboration Hub. Devices with unlisted IP addresses
can't access the workspace even with a valid certificate or username/password
combination. This can be useful, for example, if you want to restrict access to your
workspace or Collaboration Hub to one or more specific companies.
For specifying IP addresses, the following rules apply:
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o

The IP address filter is based on IPv4, therefore IPv6 addresses cannot be
added to the list of trusted IP addresses.

o

Only Internet IP addresses are accepted. Local area network (LAN) IP
addresses can't be listed because they depend on the local network configuration.

o

You must specify IP addresses in classless inter-domain routing (CIDR) notation. With the CIDR suffix, you specify whether to filter for an exact IP address
or a range of IP addresses. The smaller the number after the slash, the
greater the range of IP addresses.
Example:
99.123.134.246/8 –> range from 99.0.0.0 to 99.255.255.255
99.123.134.246/16 –> range from 99.123.0.0 to 99.123.255.255
99.123.134.246/24 –> range from 99.123.134.0 to 99.123.43.255
99.123.134.246/32 –> exactly 99.123.134.246

The operating administrator's IP address is added automatically, so if you are setting up the list of trusted IP addresses and are using a static IP address, you get
access from your current device automatically.
To filter for IP addresses, follow these steps:
1. In the explorer, click Setup > Edit security configuration.
2. Check Activate IP Filtering.
3. Enter a CIDR IP address and click Add.

The IP address is added to the list of trusted addresses.

4. Save your changes.
The IP address filter is active.
To remove an IP address from the list of trusted addresses, select the IP address
and click Remove.
To completely deactivate the IP address filtering, disable the option Activate IP Filtering.
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13.2.6.2 Define a password policy
You can implement a password policy to enforce the use of secure passwords. This
allows you to prevent access security issues even if many users have access to your
workspace.
Password policy apply whenever a user changes or initially chooses a password.
To define a password policy, follow these steps:
1. In the explorer, click Setup > Edit security configuration.
2. In the section Password policies, select the requirements that passwords
have to fulfill (see list Configuration options for password policy).

3. Save your changes.
The password policy is active and users need to choose a password that fulfills the
password policy.
13.2.6.3 Configuration options for the password policy
o

Complexity requirements
A password is accepted when it contains at least three of the following
requirements:

o

o

at least one capital letter (A to Z)

o

at least one lower case letter (a to z)

o

at least one number (0-9)

o

at least one special character (!,§,$,%,&,?,#)

Consider user name
Users can't use their first or last name in a password, no matter if written in
upper or lower case.

o

Consider user name (strict)
Users can't use three or more letters in the same order as in the user's first or
last name in a password, no matter if written in upper or lower case.

o

Minimum password age
Users can't change a password, unless the specified number of days since the
last change has passed.
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o

Maximum password age
Users are prompted to change their password after the specified number of
days has passed.

o

Minimum password length
Define the minimum length of a password. Usually, longer passwords are
more secure than shorter ones.

o

Maximum password length
Define the maximum length of a password.

o

Password history
Users can't reuse passwords. For example, if the number is set to 5, the 5 last
used passwords are rejected as new password.

13.2.7 Creating certificates
As a workspace administrator, you are able to create user certificates to grant read
access to diagrams in Collaboration Hub.
In this section, the use of Collaboration Hub with certificate in the Software-as-a-service version of Signavio Process Manager is described. If
you are using the on-premise version please read more about publishing
in the chapter Granting read-only access to diagrams. To be able to create a certificate, the Collaboration Hub extension must be activated for
your Signavio workspace. You can book Collaboration Hub with a number
of licenses fitting to your organization via your Signavio contact.
1. In the Explorer, click in the Setup menu the Manage Collaboration Hub
authentication entry. The corresponding dialog box opens.
2. If no certificate was created before, click Create certificate . This may take up
to 30 seconds.
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3. After the certificate creation has been completed, you can download it by
clicking Download certificate . The dialog also provides you with the password
for the certificate. You will need this password when Installing the browser
certificate. As a workspace administrator, you can go back to the Manage Collaboration Hub authentication dialog any time, for example to check the password and download the certificate.
You can also deactivate or remove a certificate in this dialog box. This can be useful
if you do not have access to the machines of users whose Collaboration Hub access
should be revoked.
By deactivating or removing a certificate certified users can no longer
access Collaboration Hub of your workspace. A removed certificate cannot be recovered - should you delete a certificate, a new certificate has
to be created and then reinstalled on each device. To facilitate this,
there is the possibility to Importing a Signavio certificate

13.2.8 Importing a Signavio certificate
When using the SaaS version, this feature is available through the purchase of Collaboration Hub licenses. If you are using the on-premises edition, please read more
about publishing in the chapter Granting read-only access to diagrams.
On Windows systems the tool certutil provides a possibility to manage, save, and
restore your certificates. It is installed per default and eases the installation of certificates for multiple users because you have to execute one command only.
You can use the tool via command line if you are logged into a Windows system.
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1. Hit the keys Windows key + R on your keyboard and enter cmd into the text
field. The command line interface opens.

2. Enter certutil -? . An overview of the command appears, which lists all possible parameters for the execution the tool in your system language.

If the command certutil cannot be found in your system please contact your system administrator. You may have not enough access rights
to install certificates.
3. Now install the downloaded certificate on your system by entering following
command into the command line:
certutil -f -user -p \[password\] -importpfx \
[path to the certificate\]

Sample
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certutil -f -user -p keEb52kl importpfx C:\Documents and Settings\All Users\Documents\Signavio.p12

The parameters have different meanings:
Parameter

Description

Sample

-f

If the certificate is already installed, it
will be replaced.

-user

Import the certificate for the user who is
currently logged in.

-p

Indicates that the certificate is protected
by a password.
keEb52kl

[password] Password created by Signavio.
A PFX-file is supposed to be imported.
-importpfx Different certificate types can be imported with -addstore oder -importcert .
The path to the certificate. This can
either be a shared network resource or,
if the certificate was sent by email, a
private resource.

[path to
the certificate]

...\Documents\Signavio.p12

Alternatively you can use the command certutil -f -user -importpfx [path the certificate] Protect

which prompts for the pass-

word after confirmation.

13.2.9 Updating your Collaboration Hub certificates to SHA-256 with
RSA encryption
This article is only relevant if you use Collaboration Hub with certificatebased authentication.
Until December 15, 2016, Collaboration Hub users of Signavio's software-as-a-service system could authenticate using an SHA-1 encrypted client certificate. As
SHA-1 is a deprecated encryption algorithm, on January 1, 2017, Microsoft Windows and major browsers - most importantly Microsoft Internet Explorer, Mozilla
Firefox and Google Chrome - stopped accepting SHA-1 certificates.
Thus, Signavio changed the required authentication certificates to SHA-256 with
RSA-encrypted certificates December 15, 2016 .

Version 14.9

438

13 Workspace administration

13.2.10 Configuring access to Collaboration Hub
Collaboration Hub users have the ability to read and comment on diagrams published to Collaboration Hub.
Collaboration hub users are not only (or at least not exclusively) managed in the
Explorer under Setup . To enable Hub users access to diagrams, Collaboration Hub
has to be configured correspondingly. In addition, diagrams have to be published
explicitly.
13.2.10.1 Access right management variants for Collaboration Hub users
Depending on your edition and integration variant of Collaboration Hub, the access
configuration may vary:
o

Since version 11.11.0, you can manage Collaboration Hub users in the same
way you manage users of Process Manager (username/password-based).

o

If you acquired the Collaboration Hub before the release of version 11.11.0 (January 2018), you can request the activation of
username/password-based Collaboration Hub licenses by contacting support@signavio.com . Then, you can revoke the certificate and send out email invites to the persons who should
register for Collaboration Hub. In case you have configured
authentication via LDAP or SAML, a manual activation and

o

migration is not necessary.
The username/password-based authentication mechanism also
supports fine-grained access rights management for Collaboration Hub users.

o

You are using the Signavio on-premises edition without Active Directory integration: In this case, you only have to make sure that Hub users can access the
URL <serverurl>/intra/portal (if necessary contact your administrator). Once

o

a diagram has been published, all Hub users can access and comment on it.
You are using the Signavio on-premises edition with Active Directory integration : In this case, you have to configure the Active Directory integration component. It is then necessary to configure read access to Collaboration Hub. Read
more under Manage read access rights .

Version 14.9

439

13 Workspace administration

o

You are using Signavio in combination with the Microsoft SharePoint integration
component either as Software-as-a-Service or as on-premises edition : More
information on SharePoint integration can be found here Integrate Col-

o

laboration Hub in a Microsoft SharePoint installation .
You are using Signavio as Software-as-a-Service and Collaboration Hub with certificate-based publishing: Hub users are able to access Collaboration Hub after
having installed the safety certificate in their browsers. Please refer to the
chapters Creating certificates , Installing the browser certificate and Entering

o

Collaboration Hub.
You are using Signavio as Software-as-a-Service and Collaboration Hub with
SAML 2.0-based authentication: Hub users can authenticate via a third-party
account using a SAML (Security Assertion Markup Language) SSO service. Read
more under Single sign-on using SAML .

Once Collaboration Hub is configured correctly, published diagrams are available to
all Hub users with access rights.

13.2.11 Single sign-on using SAML
You need an administrator account to set up single sign-on for a workspace.
With Process Manager version 14.6, administrators don't need the Signavio support anymore to configure single sign-on.
If you have already set up SSO with SAML, you must update both the IdP
and the SP configuration in the next few months for security reasons.
Signavio will let you know how long you can keep the existing configuration.
To update your configuration, first, follow the steps in section Configure
your IdP. Then, you must enable the new option Use the latest SAML
2.0 capabilities in the Signavio SSO settings as described in section
Enable SSO using SAML.
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Single sign-on (SSO) is an authentication method. When SSO is set up, users can
access different applications by logging in with only one account. Signavio supports
SSO authentication using the Security Assertion Markup Language (SAML), both for
the SaaS and the on-premises solution.
SAML is a standard to exchange authentication and authorization data between a
service provider (SP) and an identity provider (IdP). Signavio supports IdP-initiated
authentication and SP initiated authentication.
Signavio acts as an SP and agrees to trust an IdP to authenticate users. When a
user wants to access Signavio, Signavio sends an authentication request to the IdP.
The identity provider validates the user and generates an authentication assertion
that allows the user to log in to the workspace with their credentials.
13.2.11.1 Just-in-time provisioning
When SSO using SAML is enabled, you can specify that users automatically get an
account when they access Signavio for the first time. This is called just-in-time (JIT)
provisioning and allows users not to have to register with Signavio themselves.
For JIT provisioning to work, the following conditions must be met:
o
o

A user must be authenticated successfully with the IdP.
The response from the IdP contains the mandatory attributes. Read more in section Configure your IdP.

o

At least 1 unassigned license for Collaboration Hub is available.

With JIT provisioning enabled, the following happens:
o
o

When a user logs in for the first time, a new account is automatically created.
When a user logs in who already has a Signavio account and an IdP name ID, any
IdP change on their first name, last name, and email address will be automatically updated in the Signavio user management.

The authentication assertion sent by the IdP can contain information on licenses
and user group assignments, and the following applies:
o

o

A user receives a license that is specified in the IdP response, given that such a
license is available in the workspace.
A user is assigned to all groups that are specified in the IdP response, given that
these user groups exist. User groups that don't exist are ignored.
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o

If a user is assigned to a Signavio user group that isn't included in the IdP
response, the user is removed from this group.

When JIT provisioning is disabled, only users with an existing account can access
the workspace. Other users will receive an error message. Read more on user management in section Manage users and groups.
13.2.11.2 Set up SSO using SAML
To set up SSO using SAML, you must configure the IdP and enable SSO for your
workspace. Then, you can invite users.
All steps are described in detail in the following sections.
Configure your IdP

You can configure all third-party IdPs that support SAML 2.0, for example:
o
o
o

ADFS 2.0/3.0
Okta
OneLogin

For the configuration, the SP and the IdP must exchange metadata files.
Follow these steps:
1. In the explorer, click Setup > Manage Collaboration Hub authentication.
The configuration dialog opens.
2. Select SAML 2.0 based authentication from the drop-down list.
The configuration dialog opens.
3. Download the IdP metadata file. To do so, click the link Download the SAML
service provider metadata in the lower dialog area.

4. Upload this file to your IdP or configure your IdP manually with the information from the file.

5. In your IdP configuration, set the SAML response attributes as follows:
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Attribute

Mandatory Description
It's the primary identifier, must be unique,

Name ID

yes

and doesn't change. For example, use the
internal employee ID.

email
first_
name
last_
name

yes

Email address of a user

yes

First name of a user

yes

Last name of a user

signavio_
licenses_

The name of the license that you want to
no

v1

Edition.

signavio_
groups_
v1

assign to a user, for example Enterprise Plus

no

The names of the groups that you want to
assign to a user.

IdP configuration is complete. You can continue with enabling SSO for your
workspace. Read more in the next section Enable SSO using SAML.

Example section from a valid IdP response
<Subject>
<NameID>ID12345</NameID>
<SubjectConfirmation
Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
<SubjectConfirmationData InResponseTo="ONELOGIN_6f26b11b-b2904d2c-b79d-c46010fe686c" NotOnOrAfter="2020-10-23T11:49:29.291Z"
Recipient="https://editor.signavio.com/api/v2/saml/v2/tenant/a41f284f4
e8841b2c7f5e2af78663c0f/login"/>
</SubjectConfirmation>
</Subject>
<Conditions NotBefore="2019-10-23T11:44:29.258Z" NotOnOrAfter="201910-23T12:44:29.258Z">
<AudienceRestriction>
<Audience>https://editor.signavio.com/api/v2/saml/v2/tenant/a41f284f4e
8841b2c7f5e2af78663c0f/metadata</Audience>
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</AudienceRestriction>
</Conditions>
<AttributeStatement>
<Attribute Name="signavio_licenses_v1">
<AttributeValue>Collaboration Hub</AttributeValue>
<AttributeValue>Workflow</AttributeValue>
</Attribute>
<Attribute Name="email">
<AttributeValue>john.doe@signavio.com</AttributeValue>
</Attribute>
<Attribute Name="first_name">
<AttributeValue>John</AttributeValue>
</Attribute>
<Attribute Name="last_name">
<AttributeValue>Doe</AttributeValue>
</Attribute>
<Attribute Name="signavio_groups_v1">
<AttributeValue>Employees</AttributeValue>
<AttributeValue>Sales</AttributeValue>
<AttributeValue>Process owners</AttributeValue>
</Attribute>
</AttributeStatement>
Enable SSO using SAML

Before you start, you need the configuration metadata from your IdP. Read more in
the previous section Configure your IdP.
Follow these steps:
1. In the explorer, click Setup > Manage Collaboration Hub authentication.
The configuration dialog opens.
2. Select SAML 2.0 based authentication from the drop-down list.
The configuration dialog opens.
3. To enable IdP-initiated authentication, select Enable SAML 2.0 authentication.

IdP-initiated authentication means that a user who logs in to the IdP must
select Signavio, and is then redirected to your workspace and logged in.
4. With SP-initiated authentication, a user who is logged out from Signavio and

tries to access your workspace, is redirected to the IdP, must log in to the IdP,
and is then directed back to Signavio and logged in.
To additionally enable SP-initiated authentication, select Allow service provider initiated authentication.
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5. For SP-initiated authentication, the initial request sent by the SP to the IdP
can be signed with a certificate. If the authentication request is signed, the
IdP has additional means to verify that the request was sent by the SP.
To enable signing the authentication request, select Sign authentication
request.
6. To enable just-in-time provisioning using SAML, select Create new user
accounts automatically.

7. If disabled, enable Use the latest SAML 2.0 capabilities.
Latest SAML 2.0 capabilities ensure secure authentication and furthermore provide additional capabilities like assigning user groups
and licenses when provisioning users.
If you are configuring SSO for the first time, this option is enabled
by default and you must keep it enabled in order to successfully
enable SSO for your workspace.
If you've already configured SSO in Process Manager version
earlier than 14.6, you must first update your IdP configuration as
described in section Configure your IdP and only then enable the
option Use the latest SAML 2.0 capabilities manually.
For convenience, it is automatically enabled once an IdP-initiated
SSO is successfully executed using the updated IdP configuration.
8. Paste the configuration metadata provided by your IdP to the field XML
Metadata.

9. Confirm with Save settings and close the dialog.
Invite new users via email

If SP-initiated authentication and JIT provisioning is enabled, you can invite users
to your workspace by sending them an email.
Follow these steps:
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1. Get the workspace link:
o

Share a link to any content within your workspace, for example by copying the URL from your browser address bar.

o

Create a link to the workspace by adding the workspace ID as an URL
parameter, for example https://ed-

itor.signavio.com/p/hub?t=<WORKSPACE_ID>

2. Paste the link to an email and send it to the users you want to log in with
SSO using SAML.

13.2.11.3 Enforce SSO to disable login via credentials
When SSO is enforced for your workspace, users can't log in using their Signavio
credentials. All users have to log in through the IdP.
If SP-initiated authentication is enabled, users are logged in when clicking a link to
any content within your workspace, for example a published diagram in Collaboration Hub, or a link that includes the workspace ID as an URL parameter.
When SSO is configured but not enforced for your workspace, the following applies:
o
o

Users can log in through the IdP.
Users can also log in by entering their email and password on the Signavio login
page.

o

If SP-initiated authentication is enabled, a logged out user is always redirected
to the IdP when clicking a link to content in your workspace.
When you've set up enforced SSO, make sure SSO is working before logging out from your workspace. Otherwise all users, including you, won't
be able to access the workspace. To test the SSO configuration, log out
and log in again with another user account.
In case of problems, please contact Signavio Support so they can disable this option for you.

To enforce SSO, follow these steps:
1. In the explorer, click Setup > Edit security configuration.
The configuration dialog opens.
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2. In the Password policies section, enable Enforce SSO login.
3. Confirm with Save.
13.2.11.4 Next steps
Managing access rights
Manage security settings

13.2.12 Managing access to Collaboration Hub for Active Directory
services
This chapter describes how to manage access rights for Active Directory users and
user groups on Collaboration Hub.
A prerequisite is that you have integrated Collaboration Hub with your
Microsoft Active Directory. For an overview of authentication options to
Collaboration Hub, see Granting read-only access to diagrams.
Modeling users with the corresponding permissions have the possibility to publish
diagrams to the Collaboration Hub.
If you have purchased and configured the corresponding module, you can set read
access permissions for diagrams published in Collaboration Hub based on users and
user groups in a shared domain. Signavio uses the Windows network account list to
give users access to Collaboration Hub with their Windows network access credentials.
Active Directory integration options
o

When using Signavio's Software-as-a-Service version, you can integrate Signavio with your Active Directory through a Microsoft SharePoint Connector.
Read more in section Integrate Collaboration Hub in a Microsoft SharePoint

o

installation.
When using Signavio's On Premise Edition , you can integrate Collaboration Hub
with Active Directory with or without Microsoft SharePoint. For further details,
please read the Administrator Manual .
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13.2.12.1 Managing read access to Collaboration Hub
As a user of the publishing module , you are able to determine fine-grained access
to Collaboration Hub. You allow other users to see diagrams as well as folders in
your workspace.
Granting read access to a diagram in Collaboration Hub does not enable
Hub users to open the diagram in other applications like the Editor or
Explorer.
You can grant read access to users that are logged into your domain. It is also possible grant access rights to entire user groups.
To define read access, proceed as follows:
1. In the Signavio Explorer, click in the Setup menu the Manage access rights
entry. he user management dialog opens.
2. Switch to the Read access -tab.

3. Select a folder or diagram in the left navigation column. The dialog shows the

access rights connected to the object and, if existent, the folder the right was
inherited from.
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Select the folder you want to configure read access for.
4. Navigate to the folder or diagram. There are two ways to add access rights for
a user:
o

Type in a user name by using the search functionality - as soon as you
start typing, a drop down list with matching users appears. Select the user

o

name.
Click the input field and select a user name from the drop down list. To navigate the sites, use the arrows below the list.

Click Add . The user can now be found in the list of granted access rights.

5. Read access will be established for the user.
13.2.12.2 Removing read access
Follow the first three steps in the paragraph above and continue as follows:
1. Select the user you want to remove the read access from.
2. Click Remove next to the user name:

Version 14.9

449

13 Workspace administration

If you cannot see the remove option for a diagram or folder, the
read access right was inherited from a parent folder. Navigate to
this folder by clicking its name in the column Inherited from .
3. Confirm the action with Yes .

13.3 Configure general software settings
To configure the general settings for all modelers, open the explorer and click Setup
> Edit general configurations.
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13.3.1 Explorer settings
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Name of the workspace

Sets the name that shows up in the
workspace selection for users who
are members of multiple workspaces. By default, the name is the
name of the organization you
entered when registering the workspace, plus workspace owner's full
name in parentheses.

Organization owning this work-

Sets the name of your organization,

space

which is displayed in diagrams you
create with QuickModel and in most
reports.

Currency

Defines the default currency used in
the simulation tool and in different
reports.

Automatic subscription

Lets you define whether and when
commentators' email addresses
should be added to an email subscription that informs them about
changes in the corresponding documents.

Table columns

Defines what information the
Explorer's list view is displaying.
More detailed instructions are available under Working with folders
and diagrams .
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13.3.2 Editor settings

Color palette
Enables you to customize the colors of the color palette that is accessible in the Editor. To
adjust a color, overwrite one of the default hexadecimal values in the palette and press
enter to see the color preview change.
Enforcing matching dictionary item types
By default, Signavio enforces mappings between BPMN elements and Dictionary category
entries, as recommended by BPMN. When the check box is enabled, the following BPMN
element types only references Dictionary entries in the corresponding categories: IT system
elements reference entries in the IT Systems category Data object elements reference
entries in the Documents category Task elements reference entries in the Activities category
Pool/Lane elements reference entries in the Organizational Units or IT Systems categories
This preselection keeps Dictionary entry references consistent and prevents an unsuitable
usage of Dictionary entry references. However, this restriction can be disabled by clearing
the Enforce matching dictionary item types check box.
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13.3.3 Help settings

Here, you can (de)activate a set of help options that show news and tips about our
software and link to further information about Business Process and Business
Decision Management.
By default, all options are activated. You can also define custom help options that
can for example link to sites in your intranet. You can define these settings separately for the Explorer and Collaboration Hub.

13.3.4 General settings
Enable the upload of documents/pictures: Enable this option to allow users to
upload documents and pictures.
Enable content subscriptions: Enable this option to allow users to subscribe to content such as process models. If a user subscribes to content, the user receives email
notifications on changes. When you disable this option, user can't subscribe to workspace content. For already existing subscriptions, email notifications are no longer
sent.
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13.4 Configuring language settings for all users
The Editor allows you to define the different languages that diagrams can be translated into. Whenever a diagram is created or edited, you can for example translate
labels of modeling elements and element documentation to each language that is
defined in the workspace. Users then have the option to choose the suitable language on their own.
Users of Collaboration Hub also have the possibility to switch between
languages that are defined in the workspace. In the Software-as-a-Service version of Signavio Process Manager, this is only possible if the publishing module for Microsoft SharePoint is licensed in your workspace.
1. Open the Explorer and click Setup , then Define languages .

2. The configuration dialog opens.
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3. Choose the languages you want to add to your workspace from the drop-down
list:
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5. After choosing all languages required, you can now prioritize them via the
move up link. The language on position 1 will be the default language of your
workspace, that means it is used as the standard language for all diagrams
that are created with those settings.
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6. After finishing all configurations, click Save :

Languages that are defined for a workspace can be removed. To remove a language
from your workspace, go to Language settings in the configuration dialog and click
Remove next to the language you want to remove:
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13.5 Configuring Collaboration Hub
This section describes the configuration of the classic Collaboration Hub.
To configure the new Collaboration Hub, read more in section Collaboration Hub Settings.
You can adjust the appearance of Collaboration Hub according to your corporate
identity and choose between several layout and display options.
General configuration
You can change the configuration of Collaboration Hub by clicking Setup - Edit Collaboration Hub configuration in the Signavio Explorer.

The following configuration options are available:
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13.5.0.1 Welcome header
Here, you can configure the text that is displayed as the headline of the Collaboration Hub's 'Home' page. If no text is configured, Welcome to Collaboration Hub is
displayed instead. You can configure a text for each language you activated in your
workspace settings.

13.5.0.2 Entry Point
Whenever a user accesses the general Collaboration Hub URL, the diagram you set
here will be displayed. If you activated the Homepage, this diagram will be displayed there. We recommend to reference a value chain diagram that represents
your process landscape.

Select a diagram as entry point.
Choose a published diagram as entry point. If you choose an unpublished
diagram, your colleagues will see either the Collaboration Hub home
page or an error message, depending on if you have activated the home
page or not.
13.5.0.3 Enable Collaboration Hub Homepage
If this box is activated, Collaboration Hub will display the Homepage as entry page.
It shows an entry diagram (if specified), it also gives you the option to search for
key words amongst the published diagrams and supplies information about recent
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changes in published diagrams. The text that is provided in the Description attribute of the entry diagram will be displayed next to the diagram on the entry page. If
this attribute is undefined, a default Signavio text will be displayed.
The Searchpage provides you with the option to search for diagrams, files and dictionary entries. It also displays information such as the item's description and when
it was last published. This page is only available if the Homepage is activated in the
Collaboration Hub configuration dialog. If deactivated, a search panel is available in
Collaboration Hub's navigation panel.

13.5.0.4 Show diagram path navigation
Select if you would like Collaboration Hub to display the breadcrumb panel/hierarchy path of a diagram for Hub users and in the Collaboration Hub preview.

If this option is activated but the diagram is not linked to a hierarchy, the diagram
path will be displayed in the breadcrumb panel instead.

13.5.0.5 Comments
Choose whether you want to allow users of Collaboration Hub to see and/or leave
comments.
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13.5.0.6 Overlays
Here you can choose which of the attribute visualization layers should be available
in Collaboration Hub.

The settings are:
o

Visible by default
The overlay is displayed when a user opens Collaboration Hub. Users can hide
the overlay by deactivating it via a drop down menu.

o

Hidden by default
The overlay is hidden when a user opens Collaboration Hub. Users can show
the overlay by activating it via a drop down menu.

o

Always hidden
The overlay is always hidden. Collaboration Hub users can't activate it.

13.5.0.7 Folder overview
Configure the default settings for the folder tree on the left of the Collaboration
Hub:

By default, the folder tree at the left side of Collaboration Hub is expanded.
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13.5.0.8 Dictionary information in the folder overview
Configure whether the dictionary should be accessible via the folder tree. The
option Neither categories nor search results additionally prevents dictionary categories and items from showing up in the search results.

By default, the dictionary is visible in the folder tree.
13.5.0.9 Default language settings
You can set the application language for Collaboration Hub. If the setting is on Automatic , the program will adopt the language settings of your Signavio workspace or,
if you are not signed in, your browser.

13.5.1 Appearance
13.5.1.1 Template
Select the color template. Besides the Signavio signature theme, there are several
other color templates available:
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13.5.1.2 Using your own company logo
You can use your own company logo instead of the Signavio logo in the top left of
the Collaboration Hub window. The logo on the loading screen can also be adapted.
To switch to your own logo, click the corresponding select file button, select the picture file in the corresponding menu and click OK.

Adapt the top-left logo.

Adapt the loading screen.
If you would like to reset the logo to the default Signavio design, click the reset button.
In both cases, make sure that the file is either in PNG, JPG or GIF format and is no
larger than 500 KB.
13.5.1.3 Link behind the logo
Specify the URL that is opened when clicking the logo in Collaboration Hub:
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13.5.1.4 Embedding mode
When activated, Collaboration Hub does not have a header and it's folder overview
is collapsed, if it is embedded into an iframe (for example as part of a Microsoft
SharePoint Web Part).

13.5.2 Attributes
13.5.2.1 Layout configuration
In this menu, you can select the configuration of the tabs on the top right side in
Collaboration Hub.

Multi-tab (diagram first)
The diagram image, attributes (the Overview tab) and activities are kept in separate tabs.
By default, the Diagram tab is open.
Multi-tab (overview first)
The diagram image, attributes (the Overview tab) and activities are kept in separate tabs.
By default, the Overview tab is open.
One pager
The diagram image, attributes and activities appear on the same page. The tab menu is no
longer visible

13.5.2.2 Attribute visibility
If the check box Use custom configuration is activated, you can configure the
attributes that should be displayed in Collaboration Hub. The default configuration
is documented in the table below the select menus.
For customizing the view, proceed as follows:
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o

Activate the check box Use custom configuration:

o

Select the notation you want to configure:

o

Choose whether you want to configure Diagram attributes or Element attributes:

o

For each attribute, configure whether it should be visible , visible if a value is
assigned ( visible if set ) or invisible:

o

Configure the Visibility of linking/linked diagrams : If Use Custom Configuration is activated in Collaboration Hub configuration dialog, you can set
the attribute(s) Linking Diagrams and Linked Diagrams visible to have all diagrams that are linked or linking to the diagram open in Collaboration Hub listed in the corresponding section. These linked attributes are defined on
diagram level.
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You can switch to one of the linked diagrams from Collaboration Hub's overview tab by clicking its name. Any Collaboration Hub user navigate through
the process levels by use of the diagram path (if activated), Process level pyramid and breadcrumb panel or linked subprocesses.
All changes to the look and configuration of Collaboration Hub will
be available for your colleagues after their next login.

13.6 Managing approval workflows
You need administrator rights in your Signavio Process Manager workspace to enable, disable, and manage workflow sharing. The Software as
a Service Edition (SaaS) also requires you to be the workspace administrator.
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Signavio Process Manager enables you to define and manage approval workflows
for publishing diagrams. Approval workflows route a diagram to a predefined list of
people, who need to approve that the diagram is ready to be published. This enables
your organization to ensure the quality of all diagrams published in the Collaboration Hub.
You can define approval workflows in Signavio Workflow Accelerator . To define
approval workflows, you need to purchase licenses for Signavio Workflow Accelerator in addition to your Signavio Process Manager licenses.
To use the approval workflow feature, click Setup , then Manage approval workflows in the top drop-down menu of the Explorer.

13.6.1 Activating the approval workflow feature
If you opened the settings as explained above and if approval workflows are inactive a dialog opens for you to activate the feature. Activate the check box below the
short introduction text and click Activate :
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Activate the approval workflow feature.

Click Next to confirm and start configuring the approval workflow preferences:

The activation was successful.

Now, you can manage your approval workflows.

13.6.2 Configuring Approval Workflows
To effectively use approval workflows, you should restrict your user's
rights to publish diagrams in the Collaboration Hub. Read more about
access rights management in the section Managing users and access
rights .
Now that the approval workflow feature is active, click Setup , then Manage
Approval Workflows in the top drop-down menu of the Explorer in order to open
the following configuration dialog:
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The approval workflow configuration dialog

The dialog enables you to:
o

Open your workspace in Workflow Accelerator

Clicking the link opens your Workflow Accelerator workspace in a new browser tab,
so you can manage your tasks and processes (approval workflows) there.
o

Manage approval workflows

All approval workflows defined in Workflow Accelerator (and the default approval
workflow) are listed as links in this section. Click an approval workflow to edit.
o

Deactivate the approval workflow feature
If you want to stop using the approval workflow feature, you can deactivate it.

o

Synchronize users with Workflow Accelerator
After you created new users in Process Manager, you need to synchronize Process Manager with Workflow Accelerator, so your new users can be included
in your approval workflows. Click Synchronize users now to create a Workflow Accelerator account for all your Process Manager users who did not have
a Workflow Accelerator account before.
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Confirm the synchronization.

If your organization is using Workflow Accelerator for approval
workflows in Process Manager, synchronizing the workspace will
delete Workflow Accelerator users who have been previously
deleted in Process Manager.
o

Synchronize configuration with Workflow Accelerator

You only need to click this button if there are problems with the configuration
between your Process Manager and Workflow Accelerator workspaces--if the tenant ID is missing in Workflow Accelerator, for example. Most of the time, the configuration updates itself automatically when changes are made. If you do need to
manually fix the configuration, click Synchronize configuration now to trigger a
synchronization of all diagram states, Process Manager URLs and the Process Manager tenant ID.

Confirm the synchronization.

13.6.3 Access control for approval workflows
If the option Use workflow access permissions is enabled, permissions for processes set in Workflow Accelerator are used for approval workflows.
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'Use workflow access permissions' checkbox

"Start process" permission and "See process" permission
When an approval workflow is created or edited in Workflow Accelerator, it is possible to restrict who can see or start a process.
For details on how to set these permissions in Workflow Accelerator, see Access
control .
o

If a user is permitted to see but not start an approval workflow, that workflow is
visible as disabled in the drop-down list. In case this user still tries to start the

o

approval workflow, an error message is shown.
If a user is not permitted to see a workflow, the workflow won't be listed.
If you enable the option Use workflow access permissions , every user
who wants to start an approval workflow needs a Workflow Accelerator
account. If a user tries to start an approval workflow while not having an
account for Workflow Accelerator, an error message is shown.

13.6.4 Diagram states
You can also edit the diagram states within an approval workflow.
The table in the Diagram states tab contains all states a diagram can be in. Icon
and name of a state are displayed in the Signavio Explorer as soon as the state has
been triggered for the corresponding diagram. If the check box Publish is activated,
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a diagram will be automatically published in Collaboration Hub after the corresponding status has been triggered (for this, it is, of course, necessary that your
workspace has a Collaboration Hub).
Edit the states by clicking the corresponding table fields:

Edit the states a diagram can have within an approval workflows

The Reset expiration column is only relevant if you want to configure
Approval Expiration .
Changes in state configuration (as well as the deletion or creation of new states)
are automatically transferred to Workflow Accelerator and are instantly available
when selecting states in the Workflow Accelerator workspace.
Click the + icon to add a new state:

Add a new state.
To delete a state, click the trash button next to the corresponding column and confirm the action:

Delete a state
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Confirm the action.

You can assign diagram attributes for process participant roles. This enables you to
define the roles of participants in processes within Signavio Process Manager. Signavio Workflow Accelerator, you can then assign approval tasks to these roles.
For example, the default approval workflow process is assigning the task business
approval to the process owner role. This means that the business approval for a
process is automatically assigned to the user whom you have defined as the process
owner in the corresponding attribute.

13.6.5 Participants
Configure the Participants attributes in the Participants tab.
Here, you can assign diagram attributes to Workflow Accelerator roles. This
requires the creation of corresponding attributes on BPMN diagram level in Process
Manager. Read more about custom attributes in the chapter Configuring notations
and attributes .

Assign the attributes and save the configuration.

When creating or editing a business process diagram, you can now add the email
addresses of the corresponding participants to these attributes.
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Define process participants.

With this feature, you can only use the email addresses the corresponding users used to register themselves in Signavio Workflow
Accelerator.
When configuring approval workflows in Signavio Workflow Accelerator you can
assign responsibilities to the different participants.

13.6.6 Approval Expiration
In this tab you can set expiry dates for diagram approvals. Expiry dates ensure your
diagrams are regularly re-checked, for example to fulfill compliance rules.

Open the ‘Approval Expiration’ tab

By default, the expiry frequency is set to Never .
o

To define one static expiry frequency for all diagrams, set the drop-down
menu Select how the timespan is determined to Fixed period .
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Define a static fixed frequency for all diagrams

Next, define the expiry frequency in the field Number of months . In our
example, the system triggers a new approval workflow after twelve months.
o

To define the expiry frequency per diagram, set Select how the timespan is
determined to Custom attribute (type: number) . Next select the attribute you
want to use to configure the frequency. To configure custom attributes, see section Configuring notations and attributes .

Expiry frequency using an attribute on diagram level

Next, define the expiry frequency in the field Fallback value if attribute not set .
This field serves as the default value if a diagram's expiry frequency attribute value
is empty.
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In our example, the approval workflow is automatically triggered again after twelve
months.
To select the workflow you want the system to trigger once a diagram approval
expires, you need to switch to the Diagram states tab. Here you can define the
states that are considered as approvals in the Reset expiration column.

Select the states

To use both expiring and non-expiring approvals, set up a specific
approval workflow that triggers only states that the expiry function
doesn't regard as approved. For example, create the states Approved
(expires) and Approved (no expiry) . Activate the check box Reset expiration
only for Approved (expires) . Workflows triggering this state will expire,
workflows triggering Approved (no expiry) won't.

13.6.7 Reapprovals
To schedule reapprovals, set an expiry period in the Approval Expiration tab and
mark at least one of the diagram states in the Diagram states tab as Reset expiration .
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13.6.7.1 Existing approvals
Existing approvals are affected by changing the Approval Expiration or the Diagram state configuration.
Approval Expiration

If you change the expiration timespan, the new expiration period is used to schedule the reapproval.
Example: If a diagram was approved two months ago and you set the reapproval
period to one month, the reapproval workflow is triggered immediately.
Diagram state

If you change the diagram state that resets the expiration, reapprovals only depend
on the new states. De-selected states are no longer considered for already initiated
expiry periods. For the newly selected states, the expiry period is calculated from
the time this state was reached.
Example: You have two diagram states, approved and rejected . So far, approved was
activating the approval expiration, now you want to change the diagram state to
rejected . As soon as the diagram state is changed, the reapprovals linked to
approved are discarded by the system. The system also searches for revisions with
the state rejected and recalculates the expiry period, starting from the date the diagram was set to rejected . This means that changing the diagram state does not
immediately trigger the reapproval workflow, and that it may take less than the
complete timespan for the reapproval workflow to be triggered.

13.6.8 Creating and editing approval workflows
You can edit approval workflows and add further approval workflow processes.
To create or edit an approval workflow, click Setup - Manage Approval Workflows
in the top drop-down menu of the Explorer and click either Open workspace in Signavio Workflow Accelerator or click a link to an existing approval workflow:
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Open your Signavio Workflow Accelerator workspace

In case you did not select a specific workflow, you are redirected to your Signavio
Workflow Accelerator workspace. Go to the Processes tab to see all existing processes, including your approval workflows:

The ‘Processes’ tab provides an overview over existing processes

Now, select an approval workflow for editing it:

or click New process to create a new approval workflow:

We will now assume you created a new approval workflow, so we can guide you
through all the details of creating approval workflows in Signavio Workflow Accelerator. You can also edit all options explained here the same way when opening an
existing workflow.
Enter a name for the approval workflow and hit Enter :
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13.6.8.1 Setting the workflow trigger
If you have a Workflow Accelerator stand-alone license, you need to define Signavio approval as the trigger for the process.

Set 'Signavio approval' as trigger

In case you are using Workflow Accelerator as part of Process Manager Enterprise
Edition, the approval workflow trigger is set automatically.
13.6.8.2 Creating actions
Next, go to the Actions tab:

Go to the 'Actions' tab
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Here you can create actions for the approval workflow and link them with each
other. To create the first process element, click the Start event button:

Add a start event to the process canvas

13.6.8.3 Changing states
Click the Signavio drop down and select Change state to create a new Process Manager task:

Create a new task to be executed by Signavio Process Manager system.
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Connect start event and task, label the task and select to which state the model
should be changed by the trigger:

The task will change the diagram state to 'in progress'.

The states can be defined in Signavio Process Manager (see Diagram states). When
the task has been executed in Workflow Accelerator, Process Manager will automatically set the diagram, for which the approval workflow is executed, into this
state.
13.6.8.4 Creating and assigning user tasks
Use the interactive context menu to create the first user task and name the task:

Use the interactive context menu.

Label the task.
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Assign the task to one or several of your Signavio Editor & Decision Manager users
by clicking the + button below the Assignment tab and selecting a user:

Assign the task to one or several users.

Alternatively, you can assign the task to one of the process participant roles. This is
recommendable for most cases, as it eases approval workflow management when
having several process owners and participants within the different processes.

13.6.8.5 Adding fields for additional information
In the Form tab you can add several fields providing information about the to-beapproved diagram:
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Add a field.

To edit the field's information. like label and initial value, click the corresponding
field and edit it in the pop-up on the right:

Finally, a form for a user task could look like this:
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Example of a form for a user task

13.6.8.6 Adding exclusive gateways
Now, add an exclusive gateway followed by two (or more) Signavio Process Manager Change state tasks:

Add an exclusive gateway followed by Signavio Process Manager tasks.

13.6.8.7 Defining task labels
Define task labels as well as the state changes the tasks will trigger. If you want to
end the workflow after these steps, add end events :
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The gateway represents a user decision, meaning the user executing the previous
task can decide which of the following tasks should be triggered.
When clicking the gateway you can define the labels of the dialog that will be displayed to the executing user when the corresponding decision is to be made:

Define dialog labels.

To define the outcome or the possible process flows, simply name the task following a decision:
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Name the task.

The possible sequence flows have been defined.

13.6.8.8 Setting automatic decisions
Alternatively, gateways can be resolved automatically.
Here, you need to select Automatic decision and define the conditions for gateway
resolution:
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Gateways can be resolved automatically.

In our example, it does not make sense to resolve the gateway automatically. You
can refer to the above illustration as a reference for automated gateway resolution
in a similar case.
13.6.8.9 Publishing the process
You have now created your first custom approval workflow.
Click Publish to run this process :

Publish the workflow.

The new approval workflow can now be started from the Signavio Explorer.

Version 14.9

488

13 Workspace administration

13.6.9 Deactivating the approval workflow feature
To deactivate the approval workflow feature, open the Explorer and go to Setup Manage approval workflows .
Now, the approval workflow management dialog opens. Click Deactivate :

Deactivate the approval workflow feature.

Confirm the deactivation:

13.7 Managing notations, attributes and the dictionary
configuration
You can configure notations and create custom diagram attributes according to your
specific needs. Moreover, you can customize dictionary categories and attributes in
order to ensure consistency and enable easy re-use of objects throughout your process landscape.
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13.7.1 Managing attribute visualization layers
Attribute visualization layers allow you to display attributes directly on the diagram canvas using different icons and colors. You can create and configure custom
rules that define the state of each visualization layer.
For example, you can create a rule that tasks with costs higher than $15 will be
marked with a red icon, tasks with costs between $10 and $ 15 with a yellow icon
and tasks with costs lower than $10 with a green icon.
Attribute visualization layers can be configured and displayed for the following diagram types:
o
o
o
o

BPMN diagrams
Value chain diagrams
ArchiMate diagrams
Organization charts

To create a new visualization layer, click Setup, then Manage attribute visualization in the Signavio Explorer.

The following dialog opens:
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You can now add new attribute visualization layers.
Click Add new layer:

A new layer will be created.
You can choose the name and the icon that will be displayed in Process Manager.

You can either select an icon or select Property value. When selecting Property
value, instead of the icon the value of the corresponding attribute will be displayed.
When enabling the check box Show Details, the attributes that are used for calculating the respective rules will be displayed next to the visualization icon. This
option is only available for layers an icon has been assigned to.
Every layer can contain several rule sets.
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To configure the rules on how the icons will be displayed, click Define rules and
then Add new rules:

Proceed with defining the color the rule set will be assigned to.
You can either select one of the predefined colors out of the paintbox or set the
color using the corresponding hexadecimal code:

Now you need to configure the rule(s) that correspond to the color.
A rule consists of three parts: Property, Relation and Value:
o

Property, Cost & Ressource Analysis Attribute or a Custom Attribute can be
selected from the drop down menu:

o

The Relation drop down menu contains (depending on the type of the selected
attribute) several relational operators and/or Boolean statements:
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So in the example case, the rule states: Display the execution time highlighted in
red in case it is longer than 5 minutes:

In case you want to connect several rules with an AND operator, click the points
icon:

Afterwards you can add more rules:

In this example, the execution time of tasks is highlighted in yellow if it is between
(inclusive) three AND five minutes.
To connect rules with an OR operator, you need to create a second rule set within
the same layer, using the same color.
13.7.1.1 Displaying attribute visualization layers in the Editor
Once a layer is created, it can be displayed by clicking the corresponding button in
the upper toolbar of the Editor. Once you create a new layer, a new button that represents it will appear in the upper toolbar:
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Activate one or more visualization layers.

It is possible to display more than one layer at once.
Now icons (or the corresponding attributes properties) will appear next to the tasks
in the diagram and provide you with an overview over the attribute properties:

Visualize attribute properties.

13.7.1.2 Displaying attribute visualization layers in Collaboration Hub
In order to display visualization layers in Collaboration Hub, open Collaboration Hub,
go to Overlays in the top toolbar and select the corresponding layer:
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Select one or more visualization layers.

Elements to which the visualization layer's rule sets apply, will now be highlighted.
To display the attribute value, hover over corresponding symbol:

All elements to which the visualization layer's rule sets apply will be highlighted.

13.7.2 Managing modeling conventions
This feature is available in the Enterprise Edition.
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The modeling convention feature enables users to check if diagrams stick to certain rules regarding notation(/BPMN-language), labeling, process structure and diagram layout. This check can be displayed while modeling (or saving). Additionally, a
modeling conventions report can be generated. The Classic Edition offers the Signavio Best Practices modeling convention. The Enterprise Edition also provides
custom modeling conventions.
To manage modeling conventions in your work space you need to be a member of
the Administrators group.
To access the modeling convention dialog open the Signavio Explorer and click
Setup, then Define modeling conventions in the top drop-down menu.
The following dialog will pop up:

In this dialog you can manage the existing modeling conventions and create new ones.
This dialog offers an overview over the existing modeling conventions. Furthermore
conventions can be (de-)activated:
o

Globally for the whole work space

o

And specifically, the check button in the Editor and the auto-check in the
save dialog
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13.7.2.1 Defining custom modeling rules and conventions
This feature is available in the Enterprise Edition .
In addition to the Signavio Best Practice modeling convention, it is possible to
define custom modeling rules and conventions, that fit exactly to your needs.
Custom rules can be defined to complement already existing modeling conventions,
whereas defining a new convention means creating a customized set of rules,
either from scratch or derived from an existing convention.
If you want to create a whole new modeling convention, select Add custom modeling convention in the upper right corner of the dialog:

Now you can chose between creating a new convention from the beginning or copying an existing convention:

Afterwards, the new convention shows up as a new column in the convention table
and you can now configure it by activating rules and adjusting the importance of
rules and other parameters:
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The new modeling convention is saved after closing the dialog and is now included
in the convention checks if activated (default setting).
To add a custom rule, click Add new custom rule in the corresponding section of
the convention's table:

A dialog will appear. Here you can insert the name and description of your new custom rule:
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After clicking Create , the new rule appears in the modeling convention dialog,
where it can be edited by clicking on the small pen-icon:

These custom rules cannot be checked automatically by our system.
They need to be checked manually.
In addition to creating this kind of custom rules, you can define custom mandatory
attributes. If a process diagram contains empty mandatory attributes, this will be
reported by the modeling convention check.
To define mandatory attributes within an existing modeling convention, open the
modeling convention dialog and click Add new rule under Definition of mandatory
attributes :

In the following dialog, you can now select the attributes you want to be mandatory:
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After saving the configuration, the attribute set will be added to the modeling convention table.
To change the selection of mandatory attributes or to delete the mandatory attribute set, click the small pen icon.

13.7.3 Managing risks and controls definitions
With the centralized risks and controls management feature you can configure custom risks and controls data types and manage risk and control objects in the Dictionary.
In this way, you can ensure your risks and controls are consistent throughout your
process landscape and facilitate re-use of those already defined.
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13.7.3.1 Create dictionary categories for risks and controls
1. In the Explorer, click Setup – Define notations/attributes :

2. Switch to the Dictionary tab and create two new categories:
o

One category for risks

o

One category for controls.
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3. Set the type of the category to Risks or Controls. To customize your risks and
controls definition, add additional attributes to these categories. The attrib-

utes resemble the table headers in your risks or controls tables, for example
severity , control interval , or responsibility .
Collaboration Hub only supports the following custom attribute
types in risk management tables:
o
o
o

Single line text
Drop-down box
Number

Custom attributes of other types won't be displayed in risk management tables in Collaboration Hub.
13.7.3.2 Configure 'Risk Management' element attributes
1. Switch to the Modeling Language tab and create a custom Risk Management
attribute.
2. When configuring the attribute, reference the newly created Risk and Control
categories.
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3. Define risk and controls for diagrams in your process landscape.

13.7.4 Configuring notations and attributes
You can configure which diagram types and diagram elements modelers can use in
your workspace and which properties diagram elements have.
Users need to be members of the Administrators group to change these settings.
To edit the notation and attribute settings, open the Explorer and click Setup Define notations/attributes:
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You can define subsets for each diagram type and enable/disable diagram elements
in these subsets. In addition, it is possible to define custom attributes for diagram
elements.
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13.7.4.1 Defining a notation element subset
1. Select the modeling language you want to define a subset for:

2. Click Add subset .
3. Enter the subset's name. Activate the checkbox Group diagram element
types if the shape repository in the Editor should list the diagram elements
grouped by type. Click Save:
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4. The subset will be displayed in the left column of the dialog.

5. You can deactivate diagram elements for the subset in the central column by
deactivating the corresponding checkboxes. By default, every element is activated.

6. When you create small subsets, it's easier to deselect all elements by clicking
Uncheck all and then add all elements you need:
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13.7.4.2 Copying a subset
You can also duplicate subsets and extend them later.
1. Select the subset you want to duplicate.
2. Click Copy subset in the head of the Modeling languages column.

3. You can now activate or deactivate additional diagram elements of the subset
in the central column by (un)checking the respective boxes.
13.7.4.3 Editing or deleting a subset
It is not possible to edit or remove default subsets. However, you can edit or remove
custom subsets.
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1. Select the subset you want to editor delete.
2. Click Edit subset :

You can now edit the subset name and change the element grouping preferences.
1. To delete the subset click Remove subset and confirm with Yes in the confirmation dialog.

13.7.4.4 Define default colors and font formats for element types
You can define custom default shape and font formats for element types. These
formatting attributes are defined for all notation subsets. For example, if you
change the background color of the task element, the system changes all BPMN
subsets accordingly. You can still overwrite these settings when formatting an element in the editor as described in the chapter Format elements and labels .
The following default formatting options are available:
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Font size

Default : 12

Font bold

Default : False

Font italic

Default : False

Font color

Default : #000000 (black)

Background color

Default : #ffffcc (yellow)

Border color

Default : #000000 (black)

Solid color (no gradient)

Default : False

You can change the default format settings in the Modeling Languages tab of the
notations/attributes configuration dialog:
1. Switch to the Default Formats tab and select an element type. In our
example, we want to highlight the labels of all collapsed subprocesses of your
BPMN diagrams in pink by default:

2. Select the setting you want to adjust and click Edit or double click the setting
- in our case Font color :
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3. Adjust the settings accordingly. Here, we use the drop-down menu to select
the color of our choice or insert the respective hexadecimal value:

4. Click Apply to save the changes. All existing elements of the corresponding
type in the diagrams of your workspace will now be adjusted. Process Manager will use the changed format for new diagrams as well.
When opening a diagram containing one or more corresponding elements, an
information dialog informs you that the elements have been changed:
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If you want to revert the changes, press Ctrl + Z or click Undo.
13.7.4.5 Next steps
Add and manage custom attributes
13.7.4.6 Add and manage custom attributes
You can add custom attributes for diagram elements and dictionary categories. Custom attributes work in the same way as standard attributes in a modeling notation
and can also be displayed in Collaboration Hub.
1. In the Explorer, select Setup > Define notations/attributes.
2. To add an attribute for a modeling element, stay in the tab Modeling language.

To add an attribute for a dictionary entry, switch to the tab Dictionary.
3. Select a notation or a dictionary category.
4. Select a diagram element or dictionary category. Press Shift or Ctrl to select
more than one element or category.

5. In the tab Custom Attributes, click

Add .

6. You can create a new custom attribute or reuse an attribute you already have
available in your workspace.
o

To reuse a custom attribute, select it from the list.

o

To create a new attribute, enter a name and a description for the new
attribute. Select the data type for the attribute. You can create list
attributes by activating the checkbox As list.

7. Click Create attribute to save.
You can't edit the data type or the As listoption after saving the
attribute.
Manage custom attributes

In the tab Custom Attributes, you can manage the custom attributes in your workspace.
To access the custom attributes you want to change, follow these steps:
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1. In the Explorer, select Setup > Define notations/attributes.
2. To edit an attribute for a modeling element, stay in the tab Modeling language.

To edit an attribute for a dictionary entry, switch to the tab Dictionary.
3. Select a notation or a dictionary category.
4. Select a diagram element or dictionary category. Press Shift or Ctrl to select
more than one element or category.

The custom attributes for your selection are listed.
To view the attribute details, click an attribute.
To change the order in which custom attributes are listed in the attribute panel,
select an attribute and move it up or down with the arrow buttons.
To edit an attribute, click Edit. You can't edit the data type or the As listoption.
To remove an attribute, click Remove and confirm. If the attribute is used for more
than one element, you can decide to remove it from all elements or only from the
selected element.
Configure custom date attributes

To change the timestamp format on diagrams, tasks, and dictionary categories, customize the date attribute. By default, the format is m/d/Y (for example,
01/09/2017).
Format options

Option Meaning

Example

j

current day of the month, without zeroes

1

d

current day of the month, with zeros

01

D

abbreviated day of the week

Wed

l

full day of the week

Wednesday

F

current month name

February

M

abbreviated current month name

Feb
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Option Meaning

Example

n

current month in numerals without leading zeroes

2

m

current month in numbers with leading zeroes

02

y

current year, in two digits

17

Y

current year, in four digits

2018

a

lowercase am and pm

A

uppercase AM and PM

g

12 hour format without leading zeroes

9:15

h

12 hour format with leading zeroes

09:15

G

24 hour format without leading zeroes

9:15

H

24 hour format with leading zeroes

09:15

i

minutes, with leading zeroes

05

s

seconds, with leading zeroes

Example: Friday, September 1st, 2017 at 03:05 pm:
o

y-m-d

is displayed as 17-09-01

o

y/m/d

is displayed as 17/09/01

o

F j, Y

o

g:i:s A

o

l, F d, Y g:i:s A

is displayed as September 1, 2017
is displayed as 3:05:00 PM

PM
o

F j, Y, g:i a

is displayed as Friday, September 01, 2017 3:05:00

is displayed as September 1, 2017, 3:05 pm

Next steps
o
o
o

Create custom attributes to link documents
Define custom attributes for RACI
Attribute groups
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13.7.4.7 Create custom attributes to link documents
When you create a custom attribute of the data type Document/URL, modelers can
use this attribute to link to documents in Signavio file storage, your document management system, or in your network. They can also use this attribute to link to
online documents.
To create a custom attribute for linking documents, follow these steps:
1. In the Explorer, select Setup > Define notations/attributes.
2. Select a notation , one or more subsets and a modeling element.
3. In the tab Custom Attributes, click Add.
In the Add custom attribute dialog, enable Create new attribute.
4. Insert a name and a description for the attribute.
5. For data type, select Document/URL.
6. Select As list to enable linking multiple images or documents to one element.
You can't edit the data type or the As listoption after saving the
attribute.
7. Click Create attribute to save.
Next steps
o

Add and manage custom attributes

13.7.4.8 Define custom attributes for RACI
Responsibilities can be assigned directly to tasks. To enable modelers to do this, you
need to define custom attributes.
To define custom attributes for RACI, follow these steps:
1. In the Explorer, select Setup > Define notations/attributes.
2. From the list Modeling Language, select Business Process Diagram (BPMN
2.0).

3. From the list Diagram element types, select Task.
4. In the tab Custom Attributes, click Add.
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5. In the Add custom attribute dialog, enable Create new attribute.
6. Enter the name of the responsibility you want to assign to the task in the
field Name.

o

Enter the names exactly as listed the table below. When you use
different names, you won't be able to assign RACI responsibilities
to tasks.

o

The additional definitions are only available when using custom
attributes, not for connectors.

o

RACI definitions are only available in English, German and French.

English
R responsible or
additional responsible or

German

French

führt durch or

réalisateur

führt zusätzlich durch

additionally responsible
A accountable

erteilt Freigabe or

autorité

ist gesamtverantwortlich
C consulted

wird konsultiert

consulté

I

wird informiert

informé

informed

7. To enable dictionary suggestions for data type, select Dictionary link.
8. We recommend to enable As list.
You can't edit the data type or the As listoption after saving the
attribute.
9. To ensure suggested dictionary entries are roles, select in Only for the category Organizational Units.

10. To save the custom attribute, click Create attribute.
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Next steps
o

Add and manage custom attributes

13.7.5 Defining custom categories for dictionary entries
This feature is only available for customers with an Enterprise license.
You can define attributes for dictionary entries, just as you can define them for diagrams. You can also define custom dictionary (sub-) categories.
13.7.5.1 Category types
Category types have two purposes:
o

They are used by the system when creating reports (e.g. RACI, document usage
or process documentation reports) in order to identify objects of a certain cat-

o

egory.
They act as filters when dictionary references are suggested while modeling in
the Signavio Editor. for example, dictionary entries of the type 'IT System' are
only suggested when the user attempts to label an IT System element. Entries
that are not defined (not attached to any element type) will be suggested for
any element.

Category types can be defined for both root level categories and child categories.
Available category types are:
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Organization

Organizational entities, that can be used
to assign responsibilities for actions.
Examples would be whole organizations
(e.g. 'ACME Inc.'), organizational units or
departments (e.g. 'Finance'), roles (e.g.
'Chief Financial Officer') or even external
process participants like partners, suppliers, government institutions or customers.

Document

Anything that can hold information and
that is used or created during processes.
This may be physical documents (e.g.
printed applications), digital files (e.g.
PDF forms), entries in databases or variables in a computer program.

IT-System

Anything that can process documents or
data, from standard software programs,
individualized applications and custom
scripts to hardware systems, like individual server instances, data centers and
hand-held devices, to integrated systems
like fully-configured application servers,
scanners, printers or personal computers.

Event

Anything that can trigger a process, happen during execution or as the result of a
process. Events are usually described by
defining the situation or state reached
once the event has occurred, e.g. "Customer order received" or "Goods sent".
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Activity

Actions that are performed within processes. Actions usually connect all other
types of objects: they are performed by
organizational units or roles, may read
and create documents or data, may use
IT-systems, may cause events and should
usually achieve certain goals.

Goal

The reasons behind why processes are
executed at all and why they are designed
the way they are: business goals to be
achieved, key performance indicators to
be met or stakeholders to be satisfied.

Requirement

Typically descriptions of the differences
between as-is and to-be processes or ITsystems, e.g. change requests, functional
or non-functional specifications or tickets
in a requirements management system.

Others

Categories with this type have no defined
meaning attached to them and will thus
be recommended to users for diagram
elements that do not match more specific types. One example is the BPMN
group element.

13.7.5.2 Creating a new category
To create dictionary categories, proceed as follows:
1. Click Setup , then Define notations/attributes in the top dropdown menu of
the Signavio Explorer.
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2. Click the Dictionary tab on the top bar of the dialog. The area to configure the
dictionary attributes opens. All categories are listed on the left side of the dialog.

3. If you want to create a sub-category, select first the parent category.

Sub-categories can't be parent category of other categories, therefore a
category path is always one or two levels deep.
4. Click Add . In the corresponding dialog box, perform the following settings:

Version 14.9

519

13 Workspace administration

Preference Description
Name

Specify a name for the category (mandatory)

Parent catSpecify the parent category via the dropdown menu.
egory
Use for
Activate the checkbox if you want to use the category for DMN input data
data mod- (see Managing input and output data for DMN Data Input elements
elling
).

Determines whether (new revisions of) dictionary entries should
be published in Collaboration Hub manually or automatically
upon creation.
o

manually : an updated dictionary entry has to be explicitly
published before the most recent version is displayed in Collaboration Hub. This enables strict quality assurance (see

Publishing
mode
o

also Publishing dictionary entries ).
automatically : a new dictionary entry (update) is displayed
in Collaboration Hub as soon as the entry is saved.

Note : After enabling manual publishing , you need to explicitly
grant users the right to publish dictionary entries, as described
at Managing access rights .
o

On
change,
linking diagrams are

updated automatically : diagrams referencing dictionary
entries of the corresponding category are updated auto-

o

matically upon changes.
unpublished : the changes can be approved manually. You
can control whether the updated dictionary entry is still
matching the context of the referencing diagrams.

Color

Select a color for the category.

Typ of catSelect a category type.
egory

5. Finally, click Create . The new category is applied.
6. To edit, remove or rearrange categories, select the appropriate entry in the
category bar.
7. Click the corresponding icon in the toolbar.

Version 14.9

520

13 Workspace administration

8. To deactivate a custom category, uncheck the respective checkbox between
the category's color and it's name.

Managing custom attributes for dictionary entries

You can manage custom attributes of dictionary categories in the same way you
manage custom attributes of elements. Read more at Configuring notations and
attributes.

13.7.6 Managing external data sources
The external data sources interface for DMN data objects is available for
your On Premises installation on request. In case you want to activate
the interface, please contact the Signavio Support Team at support@signavio.com .
In the Signavio Decision Manager, you can use to define the data types of input
columns in DMN model decision tables.
For the data types string lists (enumerations) and hierarchies , you can set up
external services to retrieve corresponding data objects.
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13.7.6.1 Architecture
The following diagram shows the system architecture of the external data source
interface:

The component on the left represents the Signavio system. The right part of the diagram represents a third-party service with access to the to-be transferred data. It
may contain a bridging application that reformats third party data so the Signavio
Decision Manager can read it.
There are two options to set up a service so that third party data can be accessed
by the Signavio Decision Manager.
The options are represented by the two outgoing request/response channels in the
diagram.
o

Direct access: For this, the service URL defined in the Signavio Decision Manager has to be accessible via HTTP(S) GET requests. The service response needs

o

to match the Signavio data format. See how to match the format below.
The Range Accessor Service: Signavio offers a reference web application that
can either be used as an adapter to map data from existing services or to build up
an entirely independent data service. To use this web app provided by Signavio,
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you need to calibrate Signavio accordingly. Read more at Range Accessor Service .
13.7.6.2 Direct Third Party Access: Data Format
The Signavio system needs the response of an external service request to comply to
the following JSON structure:
<response> := <enumResponse> | <hierarchyResponse> |
[<enumItem>*]
<enumResponse> := { type: "enumeration", enumItems: [<enumItem>*] }
<enumItem> := { id:<String>, title:<String> }
<hierarchyResponse> := { type: "hierarchy", hierarchyItems:
[<hierarchyItem>*] }
<hierarchyItem> := {id:<String>, title:<String>, children:
[<hierarchyItem>*] }

The response is either declared as an enumeration or hierarchy and contains a type
definition and items.
The following examples serve as references for the data structures necessary.
Example enumeration:

}

{ type: "enumeration",
enumItems: [
{id:"firstPlace", title:"Gold medal"},
{id:"secondPlace", title:"Silver medal"},
{id:"thirdPlace", title:"Bronze medal"}
]

The enumeration response is a JSON object with a type declaration and a JSON
array of enumeration items. Each item is a JSON object with the mandatory attributes id and title . Any other attributes will be ignored.
Example hierarchy:
{
type: "hierarchy",
hierarchyItems: [{
id: "am",
title: "America"
}, {
id: "eu",
title: "Europe",
children: [{
id: "uk",
title: "United Kingdom"
}, {
id: "de",
title: "Germany",
children: [{
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id: "berlin",
title: "Berlin"

}

}]
}, {
id: "fr",
title: "France"
}]
}, {
id: "as",
title: "Asia"
}]

The hierarchy response is a JSON object with a type declaration and an array of
hierarchy items. Each item is an object with the mandatory attributes id and title
attribute and the optional attribute children . children is an array having the same
format as hierarchy items. Any other attributes will be ignored.
The id value must not contain any whitespace characters and the value
of the title attribute has to start with an alphabet letter.
13.7.6.3 Range Accessor Service
Signavio offers a reference web application that can either be used as an adapter to
map data from existing services or to build up an entirely independent data service.
To use this service, extend the AbstactExternalValueRange class (using a nonabstract class) and dispatch the RangeServingServlet . This can facilitate the reuse
of an existing service. The service can be called and the data can be mapped to the
specified data format.
In either way, the output has to comply with the data format as specified above.
The sample web app Signavio Range Accessor Service contains (among others) the
following files and folders (packages) of interest:
RangeServingServlet.java (com/signavio/rangeservice/servlet)
AbstractExternalValueRange.java (com/signavio/rangeservice/conversion/)
public byte[] getValues
(HttpServletRequest req) throws JsonProcessingException {...}

.

The subclasses in the example subpackage serve as simple examples of service
implementations for enumeration and hierarchy providers.
AbstractRangeExchange.java (com/signavio/rangeservice/util/exchange/)
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To ensure proper functionality, don't change, delete or move other files,
folders and jar files. Some of them are only of interest at compile time,
some at runtime
13.7.6.4 Creating external data sources
To make use of an external service, it has to be registered in the corresponding Signavio workspace. Open the Signavio Explorer and click Setup - Define notations/attributes in the Signavio Explorer and choose the Dictionary configuration
tab, then click the link in the explanatory header text:

Click the link to open the management dialog for external data sources.
Now, click Add :
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A service consists of a name, a unique URL and a caching configuration:
o

Name
The name is used as the identifier in the Signavio dictionary.

o

URL
This is the service URL accessible by an HTTP GET request responding with
data in the Signavio data format as specified above.

o

Cache
It is possible to cache the data temporarily. If activated and configured, the
referenced service will not be queried for the caching period, as the system
will use the cached values.
It is highly recommended to activate caching. Otherwise, the service data will
be newly requested each time the dictionary entry is loaded. Without caching,
if the service is temporarily unavailable, the request the Signavio Decision
Manager is making to the service will timeout and the data will be unavailable
until the request is answered.

Click Add to register the service:
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To learn how to reference external services when modeling data objects in the Dictionary, read more at Referencing external data sources .

13.7.7 Managing input and output data for DMN Data Input elements
The Signavio Dictionary enables you to manage the objects of your business process
landscape.
Specifically for DMN, the Dictionary implements extended functionality for the management of input data and output objects.
To enable input/output data management with the dictionary, open the Signavio
Explorer and click Setup , then Define notations/attributes in the top drop-down
menu.

Open the notation/attribute management dialog.
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Switch to the Dictionary tab and create a new category (click Add category ). The
category needs to have the check box Use for data modeling activated (you can
also activate this check box when editing an existing category):

Add a new category and activate the check box 'Use for data modeling'.
Now you can create data input/output objects in the Dictionary.
Open the Dictionary (the last item in the Explorer's folder tree):

In the dictionary, select a category that supports data modeling and click New
entry :
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In the following dialog, you can label and describe the data object:

It is important to define the Type Definition of the data input:
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o

A Simple Type can be an enumeration of values, plain text, a number or a
Boolean value:

o

Complex Type allows you to reference one or several dictionary items and to add
simple data types like plain text, numbers, Booleans or enumerations.
To reference a dictionary item, fill in a label for the reference, start typing the
entry's name into the corresponding field and select a suggestion from the
list:

Reference a dictionary item as part of a 'Complex Type' definition.
To add a simple data type, fill in a label for the type, click the + icon next to
the second column and select a data type from the list:
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Create a local type as part of a 'Complex Type' definition.
o

Not specified allows you to specify the data type in the DMN Editor.

Click Create to create the specified data object:

Now, you can reference the newly created data input in decision tables and data
input elements:

You can also add input data from a DMN diagram to the dictionary.
Select the element and click the Dictionary item in the lower left corner of the element:
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Create a dictionary entry based on the data input element.
Select the correct category (make sure to use a category that supports DMN data
modeling) and click Create :

Now, the data input is saved in the Dictionary and can be re-used in the Editor.
When labeling a data input element, automatic suggestions will help modelers with
re-using already existent data inputs:

Reference an existing data object.

Version 14.9

532

13 Workspace administration

13.7.8 Creating and managing process documentation templates
Process documentation can include diagrams as well as all element descriptions,
and dictionary entries. The documentation is created in Microsoft Word or PDF
format.
You can create custom templates that suits your organization's needs and generate
a process documentation based on a template.
You can, for example,
o
o
o

create an overview of all BPMN 2.0 process diagram tasks in your diagrams
create a matrix with all dictionary entries linked in the diagrams
create a detailed overview of the element usage in your diagrams

Not only the content of process documentations can be configured, but also their
visual properties.
Process documentation templates are stored in the Process documentation templates folder. This folder will appear in the folder tree on the left side of the
Explorer if you activate the process documentation templates as described below.
13.7.8.1 Activating the process documentation templates
1. Select in the menu bar under Setup the Show process documentation templates entry.

2. Select in the navigation on the left the Process documentation templates
folder.
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13.7.8.2 Creating a new template
1. Navigate to the template overview by selecting Templates in the folder tree
on the left side of the Explorer.

If the template folder is not shown in the folder tree, you can activate
the display as described above.
2. Select in the menu bar under New the Process documentation template
entry. You can also use create example template and then customize this
according to your needs.
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To create and edit new templates, you are directed to the Editor. Here, you can
define the document structure, edit header and footer or specify diagram details.
13.7.8.3 Working with templates
Editing templates is similar to editing diagrams - elements are placed on the canvas via drag&drop and customized via attributes, which you can edit on the right
side in the attribute editor. The alignment of the elements is done mostly automatically.
When you create a new template the following sections are applied automatically:
o
o
o

cover page
table of contents , which is automatically updated
content pages , containing the actual process documentation

You can adjust the sections as needed, add new pages, or remove one of the standard sections.
1. To delete a section, first select the element to delete, and then click in the
menu bar Delete .
2. In the panel on the left, under Document Structure all available elements are
listed. To add an element, drag the element on the canvas while holding the
left mouse button.
3. You can format labels of elements in the menu bar. Select the element and
then click the text format button. Here, you can define font size and color.
This can be useful to distinguish between various pieces of information that
are displayed as a list from each other, or to highlight certain information.
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General attributes

Many shapes have similar general attributes that can be set in the attribute panel.
These will be explained here. Other, shape specific attributes will be explained in
the section about the corresponding shape.
o

Color - You can change the background color of a section, sometimes also the
color of a label. You can either choose a color from the color picker or define a

o

hexadecimal value.
Label - Many shapes have a label that will stand in front of a value (for example
'Organization: [name of organization]'). You can define whether a label should be
displayed (check/uncheck the box 'Show label') and what the label should be by

o

o

configuring the corresponding attributes.
Show Label - Define if the label shall be displayed for the element by checking
or unchecking the box.
Hide page header/footer - Available in the More Attributes section of all sections - check or uncheck the box to hide the header or footer for the whole sec-

o

tion.
Display - Here you can choose whether you would like the information to be displayed in a list or in a table.

Importing/exporting templates

If you want to use an already applied template in an other Signavio workspace, you
can export it here. Templates are exported as Signavio archive SGX file and can
imported in another workspace for reuse.
1. Select the template file you want to export.
2. Click in the menu bar Import/Export and then the Export Signavio archive
(SGX) entry. The corresponding dialog opens.
3. By default, the latest revision of each template will be exported. However,
you can disable this option.
4. Click Export . The selected template is downloaded as SGX-file.
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13.7.8.4 The cover page
By default, when you create a new template, the first section is the cover page.
Cover page attributes

The cover page has a header and a footer, two spaces for content and the document
title in the center of the page.
You can configure the following attributes for the cover page section by clicking
onto the page and opening the attribute panel:
o

Title - Configure the title of a process documentation (per default, it is set to Process Documentation ).

o

o

o

Subtitle - An explanatory subtitle (in the example below it is "Business processes
2012")
Show a separator - When a subtitle is given, it can be separated optically by a
horizontal line.
Alignment - The title and subtitle can be aligned left, right or center. This option
only affects the text on the cover page.

Template parameters

In addition you can define template parameters for the cover page. Each template
parameter shape, available in the Document Structure header in the shape repository, contains information about the process documentation file in general.
Template parameters can contain one of the following variables:
o
o
o
o

Author
Organization (default)
Date
Version

In the attribute panel, you can define which kind of information should be displayed.
The data is automatically retrieved and added every time when you create the
actual documentation. You can also change the parameter label (for example,
'author') and determine whether this should be displayed before the value.
1. Drag the desired template parameter from the palette on the cover page.
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2. Configure its type in the attribute editor.

Adding an image

You can insert an image of your choice into the cover page. The image can be selected from the workspace or uploaded from your computer. The corresponding element can be found in the modeling palette under Static contents .
1. To add an image drag the Image element from the Static Contents section of
the shape repository to the cover page.
2. Select a picture from your computer or from the Signavio workspace by clicking the Edit button of the attribute Image. The dialog Edit: Image, link a
file/picture opens.
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4. Click Save to insert the image.
Sample cover
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13.7.8.5 The table of contents
The table of contents is created and updated automatically. When you create comprehensive templates, this update may take some time. In this case we recommend
to deactivate the automatic updating during modeling by unchecking the box of the
attribute Preview.

If you enable the preview again, the contents is updated.
13.7.8.6 The process documentation
The process documentation pages are configurable and can be adapted to your
needs.
Configuring the header and footer

For each of the three sections, you can design a separate header and footer. Thus,
you can specify for example page numbers and at the same time prevent that they
appear on the cover and in the table of contents.
1. Click at the top or at the bottom of a page (if there is no header or footer, you
can drag the corresponding element from the palette to the page).
2. In the header and footer section you will find all the elements that you can
specify. Drag the required element to the desired location.
3. In the attribute editor, configure the display of each element.
Each section's header and footer must be designed separately.
The following elements and configurations can be dropped into a header or footer:
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Element

Description

Page number

In the attribute panel, check the box Continue numbering to continue counting from a previous section. Otherwise the numbers for
this section will start at 1. Change the attribute value for Style to
switch from Arabic to Roman numbers, for example.

Date

Displays the documentation creation date.

File name

Displays the name of the file that is generated when exporting the
documentation, for example, 'Process_Handbook_Order-to-Delivery'.

Version

Displays the version of the process documentation, for example,
1.0.0.

Modification Displays the last modification date.
Text

Write a text you want to display in the header or footer into the attribute editor.

Image

Here you can put a logo or a small picture. Upload it or choose from
your workspace.

Sample footer

Configuring the header is not possible in the trial edition.
Chapters and sections

Before you can add any variable elements to the content section, you need to add a
chapter/section element.
If you drop another chapter into a chapter, a sub-chapter will be created. If you drop
a chapter below another chapter, a new chapter will be created. In case you don't
need an elaborate chapter structure, you can simply place a per Diagram or a
Folder structure element. These are needed as a container for information elements on diagram and element level. Chapters and sub-chapters can be named and
will be numbered and added to the table of contents automatically.
When you added a chapter, you can place static information elements. These elements do not need a container. Static information can be defined in the attribute
panel and does not change with the diagrams a handbook includes.
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A static attribute can for example be a disclaimer, a chapter overview, an image or
a table. You can put text directly into the table by double clicking it. Note that a
table can contain a header or a footer.
You can enforce page breaks, for example after large chapters, by placing a Page
Break element.
When configuring the display of dynamic diagram information, you can either use a
chapter per diagram with the Per Diagram element or use the Folder Structure element to create a chapter per folder (with a sub chapter for each diagram). In any
case, the order of the diagrams is aligned to the folder structure.
1. Create a chapter by dragging a Chapter/Section element from the shape
repository to the template.

2. To divide this chapter into sub-chapters, drag another Chapter/Section element on it.
3. In a chapter, you can drag different static elements whose values are set during the modeling of the template. Such elements do not need any containers.
4. In the attribute editor, you can choose between the numbering style of the
chapters (Arabic numbers (default), Roman numbers or bullet points) for the
whole section. You can also define if the corresponding chapter should be listed in the table of contents and if the numbers are displayed or hidden.
It is possible to create dynamic content based on the diagrams a process documentation is created for. Dynamic content is kept in the Per Diagram or Folder
Structure element.
Dynamically created chapters will get a small loop symbol on their upper right
corner in the template. You can easily combine static and dynamic chapters by for
example, dragging a Chapter/Section element onto a Per Diagram element.
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Sample chapter 'Introduction'

A chapter can contain different elements. For example, the chapter "Introduction"
could contain a free text element as the introduction text. Drag the Text element
from the section Static Content in the shape repository to a chapter. Add free text
to the introduction template.

Sample 'Complete overview of the individual diagrams'

In the following example, a graphic for all diagrams is displayed in the chapter
"Overview of individual diagrams":
1. Drag the container element to the appropriate chapter.

For each diagram, the container element will later create a new section.
2. Drag the element Diagram Image from the section Diagram Details to the Per
Diagram -element.
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3. In the attribute editor, you can restrict what diagram type to be inserted (if
for example only BPMN 2.0 process diagrams should be documented, disable
all other chart types).
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Diagram details

In addition to a graphical representation, you can represent numerous information
on the diagram as a whole, such as the diagram attribute and modeling elements of
a certain type. The subitems indicate the specific attributes for each template element that can be defined:
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Element

Description

Information Displays one of the diagram attributes Author, Diagram type, Last
modified, Link, Path, Revision number, Last author, Publishing
about the
status, Publishing date or Authors (all people who worked on the
diagram
diagram), which can be chosen in the attribute panel. You can add
more than one shape to display different attributes.
Diagram
image

Creates an image of the diagram. The following attributes can
be defined:
o

Rotate : defines if the diagram image should be rotated
90°. The default setting ‘Automatic’ rotates thediagram if it
is too large to fit.

o

Orientation : defines in which direction a diagram should

o

be rotated.
Stretch over multiple pages : if activated, a diagram is
printed in its original size, over multiple pages if necessary.

Attribute
on diagram
level

Select an attribute (or more in 'Multiple choice'), which value
should be presented for each diagram (for example process
description).
o

Attribute : Specify which attribute to be displayed in the
browser.

Process par- Displays all roles of a diagram. Pool/lanes, additional owner
ticipants

and organizations that are linked through a dictionary entry
are included here.
o

Lanes in diagram : Specify whether lanes should apply as

o

process participants.
Additional process participants : Select which process
participants should be taken into account in the overview

o

(depending on their RACI property).
Omit pools : Specifies whether pools should be included
in the overview.
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Element

Description

Data
objects

Lists all used data objects of a diagram.

IT Systems

Lists all used IT systems of a diagram.

Process trig- Lists all start events of a diagram.
ger
o

Only named events : Specifies whether events that have
no name, should be listed as process triggers.

Process res- Lists all end events of a diagram.
ults
o

Only named events : Specifies whether events that have
no name, should be listed as process results.

Linked dictionary
entries

Displays all dictionary entries linked in the diagram regardless of their category. Entries that are linked via a diagram element as well as links via own attributes are considered.
o

Categories : Select from which categories dictionary
entries should be included in the overview. To enable a
better overview in the list view, you can create a heading
for each of these categories in the form of a sub-chapter.

Document
revisions

This overview displays all versions of the diagram including
the creator and revision comment.
o

Limit : In the attribute editor, you can define the maximum number of revisions displayed, default: 10.

Element details

Information shapes on element level require another kind of sorting shape as diagram elements will be listed in a certain way here. You have to choose between a
table or a list view. If you add for a table, for each new information a column will be
added for the table.
1. Add a Table of Process Elements or a List of Process Elements to the documentation template. To change the layout later, alter the value of the Display as -attribute.
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2. The new element will function as a frame to display element-based information. Now you can add content to the table/list and define their attributes.
3. The columns 'Name' and 'Responsible' are created by default. Now you can
drag and drop 'Element Details' elements into the table/list. A column will be
added for each new element.
In list view, subitems are added instead of columns that you can also
select and edit.
4. If you want to delete a column, select it and click the Delete button in the
menu bar of the Editor, or alternatively use the delete key on your keyboard.
5. If you have selected an Attribute on element level or Attribute on element
level (Multiselection) , specify now a column header (attribute Title in the
attribute editor) and select the attributes to be viewed.
6. In the attribute editor, click the Edit button. In the dialog that opens, select
the corresponding attribute for each modeling element. The elements Process
participants , Data objects , IT systems and Used dictionary entries provide
information about the named item regarding the listed elements.
7. Configure the appearance and content of the table (or list) in the attribute
editor.
Table column elements

The following elements can be dragged into a table as a column:
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Element

Description

Attribute on element level

Select an attribute whose value will be listed for each element
in the diagram. A dialog will open, allowing you to configure
the selection.

Attribute on element level
(multiselection)

Select multiple attributes whose value will be listed for each element in the diagram. A dialog will open, allowing you to configure the selection.

Process participants

Insert a column that displays the element's process participants (organizations, departments or additional participants).

Data objects

Insert a column that displays the data objects that are connected to the element.

IT systems

Insert a column that displays the IT systems connected to the
element.

Linked dictionary
entries

Insert a column that displays all the dictionary entries linked to
the element.

Element type

Insert a column that displays the element type.

The resulting table could look as follows:
Sample tables

Sample: element overview table
Sample list
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Sample: element overview list
Sample exported table

This example table contains the name, the responsible role and documents that are
connected to each element of the diagram:

An exported element overview table
Table and list-specific attributes

You can configure the following properties of a table/list of process element shapes
in the attribute panel:
o

o
o
o

o

Diagram element types : choose elements that are supposed to be displayed for
each modeling language or notation.
Numbered : define whether the elements should be numbered.
Ignore unnamed elements : select whether to ignore or list unnamed elements.
Sorting : element information can be sorted by diagram and process flow or
alphanumerically by element type and label.
Display as : Choose between list and table.
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If all flows after a gateway have probabilities, flows are sorted by probability.
If only some flows have probabilities, the sorting follows additional rules:

o

o

If both outgoing sequence flows have probabilities, then the one with
the higher probability is listed first.
If only one or none have probabilities, then the positioning of their
target element on the canvas is used:
o The one positioned higher ends up in a higher list position.
o

o

If both are on the same height, then the element that is further left on the canvas is listed in a higher position.
If neither of them has a target element, then their IDs are compared to ensure consistent behavior.

13.7.8.7 Defining multiple languages for templates
It is possible to define multiple languages for diagrams in Process Manager. This feature is also available for templates.
If multiple languages are defined for you workspace, a little flag symbol in the upper
right corner of the template editor will allow switching the language of the template content.

Elements that are not available in the selected language will be highlighted. By
clicking their title, you can translate them.
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The original language will be displayed in the attribute editor. You can translate the
elements here.

If templates were defined in multiple languages you can choose the desired language each time a process documentation is created.

13.8 Importing/exporting diagrams and uploading files
The export features allow you to use your diagram data outside of Signavio Process
Manager and to transfer diagram data between Signavio workspaces/instances.
Moreover, you can import diagrams, e.g. to use data of legacy systems and upload
other relevant file to the Signavio workspace.
Importing diagrams
The import functionality allows transfer data from other workspaces or 3rd party
software to Signavio Process Manager.
Read more
o
o
o
o
o
o
o

Importing BPMN 2.0 XML diagrams
Importing XPDL 2.1. diagrams
Importing ARIS Markup Language (AML) diagrams
Importing Microsoft Visio diagrams
Importing the APQC Process Classification Framework
Import dictionary entries
Importing a set of dictionary items as a JAR file

Exporting diagrams
You can export diagrams into various formats. For example, you can create diagrams
in Signavio and export them as BPMN 2.0 XML in order to execute them with jBPM.
Read more

Version 14.9

552

13 Workspace administration

o
o
o
o

Export a BPMN diagram to XML
Export a diagram to PDF
Export a diagram as an image
Export a diagram to a Signavio archive (SGX)

Uploading files
It is possible to upload documents and pictures to your Signavio file storage.

The Import/Export menu in the Signavio Explorer provides the possibility to export diagrams
into and import them from various formats.

13.8.1 Uploading documents and pictures
Process Manager allows you to upload documents and pictures into your Signavio
file storage. These files can be linked to diagrams and, when published in Collaboration Hub, are accessible to colleagues with read access.
If the Signavio file storage is enabled for your workspace, its size and the maximum
uploadable file size are displayed in the workspace configuration dialog accessible
via the top drop-down menu of the Explorer in the header Setup. To configure those
limits according to your requirements, please contact the Signavio Support at support@signavio.com.
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This chapter contains information about uploading pictures and documents to your
file storage and maintaining your storage.
13.8.1.1 Uploading a document or picture to the Signavio file storage
To upload a file, open the folder of your workspace you want to upload a file to. Click
Import / Export , then Upload document/picture in the top drop-down menu of
the Signavio Explorer.

Upload a document or picture.
A dialog appears that allows accessing your Signavio file storage:

The upload dialog
Click Choose File to search for the file you want to upload:
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Select the file you want to upload.
The upload dialog of your operating system opens. Navigate to the file you want to
upload and confirm your selection. Please note that there must be enough free
space left in your file storage to upload the whole file. Also, make sure not to
exceed the maximum file size - by default, the maximum file size is 5 MB.
After confirming your selection, the upload dialog will update immediately:

After setting the options, click upload.
In case you want to change the folder the document should be saved in, click the
drop-down arrow and subsequently Choose another folder :
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Change the folder the document will be uploaded to.
Now you can select any folder in your Signavio workspace. After selecting the new
target folder, click OK :

Select the new target folder.
Click Save . Depending on the file size, this may take a moment. As soon as the
upload is completed, the file will be displayed in the corresponding folder.
The information panel on the bottom of the Explorer allows editing the file name or
adding a documentation:
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Edit the document's name.
If you try to upload a file that exceeds the maximum file size or the storage space of
your workspace, following dialog will appear:

If the file quota is exhausted or the size limit for a single file is exceeded, a warning
will be shown.
In those cases, you can try to upload a smaller version of the file or delete unused
pictures or documents from your file storage. If this is impossible, contact your workspace administrator or Signavio , to increase your storage space.
13.8.1.2 Updating a document or picture
A file in the Signavio file storage is updated by uploading a newer version of the
file. Each link to this file will then go to the updated version as well.
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To update a picture or document, go to the Explorer. navigate to the file and select
it. Click Import / Export , then Update picture if you selected a picture or Update
document if you selected a document in the top drop-down menu of the Signavio
Explorer.

The upload dialog appears. Click Browse again to select the new file version and
upload it as described above.
A new file version will now be created. The information panel at the bottom of
the Explorer <lower_panel>

allows viewing and reverting those versions.

13.8.1.3 Downloading pictures and documents
Of course, it is possible to download documents from you Signavio workspace.
Select the document or picture in the Explorer. Click Import / Export , then Download document in the top drop-down menu of the Signavio Explorer.
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If you selected a picture, choose Download picture from the menu.
13.8.1.4 Allowed file types
You can upload the following file types:
o
o
o
o
o
o
o
o
o
o
o
o
o
o
o
o
o
o

doc
docx

ppt
pptx
xls
xlsx
odt
ogg
zip
rar
pdf
audio/mpeg
audio/ogg
image/gif
image/apng
image/flif
image/webp
image/x-mng
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o
o
o
o
o
o
o
o
o

image/jpeg
image/png
multipart/form-data
text/css
text/csv
text/html
text/php
text/plain
text/xml

13.8.2 Importing BPMN 2.0 XML diagrams
During the 30-day trial period, this feature is only available on request.
The BPMN 2.0 standard includes an XML notation. It enables the platform independent exchange of BPMN 2.0 diagrams. To get more information about the BPMN
2.0 specifications, go to http://www.bpmn.org .
In Signavio Process Manager you can update your BPMN 2.0 model by importing a
new XML file. The import will update each process and subprocess in your model,
and will create a new diagram if a subprocess does not exist.
o

Click Import / Export , then Import BPMN 2.0 XML in the top drop-down
menu of the Signavio Explorer.
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o

A dialog opens. Click Choose File , select the XML file you want to import and
click Import .

Select the XML file. It has to be comply with the BPMN 2.0 XML standard.
o

The diagram will be imported.

In case the imported file is not standard-compliant, it is possible that not all elements can be imported or the whole import fails due to errors in the BPMN 2.0 XML
file. In these cases, a warning dialog describing the issues that will occur during the
import, appears:

In case the imported diagram is not standard-compliant, the system displays errors
and warnings.
If Errors occurred, the diagram will not be imported - Warnings only inform you
about diagram elements that may not be displayed after the import, but the diagram will still be imported.
Below you find an example of standard compliant BPMN 2.0 XML:
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BPMN 2.0 XML example code

Apart from information about the file (e.g the BPMN 2.0 Specification used), infomation about the process flow and graphical information about each element used
(bpmndi) are required.
E.g., if the bpmndi part is missing, the import will fail with the following error:

Errors occurred. In those cases, the diagram(s) cannot be imported.
If only some elements were not given bpmndi information, the import will continue
but show following warnings:

Warnings occur e.g. if graphical information is missing. However, the diagram can
still be imported, but the elements without graphical information will be left out.
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When opening the diagram, those elements will be missing.
Sometimes the import of BPMN 2.0 XML files is impossible due to errors unknown
to the System (e.g. because the imported file was not valid BPMN 2.0 XML). Please
contact the support@signavio.com in such cases.

13.8.3 Import Signavio archive (SGX) files
During the 30 day trial, this feature is available on request.
You can import diagrams that have been exported as Signavio archive (SGX) to your
workspace. For each import, you can decide how to handle dictionary entries. Dictionary entries can be added to the dictionary or merged with existing entries. Also,
you can import custom attributes and modeling language configurations.
Only one import can be started at a time. All users of a workspace with the necessary rights can see an import in progress when trying to run an import by themselves.
To run an import, follow these steps:
1. Open the explorer and go to Import / Export > Import Signavio archive
(SGX).

The import dialog opens.
2. On the Import tab, click Choose File and select the archive you want to
import.

3. You can customize the import with the following options:
o

Import contained Files/Pictures: if you disable this option, no linked documents and files are imported

o

Import dictionary entries
o

o

Overwrite existing dictionary entries with the same title

Import custom attributes and modeling language configurations

4. To run the import, click Import.

Diagrams and folders are imported.
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On the History tab of the import dialog, you can view the details of the last 50
imports, for example the import time, the import status, and which items have
been successfully imported.

13.8.4 Importing XPDL 2.1. diagrams
The XML Process Definition Language (XPDL) was specified by the Workflow Management Coalition (WfMC) to provide a language for specifying workflows. You find
more information about XPDL at www.wfmc.org .
The XPDL import is not enabled by default. The customer support team
will enable it on request.
With Signavio Process Manager. it is possible to import diagrams from XPDL files
into your workspace, also if they were created using a different modeling tool.
To import an XPDL 2.1. diagram, proceed as follows:
o

Click Import / Export , then Import of XPDL 2.1 in the top drop-down toolbar
of the Signavio Explorer.

Version 14.9

564

13 Workspace administration

o

Click Choose File , select the XPDL file and click Import .

Now, the diagram will be imported into your Signavio workspace.

13.8.5 Importing ARIS Markup Language (AML) diagrams
The ARIS® Markup Language (AML) is the XML export format of the software tool
ARIS®. Signavio Process Manager allows importing Event-driven Process Chains
(EPC), Organization Charts and Value Chains from ARIS® into your workspace.
To import diagrams from ARIS to Signavio Process Manager, you need to export the
diagrams in ARIS to the ARIS® XML format.
Then, follow these steps:
o

Click Import /Export, then Import ARIS® markup language in the top dropdown menu of the Explorer.
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o

Click Choose File, select the XML file you want to import and click Import:

Select the file you want to import.
Now, the diagram contained in the XML file will be imported.

13.8.6 Importing Microsoft Visio diagrams
This feature is only available on request. Contact Signavio Customer
Support for more details.
With a couple of mouse clicks, you can import diagrams you created with Visio Microsoft's drawing tool - into Signavio Process Manager. Like this, you can switch
to a fully-fledged BPM suite without re-modeling your business process diagrams.
The importer supports both BPMN 2.0 and EPC diagrams.
To import Visio diagrams, proceed as follows:
1. Open the Explorer and click Import / Export > Import Visio**.

2. Select the files you want to import, specify wether you will import BPMN 2.0
or EPC diagrams and click Import .
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The importer supports .vdx, .vsd and .vsdx files, as well as .zip
archives that contain such file types. Elements that are not part of
the BPMN 2.0 standard, respectively not EPC-compliant, will be
ignored.
Now, the diagrams will be imported into your workspace.

13.8.7 Importing the APQC Process Classification Framework
The APQC Process Classification Framework provides you with standardized business process landscape. Hereby, the focus on the framework lies on structure and
categorization -the what? - and not on details of process flow or activity - level the
how? .
Using the APQC framework to structure your process landscapes allows you to compare your processes and process performance metrics with other organizations and
to follow well-established BPM best practices, for example.
13.8.7.1 The representation of the APQC framework in Signavio Process Manager
The hierarchy structure of the APQC framework is represented by a folder tree in
Signavio Process Manager.
In each parent folder (a folder that is not on the lowest level in the hierarchy tree),
there is a Value Chain diagram that provides an overview over the folder content.
The diagram's Description attribute contains the corresponding APQC glossary
term .
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APQC Metrics are imported as dictionary entries with the custom attributes Metric
Category , Metric Id and Unit . The corresponding entries belong to the APQC-specific category Metrics .
A set of example metrics is imported when registering an APQC trial
workspace. To import further metrics, you need to make use of Import
dictionary entries .
13.8.7.2 Registering a APQC trial workspace
In case you don't have a Signavio workspace yet, you can register a new one at
https://editor.signavio.com/p/register?p=apqc (European Server), https://appus.signavio.com/p/register?p=apqc (US server) https://app-au.signavio.com/p/register?p=apqc (Australian server) and have the APQC framework
available right after logging in.
In case you already have a Signavio workspace, please contact our Signavio Support
Team at support@signavio.com to activate the APQC importer.
13.8.7.3 Importing the APQC spreadsheet
To import the APQC framework into your workspace, process as follows:
1. Download the framework as a Microsoft Excel spreadsheet from the
APQC web site .
You might want to modify the spreadsheet, especially in case you want
to import only part of the framework.
2. Open the Signavio Explorer and go to Import/Export - Import APQC Excel :
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3. Select APQC framework Excel spreadsheet and click Import :

The framework will be imported into the folder that is open in the
Explorer when the import is triggered.
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The import might take several minutes.
Now, you are able to use the APQC framework as the basis of your business process
management initiative in Signavio:

Use the APQC framework as the basis of your business process management initiative in Signavio.

13.8.8 Import dictionary entries
You can import dictionary entries from Microsoft Excel files (XLS or XLSX) to add
multiple entries at once and update existing entries. The import can't be used to
delete existing entries from the dictionary.
In a workspace, it is not possible to perform multiple imports simultaneously. If you
start an import while another user is running one, the import tool shows a message
and you have to wait until the other import is finished.
The import is limited to 500 records per Excel spreadsheet. When trying to import a
file with more records, the import fails. If you need to import more than 500
entries, split them up into multiple files.
For the Excel file structure, the following applies:
o

Spreadsheet
A spreadsheet can contain entries for only one category of the dictionary, no
matter if main or subcategory. This means that for each dictionary category,
you must import the entries individually.
If a file has multiple spreadsheets, all of them need at least a header column.
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o

Column header
The column header contains the dictionary attributes. You can choose any
name for the headers, as for the import you map the columns to the dictionary attributes in Process Manager.
If your dictionary entries are multilingual, we recommend to add language
codes to all column headers as language codes make the mapping easier for
you.
The import tool interprets the first row with text as the header.
You must start your dictionary file with the first column and fill in at least
three columns. If you fill fewer columns with a header or have empty columns
in between, the import fails.

o

Rows
Rows contain the actual dictionary entries and the information you want to
add, for example descriptions or statuses.

Example:

You can either create such a file or you export available dictionary entries and use
the export file as a template. Read more about exporting dictionary entries in the
section Export dictionary entries.
To import dictionary entries, follow these steps:
1. In the explorer, click Dictionary.
2. In the menu bar, click Import / Export > Import Excel.
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3. In the dialog, click Choose File, select the file you want to import from the file
selection dialog and click Open.

4. Click Import. The import mapping dialog opens.
5. In the first section, select an import mode:
o

Update existing entries only, ignore other rows

o

Create new entries for all rows

o

Update existing entries and create new ones

6. In the second section, select the spreadsheet you want to import and the dictionary category.

7. In the third section, which is active when updating entries, you must map the
Excel column and the dictionary entry attribute, which are used to identify
existing entries.
8. In the fourth section, map the file headers with the dictionary attributes.
9. To start the import process, click Import.

When all entries are imported, you are prompted with a summary including a
download link to the imported Excel file, which additionally contains the
import details. Open this file to verify the changes made by the import. Once
you have closed this prompt, the import of dictionary entries is complete.

13.8.8.1 Next steps
o

Importing a set of dictionary items as a JAR file

o

Export dictionary entries

13.8.9 Importing a set of dictionary items as a JAR file
This feature is available on request.
The JAR import feature allows you to import Java classes as dictionary items to use
them as data models in the Signavio Decision Manager.
Thereby, the attributes and relationships of the classes are created as decision
input/output data types.
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13.8.9.1 Preparation and requirements
Before you import the JAR, make sure the target dictionary category supports data
modeling .
The classes in your JAR need to fulfill the following requirements:
o
o

Classes need the @XmlType annotation.
Attributes need to be of one of the following data types:
o

String

o

Boolean

o
o
o

(and boolean )
Number (all subclasses) and int , double , byte , long , float
Nested classes (from the same JAR)

Collections of the above mentioned data types ( no generic collections, as
Set<? extends Number>

13.8.9.2 Examples
The following example shows a Java class that is valid for the import:
package sandbox.jarClasses;
import java.util.Set;
import javax.xml.bind.annotation.XmlType;
@XmlType
public class Relationship {
private
private
private
private

Person
man;
Person
woman;
Set<Person>
children;
boolean
broken;

public Person getMan() {
return man;
}
public void setMan(Person man) {
this.man = man;
}
public Person getWoman() {
return woman;
}
public void setWoman(Person woman) {
this.woman = woman;
}
public Set<Person> getChildren() {
return children;
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}
public void setChildren(Set<Person> children) {
this.children = children;
}
public boolean isBroken() {
return broken;
}
public void setBroken(boolean broken) {
this.broken = broken;
}
}

This example can't be imported, because the class lacks the @XmlType annotation:
package sandbox.jarClasses;
public class NotValid extends Relationship {
private int justANumber;
public int getJustANumber() {
return justANumber;
}
public void setJustANumber(int justANumber) {
this.justANumber = justANumber;
}
}
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13.8.9.3 Importing the JAR file
1. Open the Dictionary and click Import / Export - import JAR :

2. Select the JAR file and click Import :

Now, the JAR's Java classes are available as dictionary items.
Reload your browser to see the imported items.

13.9 Embedding Signavio diagrams in 3rd-party systems
There are several possibilities to make Signavio diagrams available in 3rd-party systems:
We recommend to embed Signavio Collaboration Hub:
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o
o

Embedding Collaboration Hub via an iframe
Integrate Collaboration Hub in a Microsoft SharePoint installation

You can also embed single Signavio diagrams.
o
o
o
o
o

Embedding diagrams as HTML code
Embedding diagrams as a Google gadget
Embed a diagram as an image
Embedding diagrams in MediaWiki
Embedding diagrams in Microsoft SharePoint wiki pages

13.9.1 Embedding Collaboration Hub via an iframe
Collaboration Hub can be embedded in third-party systems via an inline frame
(iframe). When using an internal wiki, the Collaboration Portal can be embedded to
provide direct access for authorized users. Like this, users can access the interactive functionality of Collaboration Hub alongside traditional documentation systems, such as Atlassian Confluence.
Learn how to integrate an iFrame into a Confluence documentation .
In case you are using Microsoft SharePoint, you can Integrating Collaboration Hub
with Microsoft SharePoint Online
The access control rules that normally apply to Collaboration Hub also apply to an
embedded instance:
o

o

o

o

A user who is logged in will see the Collaboration Hub preview, i.e. every diagram
of the workspace he can access, as well as his private diagrams.
A user who is not logged in but has installed the matching the Collaboration Hub
certificate will see the published diagrams.
In case Collaboration Hub is integrated with your Directory Service, a user will be
able to see diagrams they have read access to.
A user who is neither logged in nor has installed the Collaboration Hub certificate will receive an SSL connection error.

To embed a Collaboration Hub in a website or wiki via iframe, add an iframe tag and
insert Collaboration Hub URL as its source. Please make sure to use a URL of the
form https://editor.signavio.com/intra/portal (European Server),
https://app-us.signavio.com/intra/portal
navio.com/intra/portal
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that is displayed by default. To define a default diagram, its diagram identifier can
be added to the URL in the form "#/model/[diagram id]". The example iframe below
defines such a start diagram. To find the correct link, open the corresponding diagram in Collaboration Hub and copy its URL.
When defining a start diagram, make sure that the corresponding diagram has been published to Collaboration Hub in the correct revision.
Otherwise, Collaboration Hub guests that are not logged in will not be
able to see it.
On iframe that embeds Collaboration Hub can look like this, for example:
<iframe
src="https://editor.signavio.com/intra/portal#/model/273j5d0mf3174c3b8b94
39fn5k2a8b0f"
width="90%"
height="90%"
name="Signavio Collaboration Hub">
</iframe>

Embedded into an empty html page, the iframe could look like this:
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13.10 Integrating Signavio Process Manager with
Workflow Accelerator
To use this feature, you need Workflow Accelerator licenses. For more
information, contact sales@signavio.com .
With the Workflow Accelerator integration, you combine Process Manager with an
execution system.

13.10.1 Setup
To establish a link between Process Manager and Workflow Accelerator, open the
Signavio Explorer, select a diagram and click Workflow Accelerator - Execute in
Workflow Accelerator :

If the integration has not been set up, an activation dialog is displayed. Activate the
check box at the bottom of the dialog and click Activate :
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A new dialog will guide you through the deployment of your first process as
described at Process deployment .

13.10.2 Process design
You can design Workflow Accelerator processes like any other processes .
We recommend to check the BPMN elements that are supported by Workflow
Accelerator .
Let's take a look at a simple document approval process:

A document approval process that can be executed in Workflow Accelerator.
The process consists of only basic BPMN elements.
We recommend to stick to the following elements for your first Workflow Accelerator processes:
o
o
o
o
o

Pools/Lanes
Simple Start and End Events
Exclusive and Parallel Gateways
User and System Tasks
Sequence Flows

When designing a process, it often helps to make use of Signavio's Collaboration
and Simulating BPMN diagrams features.
For example, to increase process awareness and encourage feedback, you can publish the diagram in the Collaboration Hub.
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13.10.3 Process deployment
To transfer a process to Workflow Accelerator, select it in the Signavio Explorer and
click Workflow Accelerator - Execute in Workflow Accelerator .
If the process contains elements that are not supported by Workflow Accelerator, a
warning is shown. If these elements are relevant for process execution, adjust the
process accordingly.
Select the diagram language the process should have in Workflow Accelerator and
click Transfer :

13.10.4 Adjusting deployed processes
Sometimes you will find it necessary to adjust the process after a couple of test
runs in Workflow Accelerator.
o

o

You can adjust the process in Signavio Process Manager and re-deploy it as
described above at Process deployment .
You can adjust the process directly in Workflow Accelerator as described at Processes . Then, you can use the Execute in Workflow Accelerator function in
the Signavio Explorer to transfer the changes back to Signavio Process Manager.

For more information about process execution, refer to the sections Working with
approval workflows and Starting a new process case .
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13.11 Integrate Collaboration Hub in a Microsoft
SharePoint installation
If you are using our On Premises Edition, follow the instructions in the
Administrator Guide.

o

Integrating Signavio Collaboration Hub with Microsoft SharePoint
2013 requires your SharePoint system to support TLS version 1.1
or 1.2. Learn how to activate TLS 1.1/1.2 support at https://technet.microsoft.com/library/mt773991.aspx .

o

Since Microsoft stopped supporting Microsoft SharePoint version
2007 and 2010, we only support SharePoint version 2013 and
2016.

Depending on your integration scenario, you can choose between Certificate-based
and Windows Azure/Active Directory-based authentication.
o

Certificate-based authentication
The Signavio SharePoint App authenticates as a "guest user" against Signavio, using the Signavio security certificate. Every diagram published in your
Signavio Collaboration Hub will be visible for every user who has access to
the respective Microsoft SharePoint page(s).

o

Windows Azure/Active Directory-based authentication
The Signavio SharePoint App authenticates as the accessing Active Directory
user against Signavio via LDAP. The access rights of each Active Directory
user and user group can be configured in the Signavio Explorer.

In case you use SharePoint Server 2013/2016 , proceed at Integrate Collaboration
Hub with Microsoft SharePoint 2013/2016 to learn how to establish the integration with either certificate-based or Active Directory-based authentication.
In case you use SharePoint Online , proceed at Integrating Collaboration Hub with
Microsoft SharePoint Online to learn how to establish the integration with either
certificate-based or Active Directory-based authentication.
In case you experience problems when setting up the integration with Microsoft
SharePoint, see Troubleshooting the Microsoft SharePoint integration.
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13.11.1 Integrate Collaboration Hub with Microsoft SharePoint
2013/2016
This section explains the Microsoft SharePoint 2013/2016 integration
with certificate-based authentication.
If you are using our on-premises edition, follow the instructions in the
Administrator Guide.
In case you experience problems during the integration, please read Troubleshooting the Microsoft SharePoint integration .
To integrate Collaboration Hub with SharePoint Server, follow these steps:
o

o
o
o
o

Installing the Signavio Connector Web Service (AD-based access, SharePoint
2013/2016)(only for Active Directory-based authentication)
Downloading the Signavio Collaboration Hub SharePoint App
Manage read access rights (only for Active Directory-based authentication)
Install the Signavio App on Microsoft SharePoint 2013/2016
Configuring the SharePoint 2013/2016 App

13.11.1.1 Installing the Signavio Connector Web Service (AD-based access, SharePoint
2013/2016)
The web service is required for SaaS systems to gain access to Active Directory
data within a local domain.
1. Download the web service files here: https://editor.signavio.com/sharepoint/signavio_ldap_access.zip
2. Open the file Web.Config and configure the values of serverurl and base .
base_DN

refers to Active Directory folders, which are used to search for users

and user groups. In case several folders need to be added, separate them with
a | during the configuration.
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The base_DN folder values can be defined like the following examples:
o

OU=Groups,OU=AAA,OU=Organization,DC=adtest,DC=local

o

OU=Users,OU=AAA,OU=Organization,DC=adtest,DC=local

o

OU=Groups,OU=BBB,OU=Organization,DC=adtest,DC=local

o

OU=Users,OU=BBB,OU=Organization,DC=adtest,DC=local

o

OU=Groups,OU=CCC,OU=Organization,DC=adtest,DC=local

o

OU=Users,OU=CCC,OU=Organization,DC=adtest,DC=local

In Active Directory , there are two types of folder icons. Regular folders use
the syntax CN=foldername and Organization Unit folders (as shown in the
example) use a syntax like OU=foldername .
3. To use a specific user name and password to access the Active Directory
instead of an Application Pool identity, uncomment the username and password

fields and fill them accordingly. Note that the user name must have a

domain prefix, e.g. TEST\User.
4. Copy the signavio_ldap_access folder to the wwwroot directory, which is (by
default) C:\inetpub\wwwroot. Make sure that the NetworkService account
has read access to the folder (by default that is the case).
5. Open the IIS manager and select Application pools from the expandable list
on the left. Right click the Signavio application pool and select Add
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Application Pool...:
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6. Enter the following parameters for the new Application Pool:

Name: signavio_ldap_access
Net Framework-version: 4.0.X
Managed Pipeline mode: Classic Start Application pool: Yes
7. Right-click the newly created Application Pool and select Extended options .
Under Process Model , check that the identity is NetworkService. If not, edit
the field’s value by selecting NetworkService from the first drop-down list
and click OK:

Version 14.9

585

13 Workspace administration

8. Right click Sites in the menu on the left and select Add Website..:

9. Enter the following parameters:
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Sitename: signavio_ldap_access
Application pool: signavio_ldap_access (select from the list)
Physical path: navigate to the signavio_ldap_access folder(default path:
C:\inetpub\wwwroot\signavio_ldap_access)
Port: choose a suitable port, which is not used by other websites, e.g.
33333
Hostname: leave empty
Check „Start
website“

10. Enter http://<your\_ip>:<port>/setup.asmx into the web-browser, for
example http://192.168.1.1:33333/setup.asmx . The browser will notify
about the status of the service. If the page is displayed and the Active Directory connection is marked with OK , the connector URL and the Security
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Token are displayed:

13.11.1.2 Downloading the Signavio Collaboration Hub SharePoint App
Open the Explorer to download Signavio Collaboration Hub SharePoint App. Make
sure you are logged in as a workspace administrator and follow these steps:
1. Click Setup , then Manage Collaboration Hub authentication in the top dropdown menu of the Signavio Explorer.
2. Select from the dropdown menu the desired authentication method:
o

For Active Directory-based authentication, select LDAP based authentication as
the authentication mode and the correct SharePoint version. Insert the URL of

o

the connector web service, as well as its security token before downloading.
For certificate-based authentication, select Certificate based authentication as
the authentication mode and the correct SharePoint version.

3. Click Save and Test . In case the test terminates with an error, check your
configuration settings.
4. Click Download SharePoint Webpart .
The dialog also provides the download of a Collaboration Hub certificate
that can be installed in a web browser. Read more about the certificatebased publishing in the section Creating certificates
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13.11.1.3 Manage read access rights
If you set up certificate-based authentication, you can ignore this section.
If you set up Active Directory-based authentication and you do not configure access rights to any published diagram, users see an empty Collaboration Hub.
In this chapter you will learn how to manage read access rights on Collaboration
Hub for Active Directory users and user groups. To enable directory service-based
(AD, Windows Azure) authentication, it is necessary to grant diagram access rights
to domain users or user groups. Via the read access configuration dialog, you can
configure which user or user group can get access to specific diagrams or folders in
Signavio.
1. Open the Explorer. We recommend to use a different browser or your
browser's incognito mode, to avoid session conflicts, see Troubleshooting the
Microsoft SharePoint integration .
2. Click in Setup menu the Manage access rights entry.
3. Open the Read access tab in the Manage access rights dialog.
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4. Choose a folder or diagram in the left navigation column. The dialog shows
the access rights connected to the object. If the right has been assigned to a
parent directory the corresponding folder is displayed as well.

5. If you have marked the desired folder, then you can specify the user you want
to grant access for. Type in a user name by using the search functionality - as
soon as you start typing, a drop down list appears containing the user names
found. Select the user name. Alternatively click the input field and choose a
user name from the drop down list. To navigate through the sites, use the
arrow at the bottom of the list.

Opening the read access dialog and searching for a user or user group
can serve as a test of the directory service integration. If an existing
user does not appear, something went wrong during the setup.
6. Click Add. The user can now be found in the list of granted access rights.

13.11.1.4 Revoking read access
1. Open the Explorer. We recommend to use a different browser or your
browser's incognito mode, to avoid session conflicts, see Troubleshooting the
Microsoft SharePoint integration .
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2. Click in Setup menu the Manage access rights entry.
3. Open the Read access tab in the Manage access rights dialog.

4. Select the user you want to remove from the list of users with read access.
5. Click Remove right next to the user name.

If the read access is inherited from the parent directory, the
Removeoption is not displayed. Navigate to the appropriate folder using
the inherited from column and delete the permission here.
6. Confirm by clicking the Yes button in the warning message box.
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13.11.1.5 Install the Signavio App on Microsoft SharePoint 2013/2016
Configure your Active Directory service before you install Collaboration
Hub SharePoint App.
To setup certificate-based authentication, skip this step and proceed at
Downloading the Signavio Collaboration Hub SharePoint App .
Copy the file SignavioViewer2013_2016.wsp (for download see Downloading the
Signavio Collaboration Hub SharePoint App) into a directory of your choice on the
Microsoft SharePoint server. Install the Microsoft SharePoint solution as described
in the corresponding Microsoft SharePoint manual. The following section gives a
short introduction into the installation of the Signavio SharePoint App on various
versions of Microsoft SharePoint servers. The argument SharePointServerURL represents the Microsoft SharePoint server’s web application URL .
To install the webpart for Microsoft SharePoint Server, open the management shell
of Microsoft SharePoint, navigate to the directory containing the file SignavioViewer2013_2016.wsp and execute the following commands:
1. Upload the SharePoint Solution package using the following command:
Add-SPSolution -LiteralPath {PATH_TO_WSP}

Sample
Add-SPSolution -LiteralPath
C:\Users\Administrator\Desktop\SignavioViewer2013_2016.wsp

2. Install the solution on SharePoint. Please mind the version number in the
code examples. :
Install-SPSolution -Identity {} -WebApplication {SharePoint
2013 Server URL} -GACDeployment

Sample
Install-SPSolution -Identity signavioviewer2013_2016.wsp
- WebApplication http://win2k8-test3/ -GACDeployment
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3. Check the status of the installation by using the SharePoint Central Administration:
http://{SP_SERVER}:{PORT}/_
admin/SolutionStatus.aspx?ItemName=signavioviewer2013_2016.wsp&Lcid=0

Sample
http://win2k8-test3:10343/_
admin/SolutionStatus.aspx?ItemName=signavioviewer2013_2016.wsp&Lcid=0

In case there are problems during the installation, see Troubleshooting the
Microsoft SharePoint integration.
13.11.1.6 Configuring the SharePoint 2013/2016 App
Once you have installed the Microsoft SharePoint app on your server, you can add
Collaboration Hub to the desired web page.
1. Click under Page the Edit page entry.
2. Via Add webpart you can embed the installed component.
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3. Activate the Signavio Collaboration Hub Web Part option and then click Add.
4. Click Edit to add the Signavio URL to the Signavio section on the right side.
This either directs to the Signavio server or defines an URL to a specific start
diagram (URL from the Collaboration Hub preview):

5. You can set component layout components, such as title or dimensions:

6. You can perform advanced settings, such as page description or insert a link
to a help page.
You find more information about embedding a webpart here: http://office.microsoft.com/de/HA010097463.aspx .
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13.11.1.7 Manage read access rights
If you set up certificate-based authentication, you can ignore this section.
If you set up Active Directory-based authentication and you do not configure access rights to any published diagram, users see an empty Collaboration Hub.
In this chapter you will learn how to manage read access rights on Collaboration
Hub for Active Directory users and user groups. To enable directory service-based
(AD, Windows Azure) authentication, it is necessary to grant diagram access rights
to domain users or user groups. Via the read access configuration dialog, you can
configure which user or user group can get access to specific diagrams or folders in
Signavio.
1. Open the Explorer. We recommend to use a different browser or your
browser's incognito mode, to avoid session conflicts, see Troubleshooting the
Microsoft SharePoint integration .
2. Click in Setup menu the Manage access rights entry.
3. Open the Read access tab in the Manage access rights dialog.
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4. Choose a folder or diagram in the left navigation column. The dialog shows
the access rights connected to the object. If the right has been assigned to a
parent directory the corresponding folder is displayed as well.

5. If you have marked the desired folder, then you can specify the user you want
to grant access for. Type in a user name by using the search functionality - as
soon as you start typing, a drop down list appears containing the user names
found. Select the user name. Alternatively click the input field and choose a
user name from the drop down list. To navigate through the sites, use the
arrow at the bottom of the list.

Opening the read access dialog and searching for a user or user group
can serve as a test of the directory service integration. If an existing
user does not appear, something went wrong during the setup.
6. Click Add. The user can now be found in the list of granted access rights.

13.11.1.8 Revoking read access
1. Open the Explorer. We recommend to use a different browser or your
browser's incognito mode, to avoid session conflicts, see Troubleshooting the
Microsoft SharePoint integration .
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2. Click in Setup menu the Manage access rights entry.
3. Open the Read access tab in the Manage access rights dialog.

4. Select the user you want to remove from the list of users with read access.
5. Click Remove right next to the user name.

If the read access is inherited from the parent directory, the
Removeoption is not displayed. Navigate to the appropriate folder using
the inherited from column and delete the permission here.
6. Confirm by clicking the Yes button in the warning message box.
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13.11.1.9 Installing the Signavio SharePoint App on Microsoft SharePoint Online/365
1. Access the SharePoint administrator interface by clicking on the Apps button
in SharePoint Online:

2. Select the Admin tile:
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3. In the navigation area, select the SharePoint entry under ADMIN :
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4. Go to apps and open the App Catalog :

5. In the navigation area, select Apps for SharePoint and then click New .
You may need to create a new site here.
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6. Click new item and then upload the SignavioViewer365.app file. Disable the
check box Add as a new Version to existing files :

7. Finally click on OK .
Adding the app part

To add the app part to a SharePoint Online site, proceed as follows:
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1. Access the SharePoint site, to which you want to add the Signavio
SharePoint app part, e.g. https://COMPANY.sharepoint.com/ .
2. Under Settings , select the Site contents entry:

3. Select Add an app :

4. Click SignavioViewer365App and then check Trust it in the pop up dialog.
5. Now, a one-time configuration is necessary. Click on the newly installed app
to start the configuration:
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6. Upload the SignavioViewer365config.csv from the zip-file you downloaded
before and click Save . The file contains information about the server address,
a certificate and a password to identify your Signavio workspace:

Signavio Collaboration Hub opens.
Activating the app part

To activate an app part on a teamsite in SharePoint Online, proceed as follows:
1. First, select the page tab on the page on which the app part should be displayed.
2. Click Edit .
3. Switch to the Insert tab.
4. Click App Part .
5. Select the entry Signavio Collaboration Hub for SharePoint Online .
6. Click Add .
You can define an entry-point diagram for the Signavio SharePoint app part.
1. Open the configurations menu of the app part and edit the field entry point .
You can get the URL through the portal preview of the entry point diagram in
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the Signavio Explorer - for example https://editor.signavio.com/p/portal\#/model/39e3b4b9134544b98ae4291545cd7928

2. Insert the entry point URL (in the lower left corner).
It is possible to add the app part multiple times in your SharePoint, for example in
different pages, and add a different entry-point to each instance. You do not need
to upload the configuration again.
Removing or updating the Signavio SharePoint App

To install a new version of the Signavio SharePoint App, the previously
installed app must be completely removed.
1. Open your App Catalog in SharePoint Online:
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2. Select the appropriate app and then click on More - Delete :

3. In the naviagtion area, open the Site contents :

4. Select the app and then click Remove in the context menu. The app is moved
to the recycle bin.
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5. The app must now be removed from your recycle bin. To do this, open the
recycle bin :

The recycle bin should contain two apps. If this is not the case, ensure you followed the procedures correctly. Delete both Apps.
6. Now, the app has to be removed from the SharePoint Administration's
second-stage recycle bin. Open the Recycle bin and then the second-stage
recycle bin:

Version 14.9

606

13 Workspace administration

7. Remove both apps from the second-stage recycle bin.
8. If you want to update the app, reinstall it as described above.
9. When the new app is installed, update all sites that reference the app.
13.11.1.10 Removing the Signavio App
With Microsoft SharePoint 2013/2016, the web part can be removed via the solution manager of the central administration.
1. Go to the system settings in the central administration.
2. Retract the web part and then remove it.
Alternatively, you can retract and delete the web part on the Microsoft SharePoint
administration shell using the following commands:
Uninstall-SPSolution –Identity signavioviewer.wsp –
WebApplication <SharePointServerURL>
Remove-SPSolution –Identity signavioviewer.wsp
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13.11.2 Integrating Collaboration Hub with Microsoft SharePoint
Online
This section explains the Microsoft SharePoint Online integration with
Windows Azure-based or certificate-based authentication. An overview
over the different SharePoint integration variants can be found here:
Integrate Collaboration Hub in a Microsoft SharePoint installation .
In case you experience problems during the integration, see Troubleshooting the
Microsoft SharePoint integration .
To integrate Collaboration Hub with SharePoint Online, the following steps are
necessary:
o

o
o
o
o

Configuring Microsoft Azure Active Directory (only for Active Directory-based
authentication)
Downloading the Signavio Collaboration Hub SharePoint App
Manage read access rights (only for Active Directory-based authentication)
Install the Signavio App on Microsoft SharePoint 2013/2016
Activating the app part

13.11.2.1 Configuring Microsoft Azure Active Directory
Configure your Active Directory service before you install the Collaboration Hub SharePoint App.
To setup certificate-based authentication, please skip this step and proceed at Downloading the Signavio Collaboration Hub SharePoint App .
The Signavio system needs to have read access to your Windows Azure Active Directory. Microsoft offers Cmdlets for the Microsoft PowerShell to configure external
application rights to your Windows Azure Active Directory.
To configure the Microsoft Azure Active Directory, proceed as follows:
1. Download the Windows Azure Active Directory Module for Windows PowerShell and follow the installation instructions on https://docs.microsoft.com/en-us/powershell/msonline/v1/azureactivedirectory .
2. Open a PowerShell and import the MSOnline module:

Version 14.9

608

13 Workspace administration

import-module MSOnline
import-Module MSOnlineExtended -Force

3. Login with your SharePoint Online administrator account:
$msolcred = get-credential
connect-msolservice -credential $msolcred

4. Create a new service principal that represents the Signavio Process Editor

application in your Windows Azure Active Directory. Ensure that SYMMETRIC_
KEY

is created as well as AppPrincipalId . The ObjectID is used in a later

step.
See also: http://technet.microsoft.com/en-us/library/dn194119.aspx
New-MsolServicePrincipal ServicePrincipalName @("{principal name/domain}")
-AppPrincipalID "{A GUID}" - DisplayName "{Display Name}"
-Type Symmetric -Usage Verify

Example :
New-MsolServicePrincipal ServicePrincipalName @("editor/signavio.com")
-AppPrincipalID "f592d4af-bf33-47c2-a010-94f2a323ab58"
-DisplayName "Signavio Process Manager" -Type Symmetric -Usage
Verify

Output :
The following symmetric key was created
as one was not supplied
DisplayName
:
ServicePrincipalNames :
a010-94f2a323ab58}
ObjectId
:
AppPrincipalId
:
TrustedForDelegation :
AccountEnabled
:
Addresses
:
KeyType
:
KeyId
:
StartDate
:

Version 14.9

{SYMMETRIC_KEY}
Signavio Process Manager
{editor/signavio.com, f592d4af-bf33-47c2ddadd653-bda2-4f1f-87d2-22a180563a34
f592d4af-bf33-47c2-a010-94f2a323ab58
False
True
{}
Symmetric
b1b56bcc-63dc-4c80-8320-55bd3cd79a07
23.09.2013 16:58:19

609

13 Workspace administration

EndDate
Usage

: 23.09.2014 16:58:19
: Verify

5. Apply the role Service Support Administrator to the service principal (has
read access to the Windows Azure Active Directory):

Add-MsolRoleMember -RoleName "Service
Support Administrator"
-RoleMemberObjectId {ObjectID} -RoleMemberType ServicePrincipal

Example :
Add-MsolRoleMember -RoleName "Service
Support Administrator"
-RoleMemberObjectId ddadd653-bda2-4f1f-87d2-22a180563a34
-RoleMemberType ServicePrincipal

6. Get your Tenantd :
#(get-msolcompanyinformation).objectId

TenantId , SymmetricKey

, and AppPrincipalId are required for downloading the

Signavio Collaboration Hub SharePoint App, see section Downloading the Signavio
Collaboration Hub SharePoint App .
Updating expired Azure Active Directory credentials

The credentials for establishing the connection to Azure Active Directory expire after one year. Ifyou don't update the credentials, searching for users in the Manage read access dialog isn't possible .
To update the credentials, proceed as follows:
1. Look up the credentials for your service principal :
Get-MsolServicePrincipalCredential -ServicePrincipalName "editor/signavio.com"

2. Enter your symmetric key .
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3. If the credentials have indeed expired, update with the following command.
The command returns a new symmetric key .
New-MsolServicePrincipalCredential -ServicePrincipalName "editor/signavio.com"

4. Add the key to the configuration via the Manage Collaboration Hub certificate dialog.
13.11.2.2 Downloading the Signavio Collaboration Hub SharePoint App
Open the Explorer to download Signavio Collaboration Hub SharePoint App. Make
sure you are logged in as a workspace administrator and follow these steps:
1. Click in the Setup menu the Manage Collaboration Hub authentication entry.
If you have not created a certificate yet, a warning dialog opens.
2. In the warning dialog, click on Create certificate .
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3. Select the authentication mode from the drop down menu:
o
o
o

Certificate based authentication
LDAP based authentication
Windows Azure Active Directory based authentication

Depending on your selection, you have to perform further configuration.
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4. If you select Certificate based authentication as authentication mode, use
SharePoint 365 as SharePoint version. You can then download SharePoint
Webpart/App.
5. If you select Windows Azure Active Directory based authentication as

authentication mode, insert the Windows Azure Tenant ID , the Principal ID
and the Symmetric Key . Click Save and Test . In case the test terminates
with an error, check your configuration settings. Click Download SharePoint
Webpart/App.

6. Depending on your web browser configuration the download starts or a download dialog box is displayed.
7. Unpack the downloaded .zip-file with an application of your choice, e.g. with
the standard Windows tool. The unzipped folder contains the following files:
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o
o

SignavioViewer365.app - the Signavio App for Microsoft SharePoint
SignavioViewer365config.csv - the configuration file for the Signavio App.

13.11.3 Defining the entry point diagram
You can define an entry point diagram that is displayed when a user opens Collaboration Hub via a SharePoint site.
In case you configured Active Directory-based authentication, ensure
the users have access to the entry point diagram.
o

If you want to configure one entry point diagram that is displayed in all
SharePoint pages, you can set a general Collaboration Hub configuration prop-

o

erty in your Signavio workspace, see Entry Point .
If you want to configure an entry point diagram for one specific SharePoint page
you can set the corresponding property when configuring Signavio Collaboration
Hub App for this site, see Configuring the SharePoint 2013/2016 App.
This feature is supported by SharePoint 2013/2016 only.
For the new Collaboration Hub, it is possible to add deep links to different areas of your entry point diagram. For more information, please
contact Signavio Support.

13.11.4 Updating the SharePoint authentication certificate
This article is only relevant if you use the SharePoint integration with
the software-as-service version of Signavio Process Manager.
13.11.4.1 Updating the certificate in SharePoint Online
1. Remove the app as described at Removing the Signavio App .
2. Reinstall the app as described at Integrating Collaboration Hub with
Microsoft SharePoint Online .
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To update the app, you need to download the new App in the Signavio
Explorer.
13.11.4.2 Updating the certificate in SharePoint Server 2013/2016
1. Open the Explorer and click under Setup the Manage Collaboration Hub
authentication entry.
2. In the Manage Collaboration Hub authentication dialog, click Download certificate .

Make sure you download the new certificate and not the old one you
find in the section Management of old certificates .
3. Remember or document the password of the new certificate, you will need it
later.
4. In Microsoft SharePoint, open the Signavio web part configuration.
5. Upload the new certificate and insert the new password:
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6. Click OK to save the new configuration.
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13.11.5 Troubleshooting the Microsoft SharePoint integration
13.11.5.1 Microsoft SharePoint 2013/2016 Installation errors
Error

Solution

The commands to
install,
deploy, unin- Make sure the Windows Service SharePoint Administration is up
and running. By default, the startup options of this service are set
stall or
remove the

to manual .

SharePoint
solution do
not work.
If your SharePoint system setup allows you to make
changes to the web.config file of your SharePoint application (the default location is C:\inetpub\wwwroot\wss\VirtualDirectories\80

), please make your

that the useDefaultCredentials flag is set to true. By using
this configuration the SignavioViewer can make use of the
Invalid authen- system's proxy configuration that Internet Explorer is
tication
using as well.
token/cannot
On the SharePoint server, go to **Configuration** resolve host

**SharePoint** - **SafeControls** - **SafeControl** and
ensure the entry looks as follows:
SafeControl Assembly="SignavioViewer2013"
Version=1.0.0.0
Culture=neutral
PublicKeyToken="e6770998a80d4130"
Namespace="SignavioViewer2013.SignavioVisualWebPart"
TypeName="*"
Safe="True"
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13.11.5.2 Sharepoint app cannot perform requests to the Signavio server
Error

Solution

If you configured the IIS server SharePoint is
running on using Integrated Security
without anonymous access and the impersonation feature is turned on, the Signavio
When the SharePoint app

SharePoint App might not be able to per-

tries to authenticate

form requests to any server outside the

against the connected

local network.

workspace on the Signavio

The suggested solution is to disable imper-

server, it displays the error

sonation and to allow the account running

"unable to connect to the

the SharePoint application pool internet

remote server".

access.
The following blog post describes the problem in-depth: http://weblogs.asp.net/owscott/iis-windowsauthentication-and-the-double-hop-issue

13.11.5.3 Sharepoint security token issue
Error

Solution

An operation failed

The local root certificate might have been

because the following cer- deleted. Make sure to set the certificate in
tificate has validation
place.
errors
Subject Name:
CN=SharePoint Security
Token Service,
OU=SharePoint, O=MMicrosoft, C=US Issuer
Name: CN=SharePoint Root
Authority,
OU=SharePoint, O=MMicrosoft, C=US Thumbprint:
50928B849FD8AFD29A6562B6E19F45E93397F6CC
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13.11.5.4 The read access management dialog does not load users and user groups
Error

Solution

The Manage users - Read

Activate the loading of mixed content in

access dialog reports that

your Internet Explorer configuration set-

the SharePoint Connector

tings under Internet options - Security -

is not available.

Custom level (Internet zone) .

13.11.5.5 The user's Collaboration Hub remains empty
Error

Solution

The user's Col-

You haven't granted access to any published diagram

laboration Hub

yet. Read about how to grant read access at Manage

remains empty

read access rights .

13.11.5.6 SharePoint displays the Signavio login page, although the authentication
mechanism was configured correctly
Error

Solution

When opening the page that

In your browser, please check if you are

contains the Web Part, the Sig-

logged in as Signavio modeler or work-

navio login page is displayed

space administrator. If so, log out and

instead of Collaboration Hub.

reload the SharePoint page.

13.11.5.7 Authentication Certificate
If you use the Signavio SharePoint App with the software-as-a-service version of
Signavio Process Manager, please update the authentication certificate by December 15, 2016.

13.11.6 Configuring SharePoint Search
The SharePoint search allows users to search for documents which are uploaded
into SharePoint and then associated with diagram elements or dictionary entries in
Signavio Process Manager. The full text search is performed using the Explorer or
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advanced search in Collaboration Hub.
This feature is only available on request. For more information, please
contact Signavio Support.
1. Open the Explorer to configure the SharePoint search.
2. Select Manage SharePoint search in the Setup menu.

3. Make the following settings in the Manage SharePoint search dialog:
o
o
o
o
o

Search endpoint : Specify the URL of the SharePoint API endpoint.
User name: Specify the Windows user name.
Password : Enter the corresponding password.
Workstation : You can specify a computer name.
Active Directory domain : You can specify a domain.

4. Confirm your settings with Save.
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The performance of the full text search in Collaboration Hub depends on
the performance of your SharePoint server.

13.12 Signavio Process Manager for SAP Solution
Manager 7.2
This feature is available on request. For more information, please contact Signavio Support.
SAP Solution Manager is one of SAP's Application Lifecycle Management (ALM)
offerings.
Process Manager can be used as an interface for SAP Solution Manager.
You can import the following content type from SAP Solution Manager to Process
Manager:
o
o

The Executable Library as dictionary entries
The Process Step Library as dictionary entries

You can export the following content types from Process Manager to SAP Solution
Manager):
o
o
o
o
o

Folders
Sub folders as scenarios
BPMN diagrams as processes
Tasks as Process Steps and linked dictionary entries as Process Step Originals
Custom attributes

13.12.1 Process structure on the SAP side
How processes are created and structured differs between SAP Solution Manager
and Signavio Process Manager.
In SAP Solution Manger, unlike Process Manager, there is a distinction between process definitions and visual process diagrams.
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A structure that contains process definitions is called a scenario. A process definition can contain a list of Process Steps. Process Steps are stored in the Process
Step library and can contain additional links, material and attributes. This list of Process Steps can be used to create visual process diagrams.

13.12.2 Set up the integration with SAP Solution Manager 7.2
To set up the integration, follow the descriptions in the sections Configure SAP
Solution Manager and Configure Process Manager.

13.12.3 Next steps
o
o
o
o
o

Configure SAP Solution Manager
Configure Process Manager
Import Solution Manager content to the dictionary
Export to Solution Manager
Troubleshooting

13.12.4 Configure SAP Solution Manager
To prepare SAP Solution Manager for the integration with Process Manager, first
configure your systems to allow communication with Process Manager and then set
up the solution you want to integrate.
13.12.4.1 Network & firewall requirements
Ensure your security settings allow incoming requests from Process Manager to
your SAP Solution Manager server (to the URL/port you need to specify later). The
IP address of the SAP Solution Manager integration service is 130.0.76.232 for editor.signavio.com .

(missing or bad snippet)

You can optionally use a reverse proxy to shield your SAP Solution Manager server.
The following diagram shows communication between Process Manager and Solution Manager:

Version 14.9

622

13 Workspace administration

13.12.4.2 Basic administration
Activate Process Management in SAP Solution Manager as described in the SAP
Solution Administration documentation .
Ensure that in the list of gateway services for Process Management, the
following services are activated:
o

AGS_GBC_ODATA_BPMN_SRV

(Graphical Component BPMN Gateway Ser-

vice)
o
o

(GBC GOM Gateway Service)
PROCESSMANAGEMENT (SAP Solution Manager APIs for third party tool
AGS_GBC_ODATA_GOM_SRV

integration)
13.12.4.3 Solution administration
SAP recommends that you use exactly one solution for the production
scope of your SAP Solution Manager.
To set up the solution you want to integrate, follow these steps:
1. Open the Solution Administration, either through the GUI or by executing
the transaction soladm .
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2. Create a new solution or select an existing one.

Creating a new solution

3. Select the branch you want to use for the integration.
4. Leave the browser tab open or document the names of the Solution and

Branch. You'll need them when configuring the integration on the Process
Manager side.
You'll also need the SAP solution administration later for Configure SAP
Solution Manager .

13.12.4.4 Next steps
Configure Process Manager

13.12.5 Configure Process Manager
When you have configured SAP Solution Manager as described in section Configure
SAP Solution Manager, you can configure Process Manager.
To set up Process Manager for the integration, you first set up the connection as
described in this section. You then define attribute mappings as described in section
Configure attribute mappings.
13.12.5.1 Necessary user rights
You need to enter credentials for a user in the connection setup. The rights this
user needs can be system-specific. We recommend to start on a test branch with a
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powerful user for establishing the connection. Then you can remove user rights one
by one to find out what the minimum rights are to use for the connection to the
actual branch.
13.12.5.2 Set up the connection to SAP Solution Manager
1. In the Process Manager explorer, select Setup - Manage SAP Solution Manager 7.2.

The settings open in a new tab.
2. Point to your Solution Manager endpoint, which typically is <solu-

tionManagerURL>:<port>sap/opu/odata/sap/PROCESSMANAGEMENT/ . <solutionManagerURL>

stands for the base URL of your SAP Solution Manager

server and <port> for its port number.
3. Enter your credentials, the solution, and branch name of your solution:

o

Your SAP Solution Manager server needs to accept incoming
requests on the port specified in the URL from Process Manager's Solution Manager integration service. The IP address of
this service is 130.0.76.232 for editor.signavio.com .

o

(missing or bad snippet)

o

We recommend creating a new branch specifically for the Process Manager import.

4. Click Save.
13.12.5.3 Using self-signed certificates for server-side authentication
Signavio accepts certificate chains signed by any common certificate
authority by default. Uploading a certificate is only necessary when your
Solution Manager server tries to authenticate itself against Signavio
using a certificate, which is self-signed instead of signed by a trusted
certificate authority.
You can use self-signed certificates with your connection configuration. Once
uploaded, this certificate is trusted on every request sent to Solution Manager.
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Self-signed certificates must be in the SSL X509 format encoded with Base64 (this
happens by default when exporting certificates from a web browser). If your certificate is in the PKCS7 format, you need to convert it. Make sure your certificate is
in the following format:
-----BEGIN CERTIFICATE----followed by the content of the certificate on a new line.
Then, on another new line, finish the certificate with
-----END CERTIFICATE----To upload your certificate, in the Configure tab, click Select a certificate next to
SSL Certificate.
13.12.5.4 Keystore for client-side authentication
You can additionally upload a keystore containing a private key so that your Solution Manager server can validate that requests are indeed coming from the Signavio Solution Manager connector (client-side authentication).
To set up client-side authentication, follow these steps:
1. In the Process Manager Explorer, select Setup - Manage SAP Solution Manager 7.2.

The settings open in a new tab.
2. In the tab Connection settings, upload the keystore for client-side authentication.

3. Enter the keystore password.
4. Click Save.
Two-way authentication is set up.
The PKCS12 format is accepted for keystores. Uploaded files are validated.
13.12.5.5 Technical information
Signavio uses the API of the Process Management component of Solution Manager
7.2 to read and update the branch content. We use GET and PUT requests via https.
For session handling, the Signavio connector authenticates with GET request, sending a username and password and requesting a CSRF token. The response from Solution Manager is an unauthenticated session and a CSRF token. The token from the
first request is used for all further communication. It's a unidirectional connection.
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13.12.5.6 Next steps
o
o

Configure attribute mappings
Import Solution Manager content to the dictionary

13.12.6 Configure attribute mappings
You can configure attribute mappings that specify how content structures in Process Manager are aligned to content structures in SAP Solution Manager.
To configure mappings, follow these steps:
1. Switch to the Attribute mappings tab.
2. Define the SAP Solution Manager attribute that stores the Collaboration Hub
link to exported processes.
3. Optionally, you can configure mappings between Process Manager custom
attributes and SAP Solution Manager attributes.
The following Process Manager attribute types are supported:
o
o
o
o
o
o

Boolean
Number
Single-line text

Multi-line text
Drop-down (enumeration)
Dictionary link

If the Signavio attributes are defined as lists, the mapped Solution Manager 7.2
attributes have to be of the type multivalue to be compatible.
Read more about how to configure attributes in Solution Manager in this SAP blog
post .

13.12.7 Import Solution Manager content to the dictionary
You can import the following from SAP Solution Manager into the Signavio Process
Manager dictionary:
o
o

Executable Transactions from the Executable Library
Process Steps from the Process Step Library
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We recommend to trigger the import to Process Manager before you
start modeling your processes. This makes the imported content available to the modelers when you start mapping your processes.
You can import one or both content types into the dictionary. When you import
both types, modelers can use both in diagrams.
13.12.7.1 Create custom dictionary categories
We recommend that you create custom dictionary categories specifically for SAP
Solution Manager content and restrict write access to these categories to members
of the administrators group.
o

o

The custom dictionary category for executable transactions must be of the type
Others
The custom dictionary category for Process Steps must be of the type Activities

How you create custom dictionary categories is described in section Defining custom categories for dictionary entries
13.12.7.2 Import executable transactions
In SAP, executable transactions are program functions that form the building blocks
of a solution's business processes. You can import the definitions of available executable transactions from SAP Solution Manager to Signavio Process Manager as dictionary entries and use them in your process models.
To configure and run transaction imports, follow these steps:
1. Open the Dictionary Mappings tab.
2. Select the custom dictionary category of the type Others.
3. Click Import Transactions.
The executable transactions are imported.

o

When executable transactions are imported, the full library is imported. Limiting which transactions are imported is not possible, since
the Solution Manager API only allows to import the full branch
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o

o

content.
Only the name and description of the transactions are imported into
the dictionary. It isn't possible to import attributes.
The folder hierarchy from Solution Manager is not imported, all
executable transactions are added to the same dictionary category.

13.12.7.3 Import Solution Manager Process Steps
When you import Process Steps to the dictionary, modelers can link BPMN tasks directly to Process Steps. This way, the tasks contain all additional links, material and
attributes defined in the linked Process Steps when exported to Solution Manager
later.
1. Open the Dictionary Mappings tab.
2. Select the custom dictionary category of the type Activities.
3. Click Import Process Steps.
The Process Steps are imported.
The folder hierarchy from Solution Manager is not imported, all Process
Steps are added to the same dictionary category.

13.12.8 Export to Solution Manager
You can export the following content types from Process Manager to SAP Solution
Manager:
o
o
o
o
o

Folders
Sub folders as scenarios
BPMN diagrams as processes
Tasks as Process Steps and linked dictionary entries as Process Step Originals
Custom attributes

Conflicts during import or export can be found in a log output.
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Export BPM projects to SAP Solution Manager

1. Select the folder you want to export and select Import/Export - Export to
SAP® Solution Manager® 7.2 .

You cannot export single diagrams, you always need to export the folder
containing the diagram.
A new tab opens.
2. Click Start.
The status of the export is shown.
After a successful export, the selected folders and processes are available in SAP
Solution Manager.
13.12.8.1 Export links to executable transactions to SAP Solution Manager
Executable transactions are not exported to SAP Solution Manager. Instead, links to
the transaction definition in Solution Manager are exported with any BPMN task
that contains transaction references. Changes to executable transactions on the
Process Manager side are ignored during export. Changes made in Solution Manager
are updated in Signavio Process Manager when the import is triggered again. No
new object is created in this case.
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You need a custom attribute for the export, for referencing transactions in business
processes. We recommend that you create an attribute specifically for this purpose.
How to create custom attributes is described in section Add and manage custom
attributes.
1. Configure a custom attribute of the type Dictionary link (list) for the element
type task of BPMN diagrams.

2. Restrict the attribute to only support dictionary entries of the category you
configured for the import of transactions.

3. Switch to the SAP Solution Manager configuration and open the tab Dictionary Mappings.

4. In the Export section, select your custom attribute.
Now linked transactions are part of your export.
5. To start an export, close the configuration tab and switch back to the explorer
.

13.12.8.2 Export Process Steps to the Process Step Library in SAP Solution Manager
Solution Manager requires that every Process Step in a process references a Process Step original from the Process Step Library. For every exported BPMN task,
one of the following actions is performed:
If the task references a Process Step (via an imported dictionary item)
no new Process Step original is created in Solution Manager. The exported Process Step
references the existing Process Step original.
If the task references a dictionary item that hasn't been imported from the Process Step Library
A new Process Step original is created in the library and the exported Process Step references it. For all following tasks referencing the same dictionary item, the exported Process Step will reference this Process Step original (this means only one original is created
per dictionary item). For subsequent exports, the Process Step original is reused.
If the task references no dictionary item:
a new Process Step original is created and the exported Process Step references it. On subsequent exports the Process Step original is reused.

13.12.8.3 Changing the link of an dictionary item
Removing a link to a dictionary item or linking to a different dictionary item in Process Manager doesn't adjust the existing link in SAP Solution Manager if the item
was exported with a different state before.
If you want to change a link to a dictionary item, follow these steps:
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1. Delete the task in Process Manager.
2. Create a new task with the new link.
3. In SAP Solution Manager, delete the outdated item.
4. Export the new item to SAP Solution Manager.
13.12.8.4 Deleting items
You cannot delete SAP Solution Manager items in Process Manager. Deleted items
in Process Manager are still present in the SAP Solution Manager after an export.
To delete an item, for example a model, a directory, or an attribute, you must delete
it on the SAP Solution Manager side.

13.12.9 Troubleshooting
13.12.9.1 Setup/connection settings
If you have problems setting up the integration, test the availability of the Process
Management Gateway Service (typically sap/opu/odata/sap/PROCESSMANAGEMENT/
):
1. In the SAP GUI, execute the SAP Gateway Client transaction /IWFND/GW_
CLIENT

.

2. Send a GET request against: sap/opu/odata/sap/PROCESSMANAGEMENT/?$format=json

.

You also need to ensure this request is accepted when made from the origin
Process Manager's integration service.
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Problem/Error
message
URL is not
reachable/no
message

Solution
o

Check which URL you have entered for the Solution Manager. Often this address is an internal one that cannot
be reached from the internet. This means the request
needs to be rerouted, using a reverse proxy, the SAP
Cloud Platform Integration (SCPI), a load balancer, an API
management tool, or something similar. The internal
domain has to be replaced by the URL of this gateway.
The component of the Solution Manager that we access

o

via the API is sap/opu/odata/sap/ProcessManagement.
Check the user rights. If the rights are not sufficient, you
get an unspecific the error message. In that case, you
can view the login of the user in the Solution Manager to
confirm that an incorrect URL is not the cause of the
problem.

Connection
failed (the
Solution does
not exist)

Check the Solution Name you've entered. It has to be the technical
name of the Solution that can be found in the properties section of
the Solution in the Solution Manager. By default it's the solution
name in capital letters.

Connection
failed (the
Branch does
not exist)

Check the branch name you've entered. It has to be the technical
name of the branch that can be found in the properties section of
the branch in the Solution Manager. By default it's the branch name
in capital letters.

Credentials
Check the username and password you've entered to log in to the
are incorrect Solution Manager.
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Problem/Error
message
Connection
can't be
established

Solution

1. Trace the request and check if there is an incoming
request of the IP 130.0.76.232 at your firewall and/ or
the used gateway.
2. If there is no incoming request, check the URL you've
entered and your firewall settings
3. If there is an incoming request, check if there is a login
or login attempt on the SAP Solution Manager with the
credentials entered in the connection settings tab
4. If there is no login, check your gateway settings
5. If the login to the Solution Manager is successful but
you don't get a message that the connection is established:
o

check the SSL settings of your network. If you use a
self-signed certificate inside your network or for
your Solution Manager, this certificate needs to be

o

uploaded in the settings.
the self-signed certificate is valid for a specific
internal IP address. For the Signavio side of the connection, the answer to the request is coming from
the gateway and not the internal server IP.

6. If you still can't establish a connection, please contact
Signavio Support. To enable Signavio Support to
check the logs for your workspace, open the Attribute
mappings tab, and note the time you did this.
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Problem/Error
message

Solution

The connection was
established,
but diagrams
can't be
exported

o

For the export, Signavio uses a PUT request, check if

o

your firewall or gateway are blocking these requests
There could be a problem with the session handling and
the CSRF Token. For the PUT request Signavio uses the
CSRF Token, which is received at the initial login of the
session. This CRSF Token could be filtered out of the
header at the gateway. It is also possible that the Solution Manager issued a new CRSF Token for each request.

Virus scan
error message

If you get the error message Virus scan profile does not exist,
Signavio Process Manager cannot access the SAP Solution
Manager API.
To have a successful virus scan, an SAP-certified virus scanner software needs to be installed and configured.
If you assume that there is no risk from connections outside
your network, for example your SAP Solution Manager
server is run in an on-premises structure, it is possible to
deactivate the virus scan.
Signavio recommends to configure your virus scan according to the SAP specifics.
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13.12.9.2 Export
Problem
The connection was
established,
but diagrams
can't be
exported

Solution
o

For the export, Signavio uses a PUT request, check if

o

your firewall or gateway are blocking these requests
There could be a problem with the session handling and
the CSRF Token. For the PUT request Signavio uses the
CSRF Token, which is received at the initial login of the
session. This CRSF Token could be filtered out of the
header at the gateway. It is also possible that the Solution Manager issued a new CRSF Token for each request.

Exports fail

Process Manager is only able to act as connector to the SAP
Solution Manager. This connection is not able to verify the
constraints of SAP Solution Manager attributes, for example
a size limit. When an attribute is mapped that contains a
value that is longer than this size maximum, the export fails.
In that case, check the attribute constraints.

Export single You cannot export single models. To export content, select
models is not
folders that contain the models to be exported. Every model
possible

and every subfolder contained in the selected folder is
exported.
To export BPM projects to SAP Solution Manager, proceed
as described in Export BPM projects to SAP Solution Manager .
Models
linked in collapsed subprocesses
are not
exported

To export a model that links to another model by a collapsed subprocess, the linked model must be in the same
top-level folder as the model you want to export. Additionally, make sure that the linked model and the main
model are always exported together to ensure that the
linked data is consistent.
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13.12.9.3 Import into the dictionary
Problem/Question

Solution

How is the transaction Via the Processmanagement API.
list imported from SoluSignavio uses a GET request to retrieve the contion Manager?

tent of the specified branch. Only executable transactions listed in the Executable Library in this
branch are imported.
Is it possible to use

Signavio only imports elements from the Execut-

an ABAP program

able Library. If the program can fill the Executable

from SAP to define

Library or if you can import the program results

the scope of the

into that library, you can use the program. Sig-

transaction list that

navio always imports the complete library from

is imported?

the branch.

The program
extracts the executable transactions
per system, per module, or per function.

13.13 System integration scenarios
While Process Manager is a powerful tool in itself and in combination with other
applications of the Signavio Business Transformation Suite , many organization
integrate it with third-party or custom systems of their enterprise application landscape. This document provides an overview of common integration scenarios.

13.13.1 Migrating content from other process modeling tools
If you have already modeled some of your processes with a different tool, you want
import your diagrams in Signavio Process Manager without cumbersome manual
copy-and-paste. Signavio Process Manager supports the open standard BPMN 2.0
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XML for process diagram interchange, but you can also import diagrams of most popular proprietary formats. Read more in the Importing/exporting diagrams and
uploading files overview of this user guide.

13.13.2 Synchronizing data between Process Manager and
enterprise architecture and document management systems
Many customers want to exchange data between Signavio Process Manager and
enterprise architecture and document management systems, either as a one-time
transfer of enterprise application or document definitions, or to setup continuous
synchronization process.
Depending on the requirements, there are different options for an integration:
o

For a one-time transfer of data to Signavio Process Manager, you export the
data from your tool in any spreadsheet-like format and use Import dictionary

o

entries to generate the corresponding dictionary entries.
For the architecture management tool LeanIX, a special interface is available
that allows a seamless synchronization of LeanIX and Signavio Process Manager

o

data. Read more in the corresponding LeanIX documentation .
For Microsoft SharePoint, see Configuring SharePoint Search to search for documents that have been uploaded in SharePoint and then associated with dia-

o

gram elements or dictionary entries in Signavio Process Manager.
For custom integrations, you can utilize Signavio Process Manager REST API to
automate data synchronization with third-party systems. To license the Signavio Process Manager API, contact our Sales Team at sales@signavio.com .

13.13.3 Access to Collaboration Hub
The Collaboration Hub is the single source of truth about your process landscape
for all people who contribute to your organization. Consequently, it should be easily
accessible and integrated with other systems that provide your employees with crucial information.
Read more about
o
o

Single sign-on to Collaboration Hub
Integrating Collaboration Hub with Microsoft SharePoint Online
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You can also embed Collaboration Hub through an iframe into any intranet or content management system. Read more at Embedding Collaboration Hub via an
iframe .

13.13.4 Integrating Process Manager with project management
systems and wikis
Many organizations use multiple systems for knowledge management in addition to
Signavio Process Manager, for example ticket tracking/project management systems and wikis.
You find instructions on how to embed diagrams in third-party systems at Publishing diagrams to external systems .
If you have very specific requirements, consider licensing the Signavio Process Manager API, which consists of the following two components:
o

o

The REST API allows you to retrieve data from Signavio Process Manager via a
popular and well-established data exchange pattern.
The MASHUP API allows you manipulate the visual properties of embedded diagrams with custom JavaScript.

13.13.5 Single sign-on
Users find it inconvenient to manage authentication credentials for every system
in your enterprise application landscape. Enabling single sign-on improves user
experience (less time spent on login procedures and password recoveries) and
enhances security (less tempted to use easy-to-guess passwords or write passwords on post-its). Signavio Process Manager supports Single sign-on using SAML.
Signavio Collaboration Hub also supports Managing access to Collaboration Hub
for Active Directory services.

13.13.6 Integrating Process Manager with ERP systems
Many customers use Signavio Process Manager to get the most out of their ERP
implementation projects. Integrating Process Manager with your ERP system
ensures your process definitions are always in sync with your ERP system's reality.
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13.13.6.1 Signavio Process Manager for SAP Solution Manager
Engaging business users is a key success factor for SAP implementation projects
and ongoing system operations. Signavio Process Manager is the perfect businessfacing interface for SAP Solution Manager. Read more about integrating Signavio
Process Manager with SAP Solution Manager at Signavio Process Manager for
SAP Solution Manager 7.2 .
13.13.6.2 Custom API integration
If you use a different ERP system, you can implement a custom integration using
Process Manager's REST API. REST APIs are programming language-independent
and follow a popular and well-established data exchange pattern. This simplifies the
implementation for your IT department, because your engineers don't need to learn
a new programing language or paradigm. To license the Signavio Process Manager
API, contact our Sales Team at sales@signavio.com .

13.13.7 Integrating Process Manager with business process
execution (BPX) engines
Business process execution (BPX) engines allow you to execute the process models
you create with Signavio Process Manager. Because process execution is based directly on BPMN 2.0 (or DMN 1.1) diagrams, BPX engines close the communication
gap between business and IT in combination with collaborative process modeling
tools. Generally, you can integrate Signavio Process Manager with any BPX engine
that supports BPMN 2.0 XML. Below we list some of the most popular engines.
13.13.7.1 Signavio Workflow Accelerator
Signavio provides its own workflow execution platform Signavio Workflow Accelerator , which enables business users to automate workflows, while keeping IT
involvement at a minimum. Read more in the chapter Integrating Signavio Process
Manager with Workflow Accelerator of the Signavio Process Manager user guide.
We recommend using Signavio Workflow Accelerator for automating workflows
with human participation.

Version 14.9

640

13 Workspace administration

13.13.7.2 Camunda
Camunda provides a Java-based platform for automating business processes and
business decisions. In the Camunda documentation you can learn more about
deploying diagrams you created in Signavio Process Manager to Camunda's business process execution environment. Because process automation with Camunda
requires extensive Java development expertise, we recommend an integration
primarily for high-scalability process automation in a scenario where software
development resources are both available and inevitable necessary.
13.13.7.3 Red Hat Decision Manager
Red Hat Decision Manager is recommendable to automate IT-heavy, high-volume
processes. To get started with setting up an integration of Signavio Process Manager and Red Hat Decision Manager, read the following articles:
o
o

Exporting diagrams to Red Hat Decision Manager projects on GitHub
From Design to Execution with JBoss BPM Suite & Signavio Process Manager

13.13.8 Generating custom reports
The Creating reports function of Process Manager can provide you with detailed
insights into diagram and usage metrics. For example, Viewing governance reports
offers an overview of usage statistics and helps you confirm your process management initiative is really taking off. To create customized reports, you can use process documentation templates or aggregate data of process characteristics reports
with spreadsheet software like Microsoft Excel. We recommend creating custom
reports by utilizing the Signavio REST API only in scenarios with very specific
requirements that cannot be fulfilled otherwise.

13.13.9 Translating Process Manager content with external tools and
services
If you are part of an internationally operating organization, you might want to document at least some of your processes in multiple languages. Process Manager supports the creation of multi-lingual content - see Translating diagrams . Some
customers prefer to outsource the content translations to a third party, who does
not have direct access to the Process Manager workspace. In such a scenario, you
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can setup a custom integration - for example with a translation management system - through Process Manager's REST API. To license the Process Manager API,
contact our Sales Team at sales@signavio.com .

13.14 Purchasing additional licenses
Our website provides a detailed overview of the different features and license types
at https://www.signavio.com/products/process-manager/ . If you want to purchase or upgrade licenses, please contact the Signavio Sales Team at sales@signavio.com.

13.15 API access to the Signavio Process Manager
Using the Signavio Process Manager APIs requires an explicit API
license. You need to purchase this license in addition to your Process
Manager user licenses. This document provides an overview of the capabilities of Process Manager APIs. The full API documentation is only
available for customers who purchased an API license.
This section provides an overview of the accessible APIs. For more information on
common integration scenarios, see System integration scenarios .
The following diagram illustrates how to access Signavio Process Manager with the
REST API and the Mash-up API.
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13.15.1 The Signavio Process Manager REST API
The REST API provides access to Process Manager resources via HTTP.
We also provide a collection of requests you can import into the Postman HTTP client. With Postman, you can execute requests to get to know the API and generate
code snippets to transfer them to your API development project.
13.15.1.1 REST API coverage
You can use the REST API to work with folders and diagrams. You can:
o
o
o

o
o
o
o
o

List folders and their contents
Create, rename, move and delete folders
Search folders and diagrams. Searching supports filtering by result type and
paging search results.
List a diagram’s revisions
Fetch a specific diagram revision in JSON, BPMN 2.0 XML, SVG and PNG formats
Create, update, rename, move, copy, publish and delete diagrams
Import diagrams from BPMN 2.0
Check BPMN 2.0 diagram syntax

You can also use the REST API to work with the Dictionary and set-up. You can:
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o
o
o

o
o
o
o

List Dictionary categories and fetch category details
Create, update and delete Dictionary categories
Search for Dictionary entries by category, initial letter of the entry name, or full
text. Searching supports sorting and paging search results.
Fetch Dictionary entries
Create, update and delete Dictionary entries
Create custom attributes
Create custom data types (requires the Enterprise Plus Edition of Process Manager)

13.15.2 The Signavio Process Manager Mash-up (JavaScript) API

Using the Mash-up API: screen shot of an embedded Signavio diagram

13.16 Business Transformation Suite
Currently, there are some prerequisites for using this feature. For more
information, please contact Signavio Support.
When you enable the Business Transformation Suite, all users are directed to the
launchpad of the new Collaboration Hub.
Users with a modeling license are no longer directed to the explorer
when Business Transformation Suite is enabled.
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The look and feel of the launchpad is different than the old Collaboration
Hub, we recommend to inform users in your workspace about the switch.
You find more information about the launchpad in the section Your
launchpad.

13.16.1 Enable the Business Transformation Suite for your
workspace
To enable the Business Transformation Suite for your workspace, open the explorer
and click Setup > Edit Collaboration Hub configuration.
o

In the field Activate new Collaboration Hub enter the date. You need to enter a
date that is at least 72 hours ahead, as it will take 72 hours to enable the Business Transformation Suite for your workspace.
Once the Business Transformation Suite is enabled for your workspace, each
user is directed to the landing page of the Collaboration Hub. To preview the
Collaboration Hub, click the link below the date.

o

To disable the Business Transformation Suite for your workspace, click Disable &
switch back to the old Collaboration Hub. The Business Transformation Suite
will be disabled immediately for your workspace.
Disabling the Business Transformation Suite has no effect on
changes made in your workspace during the activation period. All
changes, for example new diagrams that were created, are kept.
Once the Business Transformation Suite is disabled for your workspace, users
with a modeling license are again directed to the explorer.
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13.17 Frequently asked questions
13.17.1 How can I remove a user from my workspace and what are
the consequences?
In the Explorer menu bar, click Setup, then Manage users to open the Managing
users and access rights. Select a user in the left column and click Remove user.
When you delete users from a workspace, the system doesn't send out a notification email. The next time the deleted user tries to log in, the system will show
an incorrect username-password combination error.
With the deletion of a user, all diagrams and files in the user's My Documents
folder are deleted as well. The diagrams and files the user created in or uploaded
into the Shared Documents folder remain, as well as comments and changes the
user made to other diagrams. Also, dictionary entries the user has created or edited
remain.

13.17.2 What are the possibilities to integrate Process Manager and
Collaboration Hub with Microsoft SharePoint, Active Directory and
SAML?
You find an overview of all common integration scenarios at System integration
scenarios.

13.17.3 We use the Microsoft SharePoint component of the Signavio
Collaboration Hub. Why is it not possible to print diagrams?
This problem can be solved by adding Signavio Process Manager to the trusted sites
of Internet Explorer. If you use Signavio Process Manager in the software-as-a-service version, the corresponding URL is https://editor.signavio.com (European
server), respectively https://app-us.signavio.com (US server) or https://appau.signavio.com (Australian server).
In the section Installing the browser certificate, you find detailed information on
how to set trusted sites.
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